IBM DB2 Web Query
for i
Version 2.1

Follow the best practice guides to simplify report development

Take your reporting to the next level of Business Intelligence

Learn DB2 Web Query by using the easy-to-follow
IBM DB2 Web Query for i Version 2.1: Implementation Guide

January 2014
**Note:** Before using this information and the product it supports, read the information in "Notices" on page ix.


This edition applies to IBM i 7.1 (product number 5770-SS1).
# Contents

<table>
<thead>
<tr>
<th>Notices</th>
<th>ix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trademarks</td>
<td>xi</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preface</th>
<th>xiii</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authors</td>
<td>xiv</td>
</tr>
<tr>
<td>Now you can become a published author, too!</td>
<td>xvii</td>
</tr>
<tr>
<td>Comments welcome</td>
<td>xviii</td>
</tr>
<tr>
<td>Stay connected to IBM Redbooks</td>
<td>xix</td>
</tr>
</tbody>
</table>

### Part 1. Tutorials for DB2 Web Query

<table>
<thead>
<tr>
<th>Chapter 1. Getting started with the tutorials</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The “Century Challenge”</td>
<td>3</td>
</tr>
<tr>
<td>1.2 The assignments</td>
<td>4</td>
</tr>
<tr>
<td>1.3 The QWQCENT library</td>
<td>6</td>
</tr>
<tr>
<td>1.3.1 Restoring QWQCENT on your system</td>
<td>8</td>
</tr>
<tr>
<td>1.3.2 Downloading completed tutorials</td>
<td>9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2. Security Center: Setting up users</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 How to open the Security Center</td>
<td>12</td>
</tr>
<tr>
<td>2.2 Registering user profiles to DB2 Web Query</td>
<td>13</td>
</tr>
<tr>
<td>2.3 How to designate a Web Query Administrator</td>
<td>16</td>
</tr>
<tr>
<td>2.4 Removing a user from a Web Query group</td>
<td>18</td>
</tr>
<tr>
<td>2.5 Adding a developer to a Top Level Folder</td>
<td>19</td>
</tr>
<tr>
<td>2.6 Giving run-only authority to an existing IBM i group profile</td>
<td>21</td>
</tr>
<tr>
<td>2.7 How to manage users and their attributes</td>
<td>27</td>
</tr>
<tr>
<td>2.8 Changing the owner of a report</td>
<td>29</td>
</tr>
<tr>
<td>2.9 Preparing steps for the tutorial</td>
<td>31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3. Creating and editing metadata: Century database</th>
<th>33</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Creating metadata using the metadata creation wizard</td>
<td>34</td>
</tr>
<tr>
<td>3.2 Enhancing metadata: Join</td>
<td>37</td>
</tr>
<tr>
<td>3.3 Date decomposition</td>
<td>43</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4. Assignment #1: Summary reports</th>
<th>47</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Revenue summary</td>
<td>48</td>
</tr>
<tr>
<td>4.1.1 Creating the revenue summary report</td>
<td>48</td>
</tr>
<tr>
<td>4.1.2 Adding a gross profit Define field</td>
<td>54</td>
</tr>
<tr>
<td>4.1.3 Adding a header and footer</td>
<td>58</td>
</tr>
<tr>
<td>4.1.4 Changing the theme</td>
<td>60</td>
</tr>
<tr>
<td>4.1.5 Adding traffic lighting</td>
<td>61</td>
</tr>
<tr>
<td>4.1.6 Publishing the report</td>
<td>65</td>
</tr>
<tr>
<td>4.2 Top 10 (ten) products by margin</td>
<td>66</td>
</tr>
<tr>
<td>4.2.1 Opening and saving a new copy of the report</td>
<td>67</td>
</tr>
<tr>
<td>4.2.2 Adding by field</td>
<td>68</td>
</tr>
<tr>
<td>4.2.3 Creating Define and Compute fields</td>
<td>68</td>
</tr>
<tr>
<td>4.2.4 Adding rank to the profit margin</td>
<td>72</td>
</tr>
<tr>
<td>4.2.5 Adding data visualization bars</td>
<td>73</td>
</tr>
<tr>
<td>4.3 Revenue summary with subtotals</td>
<td>74</td>
</tr>
</tbody>
</table>
Chapter 13. Assignment #10: Scheduling and distribution of reports

13.1 Report Broker overview ................................................................. 387
13.2 The assignment ........................................................................... 388
13.3 Configuring Report Broker .............................................................. 389
13.4 Scheduling a simple report and distributing by email ....................... 391
13.5 Scheduling a report with parameters and distributing it via email .......... 400
   13.5.1 Creating an Email Distribution List ........................................ 400
   13.5.2 Scheduling the report .............................................................. 403
13.6 Scheduling a report and distributing it by DB2 Web Query ................. 407
13.7 Scheduling a report and distributing it by FTP ................................. 412
13.8 Scheduling a report and distributing by printer ..................................... 422
13.9 RUNBRSCHE D command ............................................................. 424
13.10 Report Broker Console ................................................................. 426

Chapter 14. Assignment #11: Going mobile

14.1 Mobile access assignment ............................................................. 429
14.2 Preparing reports for mobile access ................................................... 430
14.3 Accessing mobile content using the web browser .............................. 432
14.4 Using Mobile Faves app ................................................................. 434
   14.4.1 Installing Mobile Faves ............................................................. 434
   14.4.2 Connecting to reporting server and running reports .................... 435
   14.4.3 Adding additional reports to mobile favorites .............................. 436
   14.4.4 Saving reports for offline view .................................................. 441
14.5 Opening reports received by email ................................................... 444
14.6 How to use Active Technologies on mobile devices ............................ 446

Chapter 15. Assignment #12: Stored procedures in action

15.1 Getting the most from your data with stored procedures .................... 453
   15.1.1 Prerequisites ......................................................................... 454
15.2 Creating a stored procedure synonym ................................................. 454
   15.2.1 Reasons you might use a stored procedure .................................. 454
15.3 Example of an HR-related stored procedure ......................................... 455
   15.3.1 Creating the synonym for the stored procedure example ................ 456
15.4 Creating a report using the stored procedure synonym ......................... 459
   15.4.1 Starting Info Assist to create the report ....................................... 460
   15.4.2 Establishing the join between Plant table and stored procedure ......... 462
   15.4.3 Formatting the report ............................................................... 464
   15.4.4 Saving your report based on a stored procedure ......................... 469
15.5 Example of an input parameter stored procedure in RPG .................... 470
   15.5.1 Creating the synonym for the MULTINPARM stored procedure ......... 471
   15.5.2 Creating the report from the MULTINPARM stored procedure synonym 472
   15.5.3 Using Info Assist to create the report ......................................... 472
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.5.4 Formatting the report</td>
<td>473</td>
</tr>
<tr>
<td>Chapter 16. Assignment #13: Query/400 modernization</td>
<td>479</td>
</tr>
<tr>
<td>16.1 Query/400: a reliable reporting tool</td>
<td>480</td>
</tr>
<tr>
<td>16.2 DB2 Web Query versus Query/400: Function similarities</td>
<td>480</td>
</tr>
<tr>
<td>16.3 DB2 Web Query versus Query/400: Function differences</td>
<td>480</td>
</tr>
<tr>
<td>16.3.1 Parameter passing</td>
<td>481</td>
</tr>
<tr>
<td>16.3.2 Using output files for the next query</td>
<td>481</td>
</tr>
<tr>
<td>16.4 The assignment</td>
<td>482</td>
</tr>
<tr>
<td>16.5 Creating metadata over Query/400 objects</td>
<td>482</td>
</tr>
<tr>
<td>16.6 Using DB2 Web Query to edit a QRYDFN</td>
<td>487</td>
</tr>
<tr>
<td>16.7 Modernizing Query/400 definitions</td>
<td>488</td>
</tr>
<tr>
<td>16.7.1 Building the initial report</td>
<td>489</td>
</tr>
<tr>
<td>16.8 The migration dilemma for Query/400 reporting</td>
<td>495</td>
</tr>
<tr>
<td>16.9 Modernizing your reporting</td>
<td>495</td>
</tr>
<tr>
<td>16.9.1 IBM offering for Query modernization</td>
<td>495</td>
</tr>
<tr>
<td>16.10 Replacing Query/400 objects with Active Reports</td>
<td>496</td>
</tr>
<tr>
<td>16.10.1 Highly parameterized report development</td>
<td>496</td>
</tr>
<tr>
<td>16.10.2 Creating the report in HTML Composer</td>
<td>501</td>
</tr>
<tr>
<td>16.10.3 Parameter controls</td>
<td>507</td>
</tr>
<tr>
<td>16.10.4 Chaining the controls together</td>
<td>509</td>
</tr>
<tr>
<td>16.10.5 Using calendar controls</td>
<td>511</td>
</tr>
<tr>
<td>16.10.6 Providing multiple report output format options for users</td>
<td>517</td>
</tr>
<tr>
<td>16.11 Additional parameter tips</td>
<td>520</td>
</tr>
<tr>
<td>16.11.1 Displaying the values of one column while passing another</td>
<td>520</td>
</tr>
<tr>
<td>16.11.2 Using another report to control parameter sorting and filtering</td>
<td>527</td>
</tr>
<tr>
<td>Chapter 17. Assignment #14: Creating JD Edwards reports</td>
<td>533</td>
</tr>
<tr>
<td>17.1 Connecting to a remote JD Edwards database using adapters for JD Edwards</td>
<td>534</td>
</tr>
<tr>
<td>17.1.1 Areas to consider when connecting to a remote JD Edwards database</td>
<td>534</td>
</tr>
<tr>
<td>17.1.2 Using JD Edwards adapter to connect to a remote JD Edwards database</td>
<td>534</td>
</tr>
<tr>
<td>17.1.3 JD Edwards dictionary files needed on local system to access remote JD Edwards databases</td>
<td>535</td>
</tr>
<tr>
<td>17.2 Using the Adapter for JD Edwards World</td>
<td>535</td>
</tr>
<tr>
<td>17.2.1 Preparing the JD Edwards World environment</td>
<td>535</td>
</tr>
<tr>
<td>17.2.2 Overview of the setup process</td>
<td>536</td>
</tr>
<tr>
<td>17.2.3 Configuring the Adapter for JD Edwards World</td>
<td>536</td>
</tr>
<tr>
<td>17.2.4 Refreshing the Metadata repository</td>
<td>539</td>
</tr>
<tr>
<td>17.2.5 Creating the JD Edwards World synonyms</td>
<td>540</td>
</tr>
<tr>
<td>17.3 Using the adapter for JD Edwards EnterpriseOne</td>
<td>541</td>
</tr>
<tr>
<td>17.3.1 Preparing the JD Edwards EnterpriseOne environment</td>
<td>541</td>
</tr>
<tr>
<td>17.3.2 Overview of the setup process</td>
<td>541</td>
</tr>
<tr>
<td>17.3.3 Configuring the adapter for JD Edwards EnterpriseOne</td>
<td>542</td>
</tr>
<tr>
<td>17.3.4 Refreshing the metadata repository</td>
<td>545</td>
</tr>
<tr>
<td>17.3.5 Refreshing the security extract</td>
<td>545</td>
</tr>
<tr>
<td>17.3.6 Creating the JD Edwards EnterpriseOne synonyms</td>
<td>546</td>
</tr>
<tr>
<td>17.4 Developing a JD Edwards report</td>
<td>548</td>
</tr>
<tr>
<td>Chapter 18. The Century Challenge BI solution: Postmortem</td>
<td>559</td>
</tr>
<tr>
<td>18.1 Summary</td>
<td>560</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. These and other IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

- AS/400®
- DB2®
- developerWorks®
- IA®
- IBM®
- iSeries®
- Power Systems™
- POWER7®
- PowerVM®
- Redbooks®
- System i®
- WebSphere®

The following terms are trademarks of other companies:

Adobe, the Adobe logo, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Intel, Intel logo, Intel Inside logo, and Intel Centrino logo are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java, and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Other company, product, or service names may be trademarks or service marks of others.
Preface

Business Intelligence (BI) is a broad term relating to applications designed to analyze data for purposes of understanding and acting on the key metrics that drive profitability in an enterprise. Key to analyzing that data is providing fast, easy access to it while delivering it in formats or tools that best fit the needs of the end user.

At the core of any business intelligence solution are end user query and reporting tools that provide intuitive access to data supporting a spectrum of end users from executives to “power users,” from spreadsheet aficionados to the external Internet consumer.

IBM® DB2® Web Query for i offers a set of modernized tools for a more robust, extensible and productive reporting solution than the popular Query for IBM System i® tool (also known as Query/400). IBM DB2 Web Query for i preserves investments in the reports developed with Query/400 by offering a choice of importing definitions into the new technology or continuing to run existing Query/400 reports as is. But it also offers significant productivity and performance enhancements by leveraging the latest in DB2 for i query optimization technology.

The DB2 Web Query for i product is a Web-based query and report writing product that offers enhanced capabilities over the IBM Query for iSeries® product (also commonly known as Query/400). IBM DB2 Web Query for i includes Query for iSeries technology to assist customers in their transition to DB2 Web Query. It offers a more modernized, Java-based solution for a more robust, extensible, and productive reporting solution.

DB2 Web Query provides the ability to query or build reports against data stored in DB2 for i (or Microsoft SQL Server) databases through browser-based user interface technologies:

- Build new reports with ease through the web based, ribbon-like Info Assist tool that leverages a common look and feel that can extend the number of personnel that can generate their own reports.
- Simplify the management of reports by significantly reducing the number of report definitions required through the use of parameter driven reports.
- Deliver data to end users in many different formats, including directly into spreadsheets, or in boardroom-quality PDF format, or viewed from the browser in HTML.
- Leverage advanced reporting functions such as matrix reporting, ranking, color coding, drill-down and font customization to enhance the visualization of DB2 data.

DB2 Web Query offers features to import Query/400 definitions and enhance their look and functionality. It enables you to add OLAP-like slicing and dicing to the reports or to view reports in disconnected mode for users on the go.

This IBM Redbooks® publication provides a broad understanding of the new DB2 Web Query product. It entails a group of self-explanatory tutorials to help you get up to speed quickly. Overall, this book is designed for IT users. You can use Part 1, “Tutorials for DB2 Web Query” on page 1, as stand-alone tutorials for anyone who is developing their own queries.
Authors

This book was produced by a team of specialists from around the world working at the International Technical Support Organization (ITSO), Rochester Center.

Robert Andrews is an Advisory Software Engineer working for the STG Lab Services team in the DB2 for i Center of Excellence. He was the technical head for support for the DB2 Web Query product and currently provides custom consulting services helping clients make the most of DB2 Web Query and DB2 for i. Since joining IBM in 2001, Robert has co-authored many IBM Redbooks publications and his work has been published in trade publications with a focus on SQL, journaling, and communications.

He can be reached at robert.andrews@us.ibm.com.

Theo Bär is an IBM Business Partner and Consultant. He teaches classes to IBM i clients. He has been consulting and writing extensively on DB2 Web Query for i. He is the author of a German book on DB2 Web Query, and is also the author of multiple articles for the German "Midrange Magazin." He worked for IBM Germany as a Systems Engineer from 1977 to 1982. Theo is a specialist in IBM i, SQL, RPG, EGL, and Profound Logic (PUI). He holds a diploma in economical engineering and mathematics from the universities of Karlsruhe and Heidelberg.

He can be contacted at Theo.baer@edv-baer.com.

Gene Cobb is a DB2 for i Technology Specialist in the IBM Systems Software DB2 for i Development team. He joined IBM in 1988 and spent over 10 years as an application consultant in the IBM STG Lab Services group, formerly the Client Technology Center (CTC) in Rochester, Minnesota. His current responsibilities include the promotion, education, enablement, and technical support of IBM DB2 Web Query, the strategic query and reporting solution for the IBM i platform. He speaks and writes regularly about DB2 for i and DB2 Web Query topics and is a co-author of the IBM Redbooks publication Getting Started with DB2 Web Query for IBM i.

He can be reached at cobbg@us.ibm.com.
Rick Flagler is an Information Technology Consultant and Adjunct Professor at Keene State College in Keene NH. He has been working on IBMi and predecessors for 30+ years. He held senior IT positions with The Timken Company and MPB Corporation, leading teams of developers and business analysts, installing ERP systems from major vendors such as SAP and Oracle/JD Edwards. His experience includes project management, database, and user interface development. He specializes in transforming data to knowledge and developing business metrics using DB2, SQL, IBMi, DB2 Web Query, Profound Logic (UI), ROBOT, SEQUEL, Microsoft Access, and Office.

Rick launched a grant-funded program to teach midrange development at Keene State College, a division of the University System of New Hampshire, where he has been an Adjunct Professor of Computer Science for 10 years. He lectures on database, user interface, and programming topics related to IBMi. He has held developer positions in the Insurance and Manufacturing industries as well as doing system integration and consulting. Rick holds a B.S. in Business Administration with emphasis on Computer Science from Nichols College.

He can be contacted at Rick.Flagler@ne.rr.com.

Kei Fujii is an Advisory IT Specialist for IBM i and working in the Systems Technical Sales division in IBM Japan. He has seven years of experience with IBM i systems in pre-sales and post sales support activities for clients as a technical expert. His areas of expertise are IBM DB2 Web Query for i, Business Intelligence, Hardware Configuration, and Capacity Planning. Kei has recently joined IBM Power Systems™ Technical Sales and is responsible for ATS and FTSS.

Hector Gongora is a System i and Database Administrator at Banco LAFISE in Nicaragua. His current responsibilities includes database performance and administration as well as System i high availability administration. Before joining Banco LAFISE, he worked for an IBM business partner as a System i Technical Support Engineer.

He can be reached at hgongora@bancolafise.com.ni.

Doug Mack is a DB2 for i and Business Intelligence Consultant in the IBM Power Systems Lab Services organization. Doug’s thirty plus year career with IBM spans many roles, including product development, technical sales support, Business Intelligence Sales Specialist, and DB2 for i Product Marketing Manager.

Doug is a featured speaker at User Group conferences and meetings, IBM Technical Conferences, and Executive Briefings.
Simona Pacchiarini has been working for IBM Italy since 1989. Over the years she has participated in Redbooks publication projects on client connectivity, Windows cooperation, and database, first on the IBM AS/400® and now on IBM i. She is currently working in STG Lab Services in Italy, assisting customers on DB2 Web Query for i projects, DB2 for i performance, and IBM i system performance studies.

She can be contacted at simona_pacchiarini@it.ibm.com.

Septia Sukariningrum is an Advisory Technical Sales Specialist - Power Systems in IBM Indonesia. She has six years experience in the IT field, and started her career with IBM in April 2007. She has worked extensively in IBM i Capacity Planning, IBM i Performance Analysis, IBM i Availability, and IBM PowerVM®. She is now an IBM Certified Technical Sales Specialist for Power Systems with Power7 and IBM i. Septia holds a degree in Informatics Engineering from Bandung Institute of Technology.

Yu Yu Wang is a Software Engineer in IBM China Systems & Technology Lab. She joined IBM in 2007 and spent three years in IBM DB2 for i test work. Now she is responsible for Web Query development. She has experiences both on DB2 for IBM i and Web Query products.

She can be reached at wangyuyu@cn.ibm.com.

Yu Zhe Zhi is a Software Engineer in IBM China Systems & Technology Lab. His current responsibilities include the DB2 for IBM i test and DB2 Web Query for IBM i test. He has spent the past year working with DB2 Web Query for IBM i HotFix testing and the GA testing of this new 2.1.0 release.

He can be reached at zhiyuzhe@cn.ibm.com.

Yu Zhu is a Software Engineer working for IBM China Systems and Technology Lab. He joined IBM in 2010 and is mainly focus on DB2 Web Query development. He also has some experiences on DB2 for IBM i test and DB2 Web Query test. He is involved in the DB2 Web Query 2.1.0 development as well.

He can be reached at yuzhubj@cn.ibm.com.
Thanks to the following people for their contributions to this project:

- Linda Robinson
- Ann Lund
- International Technical Support Organization, Rochester Center

- Jerry Evans
- Charles Farrell
- Cindy Mestad
- Steven Ransom
- Jim Bainbridge
- Robert Bestgen
- IBM STG Lab Services Rochester

- Kathryn Steinbrink
- IBM Development Rochester

Now you can become a published author, too!

Here’s an opportunity to spotlight your skills, grow your career, and become a published author—all at the same time! Join an ITSO residency project and help write a book in your area of expertise, while honing your experience using leading-edge technologies. Your efforts will help to increase product acceptance and customer satisfaction, as you expand your network of technical contacts and relationships. Residencies run from two to six weeks in length, and you can participate either in person or as a remote resident working from your home base.

Find out more about the residency program, browse the residency index, and apply online at this website:

ibm.com/redbooks/residencies.html

Hernando Bedoya is a Senior IT Specialist at STG Lab Services and Training in Rochester, Minnesota. He writes extensively and teaches IBM classes worldwide in all areas of DB2 for i. Before joining STG Lab Services, he worked in the ITSO for nine years writing multiple IBM Redbooks publications. He also worked for IBM Colombia as an IBM AS/400 IT Specialist doing presales support for the Andean countries. He has 28 years of experience in the computing field and has taught database classes in Colombian universities. He holds a Master’s degree in Computer Science from EAFIT, Colombia. His areas of expertise are database technology, performance, and data warehousing.

He can be contacted at hbedoya@us.ibm.com.
Comments welcome

Your comments are important to us!

We want our books to be as helpful as possible. Send us your comments about this book or other IBM Redbooks publications in one of the following ways:

- Use the online Contact us review Redbooks form found at:
  ibm.com/redbooks
- Send your comments in an email to:
  redbooks@us.ibm.com
- Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYTD Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400

Stay connected to IBM Redbooks

- Find us on Facebook:
  http://www.facebook.com/IBMRedbooks
- Follow us on Twitter:
  http://twitter.com/ibmredbooks
- Look for us on LinkedIn:
  http://www.linkedin.com/groups?home=&gid=2130806
- Explore new Redbooks publications, residencies, and workshops with the IBM Redbooks weekly newsletter:
- Stay current on recent Redbooks publications with RSS Feeds:
  http://www.redbooks.ibm.com/rss.html
Tutorials for DB2 Web Query

This part of the book is structured as tutorials. These examples are not intended to replace reference manuals or customer education classes. The intent is to provide hands-on exercises to help you get started and demonstrate the more common reporting techniques.

This part includes the following chapters:

- Chapter 1, “Getting started with the tutorials” on page 3
- Chapter 2, “Security Center: Setting up users” on page 11
- Chapter 3, “Creating and editing metadata: Century database” on page 33
- Chapter 4, “Assignment #1: Summary reports” on page 47
- Chapter 5, “Assignment #2: Implementing various date functions in reports” on page 91
- Chapter 6, “Assignment #3: Implementing other report features and formats” on page 113
- Chapter 7, “Assignment #4: Charting” on page 157
- Chapter 8, “Assignment #5: Adding filters to reports and charts” on page 187
- Chapter 9, “Assignment #6: Detail/print reports” on page 239
- Chapter 10, “Assignment #7: Implementing OLAP” on page 269
- Chapter 11, “Assignment #8: Building documents and dashboards” on page 301
- Chapter 12, “Assignment #9: Exploring and comparing other dashboard options” on page 323
- Chapter 13, “Assignment #10: Scheduling and distribution of reports” on page 387
- Chapter 14, “Assignment #11: Going mobile” on page 429
- Chapter 15, “Assignment #12: Stored procedures in action” on page 453
- Chapter 16, “Assignment #13: Query/400 modernization” on page 479
- Chapter 17, “Assignment #14: Creating JD Edwards reports” on page 533
- Chapter 18, “The Century Challenge BI solution: Postmortem” on page 559
The tutorials all use tables in the QWQCENT library. This library can also be referenced as the Century library. Century is the fictitious electronics company that is referenced throughout these tutorials. Specifically, we use the following tables:

- ORDERS
- INVENTORY
- PLANT
- STORES

ORDERS is the central table. It contains foreign keys or links to the other three tables. In our examples, you will see that we only directly refer to the ORDERS table. Thanks to the knowledge and understanding that DB2 Web Query has DB2 for i, the other three tables are automatically made available whenever ORDERS is referenced.

In DB2 for i, the following foreign keys are defined in the ORDERS table:

- ProductNumber is the key to the INVENTORY table.
- StoreCode is the key to the STORES table.
- PlantCode is the key to the PLANT table.
Getting started with the tutorials

This chapter provides the backdrop for “The Century Challenge”, a fictional account of a company’s struggle to fulfill their Business Intelligence reporting requirements. In this chapter, you will understand more about the company’s query and reporting needs, how it resulted in the challenge, and what you must do to win the support of a misinformed executive.

The subsequent chapters in Part 2 are structured as basic tutorials. These examples are not intended to replace reference manuals or customer education classes. The intent is to provide hands-on exercises that help you get started and demonstrate the more common reporting techniques using the DB2 Web Query product.

**Disclaimer:** The company name, Century Electronics, used in this publication was chosen as a fictitious name. It is used for instructional purposes only. This name is part of the toolkit supplied by Information Builders and was selected to assist readers wanting to explore DB2 Web Query for IBM i powered by Information Builders.
1.1 The “Century Challenge”

Century Electronics is a manufacturer and distributor of electronic equipment and they sell their products to electronics stores world-wide. They are a loyal IBM i client and have run their business on the IBM midrange platform since the AS/400 was first available in 1988.

In November of last year, the position of IT Director opened up at the company, and after several interviews, the executives at Century hired Dan (Figure 1-1), a self-proclaimed “rising star” who previously worked a national pharmaceutical retail chain where he held a similar position. To date, Dan has said and done all the right things to impress his upper management chain, but has shown little respect for those that work under him. As a result, his employees have formed a less than favorable impression of the man they jokingly refer to as “Executive Dan”

![Figure 1-1 “Executive Dan”]

You are Pat, and have worked at Century since 1990, where you have worked your way up the ranks in the IT department. During this time, you have developed deep skills in the RPG and CL programming languages as well as SQL on DB2 for i. You have attended several COMMON conferences and have built up skills in Java and PHP and are passionate about the prospect of modernizing the Century applications. You currently work for Mel, a close friend who has been a good boss over the years, but he is three months from retirement, and does not want to say or do anything that might jeopardize these plans. Mel reports directly to Dan and privately has not agreed with any of Dan’s philosophies so far, but has remained quiet; after all, he only has to put up with Dan for another 88 days (but who is counting?).

The IBM i platform has served Century well over the years, and the various organizations that IT department has served have been very happy with the applications and reports produced by your department. Aside from the occasional glitch, the relationship between IT and the other organizations has been quite harmonious for the last two decades. However, Dan has a different background, perspective, and set of ideas. He views the IBM i as a “dinosaur” and thinks it old technology. His first order of business is to form a strategy to replace the IBM i servers and applications with “more modern and sophisticated technology.” In May, he schedules a meeting with you and Mel to execute this strategy. The meeting goes something like this.
Dan: “Mel, this AS/400 is old, stale, and needs to go. We are losing market share and it is because we lack information, tools, and the appropriate hardware technology.”

Mel (stunned): “Dan, it is called an IBM i, and it is far from old and stale. It is actually built on IBM’s POWER7® processor technology, the same technology IBM built Watson on for the Jeopardy Challenge. So I really do not think this is a good idea. And who says we are losing market share? Our reports certainly do not indicate that.”

Dan: “Those reports must be wrong, they are written in Query/400 and RPG, are they not?” (he snickers to himself) “Anyway, I extracted a Query/400 report to a spreadsheet, did some shuffling of the numbers, and created a pie chart that says we are losing market share. Besides, our tools and hardware are not modern enough and cannot handle today’s complex business intelligence requirements. It is time to bring in an Intel server farm and move everything to SQL Server. That way, I can triple my IT staff. Hmmmm…just think of how much better the office Christmas parties will be.”

You: “Wait? What? Really? Our numbers are not wrong. That is the danger with creating extracts like that; it is way too easy to adjust the numbers in a spreadsheet and create your own version of the truth. The data and business rules need to be centralized.”

Dan: “Well, I do not see the harm. I always did this in my last job. At any rate, we can centralize things on a more modern platform.”

You: “Dan, the IBM i platform is as good as anything out there. The security is second to none; we have never been hacked and never had a breach of security. The system never goes down and rarely needs to be IPL’d. In fact, we have not had an unplanned outage in nine years and that was because a squirrel on the roof chewed through a power line. The database is integrated, requires very little administration, and new features are being added at every new release and PTF. And not modern? JAVA, PHP, SQL, and IBM WebSphere® are all supported. IBM i curriculum is being offered in many colleges and universities. As far as our current environment, our production system is 6 years old, so we could sure use a hardware upgrade to a new Power 7 system. I have seen demos and have been doing some reading; the new multi-core models really scream.”

Dan: “Har! My fellow executives at the country club say otherwise! They tell jokes at my expense and tell me I am running my business on 80’s technology. My caddy Fitzgerald even told me that this system still runs old System/36 code.”

You: “Well, yes, it can run S/36 code, but that does not mean the technology has not been keeping up over the years. In fact, many companies have modernized their database and applications and have dynamic websites that are served up by the IBM i and the DB2 for i database. This is where I would like to see us going. As far as Business Intelligence tools, I have been researching this tool called DB2 Web Query…”

Dan (interrupting): “Harrumph. Well, anyway, my mind is made up. We need reports that go to Excel in one step. We need charts! We need executive dashboards!”

You: “Dan, DB2 Web Query is an IBM i product and is supposed to be able to provide all of those things. Tell you what Dan: Give me two months to try out this product. You give me your business intelligence requirements and I will use DB2 Web Query and features in the DB2 for i database. At the end of the two months, I will deliver a business intelligence solution to you. If the results are satisfactory, consider staying on the platform.”

Dan (who never backs away from a challenge): “Hmmm…You’re on, Pat! Tell you what. If you pull this off, I will give you a raise, Mel’s job, and I might just upgrade to a new Power7 system.”
Dan gets up to leave. He whirls around just before walking out the door, points to his beard, and exclaims “And see this bad boy? I have had it for 10 years. As further incentive, if you can meet my requirements, I will shave it off!” And with that he leaves, his guffaws echoing down the hallway.

You: “Wow.”

Mel: “Yeah. Dan means well, but is he ever misinformed. It would be a huge mistake to move off this platform. Not to mention expensive. My brother-in-law works for a company that moved all their data and applications off of the IBM i, realized what a mistake it was, and are in the process of actually moving everything back.”

You: “Yeah, no kidding. But Dan is right. We do need better BI tools to help our executives make better business decisions. But with the help of the DB2 Web Query product, we should be able to avoid the same mistake of moving off the platform and prove to Dan that the there is no reason to leave this platform! Let us get busy, Mel, we have work to do!”

1.2 The assignments

In the subsequent chapters in Part 2, you will be given several assignments by Dan. Each assignment will be a specific set of report requirements that Century Electronics needs as part of its business intelligence solution. It is your job to use DB2 Web Query to fulfill these requirements and prove to Dan that the IBM i is the platform of the past, present, and future for Century Electronics. The tutorials in these chapters guide you through each set of requirements and provide complete step-by-step instructions. Once you have completed the tutorials, you will have a folder of reports, charts, and dashboards that go above and beyond Dan’s expectations!

1.3 The QWQCENT library

The tutorials in these chapters all use tables in the QWQCENT library. This library can also be referenced as the Century library. Specifically, the following tables will be used throughout the tutorials:

- ORDERS
- INVENTORY
- PLANT
- STORES
- DATE_CONV
ORDERS is the central table. It contains foreign keys or links to the INVENTORY, PLANT, and STORES tables. In most of the examples, you will see that we only directly refer to the ORDERS table. This because we define joins to the other three tables in the ORDERS table synonym. Subsequently, we only need to reference ORDERS to access any of the columns in all four tables. A diagram of this data model is shown in Figure 1-2.

![Diagram of tables in QWQCENT: Century library](image)
In DB2 for i, the following foreign keys are defined in the ORDERS table:

- ProductNumber is the key to the INVENTORY table.
- StoreCode is the key to the STORES table.
- PlantCode is the key to the PLANT table.

**Note:** The version of the ORDERS table at the time of this publication contained data for the years 2011 and 2012. You may want to update the date column values to reflect more recent information. The following SQL statement can be used to add one year to the date columns of the ORDERS table:

```
UPDATE qwqcent/orders
SET order_date = ADD_MONTHS(order_date , 12),
    req_date = ADD_MONTHS(req_date , 12),
    ship_date = ADD_MONTHS(ship_date , 12),
    inv_date = ADD_MONTHS(inv_date , 12),
    recv_date = ADD_MONTHS(recv_date , 12)
```

A pre-populated date table named DATE_CONV is also provided in the QWQCENT library. This table has a row for every day in the date range January 1, 1900 through December 31, 2030. Multiple columns are provided to represented the dates in various ways and is used in the tutorials and examples throughout this book. However, you may find this table useful for other applications.

### 1.3.1 Restoring QWQCENT on your system

The QWQCENT library is now shipped with the 5733WQX product. If you did not have a version of QWQCENT already installed on your system, the GA version of the library will be restored when you first restore the 5733WQX licensed program. If you already had a version of QWQCENT, your current version is not overwritten and you must restore the new version manually by specifying the following command:

```
RSTLIB SAVLIB(QWQCENT) DEV(*SAVF) SAVF(QWEBQRY/QWQCENT) MBROPT(*ALL) ALWOBJDIF(*ALL)
```

The IBM DB2 Web Query development team will make occasional changes and updates to the QWQCENT library. When this happens, a new save file will be shipped as part of a group PTF. The save file will always be named QWEBQRY/QWQCENT. If you want to restore the latest version from this shipped save file, you will need to use the foregoing command.

**Tip:** The new version of QWQCENT contains several new columns that are used in the book tutorials. If you already had QWQCENT installed and have existing synonyms built over the tables in this library, you will want to refresh those synonyms so that the new database columns appear in the Info Assist tool. For more information on refreshing synonyms, see 3.4, “Refreshing metadata when IBM i database object structure changes”.

---

IBM DB2 Web Query for i Version 2.1: Implementation Guide
1.3.2 Downloading completed tutorials

While we encourage you to go through the tutorials in this book (step by step) yourself, we realize that you may not have time to complete all of them. A completed version of all the tutorials is available on the Redbooks website. If you would like to download these completed tutorials, you may do so by following these steps:

1. Go to the Redbooks website:


2. Click the additional materials link. You will see a file named DB2_Web_Query_21_Redbook_Tutorials.zip.

3. Click this zip file to download it.

4. Use the Change Management tool to load this package into your DB2 Web Query environment. See the Change Management chapter for more information.
Security Center: Setting up users

While Dan is meeting with the other departments in the organization to gather the Century Challenge BI solution requirements, you can do some initial set up of the environment. Once the product is installed and configured, the first thing you need to do is add licensed users to the DB2 Web Query product.

In Chapter 4, “Security Center” on page 149, we introduced the new security concepts and explained the architecture of the Security Center. In this chapter, we show you how to manage users and groups with the DB2 Web Query Security Center.
2.1 How to open the Security Center

Proceed as follows:
1. Sign on to DB2 Web Query as **QWQADMIN**.
2. On the menu bar, click or right-click **Security Center** as shown in Figure 2-1.

![Figure 2-1  How to open the Security Center](image)

The Security Center opens, as shown in Figure 2-2.

![Figure 2-2  Security Center](image)
2.2 Registering user profiles to DB2 Web Query

If you want to authorize a user to DB2 Web Query, the user has to be registered. Follow the steps provided to add a licensed user to DB2 Web Query.

**Note:** In DB2 Web Query V1.1.2 and prior versions, this was done with the help of one of the CL-Commands WRKWEBQRY or ADDWQLUSR. With version 2.1, these commands cannot be used any more to register user profiles. For these types of tasks, you must use Security Center.

Proceed as follows:

1. On the Security Center window, click the **New User** icon as shown Figure 2-3.

![Figure 2-3   Start to select a new user](image)

A new User dialog box opens.
2. In the new user dialog box that opens, select one or more users from the list and click **Import Users** as shown in Figure 2-4 to add the user ID(s) as a named user (developer) to DB2 Web Query.

**Note:** All IBM i user profiles will appear on this list. Group profiles do not show up on this list.

![Figure 2-4 Import a user to DB2 Web Query](image)
The new user is added to the users list as shown in Figure 2-5.

Figure 2-5  New user in the users list
2.3 How to designate a Web Query Administrator

As we explained in Chapter 4, “Security Center” on page 149, there are two global authorization groups that are already pre-defined:

- WebQueryAdministrator
- DevWorkBench

In this example, we will add a user to the group WebQueryAdministrator:

1. In the users list, select the user to be added to the WebQueryAdministrator group.
2. Select **WebQueryAdministrator** from the Groups panel.
3. Click the **Add (>>)** button as shown in Figure 2-6.

![Figure 2-6 Add a user to the WebQueryAdministrator group](image)
The user is added to the WebQueryAdministrator group as shown in Figure 2-7.

![Figure 2-7 New user in the WebQueryAdministrator group](image)

**Tip:** You can also add users by dragging and dropping the selected users into a group.

**Note:** After you have added the new DB2 Web Query user to the WebQueryAdministrator group, you can use this user profile for the next steps, instead of QWQADMIN.
2.4 Removing a user from a Web Query group

Provided that the Security Center is still opened, follow these steps:

1. In the Groups panel, select the group which you want to modify. The members of the selected group are listed in the Users in Group panel, as shown in Figure 2-8.

![Figure 2-8 Remove a user from a group](image)

2. In the Users in Group panel, select the user or users that you want to remove from the group. You can choose multiple users by pressing the Ctrl key as you make your selections.

3. Click the Remove selected users from group (<<) button to remove users from that group as shown Figure 2-8.
2.5 Adding a developer to a Top Level Folder

As we explained in Chapter 4, “Security Center” on page 149, when you create a Top Level Folder, six groups (“roles”) are created for this folder.

In this section, we add a user as a developer to the top level folder, Century_Electronics.

1. Assuming that the Security Center is opened, select the Century_Electronics-dev group on the Groups panel as shown in Figure 2-10.

Note: There is another way to remove a user from a group. You can right-click the user in the Users in Group panel and select Remove as shown in Figure 2-9 on page 19.
2. Next, select the user you want to add from the Users panel and click the Add (>>) button as shown in Figure 2-11.

**Note:** You can also add users by dragging and dropping the selected users into a group.

*Figure 2-11  Select a user to be added to a group*
The user is added to the Century_Electronics-dev group, as shown in Figure 2-12.

![Security Center](image)

**Figure 2-12  New user in the Century_Electronics-dev group**

### 2.6 Giving run-only authority to an existing IBM i group profile

With Runtime Users support, you give run-only authority to a user by adding a group profile.

**Note**: The group profile does not have to be an MUxxxx group profile. ANY existing IBM i group profile can be assigned to a Folder-run group role.

After assigning a group profile to a Folder-run group, you have to add the group profile to all users who should be allowed to run the reports inside the folder, by using the CHGUSRPRF command.
For our next example, we use a profile CENELEC as a group profile. All users with this group profile should be allowed to run reports in the Century Electronics folder:

1. Create a user profile by using CL command CRTUSRPRF, or copy an existing profile and name it CENELEC.

   **Note:** A user profile becomes a group profile as soon as it is added to a profile as a group profile. Whenever the group profile is removed from a user or from all users, it still remains a group profile.

2. Add this new created profile to another user as a group profile by using one of the CL commands:
   - CHGUSRPRF USRPRF(TBAER1) GRPPRF(CENELEC)
   - CHGUSRPRF USRPRF(TBAER1) SUPGRPPRF(CENELEC)

3. Open the Security Center.

4. Sign on as an administrator.

5. In the Groups panel, select the folder-run group that should be associated with the IBM group profile: Century_Electronics_run.

6. Click the Edit group button or right-click Century_Electronics_run and select **Edit** as shown in Figure 2-13.

![Security Center](image)

*Figure 2-13  Select the folder-run group Century_Electronics_run*
7. The Edit Group dialog box is displayed; click the **Browse** button to retrieve a list of IBM group profiles (see Figure 2-14).

![Figure 2-14 Retrieve a list of group profiles](image)

A list of all group profiles is presented as shown in Figure 2-15.

![Figure 2-15 Browse External Groups](image)
8. Select group profile CENELEC and click Add all selected Groups button to add the selected group profile to the Web Query folder-run group Century_Electronics_run as shown in Figure 2-16.

![Figure 2-16 Add group profile to Selected Groups](image)

The group profile is added to the Selected Groups panel as shown in Figure 2-17.

![Figure 2-17 Selected Groups panel with a new group profile](image)

9. Click OK.
10. Notice that a group CENELEC is now associated with the Web Query Century_Electronics_run group as shown in Figure 2-18.

![Figure 2-18  Group CENELEC associated with Century_Electronics_run group](image)

11. Click **OK**.

12. Notice that the Century_Electronics_run group icon has changed to indicate a linkage to an IBM i group profile as shown in Figure 2-19.

![Figure 2-19  The icon has changed to indicate a linkage to a group profile](image)
Note: Groups are not displayed in the Users in Group pane (see Figure 2-20).

13. Click **Close** to exit the Security Center.

14. Now you have to add group profile CENELEC to all users who should get permission to run reports in Century_Electronics folder. Use the CL command CHGUSRPRF as explained previously.
2.7 How to manage users and their attributes

In Security Center, you can find an option to manage users and their attributes. You are authorized to do this, if you are an administrator. This can be QWQADMIN or a user with authority WebQueryAdministrator.

1. Provided that the Security Center is opened, right-click the user in the Users panel.
2. Select any one of the options, as shown in Figure 2-21.

![Figure 2-21 Select a user to manage the attributes](image)
- **New**
  Creates a new user.

- **Edit**
  Edits the user attributes.

- **Delete**
  Deletes the user.

- **Groups**
  Opens a submenu that contains the following options:

  - **Group member**
    
    **Group membership report**: Generates a report listing all the groups to which the user belongs. (See Figure 2-22.)

    ![Figure 2-22 Group membership report](image.png)

  - **Remove from**: Opens a dialog box to remove the user from one, more, or all groups. (See Figure 2-23.)

    ![Figure 2-23 Options to remove users from groups](image.png)
2.8 Changing the owner of a report

When you create a report, by default, you are the owner of this report. By default, this report is not published, so other users cannot see and run this report.

There are two ways to publish a report:
- Right-click the report you want to publish and select Publish as shown in Figure 2-24.

![Figure 2-24 How to publish a report](image-url)
Or:

- Right-click the report and select **Security → Owner → Select the new owner** (see Figure 2-25).

**Notes:**

- You can publish all reports in a subfolder by publishing the subfolder. However, publish does not work at Top Level Folder level.
- All reports that are published are displayed in **bold font**, while private content is not bold.
2.9 Preparing steps for the tutorial

In this section, we provide the steps that are necessary to follow the tutorial for a dedicated user named Simona.

Follow these steps:
1. Sign in as QWQADMIN.
2. Open Security Center as shown in 2.1, “How to open the Security Center” on page 12.
3. Import user Simona to Web Query (see 2.2, “Registering user profiles to DB2 Web Query” on page 13).
4. Add user Simona to the WebQueryAdministrator group (see 2.3, “How to designate a Web Query Administrator” on page 16).
5. Sign out.
6. Sign in as Simona.
7. Create Top Level Folder “Century Electronics”: This folder will be used for all our tutorials.
   a. In the main DB2 Web Query pane, right-click WebQuery and select New → Folder as shown in Figure 2-26.

   ![Create folder - Step 1](image)
   
   **Figure 2-26 Create folder - Step 1**

   b. You are presented with the Create Folder pane. Type “Century Electronics” in the title field. The summary field can be used for a short description with purpose and content of this folder (Figure 2-27) and select OK.

   ![Create Folder](image)
   
   **Figure 2-27 Create folder - Step 2**
Creating and editing metadata: Century database

While Dan is still in the process of meeting with the other departments to define the requirements for the Century Challenge BI solution, you already know (based on your past experience and knowledge of the business applications and database) what tables will be used as the basis for this solution. As described in Chapter 3, “Defining metadata” on page 21, before you can create any report, graph, or dashboard, you must create metadata (or synonyms) over the target tables. These tables are located in the QWQCENT library and are named ORDERS, INVENTORY, PLANT, and STORES.

DB2 Web Query is structured to organize objects in folders, which are the container for reports and the basic level to handle security. Metadata is defined in applications. Each one is related to a folder, and is only accessible/usable by those who are authorized to the folder.

In the previous chapter, we created the folder “Century Electronics.” We are now ready to start creating metadata in the corresponding application.
3.1 Creating metadata using the metadata creation wizard

In most cases, you are going to create your own metadata using the provided metadata creation wizards. To do this, take the following steps:


2. On the DB2 Web Query home page, expand the folder in which you want to work. Right-click the specific report folder and select Metadata (Figure 3-1).

![Figure 3-1 Create metadata - Step 1](image1.png)

3. In the new pane, on the left-hand side in the ADAPTERS section select DB2 CLI → *LOCAL, right-click *LOCAL and select Create Synonym, as shown in Figure 3-2.

![Figure 3-2 Create metadata - Step 2](image2.png)
If you have configured a connection to remote databases or added additional data adapters, they will be presented in the list. To learn more about data adapters, see 1.4.5, “Data adapters” on page 11.

4. In the Select Synonym Candidates for DB2 CLI pane (Example 3-3), select the type of data that you are interested in. We select Tables because we want to create metadata on tables in QWQCENT, enter QWQCENT in the library field. Click Next.
5. The Create Synonym for DB2 CLI pane is displayed (Figure 3-4) and shows all the different tables that reside on the QWQCENT schema. In this panel, set CEN_ in the prefix field, then select tables INVENTORY, ORDERS, PLANT, and STORES.

![Figure 3-4  Create metadata - Step 4](image)

You might want to include a prefix or suffix. In our example, cen_ is our prefix because all these tables reside in the same library and will be used for the Century Electronics reporting. We leave the suffix blank, but the developer has the choice to use it. In the Application field, you find the name of the folder in which you are creating metadata, century_electronics in our tutorials. Click Create synonym.

**Prefix and suffix (optional, yet recommended):**

- The prefix and suffix are optional letters that you can add to your synonym name to provide extra meaning for you. Using a prefix or suffix is not required. It is up to the developer to decide whether it is necessary to use the prefix and the naming convention that is preferred.

- We recommend that you use the library name or an abbreviated version of the library name for the prefix. This way, when you create your reports, you can search on all metadata that starts with the library name.

- Keep in mind that all metadata is displayed in one box called Database Descriptions. The box is small and lists the metadata in alphabetical order, not according to library.
The metadata takes a few seconds to create, depending on how many items you selected. After the processing is done, in the Status column, you see the message Created successfully, as shown in Figure 3-5.

![Figure 3-5 Synonyms created](image)

The process of creating metadata is now complete. Close the message box.

### 3.2 Enhancing metadata: Join

The metadata that you just created will be used in tutorials. However, before starting with reports, we may want to enhance them to make reporting quicker and easier to develop, predefining joins among the various tables that we will be using.

Be aware that many enhancements can be set in metadata, such as these:
- Join relations among tables
- Date decomposition
- Defined and computed fields
- Filters

We will be showing how to do this when we need to use the various features, in the next chapters. For details on the various operations that can be performed in synonyms, see Chapter 3, “Defining metadata” on page 21.

Many techniques are available to define joins in synonym. All of them are documented in 3.6, “Joining database objects” on page 50.

Here we are going to use Developer Workbench and the “copy of existing synonym” technique:

1. Open Developer Workbench, select the system on which to work, and validate with your userid and password. Remember that the user must be part of the DevWorkbench group (use Administration → Security Center in the web interface to set up). Select Data Servers → EDASERVE → Applications → century_electronics as shown in Figure 3-6.
2. Double-click the synonym you want to enrich with join relationships to open it. In our example, we will change CEN_ORDERS to add joins with the INVENTORY, PLANT, and STORES tables. Since we will be using "copy of existing synonym," the synonyms for these tables must already exist.

3. Right-click the main segment name, CEN_ORDERS in our example, and select **Insert → Copy of Existing Synonym** (Figure 3-7).
4. You are presented with a list of synonyms available in the folder where you started to work. Highlight `CEN_INVENTORY` and click Select (Figure 3-8). If you wanted to use a synonym from a different folder, you could locate it using the Find button (#1) at the top of the panel.

![Figure 3-8  Join in Developer Workbench - copy of existing synonym - Step 2](image)

5. On the left-hand part of the pane, notice the join option. The options can be edited and changed as necessary using the pull downs and the list items on the side of each definition. In Figure 3-9, you can see what we have selected:
   - Relation = One-to-One
   - Type = Inner Join
   - Condition: `CEN_ORDERS.PRODUCTNUMBER=CEN_INVENTORY.PRODUCTNUMBER`

![Figure 3-9  Join in Developer Workbench - copy of existing synonym - Step 3](image)
6. If you want to get a graphical view of the relationship, select the **Modeling View** tab at the bottom of the panel and hover over the arrow between the tables as shown in Figure 3-10.

![Figure 3-10](image)

*Figure 3-10  Join in Developer Workbench - copy of existing synonym - Step 4*
7. When the line connecting the two files is dotted, it means that some elements are missing in the join definition. You can always see and edit the join conditions, right-clicking the line and selecting "join properties", as shown in Figure 3-11.

![Figure 3-11](image1.png)

Figure 3-11  Join in Developer Workbench - copy of existing synonym - edit condition

8. Save the change using the Save icon on the tool bar, highlighted in Figure 3-11.

9. You may receive a message regarding a warning condition (Figure 3-12), select OK to continue saving.

![Figure 3-12](image2.png)

Figure 3-12  Join in Developer Workbench - copy of existing synonym - error message on save

This error message is caused by one of the columns in the Orders tables, which is named RETURNS. This is a reserved word in SQL. To get rid of this message, you have to rename the field.
10. Get back to the Field View tab, right-click the RETURNS field and select RENAME as shown in Figure 3-13, rename it to RETURNED, and save again your synonym using the Save icon.

![Figure 3-13 Renaming a field](image)

**Note:** Rename in the FIELDNAME (the name used by DB2 Web Query). If you change the ALIAS, the metadata will not work any more. Against logic, the term ALIAS is used to refer to the actual column name in the database.

11. Repeat the process for CEN_PLANT (join field CEN_ORDERS.PLANTCODE = CEN_PLANT.PLANTCODE) and CEN_STORES (join field CEN_ORDERS.STORECODE = CEN_STORES.STORECODE) to get the full environment.
12. Save your CEN_ORDERS synonym that now includes references to all of the four tables that will be used in our scenario. Your CEN_ORDERS synonym “Modeling View” should look like Figure 3-14.

![Figure 3-14  CEN_ORDERS synonym with full joins](image)


After COPYING the synonym, the original CEN_INVENTORY, CEN_PLANT, and CEN_STORES can be deleted unless you want to use them for other purposes.

**Note:** Remember that if your report only references columns in one segment (table), the product will generate an SQL statement to reference that one object even if the metadata used has references to multiple segments.

### 3.3 Date decomposition

In the ORDERS table, there are multiple date columns. One in particular is named ORDERDATE and represents the date that a specific order was placed. As with many date fields, we will eventually want to break ORDERDATE down and reference the individual components of order year, order quarter, order month, and order day. Breaking a date down into these components is referred to as “Date Decomposition” and is a feature that is part of the Synonym Editor. This feature will create a separate virtual/Define field in the synonym for each of the components.

This feature is very useful when we have to aggregate and compare elements based on these basic date components (that is, compare sales for year xx, on a quarter basis) without having to code complex formulas and calculations in our reports. By creating these Define fields in the synonym, they are immediately available to ALL reports in the folder.
This function can be performed either in the web interface or in Developer Workbench. Here we will be using the web interface. To decompose the ORDERDATE date field:

1. Right-click folder Century Electronics and select Metadata → Edit as shown in Figure 3-15.

![Figure 3-15 Date decomposition - Step 1](image1.png)

2. Right-click cen_orders and select Open (Figure 3-16).

![Figure 3-16 Date decomposition - Step 2](image2.png)
3. The synonym editor opens up. Right-click field **ORDERDATE** and select **Decompose Date** (Figure 3-17).

![Synonym Editor](image)

*Figure 3-17  Date decomposition - Step 3*
4. The synonym gets updated with four new field representing the date base component, as shown in Figure 3-18.

5. Save your synonym by selecting the SAVE option from the "More Options" icon pull-down, as shown in Figure 3-19.

6. Close the synonym editor panel.
Assignment #1: Summary reports

This chapter provides step by step instructions to create three summary reports based on the Century database using the DB2 Web Query Info Assist tool.

In this chapter, we explain how to do the following tasks:
- Create summary reports using the Info Assist development tool
- Add Sort-By and Sum fields to your report
- Create Define and Compute fields and understand the differences
- Create report headers and footers
- Change the report theme
- Visually enhance the report with traffic lights and visualization bars
- Add report subtotals
- Publish the report

Prerequisites: Before starting this chapter, make sure that the following steps have already been completed:
- Create a synonym over the ORDERS table.
- Edit ORDERS synonym and define joins to INVENTORY, PLANT, and STORES tables.
- Edit ORDERS synonym and decompose the ORDERDATE field.

If you have not completed these steps, go to Chapter 3, “Creating and editing metadata: Century database” on page 33.
4.1 Revenue summary

Dan has met with the various departments in the organization and has come up with a set of requirements for the Century Challenge BI solution. The first report in this solution is a fairly basic one: a summary report that shows revenue and gross profit for each product category and product type. For this, you will create a define (virtual) field to calculate gross profit. In addition, a report header and footer are required, as is a very useful feature in BI reporting: traffic lighting to easily spot data outliers in the organization. In this case, you are going to identify the top and bottom gross profit performers.

In this section, we explain how to create this report. Once completed, your Revenue and Gross Summary Report will look as shown in Figure 4-1.

![Figure 4-1](image)

**Figure 4-1** Final result of Revenue Summary

### 4.1.1 Creating the revenue summary report

Follow these steps to create the revenue report:

1. In the Reporting area, create folder “Assignment 01 - Simple Reports”.  
   In this tutorial, the folder is created under the Century Electronics folder as in Figure 4-2.  
   To create a new folder, right-click Century Electronics folder, and select New → Folder.

![Figure 4-2](image)

**Figure 4-2** Menu to create new folder
2. Expand DB2 Web Query → Century Electronics → Assignment 01 - Simple Reports. Right-click the Assignment 01 - Simple Reports folder, which is where you will store your report, and select New → Report as in Figure 4-3.

![Figure 4-3 Menu to open or create report](image)

3. The Info Assist page appears, and you see a list of available data sources (also known as metadata or synonyms) in Figure 4-4. Select CEN_ORDERS and click OK.

![Figure 4-4 Data Source Selection menu](image)

After you choose the CEN_ORDERS table, you see the list of all fields on the Data panel at the left side of Info Assist. Notice that in the Data panel, synonyms are divided into two groups: Dimensions, and Measures/Properties.
4. Double-click **Product Category**, which is under Dimensions. You see that now the Product Category column appears in the Interactive Design View as in Figure 4-5.

![Figure 4-5  Product Category field](image)

**Note:** Besides double-clicking, you can also drag and drop the field you want from the Data panel to the Interactive panel, or you can drag and drop it to the Query panel (below the Data panel).

5. Drag and drop **Product Type**. You see an additional menu that appears: “Drop as Sort” and “Drop as Sum”. For this tutorial, select **Drop as Sum** as in Figure 4-6.

![Figure 4-6  Product Type additional menu](image)
6. Double-click Revenue, which is under Measures/Properties. The Revenue column will appear on the right side of the Product Type column. Figure 4-7 shows the result.

![Figure 4-7 Revenue field](image)

7. Next we create the grand total of the report. First, select the Home ribbon and make sure the Report group is expanded so we can see the Column Totals and Row Totals function as in Figure 4-8.

![Figure 4-8 Home ribbon and report functions](image)
8. Click **Column Totals**. Selecting **Column Totals** adds a grand total row in the end of your report (see Figure 4-9). It will summarize the numeric data in each column. On the other hand, selecting **Row Totals** adds a grand total column and puts it on the right side of your report. It will summarize the numeric data in each row.

![Figure 4-9  Grand Total row in Revenue report](image)

To improve the readability of the report, you can add some formatting to the Revenue column.

9. First, select the **Revenue** field. You see a new menu named **Field - Revenue** that appears as in Figure 4-10.

![Figure 4-10  Field-Revenue ribbon page](image)

10. Some of the groupings may already be expanded depending on the width of your screen. If so, you may need to expand the **Format** group as in Figure 4-10 (see the arrow).
11. Select the **Comma** as in Figure 4-11.

![Figure 4-11 Comma format](image)

**Note:** For the decimal place, this document is referring to the North American standard, in which comma refers to thousands, and point refers to decimal.

12. Click the **Currency symbol $** down arrow, and then choose **Floating currency** as in Figure 4-12.

![Figure 4-12 Currency symbol](image)

In this case, if you use non-floating currency, the symbol will displayed only on the first row of your report page.

13. The result will be as in Figure 4-13.

![Figure 4-13 Revenue result](image)
4.1.2 Adding a gross profit Define field

At this point, the only measure column in this report is the revenue field. Recall that we also need to include gross profit, which is defined as revenue minus cost of goods sold. In many cases, businesses do not store derived fields such as these in the transactional database. Consequently the formula for gross profit must be defined in either the report or in the synonym. Let us do this by first defining it in the report as a Define field. Later you will move this to the synonym so that all reports in this folder have immediate access to the gross profit field.

**Note:** The Gross Profit formula is: Revenue - Cost of Goods Sold

Proceed as follows:

1. Still using the same report, click **Data** on the menu bar to open the Data ribbon as in Figure 4-14.

![Figure 4-14  Data ribbon](image)

2. Click **Detail (Define)** as in Figure 4-14. A new window pops up.

3. Type **Field name** as Gross_Profit as in Figure 4-15.

![Figure 4-15  Detail Field (DEFINE) menu](image)
4. Click the **Format** button, and format it as Integer with Floating Currency (M) and Comma (C). The field length should be 10. The Format page should be as in Figure 4-16.

![Figure 4-16 Field Format Options for Gross_Profit Define](image)

5. Click **OK**.

Another way to do this formatting is by directly typing `I10MC` in the Format field as in Figure 4-17.

![Figure 4-17 Advance Format Field](image)
6. In the Detail field, create the gross profit formula by double-clicking the Revenue followed by typing ‘-‘ which means subtract, then double-click Cost of Goods Sold. The filled result appears as in Figure 4-18.

![Figure 4-18  Gross Profit Define Field](image)

7. Click OK.

8. If you see Interactive Design View, nothing is changed in the view. In the Data panel, expand Measures/Properties. Here you will find the new field named Gross_Profit.

9. Drag and drop Gross_Profit to the next field of Revenue as shown in Figure 4-19.

![Figure 4-19  Gross_Profit Field](image)
10. After you put Gross_Profit field in the Interactive Design View, you see that Gross_Profit field is already formatted with comma and floating currency. Recall that you defined this formatting when you created the Gross_Profit field definition. Instead of defining the formatting in the Define field, you could have formatted this field by right-clicking the Gross_Profit field in the interactive design view. From the right-click menu, select Edit Format as in Figure 4-20.

![Figure 4-20 Alternative Format field](image)

11. The Field Format Options menu pops up, and it is exactly the same window as you see when you defined the format for the first time. Fill in the field Format Options as in Figure 4-21 and click OK.

![Figure 4-21 Field Format Options for Gross_Profit](image)

**Note:** There are several ways that you can do number formatting in the field:
- Use the Format menu from the field specific ribbon.
- Define the format when, for the first time, you create the definition of the field.
- Do a right-click directly in the field from the Interactive Design View panel.
12. The result is shown in Figure 4-22.

![Figure 4-22 Summary Report including Gross_Profit field](image)

4.1.3 Adding a header and footer

As we finish creating the gross profit report, the next step is to add a header and footer in the report so that the report consumer can know what information is provided in the report.

Proceed as follows:
1. Select the Home ribbon, and expand Report if it is not already expanded.
2. On the Report ribbon, select Header & Footer → Report Header as in Figure 4-23.

![Figure 4-23 Header and Footer menu](image)
3. The Header & Footer menu appears. You can either type in the name of the report, or you can use a system variable that will insert the actual name of the saved report into the selected area. For this report, let us use the system variable. Type \&MR\_FULL\_FEXNAME in the Report Header page as in Figure 4-24. Click OK.

**Note:** \&MR\_FULL\_FEXNAME is an example of a DB2 Web Query system variable. System variables are predefined and automatically supplied by the system when a procedure references them. For a complete list of system variables, see Appendix B, “DB2 Web Query system variables” on page 839.

![Figure 4-24 Report Header menu](image)

**Note:** For now, \&MR\_FULL\_FEXNAME does not have a value because the report has not yet been saved. To resolve this variable, the report must be saved, and you need to run the report from the DB2 Web Query Reporting page.

4. The next step is to create a footer using the Page Footer function. As in the previous step, choose: Home → Report → Header & Footer → Page Footer.

5. For this Page Footer sample, we use the **preformatted text content** function, which is another alternative for configuring header and footer. The preformatted text content function is shown in Figure 4-25.

![Figure 4-25 Preformatted Text Content menu](image)
6. In this sample, choose Date → Tue, Jun 12, 2012 as in Figure 4-25. Variable &DATEt, &DATEtM, &DATED, &DATEYY appear in the blank page as in Figure 4-26. Click OK.

![Figure 4-26 Setting variable for date using preformatted text content](image)

**Note:** Go to Appendix A, “Date and time functionality” on page 789 to see a list of all the date and time formats that you can use.

7. In the end of the report, you see the current day and date. Figure 4-27 shows the date result.

![Figure 4-27 Page footer result](image)

**Note:** If you see a header and footer menu, you realize that there are two types of header and two types of footer. Each has report and page. The differences are as follows:
- Report header and report footer only appear once in the report. Report header appears only at the beginning of the report, and report footer appears only at the end of the report. So if you create a report that needs more than one page to view, report header appears on the first page, and report footer appears on the last page.
- Page header and page footer appear on every page of the report.

### 4.1.4 Changing the theme

When you first create a report, the look and style of the report is inherited from the default theme. In some cases, you may want to override this theme and select a different one. DB2 Web Query comes with many themes you can choose to make it more interesting.
Follow these steps to change your report theme:

1. Go to **Home** → **Report** → **Theme**. A new page pops-up.

2. Experiment with different themes to see if there is one you like. Do this by selecting a theme and clicking the **Open** button.

3. For our report, we want to use the **ENgray_theme.sty** as in Figure 4-28.

![Figure 4-28 Themes](image)

### 4.1.5 Adding traffic lighting

A common feature in BI tools is something called traffic lighting. A report developer can define conditions in the data that exceed or fall below specific thresholds. When this occurs, a different color or font can be used to make that component in the report more visible to the report consumer. Traffic lighting allows the consumer to easily spot outliers, top and bottom performers, and other conditions that might need immediate attention.

Follow these steps for how to use the Traffic Lights functions in gross profit field:

- **Display a green color if the gross profit value is more than 25 million dollars**
- **Display a red color if the gross profit value is less than 10 million dollars**

1. Click **Gross_Profit** field in the Interactive Design View. You find that there's menu named **Field - Gross_Profit**.
2. Click the **Display** menu if it is not yet expanded. You can find the Traffic Lights menu as in Figure 4-29.

![Figure 4-29 Traffic Lights menu](image)

3. Click the **Traffic Lights** menu.

4. A **Traffic Light Condition** menu for Gross_Profit appears. Fill the fields as in Figure 4-30 to fulfill the condition as mentioned before.

![Figure 4-30 Traffic Light Condition menu](image)

Here is an explanation of each button or field in the Traffic Lights Condition menu:

1. The button to add a new condition of the traffic lights. In this tutorial, you need to use the button since you use two conditions for the report.

2. The button to delete condition.

3. The button to add styling if value of the field fulfills the condition. In this example, if a record’s gross profit value is greater than 25 million, the you have to configure the field to be green highlighted.

4. The button if you want to add more action if the condition is fulfilled. For example, you can refer the field to another report.

5. The active status of the condition. In Figure 4-30, the current active status is the first condition, so you can delete or add styling in this condition.

6. The condition itself. Traffic lights provide many conditions: equal to, not equal to, greater than, less than, greater than or equal to, less than, or equal to.

7. The preview of the style you made for each condition.
5. Click **OK**.

6. You go back to Interactive Design View and see that all gross profit values are in red highlighting. This is because Interactive Design View only fetches the first 500 records, which might not represent the real condition. To see the real result, you should **run** the report.

7. Click the **Run** button as in Figure 4-31.

![Figure 4-31 Run button](image)

8. A new tab named **Report1[0]** appears. You see that now the gross profit column has green and red highlighted values. But you also notice that the header still does not have any meaning. To resolve this situation, save the report and go to the DB2 Web Query Reporting page to run the report. See Figure 4-32.

![Figure 4-32 Run Report from Interactive page](image)

10. Save the report by clicking the IA® button on the top left side as in Figure 4-33 and choose Save. Name it “1a-Revenue Summary by Product Category”.

![Image](image1.png)

**Figure 4-33** Save report

11. Go to the DB2 Web Query Reporting Page. Expand **DB2 Web Query → Century Electronics → Assignment 01 - Simple Reports**. You find there is one new report you just created.

12. Right-click **1a-Revenue Summary by Product Category**. Then click Run.

![Image](image2.png)

**Figure 4-34** Run the report from the Reporting page
13. The report result will be as Figure 4-35. Now you see that the report header has change to something meaningful. The report header represents report name.

![Figure 4-35 Run Report Result from Reporting page](image)


### 4.1.6 Publishing the report

At this point, as the report developer, you are the only DB2 Web Query user that can access and run this report. This is because the report has not yet been published. After careful examination of both the requirements and the report output, you are confident that the report is ready for all DB2 Web Query users (authorized to the top level folder) to access and run. To give them access to the report, you must now publish it.

To publish the report, proceed as follows:

1. Go to the DB2 Web Query page and expand the **Assignment 01** folder. Right-click the **1a-Revenue Summary by Product Category** report and select **Publish**.
Notice that soon after you publish the report, the font in the menu will change to bold. This allows you to easily differentiate between published and unpublished content.

### 4.2 Top 10 (ten) products by margin

The next report that Dan wants you to create is one that displays the top ten product names by profit margin in descending order. This report should have the rank based on profit margin, the product name, product category, and product type. In addition to profit margin, the measure fields to be included are revenue and gross profit. He would also like you to include data visualization bars for Revenue and Gross_Profit fields.

After you finish the tutorial in this section, you will be able to create a report as in Figure 4-37.

![Figure 4-37 Top 10 Products by Margin](image)

Because this report is very similar to the report created in 4.1, “Revenue summary” on page 48, you can save yourself some time by simply editing that one and saving it as a new report.
4.2.1 Opening and saving a new copy of the report

Proceed as follows:

1. If you closed the report you created in 4.1, “Revenue summary” on page 48, re-open it by selecting DB2 Web Query → Century Electronics → Assignment 01 - Simple Reports → 1a - Revenue Summary by Product Category → Edit With → Info Assist from the DB2 Web Query page as shown in Figure 4-38.

2. Because we are making multiple changes to the original report and saving it as a new copy, we want to avoid over writing the original report. Save the report with the new name by clicking “Save As” under the IA button as in Figure 4-39, and naming it “1b - Top 10 Products by Margin”.

Figure 4-38  Edit Existing Report using Info Assist

Figure 4-39  Save As menu
4.2.2 Adding by field

Proceed as follows:

1. Now you are ready to make changes specific to this report. The first thing you need to do is make the Product Name field the first Sort-By column in the report. Drag and drop the Product Name field to the left-most part of the report, so Product Name will be the first-sort-by field. Figure 4-40 shows how it looks in the first few records.

![Figure 4-40 Product Name field as the first Sort-By](image)

2. This report does not require any traffic lighting. So first remove the traffic light function in Gross Profit field. First, select Gross Profit field in the Interactive Design View panel, then select Field - Gross Profit → Display → Traffic Lights in menu panel.

3. Delete the two conditions you made previously by using the Delete button (Figure 4-41). After deleting the two conditions, you find there are no highlights in the Gross Profit field.

![Figure 4-41 Delete Conditions in Traffic Lights](image)

4.2.3 Creating Define and Compute fields

In this section, you learn how to create a Profit Margin field using Define and Compute fields.

1. The next step is to create a new Profit Margin field using the Define function. First, click Data on the toolbar to open the Data ribbon, then click the Detail (Define) button to show the Define field menu.

2. Profit Margin formula is: (Gross Profit / Revenue) x 100%. So the filled Define field will be as shown in Figure 4-42. Name this Define field as: Profit MarginD.

![Figure 4-42 Define field](image)

3. After you finish filling in the Define field, click OK.
4. In the Data panel, you find the new field named Profit_MarginD.

![Profit_MarginD field in Data panel](image)

Figure 4-43  Profit_MarginD field in Data panel

5. Drag and drop Profit_MarginD to the right-most side of the report.

6. Run the report.

7. Figure 4-44 shows the sample result of profit margin using the Define function.

![Profit Margin Calculation using Define Field](image)

Figure 4-44  Profit Margin Calculation using Define Field

Notice the highly inflated values of the ProfitMarginD column. Either business is extremely good at Century Electronics or the calculation for profit margin is not correct. In this case, it is the latter: The profit margin calculation using the Define field is incorrect. The reason why requires an explanation and understanding of the differences between Define and Compute fields. To illustrate this, create another new profit margin field using the Compute function.

8. Repeat the same steps as before to create the profit margin field, however, this time select the Summary (Compute) button as demonstrated in Figure 4-45.

![Create Compute field](image)

Figure 4-45  Create Compute field
9. Name this new field as **Profit_MarginC**, and use the same formula as you did before for the Define field as shown in Figure 4-46.

![Figure 4-46 Compute field](image)

10. Click **OK**.

11. Notice that there is a new field named **Profit_MarginC** that appears on the right side of **Profit_MarginD**. Unlike Define fields, Compute fields are automatically added to your report when you create them.

12. Run the report,

13. As shown in Figure 4-47, notice that **Profit_MarginC** has more realistic values for a profit margin column. These are in fact, the correct values.

![Figure 4-47 Profit Margin Calculation using Compute field](image)

So why, in the case of Profit Margin, are the values incorrect for a Define field, yet correct for a Compute field? After all, the formulas you specified for both were identical.

The reason for this is because of the difference in behavior between Define and Compute fields. Define fields are calculated (evaluated) for every row retrieved by the report. If your query retrieves 1,000 rows from the ORDERS table, then 1,000 distinct values of that virtual defined field are generated. This happens even if your report does not report at the lowest detail level, meaning the values will be executed and then aggregated. Once these values are evaluated, they are summed at the Sort-By level. So you are effectively calculating the gross profit margin for every order and them adding them all together and displaying that summed value for each row (product name) in the report. Hence the inflated values for each product name.

Now contrast that with how Compute fields work. The calculation for a Compute field does not occur until after DB2 Web Query has retrieved, sorted, and aggregated (grouped) the rows. This means that all of the report’s measures (numeric field values) are aggregated (based on the specific Sort-By columns), and only after this aggregation has occurred are the computed field values calculated. So in this case profit margin is not evaluated until each of the products have been aggregated. For each product name, the aggregated gross profit value is divided by the aggregated revenue value, and the correct profit margin value is displayed.

**Note:** When the report is at the individual-row level, a computed field will have the same result as a defined field. Aggregation is what makes the difference.
14. For the next step of this tutorial, you use the Profit_MarginC field, since in this report, Profit_MarginC is the one that provides the correct calculation.

15. **Delete Profit_MarginD** in the report table.

16. Move **Profit_MarginC** by dragging it to left side of Revenue field. The result in Interactive Design View will be as in Figure 4-48.

17. Notice that the current report you have is sorted by Product Name in ascending order. The requirement was for the Top 10 Rank report to be sorted in descending order by Profit Margin. Change the report by making Profit_MarginC as the primary sort field in descending order.

18. Right-click the Profit_MarginC, and select **Sort → Sort → Descending** as shown in Figure 4-49.

19. Run the report by clicking the **Run** button. The result will be as shown in Figure 4-50.
4.2.4 Adding rank to the profit margin

In this section, you learn how to add a rank column to the report. To rank the rows based on profit margin, take the following steps:

1. From the Query panel, click **Profit_MarginC** in the By area. See Figure 4-51. This is actually an alternative way to set the ribbon to be Profit_MarginC specific.

![Figure 4-51 Profit_MarginC in Query panel](image)

2. Click the **Rank** button in the Sort group as in Figure 4-52.

![Figure 4-52 Rank menu](image)

3. In the Interactive panel, you see that new field named **RANK** appears in the left-most side of the report. This field put ranks of all records in the report table.

4. But since you only want the report to display only the top 10 products, change the limit of the rank to 10.

![Figure 4-53 Rank Limit to 10](image)
5. **Run** the report, and you see that the report now only contains 10 records which are the products with 10 best profit margin in descending order as in Figure 4-54.

![Figure 4-54 Top 10 Products in order by Profit Margin](image)

<table>
<thead>
<tr>
<th>RANK</th>
<th>Product Name</th>
<th>Product Category</th>
<th>Product Type</th>
<th>Profit Margin</th>
<th>Revenue (2014)</th>
<th>Gross Profit (2014)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7.1-Piece Home Theater Speaker System</td>
<td>Speakers</td>
<td>Audio</td>
<td>73.05%</td>
<td>$18,846,731.00</td>
<td>$13,936,761</td>
</tr>
<tr>
<td>2</td>
<td>6-Piece Home Theater Speaker System</td>
<td>Speakers</td>
<td>Audio</td>
<td>72.43%</td>
<td>$40,863,994.00</td>
<td>$29,596,224</td>
</tr>
<tr>
<td>3</td>
<td>100 Watt Front-Firing Powered Subwoofer</td>
<td>Speakers</td>
<td>Audio</td>
<td>68.99%</td>
<td>$9,172,922.00</td>
<td>$6,326,012</td>
</tr>
<tr>
<td>4</td>
<td>2-Way Speaker Pair</td>
<td>Speakers</td>
<td>Audio</td>
<td>64.82%</td>
<td>$6,395,049.00</td>
<td>$4,147,479</td>
</tr>
<tr>
<td>5</td>
<td>3-Way Speaker Pair</td>
<td>Speakers</td>
<td>Audio</td>
<td>63.86%</td>
<td>$9,435,357.00</td>
<td>$6,024,987</td>
</tr>
<tr>
<td>6</td>
<td>Easyfile Electronic Organizer 8MB Memory</td>
<td>Organizers</td>
<td>Office</td>
<td>61.54%</td>
<td>$2,105,250.00</td>
<td>$1,295,544</td>
</tr>
<tr>
<td>7</td>
<td>Easyfile Electronic Organizer 10MB Memory</td>
<td>Organizers</td>
<td>Office</td>
<td>59.18%</td>
<td>$934,361.00</td>
<td>$553,001</td>
</tr>
<tr>
<td>8</td>
<td>EasyVoice Voice Recorder 6 Hours</td>
<td>Organizers</td>
<td>Office</td>
<td>57.63%</td>
<td>$1,381,072.00</td>
<td>$795,872</td>
</tr>
<tr>
<td>9</td>
<td>EasyVoice Voice Recorder 8 Hours</td>
<td>Organizers</td>
<td>Office</td>
<td>56.52%</td>
<td>$5,999,243.00</td>
<td>$3,390,933</td>
</tr>
<tr>
<td>10</td>
<td>Digital Camcorder 14x Power Zoom</td>
<td>Digital Camcorders</td>
<td>Camcorders</td>
<td>56.33%</td>
<td>$3,583,240.00</td>
<td>$2,007,240</td>
</tr>
</tbody>
</table>

**TOTAL**

68.98% $98,700,348.00 $68,070,653

4.2.5 **Adding data visualization bars**

The next report requirement is to include data visualization bars for the Revenue and Gross_Profit columns. The benefit of using data visualization bars is so you can graphically represent numeric column values using bars that are longer as the column value is larger. This feature allows you to easily compare values between two or more columns.

1. Select the Revenue field. This will change the ribbon to the **Field - Revenue** tab in the ribbon.
2. Expand the **Display** group menu, and click **Data Bars** as in Figure 4-55.

![Figure 4-55 Data Bars Menu in Display group](image)

3. You see that data bars appear on the right side of Revenue values as in Figure 4-56.

![Figure 4-56 Revenue data bars](image)

4. Repeat the same steps for Gross_Profit to shows Data Bars as in the Revenue Data Bars steps.
5. Run the report, and you see the final report as in Figure 4-57.

![Figure 4-57](image)

6. Save the report.


### 4.3 Revenue summary with subtotals

The third summary report Dan wants you to develop is one that displays Gross_Profit subtotals for each product category.

After you finish the tutorial in this section, the finished product will look something similar to the example shown in Figure 4-58.

![Figure 4-58](image)

Once again, for similar reports, you can avoid repeating the manual development steps by making a copy of an existing report. For this tutorial, use the report created in 4.1, “Revenue summary” on page 48:

1. Open the “1a - Revenue Summary by Product Category” report using Info Assist.

2. For the purpose of the tutorial in this section, remove the Traffic Lights function in the Gross_Profit field. See 4.2, “Top 10 (ten) products by margin” on page 66 for how to remove the Traffic Lights function.
3. Drag the **Product Type** field to the left-most side of the report in the Interactive Design View panel. Now Product Type becomes the primary sort field as in Figure 4-59.

   ![](image)
   **Figure 4-59  Revenue Summary Report Sorted by Product Type**

4. Drag the **Product Name** field from the Data panel to the right side of the Product Category. Choose **Drop as Sort**. This makes Product Name the third sort field.

5. In the Interactive Design View panel, the report looks as in Figure 4-60.

   ![](image)
   **Figure 4-60  Revenue Summary Report with Product Name field**

6. In the next step, you create **subtotals** of all numeric fields based on **Product Category**.

7. To do this, click the Product Category field to have the **Field - Product Category** ribbon show up.

8. Expand **Break** group ribbon, and select **Subtotal → Recomputed** as in Figure 4-61.

   ![](image)
   **Figure 4-61  Subtotal menu**
9. **Run** the report. The result for the first three Product Categories will be as in Figure 4-62.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Product Category</th>
<th>Product Name</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Amplifiers/PreAmps/Tuners</td>
<td>AM / FM Stereo Tuner</td>
<td>$950,822.00</td>
<td>$473,022</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modular Components Series Preamp 5.1</td>
<td>$6,376,419.00</td>
<td>$1,102,689</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power Amplifier</td>
<td>$6,116,685.00</td>
<td>$1,694,985</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PreAmp/Tuner Two</td>
<td>$24,364,174.00</td>
<td>$12,157,674</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FM/AM500 Stereo &amp; Surround Power Amplifier</td>
<td>$14,586,328.00</td>
<td>$12,456,489</td>
</tr>
</tbody>
</table>

**Subtotal: Amplifiers/PreAmps/Tuners**

Audio Systems
- Home Theater Surround System: $8,884,107.00
- Home Theater 5.1 System: $25,676,144.00
- Home Theater 7.1 THX System: $24,300,897.00
- Micro HiFi Stereo System: $8,244,537.00
- Micro 5.1 System: $5,241,995.00

**Subtotal: Audio Systems**

CD Players and Recorders
- CD Changer / CD Player: $4,689,037.00
- CD Recorder with 50GB Hard Disc Drive: $5,786,755.00
- Digital CD Turntable: $9,106,958.00
- MultiChannel Super Audio CD Player: $9,359,276.00
- 400 Disc Super Audio CD Changer: $4,145,451.00

**Subtotal: CD Players and Recorders**

$122,345,680.00

10. You see that in Figure 4-62, the subtotals applied for both Revenue and Gross_Profit fields.

---

**Note:** The Subtotal menu has two functions: **Simple** and **Recomputed**. The difference between Simple and Recomputed is as follows: Simple will just add all values within a column, while Recomputed will do the aggregation of all values in the column and do calculation at the end. Use Recomputed if you want to calculate a percentage.

See the next two figures to further understand the difference between Simple and Recomputed. The sample report we use is revenue report with subtotals based on Product Type.

In Figure 4-63, which is created using Simple, subtotals for Revenue and Gross Profit in each Product Type shows the correct value while Profit Margin (which is made using Compute field) showing the incorrect value. This is because Simple subtotals only add value of all the columns. So, the profit margin percentage for Audio is just the result of adding profit margin result from each Audio category.
In Figure 4-64, which is created using Recompute, all values including Profit Margin show the correct values. This because Recompute does the calculation after the value aggregation is done. So for Audio’s Profit Margin, Recompute will do a profit margin calculation based on the subtotal result of Audio’s Revenue and Gross Profit.
11. In the next step, we discuss how to have the subtotals for Gross_Profit field only, and do small changes in the subtotal title.

12. To do this, go back to the Subtotal menu, but this time choose More Options... as in Figure 4-65.

![Figure 4-65 Subtotal menu with More options choice](image)

13. A Subtotal for Product Category menu is displayed.

14. Un-check the Subtotal all fields column, and check the Gross_Profit column.

15. If you see the Prefix column, you find that there are several choices for Prefix. In this tutorial, leave the Prefix column as Sum.

16. Change the Current Subtotal text from Subtotal: to Subtotal for.

17. The filled Subtotal menu will be as in Figure 4-66.

![Figure 4-66 Subtotal menu for Product Category](image)

**Note:** The Subtotal prefix has many options. This shows that the Subtotal function is not only intended to sum up the numeric values but, for example, it can also set the average of all values within the column using the Average function. Try to test the prefixes one by one to know the difference between one prefix and another.

18. Click OK.
19. **Run** the report. The result for the first three Product Category will be as in Figure 4-67. Compare it to the report with Revenue and Gross Profit Subtotals.

![Figure 4-67  Summary Report with Gross Profit Subtotals based on Product Category](image)

20. Repeat the foregoing steps to add create subtotals based on Product Type. Figure 4-68 shows a sample revenue report with subtotals on both Revenue and Gross_Profit fields based on Product Type.

![Figure 4-68  Sample Summary Report with Subtotals based on Product Type](image)
Figure 4-69 shows a sample revenue report with subtotals only on the Gross_Profit field based on the Product Type.

```
<table>
<thead>
<tr>
<th>Product Type</th>
<th>Product Category</th>
<th>Product Name</th>
<th>Revenue</th>
<th>Gross_Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Amplifiers/PreAmps/Tuners</td>
<td>AM / FM Stereo Tuner</td>
<td>$950,822.00</td>
<td>$473,022</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modular Components Series Preamp 5.1</td>
<td>$6,376,419.00</td>
<td>$1,102,698</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power Amplifier</td>
<td>$5,116,568.00</td>
<td>$1,604,582</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PreAmp/Tuner Two</td>
<td>$24,364,174.00</td>
<td>$12,157,674</td>
</tr>
<tr>
<td></td>
<td>Audio Systems</td>
<td>Home Theater Surround System</td>
<td>$8,894,107.00</td>
<td>$2,214,357</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Home Theater 5.1 System</td>
<td>$75,671,144.00</td>
<td>$26,481,344</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Home Theater THX System</td>
<td>$34,303,897.00</td>
<td>$8,024,597</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Micro HiFi Stereo System</td>
<td>$8,214,537.00</td>
<td>$2,252,267</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Micro 5.1 System</td>
<td>$5,214,995.00</td>
<td>$1,039,995</td>
</tr>
<tr>
<td></td>
<td>CD Players and Recorders</td>
<td>CD Player/CD Recorder</td>
<td>$1,861,477.00</td>
<td>$1,861,477</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CD Recorder with 50GB Hard Disc Drive</td>
<td>$5,778,755.00</td>
<td>$1,441,755</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital CD Turntable</td>
<td>$25,666,956.00</td>
<td>$5,445,956</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi Channel Super Audio CD Player</td>
<td>$3,342,618.00</td>
<td>$3,342,618</td>
</tr>
<tr>
<td></td>
<td></td>
<td>400 Disc Super Audio CD Player</td>
<td>$4,143,894.00</td>
<td>$917,191</td>
</tr>
<tr>
<td></td>
<td>MP3</td>
<td>MP3 Digital Audio Computer</td>
<td>$3,267,927.00</td>
<td>$1,510,077</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MP3 Digital Audio Computer 10GB</td>
<td>$4,851,850.00</td>
<td>$1,019,150</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MP3 Digital Audio Computer 4GB</td>
<td>$3,452,980.00</td>
<td>$2,518,739</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MP3 Player</td>
<td>$1,532,734.00</td>
<td>$8,227,074</td>
</tr>
<tr>
<td></td>
<td>Receivers</td>
<td>Audio/Video Receiver</td>
<td>$4,302,778.00</td>
<td>$2,140,578</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.1 Channel Home Theater Receiver 100 WPC</td>
<td>$32,039,070.00</td>
<td>$1,609,647</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.1 Channel Home Theater Receiver 150 WPC</td>
<td>$2,529,901.00</td>
<td>$1,060,101</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.1 Channel Home Theater Receiver 100 WPC</td>
<td>$29,434,467.00</td>
<td>$3,233,917</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7.1 Channel THX Home Theater Receiver</td>
<td>$6,459,870.00</td>
<td>$2,844,870</td>
</tr>
<tr>
<td></td>
<td>Speakers</td>
<td>100 Watt Front-Firing Powered Subwoofer</td>
<td>$9,172,322.00</td>
<td>$6,328,612</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2-Way Speaker Pair</td>
<td>$6,398,049.00</td>
<td>$6,147,473</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3-Way Speaker Pair</td>
<td>$9,345,357.00</td>
<td>$6,024,587</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6-Piece Home Theater Speaker System</td>
<td>$18,846,731.00</td>
<td>$13,936,761</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7.1-Piece Home Theater Speaker System</td>
<td>$18,846,731.00</td>
<td>$13,936,761</td>
</tr>
</tbody>
</table>

Subtotal for Audio $162,704,821
```

Figure 4-69  Sample Summary Report with Gross Profit Subtotals based on Product Type

21. Save As the report, and name it “1c - Revenue Summary with Subtotals”.
23. Publish the 1c - Revenue Summary with Subtotals report. To know how to publish the report, go to last part of 4.1.5, “Adding traffic lighting” on page 61.
4.4 Simple revenue report group by year

In this section, we discuss how to create a simple revenue report group by year. This report is used to learn how to create and use the dashboard feature in DB2 Web Query.

After finishing this section, you will be able to create a report as in Figure 4-70.

Follow these steps to create the report:

2. Choose CEN_ORDERS data source, and click OK.
3. Drag Product Type from Data panel to By in Query panel as in Figure 4-71. This means Product Type is the primary sorting field.
4. Next, drag Revenue and Returns from the Data panel to Sum in the Query panel.

Figure 4-72  Move Revenue and Returns from Data Panel to Query panel
5. Since you created the revenue report group by year, then you have to add year of order date to the report. To do this, drag \texttt{ORDERDATE\_YEAR} from Data panel to Across in the Query panel.

![Figure 4-73](image)

\textit{Figure 4-73} Move ORDERDATE\_YEAR from Data Panel to Query panel

6. Add the grand total of the report.

7. In the Interactive Design View, you get the report as in Figure 4-74.

![Figure 4-74](image)

\textit{Figure 4-74} Report Result in Interactive Design view
8. Add some formatting in Returns and Revenue field with **Comma** and **Non floating Currency**.

9. Run the report. The result is shown in Figure 4-75.

10. Save the report and name it “1d - Revenue and Returns by Type”.


12. Publish the 1d - Revenue and Returns by Type report. To know how to publish this report, go to the last part of 4.1.5, “Adding traffic lighting” on page 61.

### 4.5 Creating Define fields and Compute fields in the synonym

Previously in this chapter, you created the gross profit Define field and the profit margin Compute field in the reports using Info Assist. This is fine, but consider that these are likely fields that you will be including in many different reports and charts in the future. Rather than re-creating them over and over again in each report and chart, a best practice is to move the definition of these derived fields to a central location so that all reports and charts have immediate access to them.

Doing so minimizes report maintenance and decreases (or perhaps eliminates) the chance that an incorrect formula is specified for the fields. This can be done by defining these fields in the metadata layer of DB2 Web Query. In this section, you create these fields in the synonym of the ORDERS table.

The tool that you use to create these derived field is the Synonym Editor. You can access the Synonym Editor through the DB2 Web Query Developer Workbench tool, or through DB2 Web Query synonym console from a web browser. This chapter discuss how to create a field using the web based Synonym Editor.

#### 4.5.1 Creating a profit field by using a Define field

In 4.1.1, “Creating the revenue summary report” on page 48, you created the Gross_Profit Define field in Info Assist. In this section, you will create the same Define field definition in the ORDERS synonym using the Synonym Editor. To distinguish the two, instead of using Gross_Profit name, we will use the field name of Profit in the synonym.

The Profit formula is the same as before: Revenue - Cost of Goods Sold.
Follow these steps to create the new Profit field:

1. To open the Synonym Editor, go to DB2 Web Query page. Right-click the Century Electronics folder and select Metadata → Edit. See Figure 4-76.

![Figure 4-76 Edit Synonym menu](image)

2. A new page showing all synonyms you have appears. Right-click the CEN_ORDERS and choose Open as in Figure 4-77 and it will redirect you to Synonym Editor page.

![Figure 4-77 Open CEN_ORDERS Synonym](image)

3. On the left panel, go to the bottom part of the panel and you can see Constant Defines/Computes folder. Right-click it and choose Insert → Define as in Figure 4-78. This is the menu to create new Define field.

![Figure 4-78 Create Define menu](image)
4. On the right panel, new fields are displayed. Fill in the fields as shown in Figure 4-79. Click **Apply** after you finish filling in all the fields. Notice that the EXPRESSION field is filled with the formula of Gross Profit.

![General](image)

*Figure 4-79  Define field information*

Notice that the **Type** field is Decimal Packed. Decimal Packed is chosen since Revenue and Cost of Goods Sold also has the Decimal Packed type. You can check the properties of Revenue and Cost of Goods Sold by right-clicking the field and choose **Properties**.

Also notice that you have to put the correct value in the **Length** field. For example, if you set the length as 11 while the value of your Gross Profit field reaches millions (such as 2,000,000.00), then the Gross Profit field will not return the correct value. Instead of returning the numeric field, it will just return a series of stars ("********") showing that the defined field length is too short.

**Note:** Bear in mind that comma, period, and decimal are also part of the field length that should be calculated. So numeric 2,000,000.00 needs a 12 field length.

In the end of this section, you will be provided an example of a report where the defined field length is too short.
5. Notice that you cannot find the Profit field that you just created in the Constant Defines/Computes folder. You can find it under the CEN_ORDERS (Figure 4-80).

![Figure 4-80  Profit field](image)

6. Save the Synonym before you close the Synonym Editor (Figure 4-81).

![Figure 4-81  Save the Synonym](image)

7. To see whether the created field returns the correct number or not, you can create a new report and use this new Profit field. See our example of a simple report in Figure 4-82, which shows the correct Gross Profit length, since it returns a correct numeric value.

![Figure 4-82  Sample Report with correct profit length](image)
Figure 4-83 shows the wrong Gross Profit length since the Gross Profit for Audio, Camcorders, and Video numeric value is not shown.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Revenue</th>
<th>Cost of Goods Sold</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>$382,653,321.00</td>
<td>$215,978,500.00</td>
<td></td>
</tr>
<tr>
<td>Camcorders</td>
<td>$444,531,041.00</td>
<td>$341,014,310.00</td>
<td></td>
</tr>
<tr>
<td>Cameras</td>
<td>$184,103,657.00</td>
<td>$133,328,830.00</td>
<td>$50,774,827.00</td>
</tr>
<tr>
<td>Office</td>
<td>$30,245,685.00</td>
<td>$19,024,725.00</td>
<td>$11,220,960.00</td>
</tr>
<tr>
<td>Video</td>
<td>$20,360,205.00</td>
<td>$415,811,550.00</td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-83   Sample Report with incorrect profit length

So, you have to be very careful when putting the length for your defined field.

**Note:** You can add comma formatting and currency as part of the field definition when you create it in the Synonym Editor.

### 4.5.2 Creating a margin field by using a Compute field

During the making of this book, the authors were debating about what is the correct formula of gross profit margin, either \((\text{gross profit}/\text{cost of goods sold}) \times 100\%\) or \((\text{gross profit}/\text{revenue}) \times 100\%\).

In 4.2.3, “Creating Define and Compute fields” on page 68, you have learned to create a profit margin using a Compute field with the \((\text{gross profit}/\text{revenue}) \times 100\%\) formula.

In this book, we do not want to focus on which formula is correct. So to accommodate both formulas in this section, you learn about how to create a profit margin field using a Compute field by using the \((\text{gross profit}/\text{cost of goods sold}) \times 100\%\) formula.

Follow these steps to create the new profit margin field:

1. As usual, to open the Synonym Editor, go to DB2 Web Query page. Right-click the **Century Electronics** folder and select **Metadata → Edit**.
2. Open **CEN_ORDERS** synonym.
3. In the **Constant Defines/Computes** folder, choose **Compute** instead of **Define** (Figure 4-84).
4. Fill in the fields as shown in Figure 4-85. Click **Apply** after you finish filling in all the required fields.

![Figure 4-85 Compute Field Information](image)

5. Save the Synonym.

6. Notice that Margin field you created is under Constant Defines/Computes (Figure 4-86).

![Figure 4-86 Margin field](image)

7. Test the Margin that you just created by creating a simple report as shown in Figure 4-87.

![Figure 4-87 Simple report using Margin field](image)
Assignment #2: Implementing various date functions in reports

Dates are fundamental reporting elements in Business Intelligence. Many reports and charts would be meaningless if you were not able to include date components to examine business trends over time and compare your business results year over year. This chapter describes several ways to include assorted date components in reports using a variety of functions and techniques.

In this chapter, you learn how to do the following tasks:
- Change the default theme/style of the reports you create.
- Use aggregation functions.
- Edit column titles.
- Create a Define field for the name of the month using DB2 Web Query functions.
- Create a Define field for week of the year using SQL prefixing.
- Add a join to a date table to include a season of the year column.

Prerequisites: Before starting this chapter, make sure the following steps have already been completed:
- Create a synonym over the ORDERS table.
- Edit ORDERS synonym and define joins to INVENTORY, PLANT, and STORES tables.
- Edit ORDERS synonym and decompose the ORDERDATE field.

If you have not completed these steps, go to Chapter 3, “Creating and editing metadata: Century database” on page 33.
5.1 Dates using DB2 Web Query functions

After reviewing the reports you delivered for Assignment 1, Dan was happy with the results. However, the various departments at Century need additional reports with assorted date components implemented in them to help analyze store purchasing trends during specific periods of the year. In this chapter, you will create a set of queries for the second assignment: reports that utilize and implement various ways of extracting and displaying date components.

The first report requirement in this assignment is to help determine the number of orders made in each store for each month of the year over the last 2 years. This report should be sorted by country, region, store name, and name of the Month. The measure field is number of orders placed, of which there should be separate columns for the year of the order. Having these measures side by side over the year allows the report consumer to easily compare the numbers year to year. When you have finished this report, it will look similar to the report shown in Figure 5-1.

<table>
<thead>
<tr>
<th>Country</th>
<th>Region</th>
<th>Store Name</th>
<th>Month</th>
<th>2011</th>
<th>2012</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>Eastern Canada</td>
<td>ABC Electronics</td>
<td>January</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>February</td>
<td>110</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>March</td>
<td>102</td>
<td>105</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>116</td>
<td>102</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>May</td>
<td>95</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>127</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>95</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>August</td>
<td>20</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>40</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>October</td>
<td>78</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>November</td>
<td>49</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Planete Digitale</td>
<td>January</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>October</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>November</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Winnipeg Audio</td>
<td>January</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>February</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>March</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>17</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>August</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>

Figure 5-1  Report Result using DB2 Web Query Date function
5.1.1 Changing the report theme

Before using the date function, follow these steps to learn how to change the report theme:

1. Since this is a new assignment, create a new assignment folder under the Century Electronics folder. To do this, right-click the Century Electronics folder and select New → Folder as in Figure 5-2.

![Figure 5-2 Create New Folder for Assignment 02](image)

2. Name the new folder as “Assignment 02 - Implementing Various Date Functions in Reports”.

3. Next, create a new report under the Assignment 02 folder. To do this, right-click “Assignment 02 - Implementing Various Date Functions in Reports” and select New → Report as in Figure 5-3.

![Figure 5-3 Create new report](image)

4. Choose CEN_ORDERS as data source.

5. Before you start to create the report, first you have to change the theme. Click the Home menu, and on the Home menu ribbon, select Theme as in Figure 5-4.

![Figure 5-4 Select Theme function](image)
6. A **Template** menu pops up as in Figure 5-5. Choose *ENgray_theme.sty* as the theme. Click **Open**.

![Templates - Browse predefined template files](image)

*Figure 5-5   Select Specific theme*

The theme changes that you have just done are only specific for the report you are currently creating. So if you create another new report, the theme will go back to the default theme. You, as a developer, can actually change the default theme to any other themes, so all reports that you create will use this specific theme without having to change it repeatedly when creating a new report.
7. Recall that you changed the theme of the reports in assignment 1. You can either do this for every individual report, or you can save yourself some time by making a specific theme the default one for each and every report you create. To do this, click the **IA** menu button on the top left side of the IA window and choose **Options** as demonstrated in Figure 5-6.

![Figure 5-6 Options button](image)

8. The Options menu pops-up as in Figure 5-7. See the **Environment and Styling** section. On the Document Theme, click **Browse** and locate the ENgray_theme.sty file, or any file theme you like.

![Figure 5-7 Options menu](image)
9. After you change the **Document Theme**, click **OK**. See Figure 5-8.

![Figure 5-8 ENgray_theme.sty selected](image)

10. Now all the reports you create in the future will use the Engray_theme style by default.

5.1.2 Using the aggregation function

The report you will create in this section displays the total number of orders made by each store in each month. For this, you will use an aggregation function to calculate the number of unique orders:

1. To start creating the report, add these fields to the **Interactive Design View** in a sequential manner: **Country, Region, Store Name**. You can do it by double-clicking these fields, or drag and drop it from the **Data** panel to the **Query** panel under the **By** section. In this case, Country is the primary sort-by field followed by Region and Store Name as in Figure 5-9.

![Figure 5-9 Country, Region, Store Name fields as Sort-By](image)
2. The next step is put the `ORDERDATE_YEAR` field as a sort across field. Drag and drop `ORDERDATE_YEAR` to **Across** under the Query panel as in Figure 5-10.

![Figure 5-10 ORDERDATE_YEAR as sort across](image1)

3. Add the **Order,Number** field as **Sum** to the Query panel. See Figure 5-11.

![Figure 5-11 Order,Number as Sum](image2)

4. Next, you change the **Order,Number** field as **count** (count the amount of OrderNumber) using the Aggregation function.

   To do this, click the **OrderNumber** field in the Interactive Design View or Query panel. Then, from the **Field - Order,Number** ribbon, expand the **Display** group menu.
5. The aggregation function is part of the Display group menu. Click **Aggregation** and select **Count** as in Figure 5-12.

![Figure 5-12 Aggregation function](image)

6. Still on the Order,Number field (in which the name in the Query panel is changed to **CNT.Order,Number**), change its format to **Integer**. To do this, go to the Field-Order,Number menu ribbon and expand the Format group menu. Find the Alphanumeric menu and change it to **Integer** as in Figure 5-13.

![Figure 5-13 Change CNT.Order,Number Column Format to Integer](image)

7. Add a comma to the **CNT.Order,Number** field using the **Comma** function in the Format group menu.

8. After finishing with formatting the column, change the **ORDERDATE_YEAR** column title with **“Number of Orders”**. To do this, go to the Query panel and right-click **ORDERDATE_YEAR**. Select **Change Title** as in Figure 5-14.

![Figure 5-14 Change Title menu](image)
9. After you type the new title, click OK. Figure 5-15 shows the Edit Title dialog window.

![Edit Title](image)

Figure 5-15   OrderDate_Year new Title

5.1.3 Adding the month name as a Define field

Next, you need to modify the report so the number of orders count will also sorted by month, so you can know exactly how many orders are made for each month in each store.

1. To do this, first you have to create a new field using the Define function in Data ribbon menu. Click the Detail (Define) function. See Figure 5-16.

![Detail (Define) Function in Data ribbon](image)

Figure 5-16   Detail (Define) Function in Data ribbon

2. You see Define menu displayed. Fill the fields as in Figure 5-17 and click OK.

![Define field](image)

Figure 5-17   Define field
3. Because MonthName is a Define field, you can find it in the Data panel under Dimension. Drag and drop MonthName to the Query panel in Sort-By, right after Store,Name. See Figure 5-18.

Figure 5-18  MonthName field position in the report
4. Run the report. A sample of a few rows of the report can be seen in Figure 5-19. Notice that now you have the amount of order numbers grouped by month.

<table>
<thead>
<tr>
<th>Country</th>
<th>Region</th>
<th>Store Name</th>
<th>Month</th>
<th>2011</th>
<th>2012</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>Eastern Canada</td>
<td>ABC Electronics</td>
<td>January</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>February</td>
<td>110</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>March</td>
<td>102</td>
<td>105</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>126</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>May</td>
<td>95</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>127</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>96</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>August</td>
<td>20</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>46</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>October</td>
<td>78</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>November</td>
<td>49</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Planete Digitale</td>
<td>January</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>October</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>November</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Winnipeg Audio</td>
<td>January</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>February</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>March</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>April</td>
<td>17</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>June</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>July</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>August</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>September</td>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>

*Figure 5-19  Run Report sample result*
5. To complete this report, add a Report Header and title it “Monthly Orders by Country, Region, Store”.

6. Save the report and name it “2a-Monthly Orders by Country, Region, Store”.

7. **Publish** the report you have made. To do this, go to the DB2 Web Query page and right-click in the report you just created. Select **Publish** as in Figure 5-20.

![Figure 5-20 Publish the report](image)

Notice that after you publish the report, the font is changed to **bold** so you can easily identify which report is published or not yet published.

8. Do not close the Info Assist page since you will use this report in the next section.
5.2 Dates using SQL prefix

In some cases, there may not be a native DB2 Web Query function that delivers the requirement you are looking for. In those situations you may need to look for alternative ways to fulfill that requirement. One of the features of DB2 Web Query is the ability to specify a direct SQL function and pass that request directly through to the DB2 engine. This is accomplished by specifying an SQL prefix in your Define field. In this section, you learn how to do this to calculate the week of the year for each of the rows in the ORDERS table. At the end of this section, you will be able to create report as shown in Figure 5-21.

<table>
<thead>
<tr>
<th>Country</th>
<th>Region</th>
<th>WeekOfYear</th>
<th>2011</th>
<th>2012</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>Eastern Canada</td>
<td>2</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>12</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7</td>
<td>23</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>53</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10</td>
<td>77</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12</td>
<td>11</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>13</td>
<td>41</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14</td>
<td>29</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15</td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16</td>
<td>39</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17</td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>18</td>
<td>45</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>19</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>21</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22</td>
<td>52</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23</td>
<td>29</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>26</td>
<td>32</td>
<td>27</td>
</tr>
</tbody>
</table>

Figure 5-21 Order Date Report Grouped by Week of Year

Use the report you have created in 5.1, “Dates using DB2 Web Query functions” on page 92 to do the following steps.

1. First, remove the MonthName field from the report in the Interactive Design View.
2. Then remove the MonthName Define field from the Data panel. Figure 5-22 shows the MonthName field that should be removed.

![MonthName Field](image)

2. Then remove the MonthName Define field from the Data panel. Figure 5-22 shows the MonthName field that should be removed.

3. Since in this section, you learn how to create the Week of Year field, you need to simplify the report. **Delete Store Name field**, so the Week of Year field will be sorted only based on Region.

4. Add a new Define field (as described in 5.1.3, “Adding the month name as a Define field” on page 99) and fill the fields as in Figure 5-23.
   - Field Name: WeekOfYear
   - Format: I2
   - Definition: SQL.WEEK_ISO(CEN_ORDERS.T1_ORDERS.ORDERDATE)
   - Click OK.

![WeekOfYear Define field](image)

**Note:** In the Define field definition, you specified the SQL prefix to directly invoke the SQL function named WEEK_ISO, a system supplied scalar function that returns an integer between 1 and 53 representing the week of the year (where the week starts with Monday). As a result, this Define field will use this function to calculate the week of the year of the order date field. To learn more about the SQL prefixing capability, see Appendix A, “Date and time functionality” on page 789.
5. Drag and drop WeekofYear to the Query panel in Sort-By, right after Region.

6. Notice that the Interactive Design View is not able to resolve SQL prefixes at this time. See the error message in Figure 5-24. But do not worry, run the report to resolve SQL prefixes.

![Error Message in Interactive Design view](image)

7. Click the Run button. The sample result of several fetched records will be as shown in Figure 5-25.

![Report result](image)

Notice that now you have a report with number of orders grouped by week of year.

8. Save the report and name it “2b-Weekly Orders by Country, Region”.

9. Publish the report. To see how to publish the report, go to the last part of 5.1.3, “Adding the month name as a Define field” on page 99.

10. Do not close the Info Assist page since you will use this report in the next section.
5.3 Dates using date table

At this point, you have learned how to extract and calculate specific date components using DB2 Web Query functions and SQL prefixes. However, there are some date requirements that cannot be fulfilled by either DB2 Web Query or SQL functions. For example, what if you wanted to sort and aggregation of order dates by the phase of the moon? Or the season of the year? In which season or phase of the moon do you sell the most products? There are no functions in DB2 Web Query or SQL that can calculate those components. For very specialized requirements like these, a date table is a splendid solution.

A date table is actually another prepopulated table with a row for every day of the year in a broad date range and contains columns for assorted ways to represent dates. For more information about date tables, see “Using a date conversion table to convert to dates” on page 802 in Appendix A.

In this section, you learn how to use a date table to add a season in the report you have made previously. After finishing this section, you will be able to create a sample report as in Figure 5-26.

Note: To learn more about date tables, go to Appendix A, “Date and time functionality” on page 789. This appendix explains what kind of date information you can get using a date table.
In this tutorial, we use the report created in 5.2, “Dates using SQL prefix” on page 103. So if you have closed the report, re-open it using Info Assist. Then proceed as follows:

1. First, **remove** the **WeekOfYear** field from the report in the **Query** panel.
2. Then **remove** the **WeekOfYear** Define field from the **Data** panel. See Example 5-27.

![Figure 5-27  WeekOfYear Field in Data panel and Query panel](image)

If you see the sample result of the report you created in this section, you have a Season field in the third column. But if you cannot see a Season field in the Data panel, this is because the date table that contains the Season field is not yet joined to the CEN_ORDERS table.

You can either join these tables together in the synonym (highly recommended if you will be using the date table columns in other reports), or you can define the join in this report. For this example, you define the join in this report.

3. In the Info Assist page, click **Data** to open the Data ribbon menu.

![Figure 5-28  Join Menu in Data ribbon](image)
4. You see that the **Join** menu field is displayed and shows that currently you only use one table named CEN_ORDERS. Click **Add New** as in Figure 5-29.

![Figure 5-29 Join Menu field](image)

5. A new menu that contains a list of master files is displayed. Choose **CEN_DATE_CONV**, and click **OK**. See Figure 5-30.

![Figure 5-30 Master File page](image)
6. You go back to the **Join** menu field and instead of one table, now you see two tables in it. Next, drag and drop **ORDERDATE** in CEN_ORDERS table to **DC_DATE** in CEN_DATE_CONV as in Figure 5-31.

![Figure 5-31 Drag and Drop ORDERDATE to DC_DATE](image)

7. A new red line appears between ORDERDATE and DC_DATE. Right-click the red line and choose **Edit** as in Figure 5-32.

![Figure 5-32 Edit Option for Relationship between tables](image)
8. The Edit Join page appears. In the type of Join, choose **Inner** as in Figure 5-33. Click **OK** until you get back to the Interactive Design view.

![Figure 5-33   Edit Join Page](image)

9. Check on the Data panel, and you can find the **DC_SEASON** field there. Move the DC_SEASON field as the third sort-by field in the report as shown in Figure 5-34.

![Figure 5-34   DC_SEASON field](image)
10. **Run** the report to see the result as shown in Figure 5-35.

![Figure 5-35  DC_SEASON Run result](image)

11. **Save** the report and name it “2c-Seasonal Orders by Country, Region”.
13. **Publish** the report. See the steps on how to publish the report in the last part of 5.1.3, “Adding the month name as a Define field” on page 99.
Assignment #3: Implementing other report features and formats

This chapter discusses how to use other report features to increase interactivity between the report and the users, and also increase the ease with which end users can navigate the report and jump to specific areas.

In this chapter, you learn how to do the following tasks:

- Activate the Table of Contents, Accordion, and Pages on Demand features for easy navigation of large reports
- Generate other report formats such as PDF, Excel Formula, and Active Reports.

**Prerequisites:** Before starting this chapter, make sure that the following steps have already been completed:

- Chapter 3, “Creating and editing metadata: Century database” on page 33.
- Chapter 4, “Assignment #1: Summary reports” on page 47, because we will use 1a - Revenue Summary by Product Category and 1c - Revenue Summary with Subtotals reports, which are created in this chapter.
6.1 Table of Contents

The date reports you delivered to Dan were met with great fanfare and enthusiasm. So far you have proven to him that all the BI requirements can be met using native IBM i tools, and the data can be left on DB2 for i. He is starting to believe!

The next assignment he has given you contains a set of larger reports that contain many more rows of data. Consequently, navigation features are very important to allow the report consumers to quickly locate information they are looking for. The first report in the assignment is sorted by Country, Region, Product Type, Product Category, and Product Name. The measure fields are revenue and gross profit. Because there are so many Sort-By fields, this report will be aggregated at many levels and contain many rows in the result set. Providing the report consumer with a quick and easy way to jump to specific locations in the report will be the key to acceptance by the end users and a successful implementation.

In this section, you learn how to add a Table of Contents in your report so you can easily understand the content of your report and can navigate from one subset of report to another. With the Table of Contents feature activated, report consumers see a dialog window that is initially collapsed to only reveal the first Sort-By field values. Expanding a specific row will show them the next level of Sort-By fields. This condensed interface allows them to quickly locate specific points of interest in the report and immediately jump to that area.

At the end of this chapter, you will create report a report similar to the one shown in Figure 6-1.

![Figure 6-1 Sample report with Table of Contents](image)

1. As usual, create a new folder under Century Electronics named “Assignment 03 - Other Report Features and Format”. To do this, right-click in the Century Electronics folder and select New → Folder as in Figure 6-2. Click OK after you fill in the folder name field.

![Figure 6-2 Create new folder for Assignment 03](image)
For the next steps of this tutorial, we will use “Assignment 03” to refer to “Assignment 03 - Other Report Features and Format”.

2. Next, create a new report under the Assignment 03 folder. To do this, right-click “Assignment 03 - Other Report Features and Format” and select New → Report as in Figure 6-3.

3. Choose CEN_ORDERS data source.
4. In a sequential manner, add the following fields to Sort-By fields in the Query Panel: Country, Region, Product Type, Product Category, Product Name. See Figure 6-4 for a more clear explanation.

![Figure 6-3 Create New Report under Assignment 03 Folder](image)

![Figure 6-4 5 (Five) fields added to Sort-By field in Query panel](image)
5. In Figure 6-4, we put Revenue in the Sum field under the Query panel, followed by Gross_Profit.

![Figure 6-5 Revenue and Gross_Profit field](image)

To see how to create Gross Profit using the Define field, go back to 4.1.2, “Adding a gross profit Define field” on page 54. Or you can also use the Profit field that you have created using the synonym editor.

6. Do not forget to add some formatting in Revenue and Gross_Profit such as adding Comma and Floating Currency.

7. Save the report and name it “3a - Table of Contents”.

8. Run the report. The sample run result of few records is shown in Figure 6-6.

![Figure 6-6 Revenue Summary Report result](image)
Notice that it is a fairly lengthy report, because it contains so many Sort-By fields. If you want to find the first occurrence of a row for the United States, you will have to do quite a bit of scrolling and/or paging. Just imagine if you had hundreds of thousands rows in your report! Would it not be nice if you wanted to jump to a specific location in the report without have to scroll up or down or page through all of the data? Fortunately, DB2 Web Query Info Assist is equipped with the Table of Contents feature for the report you have created.

In the following steps, we add the Table of Contents in the report:

9. Go to the **Format** menu and expand the **Navigation** group menu. Select **Table of Contents** as shown in Figure 6-7.

![Figure 6-7 Table of Contents button](image)

10. **Run** the report again. In the top left side of the run report result, you can see that a new icon appears. That is the Table of Contents icon, shown in Figure 6-8.

![Figure 6-8 Table of Contents icon](image)

11. **Double-click** the icon to show the Table of Contents as in Figure 6-9.

![Figure 6-9 Table of Contents](image)
12. If you feel that the position of the Table of Contents prevents you from viewing the report, you can actually move the Table of Contents to any position you like. For example, the image in Figure 6-10 shows the Table of Contents moved to the right side of the report.

![Moved Table of Contents](image)

Figure 6-10  Moved Table of Contents

13. Next, to jump directly to a specific area in the report, expand the United States country, and click the New England region as shown in Figure 6-11.

![Expanded Table of Contents](image)

Figure 6-11  Expanded Table of Contents

14. You will jump directly to the first row for the New England region. Figure 6-12 shows a sample of the New England report for Audio Product Type.
15. Try to click another parameter in the Table of Contents to get familiar with it.

16. **Save** the report.

17. If you already feel confident and comfortable with the report, **publish** the report. To publish the report, go to DB2 Web Query page and expand the **Assignment 03** folder. Right-click the **3a - Table of Contents** report and select **Publish**. See Figure 6-13.

---

**Figure 6-12**  
New England Report result

**Figure 6-13**  
Publish 3a - Table of Contents report

Notice that soon after you publish the report, the font in the menu will change to **bold**.
6.2 Accordion

Another extremely useful navigation feature is the Accordion. The idea behind the Accordion is very similar to the Table of Contents; it allows the end user to expand and collapse at each Sort-By field level. The difference is where this occurs: When Accordion is activated and the report consumer runs the report, the rows of the report themselves are initially collapsed. The end user can expand and collapse each row. This differs from Table of Contents in that there is no separate dialog window to control this navigation. In addition, the measure columns are automatically summed at each of the Sort-By levels.

In this section, you learn how to activate the Accordion feature for ease of navigation. You will create a report that looks like the one in Figure 6-14.

![Figure 6-14 Revenue Report in Accordion mode](image)

1. If you have closed the Info Assist page, re-open it along with the “3a - Table of Contents” report.
2. Remove the Table of Contents by clicking the Table button in the Format Menu as in Figure 6-15.

![Figure 6-15 Table button to disable Table of Contents](image)
3. Now, click the **Accordion** button. The Accordion function is part of the **Features** group, still under the **Format** menu. See Figure 6-16.

![Figure 6-16 Accordion button](image)

4. **Run** the report. The first report you see is shown in Figure 6-17.

![Figure 6-17 Accordion result](image)

If you click the (+) sign, the report will show detailed information, and you can choose to drill down into which information you want to see. See the drilled down sample report in Figure 6-18.

![Figure 6-18 Drill Down Report in Accordion mode](image)

5. **Save** the report and name it “**3b - Accordion**”.

6. **Publish** the report. Go to the last part of 6.1, “Table of Contents” on page 114 to learn how to publish a report.
Now you have tried the *Table of Contents* and *Accordion* functions. So what is the difference between those two functions?

In the Table of Contents, you actually have all the records opened in the web page. With the Table of Contents feature, you can jump from one subset of records to another.

Another key difference is with Accordion, where you can open two subsets of records at the same time. For example, Figure 6-19, which uses Accordion, can open Western Canada and West Germany revenue and gross profit information for each Product Type. In the Table of Contents, you cannot do this, you can only jump to Western Canada revenue and gross profit information, or jump to West Germany revenue and gross profit information. This is very useful when you want to compare the data between two areas of the report that would be far apart when fully expanded.

**Table 6.2**

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>$181,714,046.00</td>
<td>$50,803,176.00</td>
</tr>
<tr>
<td>Western Canada</td>
<td>$28,018,061.00</td>
<td>$7,998,631.00</td>
</tr>
<tr>
<td>Audio</td>
<td>$6,260,375.00</td>
<td>$2,881,645.00</td>
</tr>
<tr>
<td>Camcorders</td>
<td>$8,215,175.00</td>
<td>$1,922,935.00</td>
</tr>
<tr>
<td>Cameras</td>
<td>$2,565,871.00</td>
<td>$720,291.00</td>
</tr>
<tr>
<td>Office</td>
<td>$424,715.00</td>
<td>$183,075.00</td>
</tr>
<tr>
<td>Video</td>
<td>$10,531,925.00</td>
<td>$2,290,685.00</td>
</tr>
<tr>
<td>France</td>
<td>$65,482,052.00</td>
<td>$18,160,512.00</td>
</tr>
<tr>
<td>Germany</td>
<td>$86,208,655.00</td>
<td>$23,633,625.00</td>
</tr>
<tr>
<td>Nord</td>
<td>$9,935,337.00</td>
<td>$2,849,407.00</td>
</tr>
<tr>
<td>Ost</td>
<td>$44,347,392.00</td>
<td>$12,197,477.00</td>
</tr>
<tr>
<td>Sud</td>
<td>$19,516,104.00</td>
<td>$5,151,884.00</td>
</tr>
<tr>
<td>West</td>
<td>$12,409,822.00</td>
<td>$3,434,777.00</td>
</tr>
<tr>
<td>Audio</td>
<td>$2,923,432.00</td>
<td>$1,339,022.00</td>
</tr>
<tr>
<td>Camcorders</td>
<td>$3,216,045.00</td>
<td>$690,895.00</td>
</tr>
<tr>
<td>Cameras</td>
<td>$1,179,042.00</td>
<td>$526,802.00</td>
</tr>
<tr>
<td>Office</td>
<td>$205,176.00</td>
<td>$59,821.00</td>
</tr>
<tr>
<td>Video</td>
<td>$4,866,127.00</td>
<td>$1,018,157.00</td>
</tr>
<tr>
<td>France</td>
<td>$69,477,649.00</td>
<td>$19,050,654.00</td>
</tr>
<tr>
<td>United States</td>
<td>$1,159,041,517.00</td>
<td>$321,118,037.00</td>
</tr>
</tbody>
</table>

*Figure 6-19  Another sample of Accordion*

### 6.3 Pages on Demand

A third option for navigating large reports is the Pages on Demand feature. With this option, the result set is broken into pages and you are presented an interface which allows you to jump to a specific page on the report. There is also a search feature which (if a match is found) takes you to the first occurrence of the search word.

To do this, follow these steps to learn how to use the Pages on Demand function:

1. Still using the “3b - Accordion” report, **deselect** the Accordion function by clicking the **Accordion** button. Make sure that the button is already in disabled mode (colored grey). Remember that the Accordion button is under the **Format** menu ribbon as part of the **Features** group.

2. Now, still on the Format menu, expand the **Navigation** group and click **Pages On Demand** as in Figure 6-20.
3. Run the report to see the result as in Figure 6-21.

4. Notice that a new panel appears right below the report:
   1. shows page search navigation where you can easily jump to the page you want;
   2. shows page navigation to help you navigate through pages in sequential manner;
   3. shows a search panel where you can search the report based on keywords. For example, you can search the Germany revenue report by typing “Germany” in the search panel.

5. Save the report and name it “3c - Pages On Demand”.

6. Publish the report. Go to the last part of 6.1, “Table of Contents” on page 114 to learn how to publish a report.

Now you have learned how to use the Pages on Demand function. The Table of Contents, Accordion, and Pages on Demand are functions to help you navigate from one subset of a report to another.

The Pages on Demand function splits the report into several pages. So if you really want to go through all the records in the report, this might be the one you need. Also, if you want to go to a subset of the report without knowing exactly where the location is, and you only know the keyword, you can take advantage of the search panel in the Pages on Demand function.
6.4 Stack Measures

Sometimes you need to create a report with a lot of numeric fields, and the report format should enable you to compare the value of one parameter to another. This is where the Measures function can help you in formatting the report.

At the end of this section, you will be able to create a report with the Stack Measures format as shown in Figure 6-22.

To learn how to use the Stack Measures function and how to further understand it, follow these steps:

1. Create a new report under “Assignment 03 - Other Report Features and Formats” folder, and use the CEN_ORDERS synonym.

2. Put the following fields under the Query panel in a sequential manner:
   a. Country, Region fields under Sort-by
   b. Product Type field under Across
   c. Quantity, Returns fields under Sum
3. The result in the Interactive Design view is shown in Figure 6-23.

![Interactive Design View result](image)

4. Next, create the return percentage field using the **Compute** field. Select menu **Data Summary → (Compute)**.

5. Return percentage formula is \((\text{Returns} / \text{Quantity}) \times 100\). The filled Compute field is shown in Figure 6-24. Name the new field as **RtnPct**.

![Compute field for Return percentage](image)
6. Change the title of the RtnPct field to "Return Percentage". To do this, right-click the RtnPct in Query panel and choose Change Title as in Figure 6-25.

![Figure 6-25  Change Title menu](image)

7. An Edit Title menu is displayed. Change the title to "Return Percentage", and click OK as in Figure 6-26.

![Figure 6-26  Edit Title for Return percentage](image)

8. Run the report. You can find the sample report result as in Figure 6-27.

![Figure 6-27  Run Report result](image)
As you can see in the sample report, the layout of this report is not comprehensive enough because all the measures are placed in the columns. It will be hard to compare one value to another in this kind of format. You can change the layout format of this report using the Stack Measures function.

9. To activate Stack Measures, go to the **Format** menu and expand the **Features** group menu, then select **Stack Measures**. See Figure 6-28 to locate the Stack Measures menu.

![Figure 6-28 Stack Measures menu](image)

10. **Run** the report again. Notice the difference between a report layout that uses and one that does not use the Stack Measures function. See Figure 6-29.

![Figure 6-29 Sample report using Stack Measures](image)

So, if your report has many measures in it, then Stack Measures is a good solution, since the measures will be placed in rows instead in columns.

11. **Save** the report and name it “3d - Stack Measures”.

12. **Publish** the report. Go to the last part of 6.1, “Table of Contents” on page 114 to learn how to publish a report.
6.5 PDF

In this section, you learn how to generate a PDF file from the report you created. So whenever you run the report, you will get the PDF file generated for you.

To do this, proceed as follows:

1. Note that to generate a PDF file, you do not have to create a new report from scratch. Just use the report you have created previously. For example, you can use the report 1a - Revenue Summary by Product Category that you have made in Assignment 01.

2. First, copy 1a - Revenue Summary by Product Category from Assignment 01 to the Assignment 03 folder. To do this, right-click the 1a - Revenue Summary by Product Category report and select Copy as in Figure 6-30.

3. Next, go to Assignment 03 - Other Report Features and Formats, right-click it and choose Paste. See Figure 6-31 for your reference.

4. Now you already the 1a - Revenue Summary by Product Category report in the Assignment 03 folder. To avoid confusion with the report in the Assignment 01 folder, rename the file name as described next.
5. To do this, right-click the 1a - Revenue Summary by Product Category report in the Assignment 03 folder and select Change Title. Rename the report name with “3e - PDF Revenue Summary by Product Category”. See Figure 6-32 for your reference.

Figure 6-32 Change Title for report

6. After you change the report name, open it using Info Assist.

7. Next, go to the Format menu, expand the Output Types group menu, and select PDF as shown in Figure 6-33.

Figure 6-33 PDF menu
8. Run the report. You see that instead of being in web-based format, the report result is in PDF format. A new menu that is PDF specific also appears. See Figure 6-34 for a sample of the report in PDF format.

![Figure 6-34](image_url)

9. Save the report to make sure that the PDF format you have just generated is saved.

10. Publish the report. Go to the last part of 6.1, “Table of Contents” on page 114 to learn how to publish a report.

### 6.6 Excel formula

Now you have learned how to make a PDF file as an output format of your report. In this section, you learn how to make an Excel file as an output format of your report. Additionally, you can actually know the formula of each field in your report.

To do this, proceed as follows:

1. Copy the “1c - Revenue Summary with Subtotals” report from Assignment 01 to the Assignment 03 folder. See 6.5, “PDF” on page 128 to learn how to copy and paste a report from one folder to another.

2. Rename the report to become “3f - Excel Revenue Summary with Subtotals”.

3. Open the report using Info Assist.
4. In Info Assist, go to the **Format** menu and expand the **Output Types** group menu. Click the drop-down button on Excel and choose **Excel Formula** as in Figure 6-35.

![Figure 6-35 Excel Formula menu](image)

5. Now, try to run the report. You get a pop-up message asking whether you want to open the file or save the file as in Figure 6-36. You can choose either one of these options.

![Figure 6-36 Pop-up message](image)

6. After you open the Excel file, put the cursor on the first **Revenue** field. Notice that in the Formula bar, it contains the same value as in the Revenue field as in Figure 6-37. The same thing also happens if you put the cursor in the Gross_Profit field.

![Figure 6-37 Revenue field in Excel file](image)
7. Next, put the cursor in the **Subtotal** field of **Revenue** as in Figure 6-38. Notice that you can see the Subtotal formula in the Formula bar. You can also see the formula of the **Gross_Profit Subtotal** field.

![Figure 6-38  Revenue Subtotal field in Excel file](image)

9. **Save** the report before you close the Info Assist page.
10. **Publish** the report. Go to the last part of 6.1, “Table of Contents” on page 114 to learn how to publish a report.

### 6.7 Active Reports

In this section, you learn how to change the reports you have created to become Active Reports.

At the end of this section, you will be able to create an Active Report as in Figure 6-39 and use the functions in Active Report.

![Figure 6-39  Sample of Active Report and its drop-down menu](image)
The Active Reports feature allows users to interact with their reports and work disconnected from the IBM i environment. HTML Active Report pages are self-contained reports. Both the data and the Java Script are compressed within a single efficient file. This file can be stored by the users on their local drive. It can be stored on the server for retrieval by the users or it can be sent by e-mail to users.

To do this, proceed as follows:

1. Note that in this section, you do not have to recreate the report from scratch, you can use “1c - Revenue Summary with Subtotals” report from Assignment 01 folder. First, copy the report from Assignment 01 to Assignment 03 folder. See 6.5, “PDF” on page 128 to learn how to copy a report from one folder to another folder.

2. Rename the report with “3g - Active Report Revenue and Profit Report”.

3. Open the report in Info Assist.

4. First, remove the Subtotal function in the report. To do this, click the Product Category field (since Subtotal is made based on Product Category). The ribbon changes to be Product Category menu specific.

5. Expand the Break group menu, click the Subtotal drop-down menu, and choose More Options. In the Subtotal menu, change it to None. See Figure 6-40.

![Figure 6-40  Remove Subtotal field](image)
6. Click **OK** after you change it to **None**.

7. The next step is to change the report format. Go to the **Format** menu, expand the **Output Types** group menu, and click **Active Report**. See Figure 6-41 to find the Active Report menu.

![Figure 6-41 Active Report menu](image)

8. Still under the **Format** menu, expand the **Features** group menu and click **Active Report Options** as in Figure 6-42.

![Figure 6-42 Active Report Options menu](image)

9. In the Active Report Options menu, do the following tasks:
   a. Change Records Per Page to All.
   b. Change Hover Color to Orange.
   c. Change Visualization Bars: positive to Blue, and negative to Red.
   d. Change Password to abc123.
10. To change the number of Records Per Page, go to the **General** tab. Find **Records Per Page** under **Page Options**. See Figure 6-43.

![Active Report Options](image)

**Figure 6-43  Change Records Per Page**
11. To change the color of Hover and Visualization Bars, go to the **Colors** tab. See Figure 6-44 for further information about the color you should change.

*Figure 6-44  Change Color menu*
12. Next, to change the report to be password protected, go to the Advanced tab as in Figure 6-45.

![Figure 6-45 Add Password Protection to the report](image)

Note: If you leave the Password field to blank, then when you run the report you will not be asked to provide any password.

13. Now, try to run the report and see the result.

14. On the first page, instead of seeing the report, you see the password field page, since in the Active Report Options, you also set the password. A sample of the Password field page is shown in Figure 6-46.

![Figure 6-46 Password field page](image)
15. After you correctly input the password, you can see your Active Report as in Figure 6-47.

![Figure 6-47 Sample of Active Report](image)

Notice that on the top left side of the report, you see that the report only contains one page. This is because you have configured to put all the records in just one page.

Next, try to access the Active Report menu using the drop-down menu. You see that every time the cursor moves to any part of the menu, the menu background color changes from blue to orange.

16. See Figure 6-48 to check the visualization function. Click the drop-down button right beside Revenue. Select **Visualize**.

![Figure 6-48 Visualize menu](image)

17. The visualization bars appears right beside each revenue record as in Figure 6-49.

![Figure 6-49 Visualization Bars for Revenue](image)
18. Do the same thing for the **Gross_Profit** field to show the visualization bars. See Figure 6-50 for a sample Active Report with visualization bars.

![Figure 6-50 Visualization Bars for Revenue and Gross_Profit](image)

Notice that in this case, all the visualization bars are blue colored. It is because all values of Revenue and Gross_Profit are positive. Can you find the negative value?

19. Save the report, and close the Info Assist page.

20. Next, go to the DB2 Web Query page and run the “3g - Active Report Revenue and Profit Report” report.

21. Publish the report. You can do it before you go through all Active Reports functions, or after you finish learning about the other Active Reports functions.

   Go to the last part of 6.1, “Table of Contents” on page 114 to learn how to publish a report.

22. Go through some Active Reports functions as described in the following sections.

### 6.7.1 Sorting

Active Reports has sorting features where you can sort the report based on certain fields. You can also sort the report in ascending or descending order. The first time you run the report, it is sorted ascending based on **Product Type**. Try to change the report by sorting it based on other fields.

**Sort Ascending based on Product Category**

Click the drop-down menu in the right side of **Product Category** and select **Sort Ascending**. See Figure 6-51.

![Figure 6-51 Sort Ascending based on Product Category menu](image)
The report is now sorted based on Product Category in ascending order. See Figure 6-52 for reference.

![3g - Active Report Revenue and Profit Report](image)

**Figure 6-52  Report Result Sort Ascending based on Product Category**

**Sorting as descending based on revenue**

Click the drop-down menu in the right side of Revenue and select Sort Descending as in Figure 6-53.

![Figure 6-53  Sort Descending based on Revenue menu](image)
The report is now sorted based on Revenue in descending way. Notice the red box in Figure 6-54.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Product Category</th>
<th>Product Name</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorders</td>
<td>DVD Camcorders</td>
<td>DVD EasyCam Camcorder - 3CCD</td>
<td>$191,386,259.00</td>
<td>$47,774,759</td>
</tr>
<tr>
<td>Video</td>
<td>DVD</td>
<td>13 Inch Portable DVD Video System</td>
<td>$167,003,590.00</td>
<td>$33,311,590</td>
</tr>
<tr>
<td>Cameras</td>
<td>Digital Cameras</td>
<td>EasyShot Digital Camera 6.1 Megapixel</td>
<td>$90,904,593.00</td>
<td>$24,936,093</td>
</tr>
<tr>
<td>Video</td>
<td>TV</td>
<td>50 Inch HD A/V Wireless Plasma TV</td>
<td>$83,071,227.00</td>
<td>$6,211,127</td>
</tr>
<tr>
<td>Audio</td>
<td>Audio Systems</td>
<td>Home Theater 5.1 System</td>
<td>$75,674,144.00</td>
<td>$26,461,344</td>
</tr>
<tr>
<td>Camcorders</td>
<td>DVD Camcorders</td>
<td>DVD EasyCam Camcorder - 3CCD Pro</td>
<td>$68,640,943.00</td>
<td>$14,998,443</td>
</tr>
<tr>
<td>Camcorders</td>
<td>DVD Camcorders</td>
<td>DVD EasyCam Camcorder 14x Power Zoom</td>
<td>$52,771,581.00</td>
<td>$5,718,731</td>
</tr>
<tr>
<td>Video</td>
<td>DVD</td>
<td>15 Inch Portable DVD Video System</td>
<td>$52,221,876.00</td>
<td>$13,035,876</td>
</tr>
<tr>
<td>Video</td>
<td>DVD</td>
<td>DVD Recorder</td>
<td>$50,355,606.00</td>
<td>$16,161,306</td>
</tr>
<tr>
<td>Video</td>
<td>DVD</td>
<td>DVD Changer / Player</td>
<td>$43,316,273.00</td>
<td>$14,414,673</td>
</tr>
<tr>
<td>Audio</td>
<td>Speakers</td>
<td>6-Piece Home Theater Speaker System</td>
<td>$40,863,984.00</td>
<td>$29,596,224</td>
</tr>
<tr>
<td>Cameras</td>
<td>Digital Cameras</td>
<td>EasyShot Digital Camera 8 Megapixel</td>
<td>$38,613,846.00</td>
<td>$12,842,648</td>
</tr>
</tbody>
</table>

Figure 6-54  Report Result Sort Descending based on Revenue

6.7.2 Filtering

The report you use in this section is the Revenue and Profit report for all products that are owned by Century Electronics. Sometimes, you or the executives do not want to see the whole report. Maybe you just want to see the Audio and Video revenue report, since you are working in that division.

Active Reports has a Filter function where you can filter the report so you can read only the parts you want to read.

Filtering to show Audio and Video revenue report only

Now you learn how to use the Filter function, where the report only shows the Audio and Video revenue report.

First, click the Product Type drop-down menu and select Filter → Equals as in Figure 6-55. Notice that under the Filter menu, there are many conditions you can choose. Equals is just one example of a condition.
Next you find the Filter Selection menu. On the right-most field, select **Audio** and **Video**. After you finish filling in the Filter Selection based on your requirement, click **Filter** as in Figure 6-56. Notice that now your report only contains the Audio and Video Revenue and Profit report. You can minimize the Filter Selection menu by clicking the (-) sign, since clicking the (x) sign means to close the Filter Selection menu and clear up all the filters.

![Filter Selection menu to choose Audio and Video](image)

**6.7.3 Charting**

In many situations, pictures are sometimes more descriptive than text or numbers. Active Reports has a Charting function where it can create several types of charts based on the report you have made. In this example, you learn how to create some types of Gross Profit charts based on the Product Type.

The first chart you make is Gross Profit Pie chart based on Product Type.

Click the **Gross Profit** drop-down menu. Select **Chart → Pie → Product Type** as in Figure 6-57.

![Create Gross Profit Pie Chart menu](image)
After you select the menu, a new window showing the pie chart result appears as in Figure 6-58.

Notice that the Pie Chart colors are almost the same and you probably cannot tell which part of the pie chart belongs to which Product Type. You can put the cursor on top of the pie chart and see further information provided. In the example shown in Figure 6-58, the cursor is placed on top of the Video section.

In the chart window, you can also change the type of chart. Suppose that you want to change the chart type from a pie chart to a bar chart. Just click the bar icon on the top left side of the chart window and the chart will automatically change from pie to bar chart as in Figure 6-59.
6.7.4 Calculate: % of total

When executives read reports, they often want to know the total revenue and gross profit, which product has the highest revenue or gross profit, or what is the average revenue and gross profit.

You do not have to modify the report by adding those functions (since probably at this point, you already know how to add those functions). Active Reports has a Calculate function that can help you to deal with some calculating functions without changing the report resource.

In this section, you learn how to use the Calculate function, specifically the % of Total function. Using this function, you can know what is the percentage of revenue or gross profit of each product name.

To do this, click the drop-down menu of Revenue and select Calculate → % of Total. Refer to Figure 6-60 for the menu selection.

After you click the menu, a new field appears right next to the Revenue field showing the percentage of each Revenue value compared to total Revenue as in Figure 6-61.

You can try to create the % of Total to Gross Profit.
6.7.5 Rollup

Another Active Reports function you can learn is the Rollup function, which can summarize the total revenue and gross profit based on Product Type/Product Category/Product Name.

In this sample, you learn how to create a rollup for Gross Profit based on Product Type.

As usual, to do this, click the Gross Profit drop-down menu and select **Rollup → Product Type** as in Figure 6-62.

![Figure 6-62 Rollup menu](image)

After you click the menu, a new window appears showing the summary of gross profit based on Product Type. You can see the report sample in Figure 6-63.

![Figure 6-63 Gross Profit based on Product Type Rollup result](image)

6.7.6 Rollup result converted to chart

You can change the Rollup result, which is numeric, to a chart. To do this, use the Rollup you have created in 6.7.5, “Rollup” on page 145. Notice in Figure 6-63 that there are many chart icons at the top of the Rollup result. Click the **Pie chart** icon.
6.7.7 Chart Tool

You have learned how to create a report chart using the Chart menu. But Active Reports actually also come with another function, the Chart Tool. In the Chart Tool, you have more flexibility to create the chart.

Using the usual Chart menu, you cannot create a Revenue and Gross Profit chart that is placed in the same chart, but you can do this using the Chart Tool.

To use the Chart Tool, click any field’s drop-down menu and select **Chart/Rollup Tool**. See Figure 6-65.

After clicking the Chart/Rollup Tool Option, a Chart/Rollup Tool window is displayed where you should configure the chart you want to create.
For example, suppose you want to create a Revenue and Gross Profit chart based on Product Type. So, in the Chart/Rollup Tool window, drag **Product Type** to the Group By box, and drag **Revenue** and **Gross_Profit** to Measure as in Figure 6-66.

![Figure 6-66 Fill in Group By and Measure](image)

After you fill in the **Group By** and **Measure**, click the **Charts** button to select the type of the charts. In this example, we use **Column Depth Chart** (see Figure 6-67). Click **OK** after you finish selecting the chart type.

![Figure 6-67 Chart Type options](image)
You can see the chart result as shown in Figure 6-68.

![Column Depth Chart result using Chart/Rollup tool](image)

*Figure 6-68  Column Depth Chart result using Chart/Rollup tool*

Now try to change the Column Depth Bar chart to a Line chart by clicking the Line icon. Notice the location of Line icon in Figure 6-68.

![Line Chart result using Chart/Rollup tool](image)

*Figure 6-69  Line Chart result using Chart/Rollup tool*
6.7.8 Exporting a chart to Excel

Additionally, with Active Report, you can export the chart that you have to Excel format. For example, suppose you want to export all records in the report to Excel format.

To do this, click the drop-down menu of any field, then select Export → XML (Excel) → All Records as in Figure 6-70.

![Figure 6-70 Menu to Export Report to Excel format](image)

After you click the All Records menu, an ActiveX pop-up window displays, asking to allow interaction. Click Yes. See Figure 6-71 to see the ActiveX pop-up window.

To learn further about ActiveX, you can refer to 6.7.11, “Notes for Active Reports” on page 154.

![Figure 6-71 ActiveX pop-up window](image)

Next, you can find that the Microsoft Excel application is automatically opened, and it shows your report in Excel format. In Figure 6-72, you can see the sample Excel file result.
6.7.9 Pivot Tool

For typical data entry, the data usually appears in flat tables that consist only of columns and rows. The table in this sample Active Report is an example of a flat table. The benefit of using a Pivot table is that it can help quickly summarize the data and highlight the desired information.

Active Reports also has a Pivot Tool function to help you create the Pivot table. But the Active Report you have right now is not enough to create a nice Pivot table. Therefore you need to do some small changes in the Active Report.

Open the report in Info Assist, and add a **Country** field as primary Sort-By field in the report. **Save**, then **run** the report. You will see the report as shown in Figure 6-73.
And now you are ready to use the Pivot Tool. The purpose of making a Pivot table in this tutorial is to get information about the total gross profit for each Product Type in each country.

First, click the drill down menu in any field, and select **Pivot Tool** as in Figure 6-74.

![Select Pivot tool](image)

After you select the Pivot Tool menu, a pop-up window appears where you can configure the Pivot table. Drag and drop these columns:

- **Country** to Group By
- **Product Type** to Across
- **Gross Profit** to Measure

See Figure 6-75 for reference.

![Configure the Pivot table](image)
Click **OK** after you finish doing the configuration. You can see the sample result as shown in Figure 6-76.

![Figure 6-76   Pivot Table Sample result](image)

### 6.7.10 Adding comments

Sometimes, in your report, you need to add notes or comments in certain columns. For example, in the Revenue report, there are some revenue values that still need to be re-validated since not all stores have sent the reports to you. Active Reports enable you to add comments specific in each field of your report.

To add a comment, follow these steps:

1. Right-click the field where you want to add some comments in it. In this example, you add comments to the first Revenue result. Choose **Comments** (Figure 6-77).

![Figure 6-77   Add Comments menu](image)
2. A new window pops up. In this window you can type the comments you want to write. Click **Add Comment** after you finish typing the comment. See Figure 6-78.

![Figure 6-78 Comment field](image)

3. Notice that in the field where you add the comment in it, there is an asterisk sign in the field. See Figure 6-79.

![Figure 6-79 Asterisk sign](image)

4. You can actually show the comment in the report instead of just showing the asterisk sign. To do this, click the drop-down menu and select **Comments → Expand**. See Figure 6-80.

![Figure 6-80 Expand Comment menu](image)

5. You can see the result as in Figure 6-81.

![Figure 6-81 Revenue comment](image)
6.7.11 Notes for Active Reports

There are several things you need to know when running Active Reports. Active Reports use ActiveX controls. Based on your browser security settings, you might see warning messages, and you might be asked whether you want to allow blocked content.

So, first of all, you must be using a browser that supports ActiveX technology. This means that only Internet Explorer can be used if you want to save your Active Reports to your hard drive. Other supported browsers have no native ActiveX technology capability.

Second, you must make sure that your Internet Explorer browser settings are configured to enable ActiveX for Internet Explorer. To set this up correctly, proceed as follows:

1. In the browser, from the menu bar, select **Tools → Internet Options**.
2. In the Internet Options window, click the **Security** tab.
3. On the **Security** tab window, click **Custom Level**.
4. In the Security Settings window, scroll through the menu and select the Enable radio button for the following menu choices:
   - Run ActiveX Controls and Plug-ins
   - Script ActiveX Controls Marked Safe for Scripting
   - Initialize and Script ActiveX Controls not Marked as Safe for Scripting
5. Click **OK** to exit and save.
6. Click **OK** again to exit the Internet Options window.
7. Close and re-open the browser.

ActiveX is now enabled and you can save your Active Reports.

6.8 Active Flash

You can also change your report from an Active Report to Active Flash format. The difference is, Active Report is a web based report, while Active Flash is a Flash based report.

Follow these steps to change your report to become an Active Flash report:

1. First, copy and paste **3g - Active Report Revenue and Profit Report** to the same folder (**Assignment 03** folder).
2. A new window pops up informing you that the item already exists, as in Figure 6-82. This message displays because you pasted the report in the same folder. Choose **Create New**.

![Figure 6-82 Message appears when duplicating the report](image)
3. Rename the report to avoid confusion with the original Active Report you have made before. Change it to 3h - Active Flash Revenue and Profit Report.

4. Open 3h - Active Flash Revenue and Profit Report in Info Assist.

5. Click the Format menu bar, and in the Output Types menu ribbon, select Active Flash.

6. Save the report.

7. Go to the DB2 Web Query page and run the report. Notice that it is almost the same as Active Report. It has the same drop-down menu as Active Report, but there are several sub-menus that do not exist in the Active Flash Report (for example: Comments menu).

8. Publish the report. Go to last part of 6.1, “Table of Contents” on page 114 to learn how to publish the report.

9. Try to go through the functions you have learned in 6.7, "Active Reports" on page 132.
Chapter 7. Assignment #4: Charting

This chapter describes how to create charts using the Info Assist tool.

Info Assist provides a wide variety of graph types and graphing functionality to allow users to choose how to present their data in the best possible format. The available graph types range from a variety of bar and line charts to histograms and area charts, stock charts, gauges for key performance indicators, and much more. You can find additional details about the graphing facility in the help text.

In this chapter, we continue with the same Century database used in the previous tutorials. And we plan to import the charts we create in this chapter, to a dashboard that we will create in Chapter 11, “Assignment #8: Building documents and dashboards” on page 301.

In this chapter, we complete the following tasks:
- Create a simple chart that contains multiple pie charts, revenue, and gross profit by Product Type.
- Create a bar chart that shows On Time Delivery (OTD) by Product Type
- Create a vertical stacked area chart that shows Orders Backlog by Period
- Create a gauge chart that shows On Time Delivery (OTD) overall

Prerequisite: To do the tasks in this chapter, you need to have a Metadata for ORDERS table and decompose the ORDERDATE field. If you have not yet created and decomposed it, go to Chapter 3, “Creating and editing metadata: Century database” on page 33.
7.1 The assignment

In today’s environment, end users need more than just reports; they also need graphs and charts to visually represent complex data and make it easier to comprehend and identify trends, problems, and areas of strength within a company. Century Electronics users are no different. So, for this assignment, Dan would like for you to create a series of charts to allow users to easily comprehend and analyze the data.

7.2 Pie chart: Revenue and Gross Profit by Product Type

For the first exercise of this assignment, Dan would like pie charts that show both revenue and gross profit by product type. The end result will be charts like the ones shown in Figure 7-1.

Follow these steps to create the chart:

1. In the Reporting area, create a folder “Assignment 04 - Charting”. In this tutorial, the folder is created under the Century Electronics folder. To create a new folder, right-click the Century Electronics folder, and select New → Folder.

2. Right-click the Assignment 04 - Charting folder.
3. Select **New → Chart** as shown in Figure 7-2. This will open Info Assist.

![Figure 7-2 Menu to Open or create chart](image1)

4. Select the **CEN_ORDERS** synonym as shown in Figure 7-3.

![Figure 7-3 Data Source Selection menu](image2)

5. Click **OK**.

After you choose the CEN_ORDERS table, you see the list of all fields on the Data panel at the left side. Notice that in the Data panel, synonyms are divided into two groups: Dimensions and Measures/Properties.
6. Select **Format** tab → **Chart Types** Group → **Pie** chart as shown in Figure 7-4.

![Figure 7-4 Selecting Pie chart](image)

7. Drag and drop **Product Type** to **Slices** as shown in Figure 7-5.

![Figure 7-5 Moving Product Type from Data panel to Query panel](image)

8. Next, Drag **Revenue** and **Gross Profit** from Data panel to Measure(Sum) in Query panel as in Figure 7-6.

![Figure 7-6 Moving Revenue and Gross Profit from Data panel to Query panel](image)
9. Select the **Features** icon as shown in Figure 7-7.

![Figure 7-7 Selecting Features icon](image)

10. Select the **3D Effect** icon as shown in Figure 7-8.

![Figure 7-8 Selecting 3D effect icon](image)

11. Select **Run** and check the result as shown in Figure 7-1 on page 158.

12. **Save** your report as **4a - Pie Chart : Revenue & Gross Profit by Product Type**.

13. If you already feel confident and comfortable with the report, publish the report. To publish the report, go to the DB2 Web Query page and expand the **Assignment 04** folder. Right-click **4a - Pie Chart : Revenue & Gross Profit by Product Type** report and select **Publish** as shown in Figure 7-9.

![Figure 7-9 Publish the report](image)

Notice that soon after you publish the report, the font in the menu will change to **bold**, so you can differentiate which report is already published or is not yet published.

---

**Note**: To do the tasks in this chapter, you need to have the Define field for **Gross Profit**. If the **Gross Profit** field is not created, go to 4.5, “Creating Define fields and Compute fields in the synonym” on page 84 and create it.
7.3 Bar chart: OTD by Product Type

For the second exercise of this assignment, Dan would like a bar chart that shows On Time Delivery (OTD) measures. OTD analysis is broken down into the following three categories:

- Early: Actual ship date was 10 days or more before the requested ship date.
- On time: Actual ship date was within 10 days of (before or after) the requested ship date.
- Late: Actual ship date was 10 days or more after the requested ship date.

For each Product Type, he would like to see the percentage break down for each of these three categories. Century’s goal is to achieve 85 percent on time delivery.

An example of this chart is shown in Figure 7-10.

![Figure 7-10 Final Result of Bar Chart: OTD by Product Type](image)

This kind of analysis is an ideal opportunity to leverage the power of SQL views. The following view is provided for you in the QWQCEN'T schema. For each Product Type, it shows both the counts and the percentages of each of the three categories, as well as the company’s goal of 85 percent on time delivery:

```sql
CREATE VIEW QWQCENT.OTDBYPRODUCT (  
  PRODUCTTYPE FOR COLUMN PRODTYPE   ,  
  "ALL" ,  
  ONTIMECOUNT FOR COLUMN ONTIM00001 ,  
  EARLYCOUNT ,  
  LATECOUNT ,  
  ONTIME ,  
  EARLY ,  
  LATE ,  
  GOAL ) 
AS  
WITH A AS  
(SELECT PRODUCTTYPE, SHIPDATE, REQUESTEDSHIPDATE,  
DEC((DAYS(SHIPDATE) - DAYS(REQUESTEDSHIPDATE)),9,2) AS OTD  
FROM QWQCENT.ORDERS O, QWQCENT.INVENTORY I  
WHERE O.PRODUCTNUMBER=I.PRODUCTNUMBER),  
B AS  
(SELECT  
CASE WHEN OTD <-10 THEN 'early'  
WHEN OTD BETWEEN -10 AND +10 THEN 'on-time' ELSE 'late' END AS OTDSTATUS,  
PRODUCTTYPE, SHIPDATE, REQUESTEDSHIPDATE, OTD FROM A)  

```

IBM DB2 Web Query for i Version 2.1: Implementation Guide
SELECT PRODUCTTYPE, COUNT(*) AS ALL,
SUM(CASE WHEN OTDSTATUS='on-time' THEN 1 ELSE 0 END) AS ONTIMECOUNT,
SUM(CASE WHEN OTDSTATUS='early' THEN 1 ELSE 0 END) AS EARLYCOUNT,
SUM(CASE WHEN OTDSTATUS='late' THEN 1 ELSE 0 END) AS LATECOUNT,
DEC(SUM(CASE WHEN OTDSTATUS='on-time' THEN 1 ELSE 0 END)*100.00/COUNT(*), 5,2) AS ONTIME,
DEC(SUM(CASE WHEN OTDSTATUS='early' THEN 1 ELSE 0 END)*100.00/COUNT(*), 5,2) AS EARLY,
DEC(SUM(CASE WHEN OTDSTATUS='late' THEN 1 ELSE 0 END)*100.00/COUNT(*), 5,2) AS LATE,
85 AS GOAL FROM B GROUP BY PRODUCTTYPE

Attention: In this exercise, you create synonyms over the OTDBYPRODUCT and ORDERHORIZON views. If you have not learned how to create synonyms, go to 3.1, “Creating metadata using the metadata creation wizard” on page 34.

Follow these steps to create the synonyms:

1. Right-click the Assignment 04 - Charting folder and select Metadata → New.
2. In the new pane, on the left-hand side in the Steps section, select Synonym Or Samples, and select DB2 CLI → "LOCAL", and click Create Synonym bottom.
3. In the Select Synonym Candidates for DB2 pane (Figure 7-11), select Views and enter QWQCENT in the library field, then click Next.

Figure 7-11  Create metadata
4. The Create Synonym for DB2 CLI pane is displayed (Figure 7-12) and shows all the different tables that reside on the QWQCENT schema. In this panel, set CEN_ in the prefix field, then select tables OTDBYPRODUCT and ORDERHORIZON.

5. Click Create synonym.

![Create Synonym for DB2 CLI pane](image)

**Figure 7-12   Create metadata - Step 4**

The metadata takes a few seconds to create, depending on how many items you selected. After the processing is done, in the Status column, you see the message Created successfully. The process of creating metadata is now complete.

6. Close the message box.

In the following steps we create the chart.

7. Right-click the Assignment 04 - Charting folder.

8. Select New → Chart as shown in Figure 7-13. This will open Info Assist.

![Menu to Open or Create Chart](image)

**Figure 7-13   Menu to Open or Create Chart**
9. Select **CEN_OTDBYPRODUCT** synonym as shown in Figure 7-14.

![Figure 7-14: Data Source Selection menu](image1)

10. Click **OK**.

11. Select **Format** tab → **Chart Types** group → **Other** icon as shown in Figure 7-15.

![Figure 7-15: Selecting Other chart](image2)
12. Select **Horizontal Percent Bars** chart as shown in Figure 7-16.

![Selecting Horizontal Percent Bars](image)

*Figure 7-16  Selecting Horizontal Percent Bars*
13. Drag and drop **Product Type** to the X Axis. Then drag and drop **EARLY, ONTIME, and LATE** to the Data panel to Measure (Sum) in the Query panel as in Figure 7-17.

*Figure 7-17  Moving fields from Data panel to Query panel*
14. Right-click any of the **EARLY** bars (blue colored bars), and select **Series Color** as shown in Figure 7-18.

![Interactive Design View](image)

Figure 7-18   Selecting Series Color

15. Select **yellow** as in Figure 7-19.

![Color](image)

Figure 7-19   Selecting Color
16. Follow the same steps, to change the color of ONTIME and LATE as in Figure 7-20.

![Bar chart of product type](image)

17. Select Run and check the result as in Figure 7-10 on page 162.

18. Save your report as 4b - Bar Chart: OTD by Product Type.

19. Publish the chart. Go back to the last part of 7.2, "Pie chart: Revenue and Gross Profit by Product Type" on page 158 to learn how to publish a report.
7.4 Vertical Stacked Area: Orders Backlog by Period

Next, Dan would like for you to create a chart that shows orders backlog by period for each product type. In his opinion, a vertical stacked area chart would be the best way to present this kind of information. In this exercise, you will create the chart shown in Figure 7-21.

Similar to the previous exercise, an SQL view is a great way to break this information down in preparation for the chart. The following SQL view is provided for you in the QWQCENT library:

```sql
CREATE VIEW QWQCENT.ORDERHORIZON (PLANTCODE FOR COLUMN PLANT_CODE, PRODUCTTYPE FOR COLUMN PRODTYPE, SORTPERIOD, PERIOD, PERQTY, PERDOLLARS) AS
WITH A AS
(SELECT PLANTCODE, PRODUCTTYPE,
CASE
WHEN ORDERDATE < CURRENT DATE THEN '1'
WHEN ORDERDATE > CURRENT DATE + 6 MONTHS THEN '3'
ELSE '2'
END AS SORTPERIOD,
CASE
WHEN ORDERDATE < CURRENT DATE THEN 'Past'
WHEN ORDERDATE > CURRENT DATE + 6 MONTHS THEN 'Future'
ELSE YEAR(ORDERDATE) || '-' || SUBSTR(DIGITS(MONTH(ORDERDATE)),9,2) END AS PERIOD,
QUANTITY, LINETOTAL
FROM QWQCENT.ORDERS O, QWQCENT.INVENTORY I
WHERE O.PRODUCTNUMBER=I.PRODUCTNUMBER )
SELECT PLANTCODE, PRODUCTTYPE, SORTPERIOD, PERIOD, SUM(QUANTITY) AS PERQTY,
SUM(LINETOTAL) AS PERDOLLARS
FROM A
GROUP BY PLANTCODE, PRODUCTTYPE, SORTPERIOD, PERIOD
```

Figure 7-21 Final result of Vertical Stacked Area: Orders Backlog by Period
Follow these steps to create the chart:

1. Right-click the **Assignment 04 - Charting** folder.
2. Select **New → Chart**. This will open Info Assist as in Figure 7-22.

![Figure 7-22 Menu to open or create chart](image)

3. Select **CEN_ORDERHORIZON** synonym as in Figure 7-23.

![Figure 7-23 Data Source Selection menu](image)

4. Click **OK**.
5. Select **Format** tab → **Chart Types** group → **Other** chart as in Figure 7-24.

![Figure 7-24 Selecting Other chart](image)

6. Select **Area** tab and **Vertical Stacked Area** chart as in Figure 7-25.

![Figure 7-25 Selecting Vertical Stacked Area](image)

7. Select the **Data** tab and **Detail (Define)** icon. A new menu pops up, as in Figure 7-26.

![Figure 7-26 Selecting Detail (Define)](image)
8. Type Field name as **PlotPeriod** as in Figure 7-27.
9. Type **A20** in the format field as in Figure 7-27.
10. In the Detail Field, create the PlotPeriod formula by double-clicking **SORTPERIOD**, input **"-"**, then double-click **PERIOD**. The filled result is shown in Figure 7-27.

![Figure 7-27 Define field for PlotPeriod](image)

11. Click **OK**.

If you see the Interactive Design View, nothing is changed in the view. Check the Data panel under Measures/Properties. You find a new field named **PlotPeriod**.

12. Drag and drop **Product Type** to Legend (Series).
13. Drag and drop **PlotPeriod** to X Axis.
14. Drag **PERDOLLARS** to Data panel to Measure (Sum) in the Query panel as in Figure 7-28.
15. Right-click **X Axis**, select **rotate**, then select 45 as in Figure 7-29.

![Figure 7-29 Selecting Rotate](image)

**Attention:** This is a date sensitive chart because you are using the CURRENT DATE register in the SQL view. If the chart does not show any data, it is probably because the date columns in the ORDERS table have values that do not contain the current year. For information on how to update your tables with more current dates, see “The QWQCENT library” on page 6.

16. Right-click **PlotPeriod** and select **Change title** as in Figure 7-30.

![Figure 7-30 Selecting Change title](image)
17. Edit title from **PlotPeriod** to **Period** as in Figure 7-31.

![Figure 7-31  Editing Title](image)

18. Right-click **PERDOLLARS** and select **Change title** as in Figure 7-32.

![Figure 7-32  Selecting Change Title](image)

19. Edit title from **PERDOLLARS** to **DOLLARS** as in Figure 7-33.

![Figure 7-33  Editing Title](image)

20. Select **Run** and check the result as in Figure 7-21 on page 170.

21. **Save** your report as **4c - Vertical Stacked Area : Orders Backlog by Period**.

22. **Publish** the chart. Go back to the last part of 7.2, “Pie chart: Revenue and Gross Profit by Product Type” on page 158 to learn how to publish a report.
7.5 Gauge chart: OTD overall

For the last chart in this assignment, Dan requested a chart that shows the overall company-wide OTD percentage. Century Electronics uses the following categories to measure and analyze performance in this area:

- Poor: Less than 60%
- Average: From 60% to 79%
- Good: Greater than or equal to 80%

As stated earlier, Century’s goal in this area is 85% on-time delivery.

A gauge chart is a popular and efficient way to present a single measure along with various bands to represent poor, average, and good performance. A red band is typically used to show the poor range, yellow to represent the average range, and green to display the good range. You can even identify a goal and show that as a band in the gauge as well.

In this exercise, you create a gauge chart, OTD overall. An example is shown in Figure 7-34.

![Figure 7-34 Final Result of Gauge Chart: OTD overall](image)

**Prerequisite:** To complete this exercise, you need a synonym for the `OTDBYPRODUCT` view. If you have not created it, go to 7.3, "Bar chart: OTD by Product Type" on page 162.
Follow these steps to create the chart:

1. Right-click the **Assignment 04 - Charting** folder.
2. Select **New → Chart**. This will open Info Assist as in Figure 7-35.

![Figure 7-35 Menu to open or create chart](image1)

3. Select **CEN_OTDBYPRODUCT** synonym as in Figure 7-36.

![Figure 7-36 Data Source Selection menu](image2)

4. Click **OK**.
5. Select **Format** tab → **Chart Type** group → **Other** icon as in Figure 7-37.

![Selecting Other chart](image)

*Figure 7-37  Selecting Other chart*

6. Select **Special** tab and **Gauge** chart as in Figure 7-38.

![Selecting Gauge chart](image)

*Figure 7-38  Selecting Gauge chart*
7. Drag and drop **ONTIME** to Measure (Sum) as in Figure 7-39.

8. Right-click **ONTIME** on the Query Panel, select **More**, select **Aggregation Functions**, then select **Average** as in Figure 7-40.
9. Right-click **AVE.ONTIME** and select **Change title** as in Figure 7-41.

![Figure 7-41  Selecting Change title]

10. Edit title from **AVE.ONTIME** to **OTD Actual** as in Figure 7-42.

![Figure 7-42  Editing title]

Next, we set Gauge Options.

11. Right-click the chart on the Interactive Design View, and select **More Gauge Options** as in Figure 7-43. A new menu pops up.

![Figure 7-43  Selecting More Gauge Options]
12. Select the **Bands** tab as in Figure 7-44.

![Figure 7-44  Selecting Bands tab](image)

13. Edit Minimum Value to **1.0**, Maximum Value to **59.0** as in Figure 7-45.

![Figure 7-45  Band setting (Band 1)](image)
14. Select **Band 2** on Band list box as in Figure 7-46.

![Figure 7-46 Selecting Band list box](image)

15. Edit Minimum Value to **60.0**, Maximum Value to **79.0**. Click **Border Color** bottom and select **yellow**. Next select **Color** bottom on the fill area and select **yellow**, as in Figure 7-47.

![Figure 7-47 Bands setting (Band 2)](image)
16. Select **Band 3** on the Band list box.

17. Follow the same steps, to change **Minimum and Maximum Value, Border Color, Fill Color** as in Figure 7-48.

![Figure 7-48 Bands setting (Band 3)](image)

18. Select **Band 4** on Band list box.

19. Follow the same steps, to change **Minimum and Maximum Value, Border Color, Fill Color** as in Figure 7-49.

![Figure 7-49 Bands setting (Band 4)](image)

20. Select **Band 5** on Band list box.
21. Follow the same steps, to change **Minimum and Maximum Value, Border Color, Fill Color** as in Figure 7-50.

![Figure 7-50  Bands setting (Band 5)](image)

22. Click **General Options** tab, change **Color** and **Border Color** on the Gauge Needle as in Figure 7-51.

![Figure 7-51  Changing Gauge Needle Color](image)

23. Select **Below** on the Gauge title position as in Figure 7-52.

![Figure 7-52  Selecting Gauge Title position](image)
24. Click **Axis Scale & Labels** tab, and change Minimum values as shown Figure 7-53.

![Figure 7-53  Axis Scale and Labels](image)

25. Check the result as in Figure 7-54.

![Figure 7-54  Interactive Design View](image)

26. Select **Run** and check the result as in Figure 7-34 on page 177.

27. **Save** your report as **4d - Gauge Chart: OTD overall**.

28. **Publish** the chart. Go back to the last part of 7.2, “Pie chart: Revenue and Gross Profit by Product Type” on page 158 to learn how to publish a report.
Assignment #5: Adding filters to reports and charts

A DB2 Web Query filter is a feature that allows you to generate WHERE clauses in your reports. This enables you to include the data you want, and to exclude the data you do not want to appear in the report. In this chapter, you will learn how to do the following tasks:

- Set up simple filters
- Set up advanced filters
- Use filters previously created in metadata
- Use the InfoMini option to set up slicers to allow end users to filter rows at runtime

Prerequisites: Before starting this chapter, make sure that the following steps have already been completed:
- Chapter 3, “Creating and editing metadata: Century database” on page 33
8.1 Simple filters: Revenue Simple Filter report

The first report in this assignment is a simple filter. Dan has requested a report to summarize revenue by product type and product category. Each user will be able to select the countries and product types for which they want data, so you will set two simple filters, both of which allow users to select multiple values. We want to produce a report like that shown in Figure 8-1.

![Simple filters report](image-url)

*Figure 8-1  Simple filters report*
For this assignment, we will be creating a new sub-folder within our Century Electronics main folder, named "Assignment 05 - Adding filters to report":

1. In the DB2 Web Query home page, right-click the Century Electronics folder and select **New → Folder** as shown in Figure 8-2.

![Create folder](image)

*Figure 8-2   Create folder*

2. In the New Folder pane, specify the name for this new folder, "Assignment 05 - Adding filters to Report" as shown below.

![Specify Folder Title](image)

*Figure 8-3   Specify Folder Title*
3. Open the folder Century Electronics and right-click Assignment 05 - Adding filters to Report. Select New → Report as shown in Figure 8-4.

Figure 8-4  Create a new report
4. Info Assist opens up; select synonym **CEN_ORDERS** as your data source and click **OK** (Figure 8-5).

![Select a data source](image)

**Figure 8-5  Select data source**
5. Create a simple report dragging PRODUCTTYPE, COUNTRY, and REVENUE in the “Interactive design view” or in the “Query” pane to obtain the result shown in Figure 8-6.

6. Your end users may appreciate getting totals both on a country and a product type basis, so we enable the corresponding functionalities. In the Home ribbon, select Column Totals and Row Totals as shown in Figure 8-8, item #1. If these items do not appear in your Home ribbon, you can enable them; click the “Report” icon highlighted in Figure 8-7.
Figure 8-8  Basic report - add totals
7. We now want to give our report a title. To do so, select the “Header and Footer” symbol, highlighted in Figure 8-8 on page 193, item #2. In the Header and footer pane, type the title for this report as shown in Figure 8-9. Here we use “Revenue by Country and Product Type”, then increase the font size (1), align it to the left (2), and change its color to blue (3).

![Figure 8-9 Insert report title](image)

8. Switch the panel to “report footer” (see Figure 8-10 #1) and type in text; here we use “Data on &DATEDMYY at &TOD,” align text to the left (#2) and change color to blue (#3). When you are done, click OK.

Note: Here we use two variables:
- &DATE to get the current system date when this report gets executed, formatted as DMYY
- &TOD to get the current time of day when this report gets executed

See Table A-1 on page 790 for more details on date and time system variables.
9. Save your report as “5a - Revenue by Country and Product”

10. We are now ready to insert a filter (that is, a WHERE clause) on COUNTRY. To do this, right-click the COUNTRY field and select Filter, as shown in Figure 8-11.

Figure 8-10   Insert report footer

Figure 8-11   Add filter on COUNTRY
11. The filter panel opens up (Figure 8-12). Here you can set the comparison operator (EQUAL in our example; see item #1), and the kind of prompt that you want to give to end users at runtime. Select **Prompt using Data Values (Dynamic)**; see item #2. There are four different prompt options:

- **No Value Prompt**: This sets the choices in advance, hard-coding a prefilled static WHERE clause in the report. The end user is not presented with a prompt.

- **Prompt using Data Values (Dynamic)**: This creates a prompt filled with data values retrieved dynamically from data source at runtime. The runtime user makes choices on a dynamic list. If new lines are inserted in the underlying table with more choices, the prompt is always updated to present ALL values available in the database.

- **Prompt using Selection (Static)**: A list of possible choices is built up within the report at development time, the end user is presented with this static list at runtime so if new values are inserted in the database these values will never be part of the possible choices.

- **Prompt using Text Input (Simple)**: At runtime, the end user is presented with a blank field in which to type in the desired choice. This setting can lead to errors and a waste of computing power (“Canada” is not the same as “CANADA” nor “canada” in the database).

![Filter for COUNTRY](image)

**Figure 8-12 Simple filter**

12. The filter pane gets updated to reflect your choice for a dynamic prompt. In Figure 8-13, you can see that it is already connected to the field on which the WHERE condition has been set (see VARIABLE #1), **COUNTRY** in our case, and it is possible to change the text that is presented at runtime (see PROMPT #2), here we use **Country**. Select the “**Allow Multiple Values for Prompt**” to make sure that more than one item can be selected. When you are done, click **OK**.
13. Repeat the process for field **PRODUCTTYPE**. The Info Assist development environment should look like Figure 8-14, with both COUNTRY and PRODUCTTYPE in the filter pane.
14. Save your report with the name “5b - Revenue Simple Filter”.

15. When running your report, you are presented with two prompts where you have to select the COUNTRY and PRODUCTTYPE values for which you want to run the report, as shown in Figure 8-15. Hold the Ctrl key to select multiple values and select RUN.

![Parameters](Image)

**Figure 8-15  Simple filter, Prompt at runtime**

8.2 Advanced filters: Revenue Advanced Filter report

For the next report in this assignment, Dan would like a simple report to summarize revenue by product type and product category. Each user will be able to select the countries and product types for which they want data, so we will set a simple filter with multiple choices.

We want to obtain a report like the one shown in Figure 8-16. In this report, we want all revenue information regarding just one or more product types, for the selected country for all years and for just the selected year for all countries. The corresponding SQL WHERE clause would be “WHERE (T2."PRODUCTTYPE" = ‘Audio’) AND ((YEAR(T1."ORDERDATE") = 2011) OR (T3."COUNTRY" = ‘Canada’))”.

![Revenue by Country and Product Type](Image)

**Data at 19/06/2012 at 15.35.08**
Figure 8-16   Advanced Filters report

To produce this report, we can start from the previous basic “5b - Revenue Simple Filter”:

1. If you had closed the Assist and the report from the previous exercise, login to DB2 Web Query, double-click the folder Century Electronics and the subfolder Assignment 5, then right-click the report 5b - Revenue Simple Filter and select Edit. If Info Assist and this report are still open from the previous assignment, just proceed to step 2.

2. In Info Assist, drag the ORDERDATE_YEAR field to the BY aggregation item in the Query pane as shown in Figure 8-17.
3. Right-click any of the filters already set and select **Open → Advanced Filter** (Figure 8-18).

   ![Editing filters](image)

   **Figure 8-18**  Editing filters

4. You are presented with the advanced filter panel, shown in Figure 8-19. Here we want to add a condition on **ORDERDATE_YEAR**, grouping it with the pre-existing condition on **COUNTRY**. To do so, select the **COUNTRY** condition (#1) and then **GROUP** (#2).

   ![Advanced filter panel](image)

   **Figure 8-19**  Advanced filter panel
5. Make sure the **COUNTRY** condition is selected, then select **Insert Before** as shown in Figure 8-20.

![Figure 8-20](image-url)  
**Figure 8-20**  Advanced filter, setting new condition Step 1

6. You are presented with a small pane in which to set up the new condition. Position on `<Field>` and select **ORDERDATE_YEAR**, then select **OK**. See Figure 8-21.

![Figure 8-21](image-url)  
**Figure 8-21**  Advanced filter, setting new condition Step 2
7. Position on <Value> and set up “Type” to Parameter, “Description” to Year: then select Dynamic, select the ORDERDATE_YEAR field and click OK (Figure 8-22).

Note: This pane gets built dynamically while you make the various choices. An initial look is not what is presented here; you will get to this appearance after all selections have been made.
8. When you are done, the advanced filters panel should look like Figure 8-23. Select **OK** to confirm your choices.

![Figure 8-23  Advanced filters](image)

9. Save your report as “**5c - Revenue Advanced Filter**” and run it. It should look like Figure 8-24.

![Figure 8-24  Advanced filters report](image)
8.3 Filters in charts: Revenue trend graph with a variable date range

Filters can also be applied to charts. In this exercise, Dan would like a simple line chart that spans two years (includes all our data). He would also like to allow the report runner to specify the time range in which they are interested (Figure 8-25).

Figure 8-25  Trending report with a variable date range
8.3.1 Creating a line graph

Follow these steps to create the revenue report:
10. Right-click the Assignment 05 - Adding Filters folder.
11. Select New → Chart. This will open Info Assist.
12. Select CEN_ORDERS synonym (Figure 8-26).

![Figure 8-26 Data Source Selection menu](image)

13. Click OK.
14. In the next window, click the Format tab. On the Format tab (Figure 8-27), under chart types group, select Line.

![Figure 8-27 Selecting Line chart](image)
15. To show product revenue trending by month, you must plot one point for every month for each product. To do this, convert the date field from year, month, and day to a field with just the year and month:

a. Click the Data tab.

b. Click the Detail (Define) icon (Figure 8-28).

c. In the Define field creator window (Figure 8-29), complete these steps:
   i. For Field, type MthYr.
   ii. In the pane below Field, where you define the formula for the new field, type ORDERDATE, which is the name of the date on which MthYr is based.
   iii. In the Format field, type TMYY.
      
      T means that the month or day immediately following will be represented as uppercase text. A single Y means that you want to display a two-digit year, but YY means that you want to display a four-digit year.

      An example of a MthYr value is Jan, 2011. If we want to place the year first, we specify a format of YYTM. DB2 Web Query is powerful when it comes to working with date and time fields. See “Date and time system variables” on page 790 for many of the different ways that you can work with date and time fields. Click OK.
d. On the Query Pane (Figure 8-30), drag MthYr to the Field value plotted on the X axis (our main X axis) pane, and drag Revenue to the Measure (Sum) pane under the Field value plotted on Y the axis. Then drag Product Type to Legend (Series).

![Query Pane](image)

*Figure 8-30*  Creating a line graph with multiple lines

16. Since an entry on an axis of “Jan, 2011” is obviously a date, remove the heading or label for MthYr from the graph (Figure 8-31):

a. Under the Field value plotted on the X axis, highlight MthYr.

b. Right-click there, and select **Delete** the label MthYr.

![Interactive Design View](image)

*Figure 8-31*  Removing the X axis field label
17. Change the X axis to rotate the text and make it look better. Right-click the X Axis, select **rotate**, then select 45 as in Figure 8-32.

![Figure 8-32  45-degree x axis labels](image1)

18. Enable the 3D effect and make it look better. Select **Format** tab and select **3D Effect** icon.

![Figure 8-33  Selecting 3D Effect icon](image2)

19. Select the **Series** tab, select the Marker icon, and select **None**. If not changed on the Interactive Design View, once select another one (for example, Square), next select **None**.

![Figure 8-34  Selecting Marker icon](image3)
20. Run your report. Figure 8-35 shows the result of running this report.

21. Save your graph as **5d - Line chart: Revenue trend graph**.

### 8.3.2 Adding a user-specified date range parameter

Up to this point, we plotted one point for every month/year combination in our data. This is not practical because the history grows in size. Next we select a specific range to display. In this example, we allow the user to specify an ad hoc date range.

22. Drag **ORDERDATE** to the filter pane.

23. In the filter pane (Figure 8-36), complete these steps:
   a. Select **Greater than or equal to**.
   b. Select **Prompt** and **Prompt using Text Input (Simple)**.

---

**Figure 8-35** Two-year product revenue trend lines

**Figure 8-36** Selecting prompt using Text Input (Simple)
c. Enter **FROM_DATE** to Variable; field, and enter **Star Date (YYYYMMDD)** to Prompt: field for your users. Click **OK**.

![Filter for ORDERDATE](image)

*Figure 8-37  Entering variable and prompt field*

24. Again drag **ORDERDATE** to the filter pane.

25. In the filter pane (Figure 8-38), complete these steps:
   a. Select **Less than or equal to**.
   b. Select **Prompt** and **Prompt using Text Input (Simple)**.
   c. Enter **TO_DATE** to **Variable**; field, and enter **End Date (YYYYMMDD)** to **Prompt** field for your users. Click **OK**.

![Filter for ORDERDATE](image)

*Figure 8-38  Setting filter*
26. Save and run your report. Figure 8-39 shows the results of running this report.

![Trend graph with variable date range](image)

**Figure 8-39**  Trend graph with variable date range

27. Try various date combinations.
8.4 Filter in metadata: Europe Revenue and Profit report

Century Electronics sells their products to stores worldwide. Dan anticipates that many of the reports that will be requested in the future will be for stores in European countries. When the time comes, you can certainly create filters in each of these reports (WHERE COUNTRY IN (‘France’, ‘Germany’, ‘Spain’), and in this case, the same rule has to be re-coded in each report.

But a better solution (and best practice) is to exploit the power of metadata and create the rule just once in the synonym and enforce it in all of the reports. To set a filter in metadata, you can use the web interface or the Developer Workbench tool. Both techniques are explained in 3.11, “Creating filters” on page 113. In this example, we will be using Developer Workbench. If you do not have this licensed tool, refer to the instructions provided in 3.11, “Creating filters” on page 113 on how to do it with the web interface.

8.4.1 Defining a filter in a synonym

We will create a “Europe” rule that defines which countries are part of Europe, and in the report, just say we want it to be validated as “true”:

1. Open Developer Workbench, select the system on which to work, and validate with your userid and password. Remember that the user must be part of the DevWorkbench group (use Administration → Security Center in the web interface to set up). Select Data Servers → EDASERVE → Applications → century_electronics, right-click the cen_orders synonym and select Edit in synonym as shown in Figure 8-40.

![Figure 8-40 Define Filter in Developer Workbench - Step 1](image-url)
2. Right-click the master file name segment containing the field that you would like to filter on, and select **Insert → Filter**, as shown in Figure 8-41, or alternatively selecting the funnel symbol highlighted. In this case, we want to filter on the Country field, which exists in our STORES segment.

![Figure 8-41](image_url)
3. In the Filter Calculator window (Figure 8-42) go to Column, type Europe, and define it as an I1 (integer one long) column. This means that we can test if for true or false in our reports. Double-click COUNTRY under the STORES segment to add it to the filter. Change the Relations to IN because we must provide multiple countries for the value. Click the list button on the value field.

![Figure 8-42 Creating a filter](image-url)
4. You are presented with the list of distinct values available in your data. Double-click the European countries (France, Germany, and Spain) or use the > button to move the selections to the right-hand side in the Value(s) Selection window (Figure 8-43). Click **OK** to close the Value(s) Selection window.

![Figure 8-43 Choosing values](image)
5. If necessary, you can add more elements by typing in directly in the VALUE box. For example, you know that your company is going to open new stores in Portugal and want your metadata to be ready for that occurrence, so you add OR ‘Portugal’ to the list of values to be checked. Click OK to close the Filter Calculator window (Figure 8-44).

![Filter Calculator](image)

*Figure 8-44 Creating a Filter detail*
We are now ready to use our “Europe” filter, since we have been asked to provide a Revenue and Gross Profit report for the European countries. The report is shown in Figure 8-45.

![Figure 8-45 Europe Revenue and Profit report](image)

### 8.4.2 Using predefined filters in a report

To produce this report, we can start from the previous basic “5a - Revenue by Country & Product.” Follow these steps:

1. If you had closed Info Assist and the report from the previous exercise, login to DB2 Web Query, double-click folder Century Electronics and subfolder Assignment 5, then right-click report 5a - Revenue by Country & Product and select Edit. If Info Assist and this report are still open from previous assignments, just proceed to step 2.

2. In Info Assist position to the Format ribbon and select “Stack Measure” in the Features group (Figure 8-46).

![Figure 8-46 Stack Measure](image)
3. Find the **Profit** field and drag it into the SUM aggregation item in the Query pane, as shown in Figure 8-47.

![Figure 8-47 Add Margin field to report](image)

4. In the “data” pane, locate your “Europe” filter and drag it into the filter pane (Figure 8-48).

![Figure 8-48 Add Filter to the report](image)

5. A pop-up opens up where you can set the check to “true” or “false”. If TRUE is selected, then you will get only European countries; if FALSE is selected, only countries not listed in the filter will appear in the report. Leave it to true and select **OK** (Figure 8-49).

![Figure 8-49 Setting filter to true](image)
6. This report now includes only the countries that are defined in the Europe filter. Save it as **5e - Europe Revenue and Profit** and run it. The output should look as shown in Figure 8-50.

![Revenue and profit for European countries](image)

**Data on 20/06/2012 at 11.50.30**

*Figure 8-50  Revenue and Profit for European countries*
8.5 InfoMini Slicers: InfoMini Revenue and Cost report

For the next request, Dan throws you a “curve ball.” He would like a report that summarizes revenue and costs by product type with the capability to be filtered on all or any of the time elements and on a geographical basis. The users must have the capability to set up the compare operators at runtime (that is, decide if they want equal, not equal, greater than....) and have to be prevented from choosing the “no data” combination (that is, country='France' and city='Honolulu' → no Honolulu city in France → 0 records returned from query). In Figure 8-51, you can see an example of the requested report.

![InfoMini report with slicers](image)

**Revenue and Cost by Product Type**

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Revenue</th>
<th>Cost of Goods Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>392683321.00</td>
<td>219978500.00</td>
</tr>
<tr>
<td>Camcorders</td>
<td>44453041.00</td>
<td>341014310.00</td>
</tr>
<tr>
<td>Cameras</td>
<td>194103667.00</td>
<td>133328330.00</td>
</tr>
<tr>
<td>Office</td>
<td>30245685.00</td>
<td>19024725.00</td>
</tr>
<tr>
<td>Video</td>
<td>520360205.00</td>
<td>415811550.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1561923919.00</strong></td>
<td><strong>1129157915.00</strong></td>
</tr>
</tbody>
</table>

Data at 20/06/2012 at 15.39.22

*Figure 8-51 InfoMini report with slicers*

Info Assist provides the InfoMini functionality that can easily help in accomplishing this task.

8.5.1 Defining dimensions in a synonym

You can put any field in InfoMini slicers; however, if you have defined dimensions in your synonym and you use them in InfoMini slicers, the various fields in the dimension are automatically connected to each other. For more information on dimensions, see 3.12, “Defining dimensions: InfoMini and OLAP” on page 126.

**Note:** Developer Workbench, a DB2 Web Query optional feature, is a prerequisite for creating OLAP-enabled reports. Developer Workbench is the only interface for defining the hierarchies that are required by OLAP at the time this book was written. Eventually a Web based interface for building dimensions may be available.
Since we want to use the Date and Store Location dimensions in our report, we are going to define the corresponding dimensions in our synonym:

1. Start Developer Workbench.
2. Expand **WebFOCUS Environments → system name → Data Servers → EDASERVE → Applications → Century Electronics**.
3. Right-click the **cen_orders.mas** table and select **Edit in Synonym Editor** (Figure 8-52).

![Developer Workbench, edit synonym](Figure 8-52)
4. In the Synonym Editor, select the field ORDERDATE, and from the right-click menu, select the Decompose Date option as shown in Figure 8-53.

![Decompose Date](image)

**Figure 8-53 Decompose Date**

5. In the Decompose Date Field dialog window, make sure that all four fields are selected and click **OK** as shown in Figure 8-54.

![Select decomposed date fields to add](image)

**Figure 8-54 Select decomposed date fields to add**
6. This will create four new Define fields as shown in Figure 8-55.

![Figure 8-55 Decomposed date fields](image)

7. In the Synonym Editor, select the Dimension Builder icon in the tool bar, highlighted at #1 in Figure 8-56. You are presented with the Dimension Builder pane, highlighted at #2.

![Figure 8-56 Dimension Builder](image)

8. There are two types of hierarchies. One is based on levels and the other is based on parent-child relationships. We use level hierarchies. For more information about the different types of hierarchies, see the Developer Workbench help text.

Right-click **Dimensions** and select **Insert → New Dimension with Levels Hierarchy** as shown in Figure 8-57.

![Figure 8-57 Insert new dimension](image)
9. A new dimension and hierarchy are created. Rename both to something more meaningful. Right-click **Dimension1**, select **Rename**, and specify the new name Order Date Hierarchy as shown in Figure 8-58.

![Figure 8-58 Rename Dimension](image)

10. Do the same for the hierarchy. Right-click **Hierarchy1** and rename it Order Date Hierarchy. When you are finished, it should look like the example in Figure 8-59.

![Figure 8-59 Order date hierarchy](image)
11. Now you are ready to bring the Order Date fields into the hierarchy. From the field view pane, hold down the Ctrl key and select ORDERDATE_YEAR, ORDERDATE_QUARTER, ORDERDATE_MONTH, and ORDERDATE_DAY. Drag them over to the Order_Date_Hierarchy in the Dimension view pane as shown in Figure 8-60.

12. When you are done, the Order_Date Dimension should look like the example shown in Figure 8-61.
13. More dimensions need to be created. Right-click **Dimensions** and select **Insert → Levels Hierarchy** as shown in Figure 8-62.

![Figure 8-62 Insert new dimension](image)

14. Right-click the new hierarchy and select **Rename** (Figure 8-63). Here we use **Product Info**. Repeat the step at the Dimension level.

![Figure 8-63 Adding a hierarchy](image)
15. In the left-hand side of the Edit Synonym window, select the segment in which the required fields are located; here we use INVENTORY. Hold the CTR key and select the field you want to be in the dimension in the exact order you want them to appear (here the sequence is Product Type, Product Category, Model, Product Name). Press the left mouse button and drag all fields to the hierarchy on the right-hand side of the panel (see Figure 8-64). Alternatively, you can drag each field, one by one.
16. Repeat the process from step 10 to add a Store Locations (segment INVENTORY fields COUNTRY, REGION, STATE, CITY) and Manufacturing Locations (PLANT segment, fields PLANTCOUNTRY, PLANTREGION, PLANTSTATE, PLANTCITY) dimensions. Your dimension should look like Figure 8-65.

![Dimension Builder](image_url)

**Figure 8-65  Dimension built**

You have now completed all the definitions that are required in our tutorials for OLAP and InfoMini usage. Typically, this is done once by the IT department. After this, any user with authority to create reports can choose to OLAP-enable their report.
8.5.2 InfoMini Slicers report

To design the report presented in Figure 8-51 on page 220, proceed as follows:

1. Open folder **Century Electronics** and right-click **Assignment 5**. Select **New → Report** as shown in Figure 8-66.

![Figure 8-66 Create a new report](image-url)
2. Info Assist opens up; select synonym **CEN_ORDERS** as your data source and click **OK** (Figure 8-67).

![Select a data source](image)

*Figure 8-67  Select data source*

3. Create a simple report dragging **PRODUCTTYPE**, **REVENUE**, and **COSTOFGOODSSOLD** in the “Interactive design view” or in the “Query” pane to obtain the result shown in Figure 8-68.

![Query](image)

*Figure 8-68  Basic report layout*
4. Your end users may appreciate getting totals, so we enable the corresponding function selecting “Column Totals” in the “Home” ribbon. In the same ribbon, select “Header & Footer” and type in “Revenue & Cost by Product Type” as your header and “Data at &DATEDMYY on &TOD” as your footer. Format and align to your liking (Figure 8-69).

![Figure 8-69  Basic report appearance](image)

5. Get to the Format ribbon and select the InfoMini icon as shown in Figure 8-70. By using the little arrow on the side of the symbol, you can toggle the various options (check the **Format tab**):

- **Format Tab**: When selected, users will get the choice to select the output format at runtime, under the “Format” tab.
- **Slicers Tab**: When selected, users will be presented with filters at runtime, under the “Slicers” tab.
- **Run Immediately**: When a checked report will be executed automatically when called by the user, with HTML format and no filtering. When unchecked users will be presented with an empty panel and may select output format and set filters before getting data from the system.

![Figure 8-70  InfoMini options](image)
6. Select the **Slicers** ribbon. In the list of available fields, locate the **Date Dimension** and drag it in the slicers bar, where it says “Drag Fields here to create slicers” as shown in Figure 8-71.

![Figure 8-71 Add Slicer](image)

7. You will notice that all the fields that are part of the selected dimension are brought into the slicer. Click **New Group** to create a new slicer (Figure 8-72).

![Figure 8-72 Slicers, Date Dimension](image)

8. In the list of available fields, locate the **Product Dimension** and drag it in the slicers bar, in the new group that was previously created. Your slicers should now look like Figure 8-73. You can add to slicers dimensions (all fields in the dimension will be available for filtering) or fields on an individual basis. This provides the developer with a very easy and quick way of defining filtering capabilities in a report.

![Figure 8-73 Slicers, Date, and Product Dimensions](image)
9. The various “filters” that have been generated dragging a whole dimension are automatically connected to each other. Imagine that the user sets a filter for QUARTER=1. When listing MONTH to set up a second condition, they will be presented with months 1, 2, and 3 only, as shown in Figure 8-74.

![Figure 8-74  Connected filters in slicers](image)

10. Run your report. You will be presented with an empty panel with two tabs, Format and Slicers. Select Slicers (1) and experiment with the various filtering options you are given. Clicking the = sign before each field (2), you can get the various comparison operators and select what you need (see Figure 8-75). After making your selections, click Run (3) to execute the report.

![Figure 8-75  Setting up slicers at runtime](image)
11. Save your report as **5f - InfoMini Rev & Cost**.

Notice that combining traditional filters and InfoMini slicers can lead to results difficult to understand by end users.

Filters set in reports are ALWAYS honored and implemented at runtime, but they do not influence a slicer’s pull-down set on the same field.

In our report, we set up a filter on field ORDERDATE_YEAR (WHERE YEAR = 2012) as shown in Figure 8-76.

![Figure 8-76  Filter on ORDERDATE_YEAR](image-url)
12. Then we enable InfoMini $\rightarrow$ Slicers and add the Date Dimension (that includes field ORDERDATE_YEAR) to it. At runtime the user gets a list of all years that are in the data (Figure 8-77), regardless of the fact that some of these values may be filtered by a condition in the report. This happens because the list gets populated with a SELECT DISTINCT on the underlying table, regardless of the actual SELECT statements that will be composed at report runtime.

![Figure 8-77  InfoMini filter + slicer](image)
13. Hence at runtime, the user can get a list of all years that are in the data and execute selecting data that get cut out by the filter condition. This results in an empty report, as shown in Figure 8-78.

![Figure 8-78 No data report resulting from Filter + slicers](image)

In Figure 8-79 you can see the underlying SQL statement. You will notice ANDed conditions \((\text{YEAR(T1."ORDERDATE"}) = 2011) \text{ AND } (\text{YEAR(T1."ORDERDATE"}) = 2012)\) in the WHERE clause. These two conditions will always lead to an empty data set.

```
SELECT YEAR(T1."ORDERDATE"), T2."PRODUCTTYPE", SUM(T1."LINETOTAL"), SUM(T1."COSTOFGOODSSOLD")
FROM QWQCENT/ORDERS T1, QWQCENT/INVENTORY T2
WHERE (T2."PRODUCTNUMBER" = T1."PRODUCTNUMBER")
AND (YEAR(T1."ORDERDATE")) = 2011) AND (YEAR(T1."ORDERDATE")) = 2012)
GROUP BY YEAR(T1."ORDERDATE"), T2."PRODUCTTYPE" ORDER BY YEAR(T1."ORDERDATE"), T2."PRODUCTTYPE" FOR FETCH ONLY
```

![Figure 8-79 Underlying SQL Statement](image)

**Notes:**
- Developers should avoid having filters on fields that are used in slicers, or at least understand their behavior, or undesired results can be obtained in reports.
- Fields used in slicers conditions are always ANDed among themselves. If you need to OR conditions, you will have to use standard filters.
8.6 InfoMini Formats: InfoMini Revenue and Cost Format report

We have presented our last report to the end users, and they complained that they also asked to be able to select the output format at runtime but this option is not in our 5f - InfoMini Rev & Cost report. So we must add this capability to the report:

1. If you had previously closed your report, open it again with the Edit option. Select the Format ribbon, position on the InfoMini icon and click the little arrow at its right. Check the Format tab as shown in Figure 8-80.

![Figure 8-80 InfoMini Format tab](image)

2. Run the report. You will now get two different tabs, Format and Slicers, as shown in Figure 8-81. Select the Format tab (1) and experiment with the various output formats you are presented with. Here we present an Active Flash output (2). Remember that after selecting the format, you have to click Run (3) to actually get your report executed.

![Figure 8-81 Formats and Slicers](image)
3. Save your report as “5f - InfoMini Rev & Cost Format” and close it.

8.7 Publishing your folder

Now that we have created the requested reports, we want to make them available to our runtime users. This can be done on an individual basis (report by report) or at the subfolder level.

You can publish subfolder Assignment 5 by right-clicking it and selecting PUBLISH.
Assignment #6: Detail/print reports

In this chapter, we perform the following tasks:
- Create summary and detailed reports.
- Create a chart.
- Convert a report to a chart.
- Drill down to another report or a chart depending on defined conditions.
- Drill down to another report without any condition.

Prerequisites: Before starting this chapter, make sure the following steps have already been completed:
- Create a synonym over the ORDERS table.
- Edit ORDERS synonym and define joins to INVENTORY, PLANT, and STORES tables.

If you have not completed these steps, go to Chapter 3, "Creating and editing metadata: Century database" on page 33.
9.1 A graphical structure of the application

In this chapter, we show how to create different reports and one chart by using Info Assist. We use the Century database that ships with the DB2 Web Query in the QWQCENT library. You can find instructions for creating the metadata/synonym that defines this database to DB2 Web Query in Chapter 7, “Creating and editing metadata - Century database”.

The basic report shows the profit margin for each product category. According the value of the margin, we define conditions for Good Profit and Poor Profit. Depending on Good Profit or Poor Profit, we drill down to another report or a chart as shown in Figure 9-1.

![Figure 9-1 A graphical structure of the application](image)

9.2 Creating the basic summary report with Info Assist (6a - Basic Summary Report)

The basic summary report is used to show the revenue and profit margin of all Product Categories. Depending on the value of the Margin, it is qualified as Good Profit or Poor Profit.

If it is Good Profit, you can drill down to a chart that shows the Margin over the last twelve months.

If it is Poor Profit, the drill down will be to another report with all products of the Product Category. From this summary report, it is possible to drill down to a detail report that shows every single order of a product.
9.2.1 Creating an initial summary report

To begin creating a summary report:

1. In the navigation area, under DB2 Web Query, expand top folder Century Electronics.
   a. If it is not created yet, create it by right-clicking DB2 Web Query. Select New → Folder → Title “Century Electronics” and click OK.
   b. Create a new sub folder under “Century Electronics” and name it “Assignment 06 - Detail and Print Reports” as shown in Figure 9-2.

2. Utilizing the techniques described in earlier chapters, create a new report in folder Assignment 06 - Detail and print reports. This report has the following specifications:
   - Based upon the synonym cen_orders
   - Report header: Good and Poor Profit by Product Category
   - Report footer: Created on &DATE at &TOD
   - By fields:
     • Product Type
     • Product Category
   - Sum fields:
     • Revenue (with commas and floating currency)
     • Cost of Goods Sold (with commas and floating currency)
     • Profit (with commas and floating currency)
     • Margin
   - Traffic lighting on Margin
     • Yellow background if Margin > 80
     • Red background if Margin < 30
   - Add Column Totals
   - Add Subtotals to the Product Type column
When you are finished, your report should look like the example shown in Figure 9-3.

![Figure 9-3  Basic Summary Report](image)

3. Save the report as **6a - Basic Summary Report**

### 9.3 Creating a summary report with a parameter
**(6b - Summary Report Product Category)**

Next we will create a summary report which should be called by the basic report after a drill down. Have a look at 9.1, “A graphical structure of the application” on page 240. There you will find that this report can be selected and run when the profit of a product category is poor (Margin is less than 30). In the basic program, product types with poor profit have a yellow background so far. This will be increased to a drill down in 9.7, “Creating drill downs and putting it all together” on page 257.

For now, it is important to know that a parameter Product Type will be passed to our new report. This report must be able to receive this parameter and then show all product numbers included in this product category:

1. Utilizing the techniques described in earlier chapters, create a new reporting folder **Assignment 06 - Detail and print reports**. This report has the following specifications:
   - Based upon the synonym **cen_orders**
   - Report header: **Good and Poor Profit by Product Category:**
     - **<PRODUCTCATEGORY>**
   - Report footer: **Created on &DATE at &TOD**
   - By fields:
     - Product Number
     - Product Name
- Sum fields:
  - Revenue (with commas and floating currency)
  - Cost of Goods Sold (with commas and floating currency)
  - Profit (with commas and floating currency)
  - Margin

- Traffic lighting on Margin:
  - Yellow background if Margin > 80
  - Red background if Margin < 30

- Add Column Totals

- Add filter for Product Category:
  - Select **Prompt using Data Values (Dynamic)**.
  - Do not select **Multiple Values for Prompt**.
  - Specify prompt text: Enter Product Category:

Notice that we used a variable in the report header: `<PRODUCTTYPE`. As shown in Figure 9-4, this will force the program to replace the variable by the value of PRODUCTTYPE that was selected by the user and used to filter the report.

![Figure 9-4](Use of a variable in the header)

2. Save the report as **6b - Summary Report Product Category**.
3. Run the report (Figure 9-5).
Because we selected a dynamic prompt when we created the filter, a drop-down list box is added to the report to select a Product Category.

This report can now be run as a stand alone report, or as a report that is called from another report as a drill down (to be explained later).
9.4 Creating a detail report with a parameter
(6c - Detail Report Product Number)

The third report will list all products that belong to a product category with poor profit. The filter is created from the field Product Number.

Proceed as follows:
1. Utilizing the techniques described in earlier chapters, create a new reporting folder Assignment 06 - Detail and print reports. This report has the following specifications:
   - Based upon the synonym cen_orders
   - Specify two variable in the report header: <PRODUCTNUMBER, <PRODUCTNAME>
   - Report footer: Created on &DATE at &TOD
   - By fields:
     - Order Date
     - Order Number
     - Plant Name
     - Plant Country
   - Sum fields:
     - Revenue (with commas and floating currency)
     - Cost of Goods Sold (with commas and floating currency)
     - Profit (with commas and floating currency)
     - Margin
   - Traffic lighting on Margin:
     - Yellow background if Margin > 80
     - Red background if Margin < 30
   - Add Column Totals
   - Add filter for Product Number:
     - Select Prompt using Data Values (Dynamic).
     - Do not select Multiple Values for Prompt.
     - Specify prompt text: Enter Product Category.
Once again, notice that we used variables in the report header. As shown in Figure 9-7, this will force the program to replace the variable by the values of PRODUCTNUMBER and PRODUCTNAME selected by the user and used to filter the report.

![Figure 9-7 Add header with to variable fields](image)

2. Change the report type from Sum to detail:

In our example reports, we always used the default setting Sum. These reports were aggregated or summed on the fields which were defined as Sort fields. The Print option in the Query panel turns off the aggregation and produces a detail listing. This means that each row returned from the ORDERS table will be represented by a line in the report.

Right-click **Sum** in the Query panel and select **Print** (Figure 9-8).

![Figure 9-8 Change report type Sum to Print](image)

3. Save it as **6c - Detail Report Product Number**.
4. Run the report. Your report should prompt for Product Number (Figure 9-9).

![Report with autoprompt Product Number](image)

*Figure 9-9  Report with autoprompt Product Number*
9.5 Converting a report to a chart

It is very easy to convert a report to a chart. First we will create a report out of Product Category, Profit, and Margin. With just a mouse click, it can be converted to a chart.

1. Create a new report.
2. Add these fields to it:
   - Product Category
   - Margin (Drop as sum)

3. Select the Home ribbon and expand the Format group if necessary) or select the Format ribbon and expand the Destination group (if necessary).
4. Click the Chart button, which can be found in both groups (Figure 9-11).
5. Your report is converted to a chart (Figure 9-12).

![Figure 9-12 Chart created from a report](image)

6. If you want, you can save the report. But this is not compulsory for our tutorial.

**Note:** After the report was converted to a chart, the tab Reports at the bottom of the window was updated (see Figure 9-13). Both report and chart are still available.

![Figure 9-13 List showing both report and chart](image)

In the next section, we will refine this chart so that it will suit to our application.
9.6 Creating a chart
(6d - Chart Good Profit)

We will use the chart from 9.5, “Converting a report to a chart” on page 248, which was created out of a report:

- As we want to use it for a drill down from our first report 6a - Basic Summary Report, if the profit is good for a special Product Category, we must add a filter (autoprompt) for this field.
- The default chart is a bar chart. We want to show the margin and profit trending by month over multiple years in a Line chart. For this purpose, we need a Define field for MonthYear, which can be extracted out of the field Order Date. And we have convert the type of the chart to a bar chart.
- Margin and Profit have different dimensions, so we will add a second Y-axis with another dimension.

Follow these steps:
1. The chart which was created before should be opened.
2. Save it as 6d - Chart Good Profit.
3. Add a Define field Order_MonthYear with a format of MtYY (Figure 9-13).

Note: There are many ways to format the date June 2012. These are two of the possible choices for this chart:
- MtYY which means Jun, 2012
- YYM which means 2012/06

![Create a Define field Order_MonthYear](image)
4. Remove Product Category from the X-Axis in the Query panel (Figure 9-15).

![Figure 9-15 Delete a field from the X-Axis](image)

5. Add the Define field Order_MonthYear to the X-Axis. Drag and drop it to the X-Axis. Your Query panel should look like in Figure 9-16.

![Figure 9-16 Query panel](image)

6. Change the chart type to Line. Select the Format ribbon, expand the Chart Types group, and select Line.

7. Add Product Category to Legend (Series).

8. Run the query.

   **Note**: It is good practice to run the query after every update to see if it really affects what you wanted to reach. Remember to save it.

   Do not worry if the result looks a bit odd. After the next step, it will look better.

10. Run the chart and select a Product Category.
Now the chart will look better (Figure 9-17).

As you can see from Figure 9-17, the date is too wide horizontally for the X-Axis legend. This is why not every month is listed. It is possible to rotate the date shown on the legend.
11. Right-click a date in the legend.
12. Select Rotate and 45 (see Figure 9-18).

13. Run the chart.
14. Add a header to the chart (Figure 9-19):
   - Select the Home ribbon.
   - Open Report group.
   - Select Header & Footer.
   - Select Page Header.
   - Enter “Good Profit (Margin > 80).”
   - Click OK.

Figure 9-18   Rotate the date legend

Figure 9-19   Add header to the chart
Your chart should now look like the one in Figure 9-20.
15. Remove “Order MonthYear” from the legend: Right-click the text and select **Delete**.

Now we will add a trend line for Profit. This can be done by creating a second Y-Axis and put the Profit on it. The dimension of Profit will be different from the one Margin. So think of it just as a trend line, without comparing the absolute values of Profit and Margin.

If we want to add a second Y-Axis, we have to select another type of chart named “Vertical Dual-Axis Absolute Line”.

16. Select the Format ribbon, expand the Chart Types group, and select Other.

17. On the Other Chart Types Menu select the second category “Line” and then “Vertical Dual-Axis Absolute Line” (see Figure 9-21).

![Select another chart type](image)

*Figure 9-21*  Select another chart type

In the Query panel, a new Y2 Measure is added.
18. Drag and drop the Profit field from the Data list to the Y2 Measure (Figure 9-22).

![Figure 9-22  Query panel with a second Y-Axis](image)

19. Run the chart (Figure 9-23).

![Figure 9-23  Chart with Profit and Margin](image)

20. Save the chart as **6d - Chart Good Profit**
9.7 Creating drill downs and putting it all together

Now the time has come to put all reports and the chart together. It is very easy to create a drill down and to pass one or more parameters. But be careful when adding the name of a parameter. It must correspond exactly to the name of the parameter, which the called program expects.

Have a look at 9.1, “A graphical structure of the application” on page 240 to see the three different drill downs. There are two conditional drill downs from the first report 6a - Basic Summary Report:

- If the profit is good, chart 6d - Chart Good Profit is loaded.
- If the profit is poor, the second report 6b - Summary Report Product Category is loaded.
- For both drill downs, parameter PRODUCTCATEGORY is passed.

- The third drill down is initiated by the second report without a condition.
- The third report 6c - Detail Report Product Number is launched. whatever condition exists.
- As a parameter, the value of PRODUCTNUMBER is passed.

**Note:** A parameter can be passed via an autoprompt when the query is called directly (as we did in our report and chart). It can be passed when one report links or drills down to another. It can be also passed from an HTML page.

9.7.1 Conditional drill downs from the Basic report

Proceed as follows:

1. Edit our first report 6a - Basic Summary Report.
2. Right-click the Margin column.
3. Select More, then Traffic Light-Conditions.
4. Select Margin “Good Profit” and click Drill Down (see Figure 9-24).

![Figure 9-24 Select to create a drill down](image)
A new window will open (see Figure 9-25).

**Figure 9-25** Find the report to be drilled down to

5. Select **Report** and **Browse**.

All the reports and charts that were created in folder “Assignment 06 - Detail and print report” will be listed (see Figure 9-26).

**Figure 9-26** Queries in folder “Assignment 06 - Detail and print report “
6. Select chart 6d - Chart Good Profit and click Open (see Figure 9-27).

![Image](image_url)

Figure 9-27  Select a query from the list

The selected query and the path to it is added for a drill down. Now we have to select a parameter which is passed to the selected query.

7. From the drill down window, select the “Add Parameter” icon (see Figure 9-28).

![Image](image_url)

Figure 9-28  Add a parameter
8. Enter parameter name “PRODUCTCATEGORY” and select “Product Category” from the list box (see Figure 9-29).

![Figure 9-29  Enter parameter’s name and value](image)

Note: The name of the parameter must be exactly the same as it was used for the autoprompt filter of the drilled down query. The name is even case sensitive.

9. Click OK twice and you will be back to “Traffic Light Condition for Margin” window.

Now we will add the second drill down for “Poor Profit”.

10. From the “Traffic Light Condition for Margin” window, select the condition for Poor Profit and click the Drill Down button.

11. Follow steps 4.) to 10.):
   - Select the second query “6b - Summary Report Product Category” as the drilled down report.
   - Select the same parameter PRODUCTCATEGORY as before.

12. Click OK.

13. Save the report

14. Run the report.
Have a look at the margin column. The values with good and poor profit are shown with background color yellow and pink. These fields are underlined indicating a hyperlink. (See Figure 9-30.)

![Image](image.png)

*Figure 9-30  Report with drill down function*

When you click a “Good Profit” link, the chart should be created showing the margin and the profit of the selected Product Category.

When you click a “Poor Profit” link, the second report should be created showing all products of the selected Product Category.

**Note:** When you select a drill down and it does not show the query with the selected Product Category, instead it shows an autoprompt for the category, check the spelling of the parameter’s name.
This should be your result when everything is fine (Figure 9-31).

Figure 9-31  Basic report and drilled down report and chart
9.7.2 Non-conditional drill down from the second to the third report

In the previous section, we showed you how to create conditional drill downs and pass a parameter. In this section, we use a simple non-conditional drill down. The way of adding a drill down and passing a parameter is nearly the same as showed before. The only difference is the entry point:

1. Edit the second report "6b - Summary Report Product Category".
2. Select column **Margin**.
3. Check if the ribbon Field-Margin is shown.
4. Click the Links group if not opened (see Figure 9-32).

![Figure 9-32 Open the Links group](image)
5. Click the **Hyperlink** button in the Links group.
   
   The Drill Down window opens.
   
   The following steps are similar to the ones in step 5 on page 258.

6. Select **Report** and **Browse**.

7. Find and select **6c - Detail Report Product Number**.

8. Add **PRODUCTNUMBER** as a parameter.

![Figure 9-33  Add a report and parameter to the drill down](image)
9. Click **OK**.

10. Click **OK**.

11. Save the report.

12. Run the report.

The result of the drill down is shown in Figure 9-34.

**Note:** We did not use a conditional drill down. This is why all fields in the Gross Profit Margin column are underlined, which is a hint for a hyperlink.
9.7.3 Publishing the reports and charts

Finally, you have to publish your reports and charts so that other users are able to see the reports and run them.

1. Right-click each report/chart and select Publish.

![Figure 9-35  Publish all reports](image)

**Note:** If you publish only the first report that calls the other reports/chart by a drill down, you will not be able to drill down (see Figure 9-36).

![Figure 9-36  Message if report/chart is called by a drill down without being published](image)
2. It is better that you get the result shown in Figure 9-37.

---

Figure 9-37  The final result of your drill down application

Congratulations! You have finished Tutorial “Chapter 9, “Assignment #6: Detail/print reports” on page 239”.

---

Chapter 9. Assignment #6: Detail/print reports 267
Assignment #7: Implementing OLAP

Online analytical processing (OLAP) is best known as the technology that allows a user to *slice and dice* data or drill down into data. DB2 Web Query makes it easy to provide users with a sophisticated drill-down, slice and dice interface without the report developers having to do anything at all. You will have a better understanding of this concept by the time you finish this tutorial. After taking a standard report created with Info Assist, the report developer selects an output option to OLAP-enable the report. This automatically provides an interface with drop-down lists and drill capable columns that allow the user to slice and dice or pivot their data and perform a variety of local analysis on the original report.

Tables must have any embedded hierarchies predefined via the Developer Workbench. After this is done, the users have an easy and intuitive way to navigate and drill down on the hierarchy within their data.

OLAP analysis typically starts with a question such as “What were my regional sales numbers across the United States?” At this point, you might look at the numbers and ask to see the details for the Eastern region, which looks out of line with the other regions. If you then find that a single state is pulling down the region you might ask to see the revenue for that state split out by the different product groups.

After you find a product group that appears to be in trouble, you might ask to see the sales for that product group in that state summarized by month for the last two years. This type of analysis is sometimes called *having a conversation with your data*. It is OLAP technology that enables this quick and easy interaction with the data. A user could have created a separate ad hoc query for each of the above questions but that would probably not occur in real life. If a user simply had to click a specific field of interest to go down to the next level of detail, they would be far more likely to continue with their analysis.
10.1 Assignment

In this assignment you will provide a solution that goes above and beyond Dan’s requirements. You will OLAP enable a report. By doing so, a fairly simple summary report turns into a powerful query in which report runners can drill down, slice and dice data, and analyze data in ways they never considered before. A before and after example is shown in Figure 10-1 below.

Figure 10-1  A simple report (before and after OLAP is enabled)
10.2 OLAP terminology

Before you begin, it is important to understand some of the various terms associated with the OLAP terminology. Table 10-1 covers basic OLAP terminology to explain the concepts that we use in this chapter.

Table 10-1  OLAP terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension</td>
<td>A set of columns structured in a hierarchy. For example, a geographic dimension might include a city that belongs to a state, which is in a region, which is part of a country. In this example, Country is the top level and city is the bottom level of the dimension. A product dimension might include product type at the top level and below that a product category, which contains multiple models and each model contains multiple part numbers or SKUs.</td>
</tr>
<tr>
<td>Drill down</td>
<td>An action that involves going from one level in a hierarchy to the next lower level. For example, if a user drills down on country, he sees the different regions that make up the country. If he then drills down on region, the states that compose the region are displayed. Drilling down can also involve invoking more detailed reports or graphs. For example, in an earlier tutorial, we drilled down on product type and passed the product type as a parameter to a second report. If this type of drill down is defined for a column, it takes precedence in an OLAP report over drilling down through the hierarchy.</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>The structure or sequence of each of column within the dimension. In the example, above the geography dimension is a hierarchy of country, region, state, and city.</td>
</tr>
<tr>
<td>Hyperlinks</td>
<td>A column that is displayed in blue in a report. The user can click the hyperlinked column to initiate an action. The standard action that is linked to a column is the ability to drill down to the next level of data. A hyperlink can also take you to another report, as previously demonstrated.</td>
</tr>
<tr>
<td>Measure</td>
<td>Numeric fields that you want to analyze at the various levels of a hierarchy and at various intersection points. For example, you might want to analyze sales of video equipment in the United States. This is the specific intersection or slice of the data in which you are interested. Normally, these fields are summed or totalled, but they do not need to be. For example, you might want to report your revenue by country and then drill down to the revenue in the regions that make up the country. Now the revenue is summed by region. You might also want to see the average profit on an order across states or regions to see if certain areas are offering too deep a discount. In this case, profit is an average measure, not a summed or totaled measure.</td>
</tr>
<tr>
<td>Pivot</td>
<td>To move a field from a column to a row or vice versa. For example, year might be one of the by fields where the different years are listed down the side of your report. If you wanted the various years across the top of your report instead, you pivot the field or heading Year. You can do this in multiple ways in an OLAP report including dragging the field or using the control panel to pivot your data.</td>
</tr>
</tbody>
</table>
10.3 Turning on the OLAP option in Info Assist

The first report is a simple summary that shows revenue by product type. Next you will enable OLAP with this report.

Prerequisite: If you are going to create OLAP reports, you should define dimensions for OLAP Analysis reports. Prior to reading this section, you need to read 8.5.1, “Defining dimensions in a synonym” on page 220.

10.3.1 Creating an initial report

Proceed as follows:

1. Create the Assignment 07 - Implementing OLAP folder.
2. Right-click the Assignment 07 - Implementing OLAP folder.
3. Select New and Report. This will open Info Assist.
4. Select CEN_ORDERS synonym.
5. Click OK.
6. Double-click the Product Type.
7. Double-click the Revenue.

Prerequisite: If you are going to create OLAP reports, you should define dimensions for OLAP Analysis reports. Prior to reading this section, you need to read 8.5.1, “Defining dimensions in a synonym” on page 220.

8. If the Report group is not already expanded, click the Report icon on the ribbon to open it (Figure 10-3).
9. Click **Column Totals** in the expanded Report ribbon (Figure 10-4).

![Figure 10-4 Selecting Column Totals](image)

**Editing the format of a column**

Follow these steps:

1. Click the **Revenue** field. You are going to format this field with commas and dollar signs. When you select the Revenue field, the ribbon becomes field-specific. Some of the groupings may already be expanded depending on the width of your screen. In this case, you may need to expand the **Format** group (Figure 10-5).

![Figure 10-5 Editing Format](image)

2. Select the **comma** (Figure 10-6).

![Figure 10-6 Adding a comma](image)
3. Select the **currency symbol** down arrow and then choose **Floating currency**. (Figure 10-7).

![Adding the currency symbol](image)

**Figure 10-7** Adding the currency symbol

**Using the Aggregation Functions**

You are going to add a count of the number of orders for each product type to the report.

Follow these steps:

1. If compressed, expand **Dimensions** in the Data panel.
2. Drag **Order Number** to the left of the **Revenue** column, then Select **Drop as Sum**. (Figure 10-8).

![Dropping as Sum](image)

**Figure 10-8** Dropping as Sum
3. Right-click **Order Number**, in the report, to open the field-specific submenu.

4. Select **More**, then **Aggregation Functions** and then select **Count** (Figure 10-9).

![Figure 10-9  Selecting Aggregation Functions as Count](image)

5. To create a new heading in the Query panel, right-click **CountOrderNumber** to see the field specific submenu (Figure 10-10).

![Figure 10-10  Selecting Change Title](image)

6. Select **Change Title** and type the new title **Count**. Click **OK** (Figure 10-11).

![Figure 10-11  Changing Title](image)
7. Click **Save**, save the report with the name **7a - Revenue summary**.

8. Run the report. You have completed your initial summary report (Figure 10-12).

![Figure 10-12 7a - Revenue summary](image-url)

9. Close the report **7a - Revenue summary** to return to the Interactive Design View.

We will continue to use this report as the basis for our next report.

### 10.3.2 Enabling an OLAP report: How to use Auto Drill & Analysis

1. Select the **Format** ribbon and expand the **Navigation** group if it is compressed.

2. Open the report **7a - Revenue Summary**

3. Click **Auto Drill & Analysis** (Figure 10-13).

![Figure 10-13 Selecting Auto Drill & Analysis](image-url)

4. **Run** your report. Do not save this version (Figure 10-14).

![Figure 10-14 Run your report](image-url)

5. The **Product Type** is automatically highlighted and underlined; this indicates that you can drill down on this column.
6. Click **Audio**.

In the CEN_ORDERS master file, **Product Category** was below **Product Type** in the Product dimension. You are now drilling down to the Product Categories within Audio (Figure 10-15).

**Note:** If you do not remember the dimension, read 8.5.1, “Defining dimensions in a synonym” on page 220.

![Drilling down to Product Category](image1)

Figure 10-15  Drilling down to Product Category

7. **Close** the results display.

Auto Drill & Analysis has much more power than the simple example you just executed. Look at the drop-down options on the Auto Drill button. “Dimensions grouped in tabs”, for example, can turn a small report into a powerful analytical tool.

8. **Select** **Dimensions grouped in tabs** (Figure 10-16).

![Selecting Dimensions grouped in tabs](image2)

Figure 10-16  Selecting Dimensions grouped in tabs
9. Under the **More options**, select **Dimensions and Measures**. This gives you the maximum drill-down capabilities. When creating your own reports, you can choose to drill down on the dimensions only and not the measures (Figure 10-17).

![Figure 10-17  Selecting Dimensions and Measures](image)

**OLAP options**: The Enable OLAP options control how users can interact with an OLAP report and access OLAP tools:

- **OLAP panel is not accessible (Columns only)**: allows you to sort, hide, drag, and drop columns. There is no top Selection pane and there is no access to the OLAP Control Panel.

- **OLAP panel is accessible (Show Panel in Report)**: includes a small OLAP symbol in the lower left to more obviously allow the user to open the OLAP Control Panel. And when you click the square button over a dimension, you open the OLAP Control Panel.

- **Dimension filtering enabled (Show filters on top/bottom)**: adds the OLAP Selections pane to the top (or bottom) of the report. This option is acceptable with a few dimensions and a few levels in each hierarchy. It tends to look messy when you have too many levels within different dimensions. Try it to see the difference between showing dimensions and hierarchies as filters or as tabs.

- **Dimensions grouped in tabs (Show Tabbed)**: for OLAP reports that have multiple dimensions, this option groups the dimension elements under a tab labeled with the dimension name. This is the option that we use.

- **Hide access to the OLAP panel (Columns with panel)**: looks the same as “OLAP panel is not accessible”, but when you click the square button over a dimension, you open the OLAP Control Panel.

**Automatic drill options**:

- **Dimensions**: The user can drill down on a dimension to proceed to the next level down in the hierarchy.

- **Dimensions and Measures**: In addition to drilling down on the dimensions, the user can drill down on the measures within the report. This allows the users to drill down to the lowest level of all displayed hierarchies.

- **None**: The user cannot drill down to a lower level in the hierarchy within the report itself.
10. Click **Save**, save the report with the name **7b - Revenue OLAP report**.

You have now OLAP enabled your report. To summarize, we took a basic report and selected an output option to enable OLAP. This simple selection automatically gives you an enormous amount of analysis capabilities, as you will see in the next section.

### 10.4 Working with an OLAP enabled report

To begin working with the OLAP-enabled report as explained in this tutorial, run your **7b - Revenue OLAP report**. Figure 10-18 shows this report.

Notice the addition of a completely new panel at the top of the report. This is called the **Selection pane**. It includes tabs for every dimension described for any of the tables that are part of the orders cluster. You also have the capability to work with the measures and to create graphs directly from the report.

There are three ways to work with your OLAP data:

- From the report itself
- From the Selections pane
- From the Control Panel

In the report shown in Figure 10-18, you cannot see the control panel. In this example, the control panel starts as hidden or closed. You can open it by clicking the **OLAP** button or by clicking the blue square to the left of the Product Type heading.

---

**Figure 10-18** 7b - Revenue OLAP report
10.4.1 Slicing, dicing, and drilling down for more details

Looking at the report in Figure 10-18 on page 279, notice that the heading for every column either has a blue square or a set of arrows. The blue square allows you to drag and drop the column and to rearrange or pivot it. It also allows you to open up the OLAP Control Panel. The arrows allow you to sort the measures or numeric fields.

**Tip:** When working with an OLAP-enabled report, there are multiple ways to accomplish the same end result.

To use the arrows and buttons to drill down for more details, follow these steps:

1. Because revenue was previously unsorted, neither half of the arrow is dark and the prompt reads sort Revenue. Click the sort arrow to the left of Revenue (Figure 10-19).

   ![Figure 10-19 Sorting a measure](image)

2. Now that you have sorted by revenue, hover over the column again. Notice that the bottom half of the arrow is dark. Click this arrow and sort the column in descending sequence (Figure 10-20).

   ![Figure 10-20 Sorting from highest to lowest](image)

   Right-click the column heading Revenue and select Visualize (Figure 10-21).

   ![Figure 10-21 Revenue context menu](image)
As we saw in Active Reports, selecting Visualize displays bars to help you quickly note trends or easily compare two columns. See Figure 10-22.

**Note:** Positive numbers are visualized with blue bars, while negative numbers are visualized with red bars.

3. Click the **Store Location** tab.

The Store Location tab has a drop-down tab for each element in the hierarchy, proceeding from the top of the hierarchy to the bottom.

By default, each of the drop-down lists contains all the unique values for that column. For example, initially every region in the world is available under the Region tab.

4. To start to filter and drill down on your data, click the **Country** drop-down list and select **United States** (Figure 10-23).

**Tip:** You can select multiple values using the Ctrl or Shift keys.

5. Click the **Region** drop-down list. Notice that the only regions displayed are for the United States. Select the **North** region (Figure 10-24).
6. The filters in the Selection pane do not take effect until you click **Run**. Review your current totals and click **Run** (Figure 10-25).

Your report now shows the revenue and number of orders for the North region in the United States.

![Figure 10-25](image)

7. Notice that immediately to the right of COUNTRY and REGION is an equals sign (=). Click the = button. Each time that you fill in a value you filter your data by creating a WHERE clause. Instead of selecting COUNTRY equal to United States, we can select all countries except the United States by changing the button to not equal. Click the button multiple times to cycle through your choices.

8. Click **Reset** to reset the report back to its initial state. You can also use the back arrow on the browser to go back one page at a time.

9. Click the **Product Info** tab (Figure 10-26).

![Figure 10-26](image)

10. Drill down within the report, not by using the hierarchy tabs. Click **Audio**.

Notice that not only did you drill down from Product Type to the next level of Product Categories within Audio, but DB2 Web Query has also filled in the Selection pane tabs for you (Figure 10-27).
11. Drill down on Amplifiers/PreAmps/Tuner to see the products that compose the Amplifier
category.

Again notice that the drop-down lists have been filled in for you. You can go back and forth
this way between the body of the report and the tabs at the top. See Figure 10-28.
12. Continuing to analyze our data, drill down to see only the Amplifier sales that occurred in January 2011. Click the Order Date Hierarchy tab.

13. For ORDERDATE_YEAR, select 2011. You can then select the quarter or go straight to ORDERDATE_MONTH and select 1 (Figure 10-29).

![Figure 10-29  Selecting values in non-consecutive levels](image)

14. Click Run. Figure 10-30 shows the results of running this report.

![Figure 10-30  Slice of your data (January 2011)](image)

15. Click Reset to start back at the beginning with an unfiltered report.

16. Try drilling down on a measure or total field. Drill down on the Revenue column for Office products (Figure 10-31).

![Figure 10-31  Drilling down on a measure](image)
After drilling on the revenue for office products, the Office product type is expanded to its subcategories and products. The revenue and Count are now grouped at a much more detailed level (Figure 10-32).

17. **Reset** your report now so that all drill-downs are removed.

18. The next request from our users is to generate a report that shows revenue by product type by year.

Drag **ORDERDATE_YEAR** from the Selections pane into the area of the report where you want it (that is, across the top). The plus symbol (+) shows that you are in a valid area in which to drop the field (Figure 10-33).
19. Right-click **Count** and select **Hide** (Figure 10-34).

![Figure 10-34  Hiding a field](image)

20. We now have a pivot table (Figure 10-35).

![Figure 10-35  Pivot report](image)

21. Click **Save** and select **Save the data in an Excel 2000 file with formulas** to save the new Excel file (Figure 10-36). You can also see what happens when you save to a PDF and an Active Report output formats.

![Figure 10-36  Saving an OLAP report](image)
22. We get the Excel format report (Figure 10-37).

![Excel 2000 file with formula](image)

Figure 10-37  Excel 2000 file with formula

23. Our users have changed their minds and decided that they do not want a pivot table. Instead they want to see the year and product type to the left of Revenue.

Drag **ORDERDATE_YEAR** from the Sort across portion of the report to the Sort-By section (Figure 10-38).

![Pivoting a column](image)

Figure 10-38  Pivoting a column

In addition to dragging from the Selection pane area, there are other methods to display additional columns in the report as explained in the following steps.
24. Right-click ORDERDATE_YEAR and select Unhide (Figure 10-39). You see a list of columns that were either part of the initial report or that are in one of the hierarchies. These are the columns that are available for display.

Figure 10-39 Unhiding columns

25. Try the same process for the Revenue field. Right-click Revenue and select Unhide. Notice that you see that only numeric fields are available.

26. Click the down arrow for the Measures tab (Figure 10-40):
   a. You will see a list of all the measures that are available to you in this report. Notice that Count has no check mark. This is because we hid it. To display Count, select it again.
   b. Select Revenue. Notice that you can cycle through the different options for displaying, visualizing, and hiding the measure. We visualize Revenue, display Count, and Run the report again.

Figure 10-40 Measures tab
27. Click the down arrow for the Graph tab (Figure 10-41):
   
a. Select Revenue.

b. Click the icon to the right of Revenue to cycle through the graph types until you come to pie charts.

c. Click Run.

d. Make the pie chart window larger by dragging down the horizontal break line between the graph and the report.

![Figure 10-41 Graphing an OLAP report](image-url)
Notice that there is one pie chart for each year that was your major Sort-By axis. See Figure 10-42.

**Tip:** To control the scope of the graph, use the drop-down lists in the Selection pane. For example, if you only want a graph for 2011 revenue, you can select the year 2011 from the ORDERDATE_YEAR drop-down list.

If the measures in the original report were drill-down capable, then the graph can be drilled into.

![Graph drill down](image)

Drilling down on the graph generates the same report as though you drilled down on the Revenue field in the original report.

28. Experiment with the various options for drilling down and filtering your report. When you are finished, click **Reset** to restore the report to its original values.

**Tip:** If our report has multiple measures that can be graphed, you can graph them on the same chart. You can select each measure for graphing and choose a different graph type. For example, if our report contains profit, you can superimpose a line graph on a bar graph with the line representing the profit and the bar representing revenue.
10.4.2 Manipulating the data using the OLAP Control Panel

Up to this point, we have manipulated the OLAP report through the Selection pane at the top of the report and directly through hyperlinks in the report itself. Now we use the third method for interacting with the data, which is the OLAP Control Panel.

1. Click the **OLAP** button at the bottom of the Selection pane to open the OLAP Control Panel. Alternatively, you can click the blue square next to Product Type.

**Tip:** If your OLAP Control Panel shows the selection criteria pane, click **OK** to return to the view shown in Figure 10-43.

![OLAP Control Panel](image.png)

Although the most frequently used functions are available directly from an OLAP report, the Selection pane, or both, several functions can be performed only from the OLAP Control Panel. The OLAP Control Panel can do everything that can be done from the OLAP report and the Selections pane and more.

The following unique OLAP functions, among others, can be performed only from the OLAP Control Panel:

- Selection of a Top or Bottom n rows report
- Ability to group numeric data by percentile (or decile, quartile, and so on)
- Advanced row selection criteria
- Stacking of multiple measures vertically in a report as opposed to horizontally
2. We want to see our data in columns by quarter:
   a. Expand **Date Dimension**.
   b. Click the **Drill Across** box. When selected, it is surrounded by a blue rectangle.
   c. Click the **ORDERDATE_QUARTER** field. It should appear in the Drill Across box. See Figure 10-44.

   **Tip:** If Quarter appears in the Drill Down box by accident, simply highlight it and use the **Pivot** button to pivot Quarter from rows to columns.

d. Click **Run**.
e. Double-click **Quarter Q1** to drill down to ORDERDATE_MONTH (Figure 10-45).

![Cross-tab drill down](image)

3. Often when you have multiple measures and sort across columns, the report can become wide and unwieldy. Open the OLAP Control Panel and select **Stack Measures** (Figure 10-46). Click **Run**.

![Stack Measures option](image)
There is a potential problem with this report as it stands right now. If the orders table contains data for multiple years, we now have the sales for every Q1 added up together (Figure 10-47). Although this is technically accurate, it probably is not what the user wants to see.

![Figure 10-47   Stacked measures report](image-url)
4. From the OLAP Control Panel, expand **Date Dimension** and select **Values** for ORDERDATE_YEAR (Figure 10-48).

**Note:** For most dimensions, when you click **Values**, you see the list of values from your table. The date components are prefilled in with general dates. If you expand ORDERDATE_MONTH, you see that the actual month names (that is, June) are filled in for ease of use for the user.

5. For ORDERDATE_YEAR, select **2011**.

![Dimensions - Click a Box to Add](image)

6. At this point you can click **Run**. However, for demonstration purposes, click **OK** to see the full Selection Criteria pane.
7. In the Selection Criteria pane (Figure 10-49), notice that Q1 is prefilled in for ORDERDATE QUARTER because we drilled down and selected Q1 prior to opening the control panel.

If you use the scroll bar on the right, you see all the various dimensions and their individual elements or columns that were available through the tabs in the Selection pane. You can continue to filter your data here.

If you want to filter on Product Type, you have two choices. You can click the down arrow next to Product Type or you can click **Select**. In both cases, you see a list of all the unique values for Product Type. Using the Select button takes you to a second window. This is easier to use when you are selecting multiple values.

Again, when filtering, you can modify the operand for each filtered column. Here we do not filter on Product Type.

Click **Run**.
Figure 10-50 shows the output of running the report.

**Note:** Best practice states that you should always display any filters in effect on a report. DB2 Web Query has the capability from the OLAP Control Panel to document your filters at the beginning or end of your report.

8. If you are still on the Selection pane in the OLAP Control Panel, click **OK** to return to the initial layout. Notice that you can click **Selection Criteria** in the bottom right of the Control Panel to return directly to the Selection Criteria layout.
9. In the Measures pane (Figure 10-51) select the **Revenue** check box. Then click the **Revenue** name.

*Figure 10-51  Measures pane*
10. In the Revenue pane (Figure 10-52), if we want to see a Top 3 analysis report:

- a. Select the Sort check box.
- b. Select High to Low.
- c. Select the Rank (1, 2, 3...) check box.
- d. For Highest, select 3.
- e. For Measure Calculations, keep the default of None.

![Figure 10-52 Top 3 OLAP report](image)

Notice that if you expand Measure Calculations, you can ask to see the Revenue column in multiple ways. For example, you can ask to see each Revenue as a percentage of the product type revenue in that quarter (Row Percent). You can ask to see the average revenue per order, and much more.

**Tip:** If you want to see a report that shows your bottom Products by revenue, sort from low to high and then rank and select your top three.
Assignment #8: Building documents and dashboards

This chapter discusses techniques used to create documents that contain groups of reports or charts, sometimes referred to as dashboards or scorecards. Such documents can serve as a means of providing centralized reporting. These documents can be used to present information to clients for monitoring daily business activity, viewing key metrics, spotting trends, or as a trigger to initiate actions for business improvement.

**Prerequisites:** Before starting this chapter, make sure the following steps have already been completed:

- Chapter 3, “Creating and editing metadata: Century database” on page 33.
- Chapter 4, “Assignment #1: Summary reports” on page 47. because we will use 1a - Revenue Summary by Product Category and 1c - Revenue Summary with Subtotals reports, which are created in this chapter.
11.1 Documents and dashboards

In this section, we conceptually define dashboards and explore documents created with DB2 Web Query, using the sample data provided with the product.

11.1.1 Prerequisites

The exercises to be performed in the following section utilize data from the QWQCENT library which installs with the DB2 Web Query product. Before going further with this chapter, you should create a folder under the Century Electronics folder and name it: “Assignment 08 - Building Documents and Dashboards”. Place your work from this chapter into this folder.

11.1.2 What a dashboard is

A driver uses the instrumentation in a vehicle to monitor speed, fuel levels, engine temperature, or the general health of the vehicle. Increasingly, with modern GPS equipment, a driver will also monitor progress towards the destination. In the same way, a dashboard developed with DB2 Web Query may be used to monitor key metrics associated with the performance and objectives of a business.

In the past, Query/400 and other information reporting tools were frequently used to prepare end-of-the-month reports about business performance and goal achievement. Staying with the car analogy, this could be likened to using the rear view mirror. Using such reports, we know where we have been but perhaps not how we are moving forward toward the business goals. Today businesses want to look forward as well as backward. Dashboards and key performance indicators (KPIs) are a way to present periodic and/or real-time analysis of business achievement. Furthermore, with the advent of tablet computers and smart phones, many business leaders seek to place dashboards on these popular devices.

11.1.3 Developing KPIs

Every business is different, but KPIs in general might take the following forms:

- Current status of a metric
- Trend analysis of a metric over time
- Geographic analysis to see performance by regions
- Comparison of a metric to the same metric in a prior period
- Forecasting of a metric into the future

11.1.4 Business leader requests

Dan has heard from his colleagues at the country club that BI dashboards are a top priority for many of today’s CIOs. Consequently, he is eager to have a dashboard for use by the Century Electronics executive staff and their sales teams. His vision is to create a sales information dashboard to expose elements of profitability, delivery performance, and order status.
In Figure 11-1, we show an example of a dashboard containing several measures of sales performance for the Century product types. This dashboard is developed as a document in DB2 Web Query and shows various charts and reports giving several different views of Product Type information.

![Product Sales Information Dashboard](Image)

**Figure 11-1 Example Document containing charts and report**

### 11.1.5 Creating a dashboard document with Info Assist

There are several ways within DB2 Web Query to group charts or reports together into a document or dashboard:

- Create a new document and within it, create one or more charts or reports.
- Create a chart, then import it into a new document using **Insert**, and **Existing chart**.
- Create charts or reports and then use the BI portal **Pages** feature to allow users to combine various charts or reports on a page for themselves.

There is **no single right approach**. The approach you implement will depend upon choices made in your organization combined with the abilities of your developers and users. We recommend that you choose the one that best fits your circumstances.

There may be some benefits and reuse of charts by creating the chart externally and incorporating the completed chart into a document. Using this technique will enable users and developers to more easily incorporate a chart in more than one document or page.

### 11.1.6 Viewing business data on popular devices

The proliferation of tablets and smart phones provides the opportunity for mobile users to receive and utilize business information on the go. In Figure 11-2, you can see the same document shown before, when used as a PDF document on a couple of mobile devices. Other chapters for this guide will discuss mobility options in more detail.
11.2 Creating a document, adding an internally defined chart

In this section, we start from a blank canvas of a new document and create a chart inside that document. This document will form the basis for a dashboard containing several reports or charts. In this first example, the chart is defined as a part of the document and, when complete, will not show as an object in the folder where the document resides.

11.2.1 Starting a new document

Follow the steps outlined here to create a new document and define a chart internally to that document:

1. Create a new folder under Century Electronics folder named “Assignment 08 - Building Documents and Dashboards”. To do this, right-click in Century Electronics folder and select New → Folder. Click OK after you fill in the folder name field.

2. On the Web Query main menu, right-click the target folder and select New and then Document as shown in Figure 11-3.
3. Info Assist will open in a new window and prompt you for the name of a data source within the metadata created for the QW QCENT library. Locate the synonym named CEN_ORDERS, which we will use to create a chart depicting the margin percentage for the various product types. Select CEN_ORDERS and click OK as shown in Figure 11-4.

4. After selecting CEN_ORDERS, Info Assist will present a blank canvas area on the main window. Click Home and select HTML as the output type as shown in Figure 11-5.
11.2.2 Adding a chart

Proceed as follows:

1. Click **Insert** and select **Chart** to add a chart to the canvas as shown in Figure 11-6.

![Figure 11-6 Inserting a chart](image)

11.2.3 Manipulating fields for the chart

Proceed as follows:

1. Once the chart widget is on the canvas, you can begin to drag fields to the query area to populate the X and Y axis. In our example, we need to manipulate the data slightly to get the best presentation. We will create two additional fields from the input data. Click **Data** on the menu to bring up the **Detail** and **Summary** icons as shown in Figure 11-7. Click **Detail** or **Summary** to create a new field as discussed below. Also, note that the topic of when to select detail versus summary has been covered in more depth elsewhere in this book.
2. Whenever you calculate a field, a computation box will appear. In this box, you can work with the fields from your data source as well as a variety of built-in functions. These functions enable you to transform data from one data type to another, convert character to numeric, perform date arithmetic, extract portions of dates or times, concatenate character data fields, and carry out many other useful processes.

a. MarginPct will be calculated in this report as a Summary (COMPUTE) field to generate a total margin percentage for the aggregate data for each Product Type. As shown in Figure 11-8, use the equation:

\[
\text{MarginPCT} = \frac{(\text{Revenue} - \text{CostofGoodsSold})}{\text{CostofGoodsSold}}
\]

Double-click each data field to add it to the compute box and then formulate the correct equation. Click OK when the formula is complete. When you compute a field at the summary level, it usually moves automatically to the query measures area.

Note: Be aware that computations done in the report are only viewed in the subject report. For a computation to be viewed globally in all reports, the best practice is to enter the calculation within the metadata. In this way, calculations are centralized, correctly performed with mistakes minimized, and formulas do not need to be re-done in each report.
b. Period will be calculated as a Detail (DEFINE) field for use on the x-axis in the format YYYY-MM so that year and month are more readable and sortable. As shown in Figure 11-9, use the equation:

\[ \text{Period} = \text{EDIT(Orderdate\_Year)} \| \, {}^-{} \| \, \text{EDIT(Orderdate\_Month)}. \]

For the Period, use the EDIT( ) function as shown to convert the number fields for year and month to alpha fields with leading zeros. This is similar to the DIGITS function in SQL. Concatenate the YYYY to MM by using the double vertical bars || and insert the dash "-" character between the parts.

![Figure 11-9 Calculating Period from Order date fields](image)

**Note:** For more documentation on the Web Query built-in functions, refer to either the help on the Web Query login panel or the help in the Developer Workbench. Either source has extensive online help, definitions, and examples of function usage.

3. Adding the computed fields to the chart is a simple drag and drop. Highlight your chart and notice that the Query area has sections called Measure, X-axis, and Legend. Drag the fields to the Query area as defined here, and when done, your Query area should look like Figure 11-10:

a. Drag **Period** over to **X-axis** and drop it there.

b. Drag **ProductType** to **Legend** and drop it there.

c. Verify that **MarginPCT** is already listed under measures in the Query area.

![Figure 11-10 Completed Query area](image)
11.2.4 Making layout changes to improve the look of the chart

To make these changes, proceed as follows:

1. Your chart will reformat to depict the data you have added, but we want to show a line chart, and your chart is probably still showing a bar chart. To change from bar to line, click **Format** and **Line** on the ribbon menu. Then click **Run** and see if your chart looks like that in Figure 11-11.

![Figure 11-11 Selecting a line chart](image)

2. We are almost done, but a couple of steps will make the resulting graph more pleasing to view:
   a. First, click **Layout → Orientation** and change from **Portrait** to **Landscape** as shown in Figure 11-12.

![Figure 11-12 Orientation options](image)
b. Next, click the dates (example: 2012-01) on the date axis of the chart. A bold box will appear around the dates. Right-click a date and select Rotate \(\rightarrow\) 45 from the menu (Figure 11-13).

![Figure 11-13  Rotating axis labels to 45 degrees](image)

Figure 11-13  Rotating axis labels to 45 degrees


c. Finally, click the blank area of the canvas, then click Insert \(\rightarrow\) Text Box on the menu. A box will appear and your result will look as shown in Figure 11-14.

![Figure 11-14  Inserting descriptive text into canvas](image)

Figure 11-14  Inserting descriptive text into canvas

Drag the text box away from your chart area so you can size it to be wider and shorter in height than its default size. Tap by double-clicking as indicated and type the words, Average Margin by Period. Change the text color to blue, using the menu above the text field. Using the field handles, drag the text description to a position just above the chart (Figure 11-14).
d. Add one more Text Box to the canvas and type the words Product Sales Information Dashboard. Again, using the text box menu, make the text bold, color blue, and change its font size to 18. Center this text on the canvas above your chart and the other descriptive text.

e. Click Run to see your completed chart in action. Your result should look like Figure 11-16.
Congratulations on completing this document. As we move along in this chapter, you will see how to drop additional charts or reports into the document, creating a dashboard of useful information.

Save the document to your Century folder, naming it 8a - Document Dashboard.

11.3 Adding existing reports and charts to a document

When a number of charts and reports have already been developed, it is easy to add them to an existing document to make a compound document, which we may refer to as a dashboard. When the dashboard is opened, all the reports or charts contained within it are executed to provide current data views. When adding existing objects to a document, note that the term **Existing Report** is used to mean any Web Query procedure (technical term is a FEX file), whether it generates a chart or report when executed.

In this section, we will build on the previous example, using our document which already contains one chart within it. We will add several more charts to create a dashboard. Use the following steps to add an existing chart inside your document.

11.3.1 Opening the existing document

Locate your document from the previous section and open it for editing by right-clicking the document and selecting **Edit** from the menu as shown in Figure 11-17.

![Figure 11-17 Opening an existing document](image-url)
11.3.2 Inserting an existing report

When you initially open the document, you will see the chart you previously created and the data source information related to that chart. You can see this in Figure 11-18.
The first chart may be highlighted with handles showing. If so, click the canvas outside of the chart area to turn off these handles as shown in Figure 11-19.
Do the following steps to add a previously created chart to your document:

1. Click somewhere in the blank area, outside any charts.

2. Click **Insert** and then click **Existing Report**. The existing report option will prompt you to select an existing procedure. Open folder **Assignment 04 - Charting** and select the gauge chart named **4d - Gauge Chart: OTD overall** as shown in Figure 11-20 and click **Open** to add the chart and make the data source available.

![Figure 11-20 Selecting existing gauge chart into the document](image)

3. Figure 11-21 shows the new chart widget added to the panel. Drag the gauge widget away from the initial chart and place it somewhere in the white space of the canvas. Right-click the gauge, selecting **Size and Position** to adjust the size to 2 inches by 2 inches, then click **OK**.
4. The chart is ready to run, but we also need to insert a text box as a label above the new chart. Click **Insert → Text Box** and move the resulting box above the gauge chart. Change the label to be blue and type the text *On time Delivery overall* in the box. Size the box as appropriate so that it is above but not overlapping the chart. Align the charts and their titles by selecting each object and moving it to the desired position. Click **Run** to see your work execute, and it should appear as in Figure 11-22.
5. Save your document to your folder by clicking the Save icon as shown in Figure 11-23.

![Figure 11-23 Saving your document](image)

**Tip:** Whenever you have multiple objects on the canvas, it is natural to want to align them in some way. Using the **Layout** and **Align** menu options, you can select multiple objects with **Shift-Click** and align them to the top, right, left, or bottom to achieve the desired look and feel in your document.

Let us review what you have accomplished. You should have a document with two charts inside, aligned in the top row, with titles above each and an overall title at the top. The Margin chart is defined internally and the On-Time Delivery chart is defined externally, then simply added as an existing report. In the following section, we will add more charts to this document dashboard.

### 11.3.3 Inserting more charts or reports into an existing document

In this section, we repeat the steps used in the prior section to add three more charts and a report to the canvas. Open your document again and locate the three objects highlighted in the following Figure 11-24.

Remember, the steps are as follows:

1. Click **Insert**.
2. Click **Existing Report**.
3. Drag the inserted chart to the desired location.
4. Set the size of the chart using either its handles or with the layout menu size fields.
5. Add a text box to describe your chart, color it blue, and set the font size and align the text adjacent to your chart. Use the same font for all descriptive text.

![Figure 11-24 Existing reports to be added to the document](image)
6. One by one, using **Insert** and **Existing Report**, select each procedure to add them to your canvas. The resulting canvas should look something like that shown in Figure 11-25. Initially, all charts overlay the upper left one. We need to spread them out but we do not really have enough room to fit all these charts on the page, do we? The solution is to either make the charts smaller, or make the canvas larger. By changing from Letter to Legal, the charts can be spread across the document more evenly.

![Figure 11-25](image)

*Figure 11-25  Reports added to panel - work in progress*
7. On the menu, click **Layout → Size** and switch Letter to Legal, giving additional space on the right of the canvas. Drag your charts into position and add the text to describe each. With the object handles selected by pressing and holding keyboard Shift while clicking each object, your result should look like the following example in Figure 11-26. You can better see whether charts will overlap by showing the handles of each. Arrange them as best you can to avoid overlap and save your work at this time.

![Figure 11-26  Nearly completed document with added charts](image)

Chapter 11. Assignment #8: Building documents and dashboards  319
8. By adding a final report, your dashboard will be completed and should appear similar to the picture earlier in this chapter. In your open document, click **Insert → Report**. This will generate a box on the canvas requesting you to "drag and drop fields to the canvas" as seen in Figure 11-27. In the Data panel on the left of your panel, locate fields under the CEN_ORDERS data area, selecting Product Type, Revenue and Returns. Hold the CTRL key while selecting these three fields. Once they are selected, drag them to the canvas. Dropping them on the box there should capture all three fields for your report.

![Figure 11-27  Building a new report inside the document](image)
9. Also drag the fields ORDERDATE_YEAR from the Data area to the Across section of the Query area. The three fields ProductType, Revenue, and Returns will populate the box in the order they were selected and Orderdate will be on the top as seen in Figure 11-28.

![Figure 11-28 Manipulating the Query area to control report output](image)

Now do the following steps to complete your report:

1. Drag your report box to the lower left of the canvas so it does not overlap any of the other objects. Leave space for a title above as you did before.

2. Arrange the report so that you leave space for it to become wider when executed with all the data existing in the database.

3. Using the alignment steps discussed earlier, align the two items in the bottom row.

4. Insert a blue title above your Revenue report with the words **Revenue and Returns by Product type**.

5. Optionally, you can choose to add a company logo to the document. Click **Insert → Image** to place a logo on the canvas. Images for logos must first be uploaded to the reporting server before being used in the designer. To do this, simply copy or move your image to the same application folder which contains your metadata (synonyms).

6. Click **Run** to view your report, which should resemble Figure 11-29.

7. **Save** your work again.
Congratulations! You have created a dashboard for Product Sales Information. You can publish this from the DB2 Web Query BI Portal so that other users can view it.
Assignment #9: Exploring and comparing other dashboard options

In previous chapters, we introduced the concepts of documents and how they can be formatted in ways to create grouping of business information or dashboards. DB2 Web Query has additional options to create dashboards and documents of a more complex nature. In this chapter, we provide examples of a few other techniques for presenting business data.
12.1 Additional features of Web Query for documents

There are several approaches available in DB2 Web Query to create interactive documents for use in dashboards. Depending upon your requirements, for example, you might want to allow the user to prompt for a key value, such as country or region, to enable selection of metrics for one geography at the time. Or, you might want to give the user even more control over what metrics they see, through use of several selection fields, date ranges, checkboxes and other forms controls.

Dan liked the dashboard you created in the previous assignment, but he was looking for something more in terms of more features and flexibility when selecting the data to query, providing more features that are available to runtime users, and Century Electronics also has a number of analysts that rely heavily on Excel spreadsheets. Dan would like for you to determine if this tool could be integrated with DB2 Web Query to deliver dashboards for that group of users.

In this chapter, we explore several examples of such interactions:

- A coordinated document: Allows run-time selection of one element.
- A document using a combination box form control (drop-down list) to control data selection
- The BI portal pages: User managed selection of reports, charts or documents via “Pages” within the BI portal of Web Query.
- HTML Launch pages: The HTML Composer feature of DB2 Web Query Developer Workbench is a powerful development environment used to create and customize dashboards.
- The Spreadsheet Client: This enables DB2 Web Query content integration into an existing Microsoft Excel spreadsheet.

12.1.1 Prerequisites

Before going further with this chapter, you should create a folder under the Century Electronics folder and name it: “Assignment 09 - Exploring and comparing other Dashboard options”. Place your work from this chapter into this folder.

12.2 A coordinated document

A coordinated document is designed from a single grouping of metadata using one synonym as a single data source. The requirement to have all reports and charts work off the same data exists because the coordination feature seeks to make the data views act in unison when a change is made to the coordinated field. Due to the coordinated feature, all reports are internal to the document, meaning that they are defined on the canvas, in the document. Externally defined reports, inserted as existing reports, would not participate in the coordinated feature.
Suppose you need to create a dashboard to show sales information by country. The country field would be the coordinating field and each chart or report in the document will specify country under the Coordinated section of the Query area. At runtime, the coordinated field will appear across the top of the window as shown in Figure 12-1. As the user changes the Country value, the reports and charts change simultaneously, showing the applicable country information in each. This is a powerful technique depicted in the Web Query document named 9a - Coordinated Document - Country.

Figure 12-1   Coordinated chart

The major steps in creating this coordinated chart are as follows:

1. Open a new document.
2. Select the CEN_ORDERS data source. It will be shared by all charts and reports included in this document.
3. Insert a report, line chart, and two pie charts into your document, placing them as shown in the example above. Click the report and drag the appropriate dimension fields to the query area and the Country field to the coordinated area.
4. For the remaining charts, drag the dimensions and measures to the respective parts of the Query area and verify that Country is under coordinated for each chart.
5. Add any descriptive text and company logo information that is appropriate.
6. Click the Format tab and select “Active Report” or “Active Flash” or “Active PDF”.
7. Save your document as 9a - Coordinated Document - Country.
All reports and charts will share the common dimensions and measures from CEN_ORDERS as seen in Figure 12-2 and Figure 12-3.

![Figure 12-2 Available Dimensions](image1)

![Figure 12-3 Available Measures](image2)

The query area for the **Revenue by Product Type** report looks like Figure 12-4. The important part of this figure is the presence of Country under Coordinated. This drives Country to be used as a key selection field at the top of the panel and also causes the other charts and reports to change when Country changes.
Chapter 12. Assignment #9: Exploring and comparing other dashboard options

Figure 12-4  Revenue by Product Type - report

Use Figure 12-5 to establish the query area for the Revenue line chart.

Figure 12-5  Revenue History - line chart

Use Figure 12-6 to establish the query area for the Profit pie chart.

Figure 12-6  Profit Breakdown by Product Type - Pie chart

Finally, use Figure 12-7 to establish the query area for the Warranty pie chart.

Figure 12-7  Warranty Analysis - Pie Chart
Even though the Reports, Pie Charts and Line/Bar charts represent data differently, they will all specify Country under coordinated and therefore react at the same time when the Country value is changed.

Once you have completed one Coordinated document and saved it, you may easily extend the concept to other measures. As an example of this, open your document **9a - Coordinated Document - Country** for editing, change the coordinating field from Country to Store Name. Verify that Store Name has replaced Country in the Query area settings of each chart. Using the menu’s Save As feature, give this document the new name **9b - Coordinated Document - Store Name**. Now you can run these documents to see sales information by either Country or Store Name.

### 12.3 Creating documents with Form Control fields.

Info Assist also has the ability to create what are called Active documents, where fields on the canvas are linked to the charts and reports in the document. The term *Active* refers to the output type. The active form controls will only appear in your document if you select Active Report, Active PDF, or Active Flash as the output type. Or, stated another way, when using form controls, the output type is limited to one of the Active Report types.

In prior examples, we have used HTML output. When you add fields to the document, you will see that the output type is constrained to one of the Active Report types as shown in Figure 12-8.

![Figure 12-8  Active document output types and others no longer available](image)
The form controls can control one or more reports and charts. The example in Figure 12-9 shows such a chart which mimics the Country chart previously created but does not use the Coordinated feature. Instead the Country is selected from a drop-down list and the charts are linked with the changed value.

![Figure 12-9 Selection example by Country](image)

The reports and graphs are created inside the document and an active control combination box from the Info Assist menu is added to the document and associated with the charts and reports. The selection of DB2 Web Query form controls available is shown in Figure 12-10.

![Figure 12-10 Available controls to place on the canvas](image)

Whenever the value of the drop-down list value for Country is changed, the reports linked to it are reformatted to depict the new value. There is an important distinction between a coordinated document and a document with form controls. A document can contain both charts that are controlled, and charts that are NOT controlled. There may be some creative reasons why you want to do this. Perhaps a drop-down list on the left side of your dashboard controls charts there, while a drop-down list on the right controls a different set of charts.
We will leave it to your imagination to create complex dashboards combining charts, reports, and form controls after reviewing the steps to create such a document.

Proceed as follows:

1. Open the previously created document named “9b - Coordinated Document - Store Name” for editing and immediately save as to the new name 9c - Country Document with Form Control Field.
2. Click the Revenue report.
3. In the Query area, delete the Country field from under coordinated.
4. Drag the country dimension from under CEN_ORDERS to the Revenue report and insert it as the first, left-most field.
5. Click the Insert menu and click Drop Down to add a combination box control to the canvas. Move this to the top left of the panel. Your result should now look like Figure 12-11. Note the combination box is visible, the report has country first and the query area has country under the By section.

![Figure 12-11 Formatted document with charts and form control inserted](image)

6. Select the combination box, right-click it and select Properties from the menu. You will see a dialog enabling you to configure the combo box to control reports in your document. Figure 12-12 shows the initial settings for this dialog.
7. Turn off the check box marked “Include all” which removes the option of user seeing ALL in the drop-down list.
To configure the combination box to control your data, select the name `combobox_1` on the left under Prompts, select `table_1` under Reports, and select Country under Fields. Hold shift and click each of the names under the Candidates column. When you have selected them all, use the movement arrow icon to move your reports and charts from left to right, changing them from Candidates to Targets. This accomplishes the linkage to make these four reporting objects react to the changes in the combination box, as you change from one country to another. Figure 12-13 on page 331 shows the resulting settings for this dialog.

After using the selection arrows to move all charts from the Candidates area to the Targets area, click OK to save these settings.
Settings in the query area for each element are as follows in Figure 12-14. Pie charts may need to change from the initial settings because pie charts have category and slices whereas bar and line charts have the x/y axis. Verify the pie charts have Country and Product Type under Category.

![Figure 12-14](image-url) Left to right - Revenue report, Revenue line chart, Profit pie chart, Warranty pie chart

Click Run to view your work. Your panel should look like the screen capture in Figure 12-15; save your work.

![Figure 12-15](image-url) Completed document with Country form control
What if we added another controlling field, such as Store Name? Some rearranging of the panel, due to space constraints, would be required, however, you can see the point. We can build reports of increasing complexity and offer users more self-service choices by adding form controls for selection to the panel. See Figure 12-16.

**Note:** At the time of publishing, each time you first run this chart, the display defaults to ALL, even though a country name shows in the drop-down list. You must select a country, and the change action will show only the data for that country for this and subsequent country selections.
The introduction of additional form controls that work together introduces the need for cascading logic. Web Query handles this on the same panel where you configured `combobox_1` to control the various charts. At the top of the panel, when you have added more than one form control to the canvas, you will see that a button for Cascades has become available. Clicking this button yields the panel shown in Figure 12-17, where you can order the logic of related form controls. In this case, `cascade1` is going to control both `combobox_1` and `combobox_2` in that order. Clicking `Prompt Sources & Targets` returns to the panel where you linked the controls to the graphical objects.

![Figure 12-17 Illustrating Cascades button availability for more than one form control](image)

**Tip:** Drop-downs, lists, radio button groups, and check box groups all work similarly and require the same configuration to link them to charts or reports. When used in combination, you will have to decide whether the cascading feature is required or whether they operate independently of each other.

### 12.4 Self-service dashboards using the BI Portal

The Web Query home page acts as both a main menu and a portal. It is designed to allow business analysts and developers to create BI resources and publish them for users to consume. The portal provides a couple different ways for users to access these pre-created resources. In this section, we will review these approaches for selecting previously created reports. This section will not delve into security matters but remember that users will see only those items for which they have been granted access and they also need appropriate database security permissions in order to view data in Web Query reports and charts.

Access is obtained by logging in and selecting (or running) objects that have been published. We will review selecting published reports, adding to favorites or mobile favorites groupings, and building a personal portal of business information.
12.4.1 Favorites and Mobile Favorites

When a user logs on to Web Query, a panel similar to that in Figure 12-18 is the first one displayed. A client will use the DB2 Web Query area to develop BI content, creating folders that contain published items, developer folders or maybe company level folders. Once content is developed and published, users may then add this content to their Favorites and/or Mobile Favorites areas for frequent access. The Recent Items area will also contain a list of those reports previously used.

![Figure 12-18  Web Query areas](image)

Any report can be added to the Favorites by right-clicking it and selecting Add to Favorites (or Add to Mobile Favorites) as shown in the menu in Figure 12-19.

![Figure 12-19  Adding a query to the Favorites areas](image)
When the user expands any of these Favorite areas, they see items that they previously saved there, as shown in Figure 12-20. A double-click action on the item will run the subject query.

Figure 12-20  Executing favorite chart

Favorites and Mobile Favorites work similarly by storing links to any reports that the user likes and has decided to save for future viewing. This is a very handy feature which will be demonstrated in more depth in the Going Mobile chapter.
12.4.2 Creating a Personal BI Portal

Another important feature of Web Query is the ability to create a user-named tab page adjacent to the login page. This enables a user to select multiple reports and combine/arrange them on a single panel. We will run through the steps to create a dashboard on the fly using this technique. The steps are as follows:

1. On the web Query portal page, select the icon to the right of the Reporting tab as shown in Figure 12-21 below. This will cause a new tab to be created named Page N, where N is the next available page number. The page can be renamed as desired with a right-click and Rename action.

![Figure 12-21 Initiating a new tab page on the portal](image)

2. Once the new page is added, you should select a page layout style. There are several choices for page layout but if you think of the page as a piece of paper divided into quadrants, you can drop a chart in each of the squares. The Page Layout option allows you to specify how many squares you want on your page. What you select will depend mostly on the size of your charts and reports. Right-click the new tab, select Page Layout from the menu and from the resulting pop-up menu, select Four Columns as shown in Figure 12-22.

![Figure 12-22 Selecting page layout](image)
3. When you create the new page and a page layout, the Web Query Resources window will be added to the right of your panel. From this panel, you can drag and drop your favorite reports to the new page. Each time you do so, the resulting report box will snap into place as shown in Figure 12-23. Adding a second third and fourth is just as easy.

4. When viewing your portal page, if the Resources window is not visible, you may select it by clicking the Resources link on the upper right of your Web Query window.

5. Select three of your favorite reports and try this now. You will end up with a customized portal page containing your charts displayed together as shown in Figure 12-24. Depending upon your screen resolution, you might fit a number of items on the page easily. Here are a few points about the arrangement of these charts:

- Web Query will remember this layout and generate this page each time you return to your portal page. When you exit Web Query from your portal page, it will reopen to the same place next time you log in.

- You can minimize, maximize, or hide each of these charts independently as needed by right-clicking the icon that appears in the upper right of each chart as you roll your mouse pointer over the header frame.

- You can rearrange the charts in your window by dragging the header bar to a new location on the canvas of the window.

- You can use the portal tab menu to restore content that you previously hid via the Hide menu option.

- You can create more than one page to handle different companies, topics or categories. Rename each tab by using the tab menu and selecting the Rename action.
To remove a chart from view, click the header menu and select Delete or Hide. This does NOT delete the chart from Web Query, just removes it from your portal page as shown in Figure 12-25.

As you can see, the BI portal pages enable an excellent self-service approach for making an inventory of charts and reports available to consumers. The portal may allow a practice to have your business analysts create reports, publish them and then notify the target audience of their existence. Each user has the flexibility to select those reports that interest them, to which they are authorized and then they can arrange them in a convenient format for daily viewing.
In Figure 12-26, you can see the result of the Single area selection with various charts arranged manually.

Tip: While selecting a page layout containing One, Two, Three, or Four columns causes the “snap into place” behavior in the Portal, the Single Area selection enables you to manually size and shape each chart and place them wherever you choose on the canvas.

In Figure 12-26, you can see the result of the Single area selection with various charts arranged manually.

12.5 DB2 Web Query Developer Workbench

Developer Workbench provides an integrated development environment (IDE) for building and maintaining a DB2 Web Query reporting environment. In addition to providing an HTML Composer editor to develop sophisticated reports, the Developer Workbench includes additional tools to work with metadata.

The Synonym Editor allows you to change the way in which a field is displayed to the users. You can add descriptions, control data presentation such as commas and decimal signs, convert date formats, convert alpha to numeric fields, or even change the length of a field. The Synonym Editor also allows you to create calculated fields for users. You can predefine joins for the users or create business views that simplify the structure and number of columns that the user sees. If you plan on using the online analytical processing (OLAP) feature, you must define your hierarchies or dimensions with Developer Workbench.

Using the metadata layer, Developer Workbench provides the ability to perform impact analysis at both a file level and a field level. If you must make changes to a field, you can see which reports and graphs use that field and the business views of which it is part.
12.5.1 Why you would use Developer Workbench

These are some possible reasons to use Developer Workbench:

1. Editing metadata and profiling your data
2. Creating documents with customized style sheets, logos, and formatting, perhaps to conform to corporate standards for a web-portal look and feel
3. Going beyond what Info Assist can presently handle in compound documents or coordinated documents
4. Using advanced features such as incorporating Goggle Maps APIs in your document
5. Combining data from many data sources in some unique way
6. Importing SQL

Developer Workbench provides the capability to profile your data. Profiling allows you to see patterns in the text characters. For example, profiling telephone numbers in the Stores table might show us that five records have a format of nine numeric characters instead of 10. We might want to know if these five records are a quality problem. Data profiling also shows the minimum and maximum values in a column and identifies the outliers.

The SQL Wizard allows you to import SQL into Information Assistant.

One of the major tools within Developer Workbench is the HTML Composer component. HTML Composer is specifically designed to create HTML pages that can contain compound reports or dashboards. You can find a complete tutorial for this component later in this chapter.

Before you begin using Developer Workbench, you must first perform several configuration steps. These steps are documented in Appendix D, “Configuring Developer Workbench” on page 851.

12.6 Dashboard using HTML Composer

HTML Composer is a component of Developer Workbench, and is specifically designed, as the name suggests, to design HTML pages. HTML Composer does not create reports or graphs, but rather references existing ones. You can create compound reports with background style sheets and add company logos and other standard HTML components. The design of the HTML page can be set to match your company’s intranet standards.

Both HTML Composer and Info Assist can create compound reports. Info Assist is architected for PDF and Active Report output. It can also create other types of output such as HTML pages. HTML Composer is architected for HTML pages. It can only create HTML pages. It cannot create a PDF report. The products have different user interfaces. You have already tried Info Assist. In this tutorial, you try HTML Composer. Then you can choose the option that fits your company’s needs the best.

In this tutorial, we design an HTML page that is a compound report with a single input parameter. This style of report can be used as the basis for key performance indicator (KPI) dashboards where the user might request the KPIs for a specific country, product type, and so on. This type of report is often designed by IT and deployed to senior management and executives within a company.
12.6.1 Comparison between Info Assist and HTML Composer

Before getting into the details of using HTML Composer, it is relevant to discuss why this technology would be used instead of, or in conjunction with, Info Assist. Info Assist is designed for developers, business analysts and users with proper skill set. HTML Composer is perhaps more of an IDE that suits the IT professional or advanced analyst. As we compare the capabilities of the two development tools, each has strengths:

**HTML Composer advantages**

This tool has the following advantages:

- Provides an interface to embed Java Script for field validation/transformation (data editing, convert input to upper case) before hitting the server (good for performance)
- Advanced parameter chaining controls
- Nice features such as populate drop-down with one field but actually pass another field to the FEX procedure (select store name but pass store code to FEX for filtering)
- Faster population of dynamic prompt controls (drop-down lists)
- Flexible user interface with more developer control of the presentation
- Can provide the user a nicer interface for entering parameters (date pickers). Analogous to building CL commands to front end RPG/CL programs (rather than have users call programs and specify parameters somewhat blindly)
- Can use meta tags/java script to auto refresh at specified interval
- All in all, a more advanced tool with more controls, but again, the output generated is HTML only

**Info Assist advantages**

This tool has the following advantages:

- Generates FEX procedures which can be invoked from the SDK/Application extension. Only way to call a compound doc/dashboard from these interfaces. SDK cannot invoke HTML launch page generated by HTML Composer.
- Easy to switch output types, specifying formats like Active Flash, PDF or Excel.
- Includes powerful Slicer capability without any programming by the report designer
- Probably a higher level of “ease of use” in the Info Assist component
- No other software is required, no code required - a case of complexity vs. simplicity

12.6.2 Compound parameterized report (HTML1_KPI)

In the first exercise, using two graphs and one report, we add a common parameter and bring them together on one HTML page for the user. Figure 12-27 shows the final output page.

Before going further with this chapter, you should verify that a folder under the Century Electronics folder exists named: “Assignment 09 - Exploring and comparing other Dashboard options”. Place your work from this chapter into this folder.
12.6.3 Preparing the charts for HTML Composer

You can launch Info Assistant from either Developer Workbench or the DB2 Web Query home page. In this tutorial, we do all our work from Developer Workbench.

In 12.5, “DB2 Web Query Developer Workbench” on page 340, we introduce the two main functional areas of Developer Workbench. The first leg of the explorer tree expands through Data Servers to allow you to work with your metadata. The second branch expands down through the site folder tree where your DB2 Web Query production and development resources are located. Both the web-based DB2 Web Query home page and the Developer Workbench allow you to work with the folders in your domains.
In this section, you will use the skills you learned from other chapters to create three reports. All reports on our KPI page need to have product type as an input parameter, in order to have the proper parameter linkage. We will create each of the reports to accept this parameter and save them under the following titles:

- 9d - Revenue Trend over time
- 9e - Revenue by Product Type
- 9f - Revenue report

**Generic term report:** The generic term *report* is used for both text reports and graphs. It is also used to refer to the completed HTML page. In the first exercise, the completed HTML page is a compound report.

Follow these steps:

1. Open Developer Workbench. You see WebFOCUS Environments under Developer Studio Desktop. You may or may not see Windows Desktop.

2. Expand **WebFOCUS Environments** → **your environment** → **Repository** → **Century_Electronics** → **Assignment_09_-_Exploring_and_comparing_other_Dashboard_options**.

3. Right-click your Century Electronics folder and click **New** → **Procedure** using Info Assist to launch the development tool. See Figure 12-28.

![Figure 12-28 Workbench tree]

**Figure 12-28** Workbench tree
4. When Info Assist opens, select the **Build a Chart** option. Use the following steps to format the chart:

   a. Select data source CEN_ORDERS, and create a line chart as shown in Figure 12-29.
   
   b. Change the chart heading title from blank to “Revenue Trend” in blue with Tahoma 10 font.
   
   c. Create the Period field that concatenates the OrderDate_year and OrderDate_month with a dash between, resulting in a character type field in format YYYY-MM. This formula demonstrates use of the EDIT(numeric-field) function and double vertical bars (||) for concatenation.
   
   d. Drag the Period field to the X-axis, Revenue to Measures and Product Type to the Legend positions in the Query area. Rotate the x-axis labels to 45 degrees for readability.
   
   e. Create a filter on Product Type adding a dynamic parameter so that Product Type can be passed into the report.
   
   f. Save the report as **9d - Revenue Trend over time** under your Chapter folder.
5. Repeat the chart creation process for the next chart using the following information:
   a. Select data source CEN_ORDERS, and create a bar chart as shown in Figure 12-30.
   b. Change chart heading title from blank to “Revenue by Type - Country Comparison” in blue with Tahoma 10 font.
   c. Drag the Revenue to Measures, Country to X-axis, and Product Type to the Legend positions in the Query area.
   d. Rotate the x-axis labels to 45 degrees for readability.
   e. Create a filter on Product Type adding a dynamic parameter so that Product Type can be passed into the report.
   f. Save the report as 9e - Revenue by Product Type under your Chapter folder.

![Figure 12-30 Revenue by Type - Country Comparison](image-url)
6. Repeat the creation process once more for the report and use the following information:
   a. Select data source CEN_ORDERS, and create a report as shown in Figure 12-31.
   b. Change chart heading title from blank to "Gross Profit by Type" in blue with Tahoma 10 font
   d. Drag Product Type and Product Category to By.
   e. Right-click GrossProfit and select Sort → Sort → Descending. Note that this adds a column for GrossProfit under By, but places it at the top. Drag this column between ProductType and ProductCategory.
   f. Right-click GrossProfit under By and enable Ranking as shown in Figure 12-31 by selecting Sort → Rank → On. Also, if you find that you have two GrossProfit columns, right-click the one next to Rank and hide it using Visibility → Hide.
   g. Right-click again on GrossProfit and enable traffic-lighting by selecting More → Traffic Light Conditions and set the background to green when GrossProfit is greater than 25 million dollars.
   h. Create a filter on Product Type adding a dynamic parameter so that Product Type can be passed into the report.
   i. Save the report as 9f - Revenue report under your Chapter folder.

7. Now that your three reports are created, you will be able to include them in a new compound document created with Developer Workbench.
12.6.4 Adding controls to the HTML Composer canvas

In this section, we explain how to design the layout for an HTML document. When you open the workbench, you will get a blank canvas on which to place form controls and reports. Follow these steps to begin this process and utilize the charts you created above in a compound document.

Proceed as follows:

1. Open Developer Workbench.
2. Expand WebFOCUS Environments → your environment → Repository → Century_Electronics → Assignment_09_-_Exploring_and_comparing_other_Dashboard_options.
3. Right-click Assignment_09_-_Exploring_and_comparing_other_Dashboard_options and select New → HTML File (Figure 12-33).
4. Call your new HTML file by the name 9g_HTML_KPI_Compound and click Open. You will see a lot of icons on the tool bar and a blank canvas where you can design your HTML page (Figure 12-34).

*Figure 12-34  Workbench blank canvas*
5. Using the following steps, create all the objects on the canvas page by using the row of icons containing graphs, reports, images, field boxes (Figure 12-35).

![Figure 12-35 Form Control icons in Developer Workbench](image)

a. Drag a Group box to the canvas (1-in Figure 12-35) and place it in the upper right of the canvas. Make it wide enough to accommodate a drop-down list of Product Types and a button next to this list. The advantage of the Group box is that it has a text field incorporated to describe the purpose. You would change the text field to Product Types and change the Font to Tahoma and blue.

b. Drag a drop-down list (2) into the group box area. When you do this, the properties of the box will appear next to the canvas. Click the Dynamic Radio button, click the radio button for Embedded Procedure, and then select the source of the procedure by clicking the button and picking `CEN_ORDERS.mas` from the list of procedures as shown in Figure 12-36.

Select the ProductType fields for Value field and Display field entries. Note that this is how you could specify a code for the Value and a description of that code for the Display field, if needed. Finally, check the All option and change the prompt text to “All Products”. This prepares your combobox to get available values from the CEN_ORDERS ProductType field at run-time.
c. Drag a push button (3) into the group box area. Select the box text with your mouse and change it from Button to Run.

d. Twice, drag a chart (4) into any empty space on the canvas.

e. Drag a report (5) into an empty space on the canvas. Your in-progress canvas should appear as in Figure 12-37.

f. In turn, right-click each of the three report areas you have dragged to your canvas. Select **Properties** and give each box a name using Linechart, Barchart, and ProfitReport respectively. The properties dialog looks like Figure 12-38. While in here, change the size of the two graphs to 250px high by 400px wide. Leave the size of the report as it is from when you placed it on the canvas.
12.6.5 Referencing external procedures in HTML Composer

Proceed as follows:

1. Now that you have form controls on the canvas, you need to configure them to work together and point to previously created chart and report procedures. The following steps will accomplish these tasks:

a. Right-click each box and select the default menu option Reference External Procedure, which will prompt you for which procedure is to be run. In this action, you associate the container with the Web Query procedure to reference (*.FEX file) as shown in Figure 12-39.
b. When you select a procedure, you will be prompted, at least for the first one, to associate it with a control. The default (Figure 12-40) is to create NEW controls. You do not want to do this, as you have manually created the ComboBox control in previous steps.

![Figure 12-40 Default prompt for linking procedure to controls](image)

Figure 12-40  Default prompt for linking procedure to controls

c. Un-check the checkboxes related to creating a new control, change the selection value from “New single form” to “Do not create a form” and pick your combobox (Figure 12-41) as the preferred control.

![Figure 12-41 Changed settings to link chart to control](image)
d. As you connect each report box to a procedure that is going to populate it, you will see data shown inside each box. Each box may be too small or too large, depending on the size when you initially dragged it to the canvas. Do not worry, it is easy to resize them by grabbing the handles and dragging the corner in or out, or by utilizing the properties page. Also, the action of connecting the first box on your canvas to a procedure, will cause a form with a button within it, to appear above the chart (Figure 12-42). This is because, by default, a form with a reset button is created. You can delete this form, as neither item will be referenced on this page because we already have our drop-down and button created. In some cases, however, the reset button might be useful.

Figure 12-42   Deleting the extraneous form control

e. The final step to tie this all together, involves linking the Run button to your three reporting areas (Figure 12-43). You can configure the Run button by right-clicking and selecting Create Hyperlink. On the resulting panel (figure), next to Reports to Execute, click the new button three times. Then configure Action, Source, Target type, and Target/Template Name for each of your reports. Click OK to save this information. You can get back to this information by right-clicking the Run button and selecting Hyperlink Properties.
f. When complete, your settings will activate all three reports by a click of the Run button. Your completed hyperlink panel will look like Figure 12-44.

![Hyperlink Properties](image1)

**Figure 12-43 Configuring Run button to actuate reports**

**Table 12-44** Hyperlink settings for button to report activation

<table>
<thead>
<tr>
<th>Action</th>
<th>Source</th>
<th>Target Type</th>
<th>Target/Template Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>External procedure</td>
<td>IBFS:MYBMConnection...</td>
<td>Frame</td>
<td>Linechart</td>
</tr>
<tr>
<td>External procedure</td>
<td>IBFS:MYBMConnection...</td>
<td>Frame</td>
<td>BarChart</td>
</tr>
<tr>
<td>External procedure</td>
<td>IBFS:MYBMConnection...</td>
<td>Frame</td>
<td>PivotReport</td>
</tr>
</tbody>
</table>

Click the Run button on the Workbench. This causes the page you have developed to execute in a new window. When your page opens, it will be blank until you click the Run button you created on the canvas.

Click the Run button and you should see a load message (Figure 12-45) on your screen in each of the boxes before seeing the actual data appear. Note that if you did not get the linkage correct between the Run button and the various procedures, you might not get this load message for one of your reports and might not see any data displayed, thus leaving one of your reports or charts missing. Correct this by verifying your procedure name, and your hyperlink values associated with your Run button.

![Loading, please wait](image2)

**Figure 12-45 “Loading, please wait” message while Web Query runs the procedure and loads data**
Improving the layout of the HTML document

Once we have a functional page, the next step is to add a title, arrange the reports attractively, include any logo that is desired, and generally clean up the page. For example, to make this page look a little cleaner, we can remove the frames around each of the reports:

1. Drag an image control from the tool bar to the top left of the canvas. Locate a *.GIF logo image that you uploaded to the century folder of Web Query earlier and select it. Size this as appropriate.

2. Drag a text field to the top center of the page and type the text Product Type Indicators in the resulting box. Highlight the words and set the font, size, and color as shown in Figure 12-46.

3. Highlight each of the three reports.

4. From the Properties pane on the right, change the Frame border setting to No.

5. To have the all three reports in our compound HTML page automatically run when the page is opened, highlight each of the three reports, and from the Properties pane on the right, set Auto Execute to True.
Executing the Run button
Save your report and then run it by clicking the Run icon (circled in Figure 12-47).

Figure 12-47  Run icon

Tip: You can return to the DB2 Web Query home page and run this dashboard. The easiest method is for a developer to stay within Developer Workbench and test from there. Do not forget that the page should be designed small enough to be viewed within the context of the DB2 Web Query home page.

Your dashboard or KPI should look like the example in Figure 12-48.

Figure 12-48  Completed compound report in designer
When run, your report should appear like the example in Figure 12-49 and should correctly limit data shown to the selected ProductType from the drop-down list.

![Product Type Indicators](image)

**Figure 12-49** HTML page rendered in a new browser window

When you have finished your document, save it and make sure to go back to the folder in Century Electronics to publish your example document so those requesting it can review the results. By default, documents are Private to the creator until published, when they become public.

12.7 DB2 Web Query Spreadsheet client

Even with the growing popularity and evolvement of Business Intelligence products such as DB2 Web Query, Microsoft Excel continues to be one of the most common means used to generate reports and analyze data. Excel users continue to stand firm when it comes to replacing Excel with a BI reporting tool, despite the challenges involved with accessing data within the Excel environment.
DB2 Web Query has responded to these demands and challenges with the Spreadsheet Client, a DB2 Web Query Add-in for Excel. Now users can access and analyze all of their enterprise data without leaving their preferred environment. The Spreadsheet Client allows Excel (2002 or higher) users to run DB2 Web Query reports from within Excel and populate an identified cell range. This means that you can build sophisticated charts, scorecards, and dashboards using Excel and use DB2 Web Query reports to populate the cells that those components are based on. Users never need to go into the web browser to access the power of DB2 Web Query.

Use of the Spreadsheet Client does require some configuration steps. See Chapter 15, “Using the DB2 Web Query Spreadsheet Client” in the DB2 Web Query Version 2.1 Product Manual. This manual can be downloaded from the IBM developerWorks® wiki using the following URL (the Spreadsheet Client configuration section is located in Volume 1):


In this section of our tutorial, we build a dashboard of charts and reports from within the Excel tool. The data for these reports and charts will be pulled down from DB2 for i tables using the DB2 Web Query Spreadsheet Client. An example of the output from the Spreadsheet Client is presented in Figure 12-50.
12.7.1 Creating a dashboard in Excel

In this section, you create a new dashboard using Microsoft Excel. The dashboard will be composed of three charts and one report. Each of these dashboard elements will be based on new DB2 Web Query reports that you create using the DB2 Web Query Spreadsheet Client and Info Assist.

Creating DB2 Web Query reports

The first two reports that we create are going to be the basis for charts in Excel. Consequently we want to “hide” these cell ranges (the data generated by the reports) to another worksheet. We put these reports on worksheet 2. To create the reports, take the following steps:

1. Open Microsoft Excel.
2. Click Sheet 2 tab at the bottom of the spreadsheet.
3. In cell A1, right-click and select Create Web Query Report as shown in Figure 12-51.

![Create Web Query Report from within Microsoft Excel](image)

A dialogue window opens and you are prompted to specify the Web Server Connection, which is the URL of the DB2 Web Query host server. This will be the following string:

http://your_system:12331

Where “your_system” is the fully qualified domain name server (DNS) or IP address of the IBM i system which has DB2 Web Query up and running.
4. As described before, specify the Web Server URL. An example is shown in Figure 12-52.

![Web Server URL](image)

Figure 12-52  Web Server URL

At this point, you need to be authenticated to the server as a valid DB2 Web Query user profile. A logon window is presented so you can enter your IBM i credentials.
5. Enter your IBM i user profile and password and click **Next**.

In this exercise, you are creating new reports using the Info Assist tool. Consequently (just as you did in the other assignments using Info Assist), the first thing you must do is specify a data source. A dialog window with the list of data source is presented.

6. Select the **CEN_ORDERS** synonym as shown in Figure 12-53 and click **Finish**.

![Select data source](image)

*Figure 12-53  Select data source*
The Info Assist tool is presented as shown in Figure 12-54. You may notice that this is not the full version of Info Assist. This is as designed: Some of the features of the full Info Assist tool are not exposed from within the Spreadsheet client because they are not applicable from this interface.

![Figure 12-54 Info Assist from within the Spreadsheet Client](image)

At this point, you should already be very familiar with the Info Assist tool.
7. For the report definition, do the following tasks:
   a. Select **Product Type** field as the Sort-By field.
   b. Select **Gross Profit** and **Revenue** fields for the measure fields.

   The report should look the same as the example as shown in Figure 12-55.

   ![Figure 12-55  Gross Profit and Revenue Report](image)
8. We only want to show data for the year 2011, so add a simple filter to this report based on the field ORDERDATE_YEAR equal to 2011 as shown in Figure 12-56.

![Figure 12-56 Filter for order year 2011](image)

9. Click the Save icon and close the Info Assist window.

You return to the spreadsheet. In your worksheet, the cell range A1 though C6 is populated. DB2 Web Query ran the report and the results were automatically brought into that cell range.

![Figure 12-57 Results from report and pulled into cell range](image)
10. Using the same steps as before, create another DB2 Web Query report in sheet 2 starting at cell E1.

11. Once Info Assist is presented, create a new Define field called OrderMonthName. The format is Mtr and it is based on the ORDERDATE field as shown in Figure 12-58.

![Figure 12-58 Order Month Name Define field](image)

12. For the report definition, do the following tasks:
   a. Select OrderMonthName for the Sort-By field.
   b. Specify Quantity as the measure.
   c. As you did for the first report, add a filter for ORDERDATE_YEAR = 2011.

When you are finished, the report should look like the one shown in Figure 12-59.

![Figure 12-59 Quantity by Month Name](image)
13. Save the report and close Info Assist.

Back in Excel, the two reports are run and the cell ranges populated. Sheet 2 should look similar to the example shown in Figure 12-60.

![Figure 12-60 Two reports in sheet 2](image)

**Creating Excel Charts**

You are now ready to create charts based on these two reports. You will actually create three graphs in Excel based on these two reports: two pie charts and one line chart:

1. Click the Sheet 1 tab at the bottom to go to the first worksheet.
2. From the Insert tab, select **Pie** → **Exploded pie in 3-D** as shown in Figure 12-61.

![Figure 12-61 Exploded 3-D pie chart](image)
3. Right-click the chart area and select **Select Data** as shown in Figure 12-62.

![Select Data for pie chart](image)

*Figure 12-62   Select Data for pie chart*

4. While the cursor is in the **Chart data range** text box, go to Sheet 2 and select the range A1 through B6. This is done by selecting cell A1, holding down Ctrl key, and selecting cell B6. When you press the Enter key, the selected range is brought into the Chart data range text box. An example is shown in Figure 12-63.

![Select range](image)

*Figure 12-63   Select range*
As demonstrated in Figure 12-64, you should see Gross Profit as the **Legend Entry (Series)** and the various product types under the **Horizontal (Category) Axis Labels**.

5. Click **OK**.

6. Right-click the chart and select **Add Data Labels** as shown in Figure 12-65.

Data labels showing the actual values are added to the chart. In addition to actual values, you can add percentage of total as a data label.
7. To customize the data labels, right-click the chart and select **Format Data Labels**.
8. Under **Label Options**, add check to the **Percentage** check box and click **Close** as shown in Figure 12-66.

![Format Data Labels](image)

*Figure 12-66  Add percentages to data labels*

9. Your chart should look similar to the example in Figure 12-67.

![Gross Profit pie chart](image)

*Figure 12-67  Gross Profit pie chart*

You have now finished creating your first chart based on a DB2 Web Query report.
10. Following steps 1 through 3 above, insert another chart in Sheet 1.
11. This time the chart data range is A1 through C6. However, we do not want Gross Profit in this chart, so select it and remove it as shown in Figure 12-68.

![Figure 12-68 Remove Gross Profit](image)

12. Click OK.
13. As you did for the Gross Profit Pie chart, add data labels and format data label to show percentages.
14. When you have finished your two pie charts, they should look like the example shown in Figure 12-69.

![Figure 12-69 Gross Profit and Revenue pie charts](image)
The last chart to create is a line chart in Sheet 1. This will be based on the OrderMonthName and Quantity report.

15. From the Insert tab, select **Line** → **Line With Markers** as shown in Figure 12-70.

16. Right-click the chart area and select **Select Data**.
17. The line chart should be based on the sheet 2 range E1 through F13 as shown in Figure 12-71.
18. When you are done, Sheet 1 should look like the example shown in Figure 12-72.

![Figure 12-72: Two pie charts and a line chart](image)

19. Next add a title to the dashboard. From the Insert tab on Sheet 1, select **Text Box** as shown in Figure 12-73.

![Figure 12-73: Add Text Box for Title](image)
20. Draw a box above the two pie charts and type “Sales Dashboard”. If you want, make the font larger and bold. Your dashboard should look like the example provided in Figure 12-74.

![Sales Dashboard](image-url)
Creating a report for the dashboard
The final addition to the Sales Dashboard is a report showing profit margins for each product category. We want to include this report in the dashboard and not hide it in sheet 2, therefore it will be created on a cell in sheet 1:

1. Create a new Web Query report on Sheet 1 cell K21.
2. Select your DB2 Web Query server and click Next.
3. Select data source CEN_ORDERS and click Finish.
4. For the report definition, do the following tasks:
   a. Select Product Category and Product Type for the Sort-By fields.
   b. Specify Margin as the measure.
   c. As you did for the other two reports, add a filter for ORDERDATE_YEAR = 2011
5. When you have finished, the report definition should look identical to the example in Figure 12-75.

![Figure 12-75  Margin by Product Category report](image)
6. Save the report and close Info Assist.

Sheet 1 of the spreadsheet should look like the example provided in Figure 12-76.

![Sales Dashboard](image)

**Figure 12-76  Sales Dashboard with 3 charts and 1 report**

**Conditional formatting**
Conditional formatting is a feature in Excel that provides some interesting visual effects. It basically allows you to add visual effects to your report based on the values of the data. It is very similar to what is referred to as Traffic Lighting and Conditional Styling in DB2 Web Query.
To implement conditional formatting, follow these steps:

1. Back in Excel, select the cells for the Margin values (M24 through M38),
2. From the Home tab, select Conditional Formatting and select the four colored arrow set of icons under the Icon Sets option. This is demonstrated in Figure 12-77.

![Figure 12-77  Conditional formatting](image)

This will automatically distribute the data into four categories (based on percentage) and provide an appropriate icon for each category.

**Note:** You can customize the values for each of the categories by editing the formatting rules. To do this, from the home tab, select **Conditional Formatting → Manage Rules**.
Summary functions
In Info Assist, you can include summary functions in your report (such as sub-totaling and grand totals). An alternative is to use the many powerful summary functions that Excel has to offer. This is done by applying the summary functions to the data range returned by the DB2 Web Query report. The requirement for this particular report is to display the average margin for all products. Proceed as follows:

1. In the cell below the last row of data and in the Product Type column (cell L39), add the text "Average margin".
2. Select the cell below the last margin value row and column (cell M39).
3. From the Formulas tab, select AutoSum → Average as shown in Figure 12-78.

Your report should look like the example in Figure 12-79.
Data range properties

Each of the reports you have created in the spreadsheet using the DB2 Web Query Spreadsheet Client can be modified to include features such as background refresh, automatically refreshing at specified intervals, and preserving cell formatting. All of these attributes can be defined via the Data Range Properties interface by taking the following steps:

1. Select a cell in one of the reports, right-mouse click, and select **Data Range Properties** as shown in Figure 12-80.
2. Activate the each of the Refresh Controls and select Preserve Cell Formatting as shown in Figure 12-81.

![Figure 12-81 Data Range Properties](image)

A description is provided for each of the settings:

- **Enable background refresh:**
  Allows the report to run and data to be refreshed in a background mode. This means the user can continue to perform other tasks within the spreadsheet while the refresh occurs. If this setting is not activated, the user must wait until the refresh is over before performing other tasks in the spreadsheet.

- **Refresh every x minutes:**
  The interval (in minutes) to automatically run the report and refresh the data.

- **Refresh data when opening file:**
  The report is run and data is refreshed when the file is opened. This will require the user opening the spreadsheet to log in to DB2 Web Query at the time the file is opened.

- **Preserve cell formatting:**
  Any Excel customization made to the cells (such as fonts, custom formatting, and so on) are not overwritten when the data is refreshed.
**Guided Ad Hoc Forms**

Just as is the case with using Info Assist from the BI Portal (BIP) interface, you must be an explicit licensed user to be able to use this DB2 WebQuery development tool within Excel. For those runtime only users who would like to use the Spreadsheet Client, another option is to use something called guided ad Hoc forms, an HTML page (pre-built by a licensed user using the HTML Composer tool). This feature provides runtime users with a more “structured” method of accessing and interacting with the data by using simple parameters to interact with a predefined data source. Use of guided Ad Hoc Forms requires the following steps:

- Configure the environment.
- Create a Guided Ad Hoc Form.
- Use the Guided Ad Hoc Form.

In this section, the steps for configuring, creating, and using guided ad hoc forms for the Spreadsheet Client are provided. This section is not part of the assignment, it is provided for reference only.

**Configuring the environment for Guided Ad Hoc Forms**

To configure your environment for the usage of Guided Ad Hoc Forms, take the following steps:

1. Sign on to DB2 Web Query as an administrator such as QWQADMIN.
2. Under Administration link, select Administration Console as shown in Figure 12-82.

![Figure 12-82 Administration console](image)

The DB2 Web Query Administration Console is presented.

3. In the left navigation pane, expand Configuration.
4. In the left navigation pane, select Spreadsheet Client.

The Spreadsheet Client Configuration page is presented.

5. Make sure IBI_Quick_Data_Security is set to the value MR.
6. Specify a valid Full Path that contains the folder where the Guided Ad Hoc Forms will be created as shown in Figure 12-83. In our example, we use the value /IBFS:/WFC/Repository/Century_Electronic/Guided_Ad_Hoc_Forms

![Figure 12-83 Spreadsheet Client Configuration page](image)
7. Click **Save**.
8. Close the Administration Console.

**Creating a Guided Ad Hoc Form**

Next, you will actually create a form that runtime users can use. To do this, take the following steps:

1. Launch the DB2 Web Query Developer Workbench tool.
2. Connect to the server.
3. Sign on to DB2 Web Query with a user profile that is licensed to use Developer Workbench and has development rights to the top level folder containing the folder of the structured ad hoc forms.
4. Under **Repository**, expand and find the folder which will contain the guided ad hoc forms. An example is shown in Figure 12-84.

   ![Figure 12-84](image1.png)

   *Figure 12-84   Folder with Guided Ad Hoc Forms*

   5. Select the folder and from the right-click menu, select **New → Guided Report Form**.
6. Specify the name of your new ad hoc form, make sure it is an HTML file type, and specify **Create with Composer**. An example is shown in Figure 12-85.

**Note:** To obtain the full path for a particular folder, go to the BI Portal and select the folder. From the right-click menu, select the **Show Path** option. The full path will be presented in a new dialog window within the browser. From here you can copy (Ctrl-C) the full path to your clipboard and paste it elsewhere.
7. The steps for creating an HTML form have already been covered earlier in this chapter, so they will not be repeated here. If you need to review this topic, see the previous example in 12.6, “Dashboard using HTML Composer” on page 341.

8. For our example, we have created a guided ad hoc form that references the report 5c - Revenue Advanced Filter that was created in 8.2, “Advanced filters: Revenue Advanced Filter report” on page 198. Once created and run, this form looks like the example shown in Figure 12-86.

![Guided Ad Hoc Form](image)

**Figure 12-85** Name your guided ad hoc form

![Finished Guided Ad Hoc Form](image)

**Figure 12-86** Finished Guided ad hoc form
Using the Guided Ad Hoc form

Now that the environment for Guided Ad Hoc forms has been configured and a guided ad hoc form has been created in the specific folder, your runtime users can run these forms from within Excel using the Spreadsheet client. To do this take, the following steps.

1. Open Microsoft Excel.
2. Right-click a cell and select Create Web Query Report.
3. Specify the correct Web Server URL.
4. Enter your user profile and password.
   A dialog window is presented which prompts you for the report type. This is a noticeable change from the environment before Guided Ad Hoc Forms were configured.
5. As shown in Figure 12-87, select the radio button for Use guided ad hoc form.

![Figure 12-87 Specify Report Type](image)

---

**Figure 12-87 Specify Report Type**
6. Select the guided ad hoc form from the list displayed.

   The selected guided ad hoc form is presented from within Excel.

7. Select the desired parameter values and click the **Run** button.

   As shown in Figure 12-88, the query runs and the results are displayed in the specified cell range.

![Figure 12-88  Run results of guided ad hoc form request](Image)

**Note:** Users can change the values of the parameters and run the report again (and the cells in the spreadsheet are repopulated with the results of that run request). Once you close the HTML Form, you can reopen it by right-clicking the cell range and selecting the **Edit Query** option. Be aware that selecting the **Refresh** option will NOT re-present the form to prompt the user for parameter values; it will simply rerun the query using the last input parameter values that the user specified.
The finished product
That is it! You have completed the assignment of using Excel and the DB2 Web Query Spreadsheet Client as the tools for delivering a Sales Dashboard. Your completed dashboard should look like the example in Figure 12-89.

![Sales Dashboard](image)

**Figure 12-89** Completed Sales Dashboard using Excel and Spreadsheet Client
Assignment #10: Scheduling and distribution of reports

In this assignment, we go into detail about how to schedule a report for distribution, view the various frequency options when scheduling a report, show how to get failure notifications, create a distribution list for email, FTP and printer, enable a report for a capability known as intelligent bursting, and view the log entries for a scheduled distribution.

Prerequisites: To complete this assignment, you need the following reports:
- 1a – Revenue Summary by Product Category and 1d - Revenue and Returns by Type, which were created in Assignment 01 - Simple Reports
- 5a - Revenue Simple Filter, which was created in Assignment 05 - Adding filters to report

In this assignment, we will schedule the existing reports and distribute them. It is a best practice to save the schedules in a separate folder from where the reports are located:
- Create a new folder named Assignment 18 - Scheduling and Distribution of reports under folder Century Electronics.
  - Under this folder, create three sub folders named Distributions, Schedules, and Reports run from Schedules.
    - Under the Distributions folder, create folders named FTP, Email, and Printer. FTP, Email, and Printer will contain different types of Distribution Lists.
    - The Schedules folder will contain the schedules that we are going to create later on.
    - The Reports run from Schedules folder will have the output of the report that we are going to schedule and distribute via DB2 Web Query.

Also, the user we are going to use to create the schedule should be Web Query Admin.
13.1 Report Broker overview

DB2 Web Query Report Broker is a feature in DB2 Web Query Standard Edition that builds on the strengths of the Web-based query and reporting tool, DB2 Web Query. With Report Broker, you can automate the process of running your reports and schedule them for distribution to individuals, distribution lists, printer destinations, or for storage in a Web Query folder for shared online viewing or archival purposes.

The scheduling function and the ability to view and change existing schedules, create and view distribution lists, view Distribution Server log entries, establish schedule blackout dates, and other Report Broker services are all presented to a Web Query Admin. The user who is in Analyst, Dev, or Sched group of the top level folder where the report is created, is also able to create the schedule.

Report Broker services are included in the DB2 Web Query online help. Report Broker help text is context sensitive and will position you to the appropriate help for the corresponding screen or topic. Look for icons with a question mark. Report Broker help text is available in the same language translations as DB2 Web Query.

You can use CL commands to start and end Report Broker Distribution Server. All three CL commands used to start or end of Web Query services (Start Web Query (STRWEBQRY), End Web Query (ENDWEBQRY), and Work Web Query (WRKWEBQRY)) include the Report Broker Distribution Server as part of the command default ‘*ALL’.

To see how the Report Broker Distribution Server fits into the DB2 Web Query architecture, see Figure 1-1 on page 9.

13.2 The assignment

Dan (being an executive himself) knows that many executives do not want to spend time looking for and “pulling” their reports. Rather, they would prefer to have the reports come to them (“pushed”) in one centralized location: their email inbox. Dan would prefer that all managers at Century would never have to log in to DB2 Web Query to pull reports. He would like all of their reports to be automatically distributed to them on a daily basis. That way, when they open their email in the morning, all of the reports are there waiting for them.

For this assignment, you will utilize Report Broker, the DB2 Web Query scheduling and distribution feature. You will set up schedules to run reports and have them emailed to the management at Century Electronics.
13.3 Configuring Report Broker

Report Broker is part of DB2 Web Query Standard Edition. So if DB2 Web Query Standard Edition is active on your system, then you can use Report Broker. But you must configure it first before using it:

1. To configure it, you need to sign in DB2 Web Query as \texttt{QWQADMIN}. After that, go to the \texttt{Administration Console} by selecting \texttt{Administration \rightarrow Administration Console}, as illustrated in Figure 13-1.

\textbf{Figure 13-1} Administration Console
2. In the left panel of Administration Console, click **Configuration** as shown in Figure 13-2. Fill in the **Default Mail From** and **Default Mail Reply Address**. Also, fill in the **Mail Host** field with your mail server name. You can set up SMTP on the system that Web Query and Report Broker reside on, or you can also use an external mail server. After setting these up, click **Save**.

![Configure Report Broker](image)

**Figure 13-2  Configure Report Broker**

**Note:** You need to make sure that the following system values are correctly set up on your IBM i system where Web Query and Report Broker reside on. Since we are scheduling the report to be run at a specific time, it is important that the date time and the time zone system values are set up correctly. This will avoid having some problems that are difficult to find later:

- QDATETIME
- QTIMZON
- QTIMADJ
- QUTCOFFSET
### 13.4 Scheduling a simple report and distributing by email

Now we are going to schedule a simple report and distribute it to individuals via email:

1. Log on to Web Query using your Username and Password.
2. Expand the Century Electronics → Assignment 01 - Simple Reports folder. Right-click report 1a - Revenue Summary by Product Category and select Schedule → Email as illustrated in Figure 13-3. This will open the Basic Scheduling tool.

![Figure 13-3 Schedule the report](image)
3. First we will see the DB2 Web Query Report Task as illustrated in Figure 13-4. It shows the path of the report, the name of the procedure, the server name, and the execution ID. These are not editable. We can select the output format of the report, the default format is HTML. In this section, we will use this format so when we get the report via email, it will be an HTML file. Click Properties in the Basic Scheduling tool ribbon.

![Figure 13-4 Set Task in Basic Scheduling Tool](image)
4. Name the title **1a - Revenue Summary by Product Category via Email**. The summary field allows you to insert a description for the schedule. This is an optional field. Enter **This is a Web Query report of Revenue Summary by Product Category** as the description. Based on the type of the report being distributed, different format options will present themselves. For this example, we will leave the Report Format as its default value, which is **HTML - Web Page**. Click **Recurrence** as shown in Figure 13-5.

*Figure 13-5  Set Properties in Basic Scheduling tool*
5. The **Recurrence** section determines when and how often the report is distributed. By default, the run interval is **Once** on a create and it is primed with the current date and time. We are going to create a weekly schedule, which runs the report on every Tuesday and Thursday from **Jul, 24, 2012 to Dec, 31, 2012**. As illustrated in Figure 13-6, click the **Weekly** radio button. Set the start time as **Jul, 24, 2012 8:30PM** and the end time as **Dec, 31, 2012 11:00PM**. Check the **Tue** and **Thu** checkboxes and accept the default Every 1 week value in the spinbox. Then click **Distribution**.

![Figure 13-6  Set Recurrence in Basic Scheduling tool](image)
6. In this example, we are going to distribute the report to two email addresses. So select the type as “Email Address(es)”, as shown in Figure 13-7. Enter the 2 Email addresses in the To fields, separated them with a comma (,) or a semicolon (;). And then enter the From and Reply Address fields of the report. The Subject field of this report distribution is primed with the name of the selected report being scheduled. Leave it as it is or give it a more meaningful subject. By default, the report is sent as an attachment. You have the option to add reports to the zip file by clicking Add Reports to Zip File. As this report is small, we leave that box unchecked.

![Figure 13-7 Set Distribution in Basic Scheduling tool](image)

7. The Notification section allows you to specify if and when you want failure notification and who should receive that notification. You can Always get a notification, Never get a notification, or get one only On Error. If you designate notification, you will be required to provide a Message To and Reply Email address and the subject. Note that the Subject is populated with the subject of the original report. You should change the subject to indicate the appropriate notification state. See Figure 13-8.
8. Click the **Email Server** button and check if the Email Server is already set up as shown in Figure 13-9. If not, we need to fill in the **Mail Server Name** field with the Email Server name or IP. This step may not be needed if we have already configured Report Broker in **Administration Console**. After setting these, Click the **Save & Close** button.

**Tip:** Use the **Brief Message To** option when you are sending notification to devices that have limited memory, such as cell phones.
9. In the window that pops up as shown in Figure 13-10, select **Assignment 18 Scheduling and Distribution of reports → Schedules** and then click **Save**. Then the Basic Scheduling Tool window will be closed.
10. Then we will see the schedule is in the Schedules folder as shown in Figure 13-11.

![Figure 13-11   View the schedule](image)

At this point, the example is done. After the schedule is executed, emails will be sent out and those 2 individuals who we set in Distribution with the Email addresses will get a mail. The mail will contain the output of report **1a - Revenue Summary by Product Category** as an html attachment.
After the schedule runs, we can double-click the **1a - Revenue Summary by Product Category via Email** schedule to open it, and then click **Log Reports** as shown in Figure 13-12. Then we can check the logs when it ran and see if it executed successfully or not.

![Figure 13-12 Log Reports](image)
13.5 Scheduling a report with parameters and distributing it via email

In the previous example, we explained how to schedule a simple report. Now we are going to schedule a report that requires parameters. We will create an Email Distribution List, schedule the report, and distribute it via email to the Email Distribution List.

13.5.1 Creating an Email Distribution List

Proceed as follows:

1. First, we need to create an Email Distribution List. Expand Century Electronics → Assignment - 18 Scheduling and Distribution of reports → Distributions → Email and select New → Distribution List as shown in Figure 13-13.

![Figure 13-13 Create Distribution List](image)
2. Name the title Email Distribution List 1 as illustrated in Figure 13-14. Accept the default **Method** value, which is **Email** in the combobox and then click **Add New** button in the ribbon. After the **Add New Member** window is displayed, type the Email address in the **Email Address** field.

3. Click the **Add New** button again and add another Email address or add more according to your own requirements.

4. Click the **Save & Close** button in the ribbon. See Figure 13-15.
5. Select **Century Electronics → Assignment - 18 Scheduling and Distribution of reports → Distributions → Email** folder and click the **Save** button. Then the schedule is saved in the Email folder. See Figure 13-16.

![Save the Distribution List in Email folder](image-url)
13.5.2 Scheduling the report

1. Expand the **Century Electronics → Assignment - 05 Adding filters to report** and right-click the **5a - Revenue Simple Filter** report and select **Schedule → Email**. See Figure 13-17.

![Figure 13-17  Schedule the report](image-url)
2. Set the Properties, Recurrence, Task, and Notification as we introduced in 13.4, “Scheduling a simple report and distributing by email” on page 391, according to your own requirements.

3. Click the Distribution button in the ribbon as shown in Figure 13-18. Select Distribution List as the value of Type and then click the To... button.

![Distribution: Email](image)

**Figure 13-18** Set Distribution in Basic Scheduling tool
4. Expand the **Century Electronics → Assignment 18 - Scheduling and Distribution of reports → Distributions → Email** folder, select **Email Distribution List 1**, and click **Open**. See Figure 13-19.

![Figure 13-19 Select Distribution List](image_url)
5. We need to provide the parameters when scheduling the report, since this report requires two parameters. Click the Parameters button in the ribbon as shown in Figure 13-20. In the Task Parameters window that pops up, click the COUNTRY parameter, select United States as the parameter’s value in the Value combobox. Then do it the same way and select Cameras as the value of parameter PRODUCTTYPE. Click OK.

![Figure 13-20 Set Parameters](image)

6. Click the Save & Close button and save the schedule as 5a - Revenue Simple Filter via Email in the Schedules folder.

After this schedule runs, the individuals who are in Email Distribution List 1 will get the output of the report via email. The output will only have the records whose COUNTRY is United States and PRODUCTTYPE is Cameras.
13.6 Scheduling a report and distributing it by DB2 Web Query

Besides scheduling the report and distributing via email, we can also distribute scheduled output via DB2 Web Query in the Basic Scheduling tool by specifying the repository folder location to distribute the report output to. Follow these steps:

1. Expand the **Century Electronics → Assignment 01 - Simple Reports** folder. Right-click **1a - Revenue Summary by Product Category** and select **Schedule → DB2 Web Query** as illustrated in Figure 13-21. This will open the Basic Scheduling tool.

![Figure 13-21 Schedule the report](image)

2. After the Basic Scheduling Tool pops up, click **Distribution** as shown in Figure 13-22, and then click the **Folder Location** button.

![Figure 13-22 Set Distribution in Basic Scheduling tool](image)
3. As illustrated in Figure 13-23, browse to the folder location that we want to distribute the report to after it runs. In this example, select Century Electronics → Assignment 18 - Scheduling and Distribution of reports → Reports Run from Schedules folder and click OK. Besides these settings, also set the Properties, Recurrences, Task, and Notification according to your own requirements. Click the Save & Close button.

![Figure 13-23 Set Folder Location](image)
4. Change the title of the schedule to be **1a - Revenue Summary by Product Category via DB2 Web Query**, expand the **Assignment 18 - Scheduling and Distribution of reports** folder, select the **Schedules** folder, and then click the **OK** button. This will save the schedule. See Figure 13-24.

![Save the Schedule](image)

*Figure 13-24  Save the Schedule*
5. After the schedule is executed according to the **Recurrence** settings that we made, the report will be distributed in the **Reports Run from Schedules** folder, as we can see from Figure 13-25. When the report is distributed, the Distribution Server adds Day, Date, and Time to the beginning of the “Save Report As” value specified in the Task tab.

---

*Figure 13-25  Reports run from Schedule*
6. We can also run the schedule once as a test as shown in Figure 13-26. Right-click the schedule and select Run. This will also run the schedule and distribute the report into the Reports Run from Schedules folder. We are also able to click the View Log button to check the log when the schedule runs so that we know if the schedule successfully runs or if some errors are happening.

![Figure 13-26 Run the Schedule](image-url)
13.7 Scheduling a report and distributing it by FTP

This section provides information about distributing scheduled output using File Transfer Protocol (FTP). Follow these steps:

1. Expand Century Electronics → Assignment 18 - Scheduling and Distribution of reports → Distributions folder. Right-click FTP folder under Distributions and select New → Distribution List. See Figure 13-27.
2. Name the title **FTP Distribution List 1**. Select the **FTP** value in the **Method** combobox. Click the **Add New** button in the ribbon as shown in Figure 13-28.

![Figure 13-28   Add New Member](image)

3. Set the **Burst value** to be **Audio**, select **Plain text** as the value of the **Pattern** combobox, and then set the **FTP location** to be **Audio.pdf**. Click **OK**. See Figure 13-29.

![Figure 13-29   Add new member](image)
4. Click the Add New button again to add another member in the distribution list. Set the Burst value to be Cameras, select Plain text as the value of the Pattern combobox and then set the FTP location to be Cameras.pdf. Click OK. See Figure 13-30.

![Figure 13-30 Add New Member](image)

5. Click the Add New button again to add the last member in the distribution list. Select Else end as the value of the Pattern combobox and then set the FTP location to be Others.pdf. Click OK. See Figure 13-31.

![Figure 13-31 Add New Member](image)
6. Now we can see all three members in FTP Distribution List 1 as illustrated in Figure 13-32. Click the Save & Close button.

7. Select Century Electronics → Assignment 18 - Scheduling and Distribution of reports → Distributions → FTP. Accept the default value of the Title, which is FTP Distribution List 1, and click Save. See Figure 13-33.
8. Then we can see FTP Distribution List 1 is created as shown in Figure 13-34.
9. Expand Century Electronics → Assignment 01 - Simple Reports. Right-click the 1d - Revenue and Returns by Type report and select Schedule → FTP. See Figure 13-35.
10. Check the **Burst Report** check box. The burst feature enables you to instruct the reporting server to create the report in sections so that the sections can be distributed separately. Each report section is saved to a separate file. Select the **PDF - Adobe PDF(*.pdf)** as the **Report Format** value as illustrated in Figure 13-36. Click **Distribution** button in the ribbon.

*Figure 13-36  Select the report format*
11. Select **Distribution List** in the **type** combobox, and then click the **Name** button as shown in Figure 13-37.

![Figure 13-37  Select Distribution type](image)
12. Expand **Century Electronics** → **Assignment 18 - Scheduling and Distribution of reports** → **Distribution** → **FTP** and click the **FTP Distribution List 1** that is listed, which we created previously. Click the **OK** button. See Figure 13-38.

*Figure 13-38   Select Distribution List*
13. Fill in the Directory with the directory name on the FTP server that you want to save your report into as shown in Figure 13-39. You need to make sure that this directory exists on the FTP server. Click the Save & Close button.

Figure 13-39  Save the Schedule
14. The FTP Distribution Options window will display, which requires you to enter the 
Account name and password for the FTP server if you are scheduling for the first time 
on this server as shown in Figure 13-40. The credentials will be stored, so it will not let you 
enter these again for the next schedule on the same server.

![Figure 13-40  Enter Credentials](image)

15. Click Save & Close and save the schedule as 1d - Revenue and Returns by Type via 
FTP in the Schedules folder.

16. At this point, the report is scheduled and when this schedule runs, Audio.pdf, 
Cameras.pdf and Others.pdf will be sent via FTP to your FTP server which you just set. 
Since we have bursted the report, Audio.pdf will only have the records whose product type 
is Audio, the Cameras.pdf will only have the records whose product type is Cameras, and 
the Others.pdf will have all the other records which are not Audio or Cameras.

### 13.8 Scheduling a report and distributing by printer

Report Broker also supports scheduling a report and distributing it by printer. When the 
schedule runs, the output file of the report will be printed out.

The way to distribute the report by printer is very similar to how we did it to distribute it by 
email. The difference is mostly in the Distribution set up of the schedule.
To distribute the report by printer, in the Distribution setup of the schedule, we need to specify the printer name, or a distribution list which contains several printer names:

- **Distribution List.** The report will be sent to all printers in the selected Distribution List. To select a Distribution List, click the icon next to the Distribution List field as is shown in Figure 13-41.

![Figure 13-41 Distribution List](image)

- **Printer Name.** Specify the printer using the format of `queue@printserver`. **Queue** is the name of the printer queue. **Printserver** is the host name or IP address of the printer. Report Broker can differentiate between the printer queue and the printer host name/IP address due to the presence of the `@` separator. Although Report Broker supports specifying only the host name or IP address of the printer, we recommend specifying both the printer queue and host name/IP address when distributing Report Broker output to a printer. The maximum length of this field is 800 characters. See Figure 13-42.

![Figure 13-42 Printer Name](image)

The report formats that support printing are DOC, PDF (when you configure Report Broker to enable PDF to print and the printer has the appropriate driver), PS, and WP.
13.9 RUNBRSCHED command

There is a Run Report Broker Schedule (RUNBRSCHED) command that is provided in Web Query 2.1.0. With this command, we can run an existing schedule on IBM i and the output will go to the place that we set in the Distribution of the schedule.

RUNBRSCHED command requires two parameters, a Schedule ID and a Run Report with User ID. Following are the steps for how we use this command.

1. Log on Web Query.
2. Expand Century Electronics → Assignment 18 - Scheduling and Distribution of reports → Schedules folder. Right-click the 1a - Revenue Summary by Product Category via Email schedule and click Properties as shown in Figure 13-43.

![Figure 13-43  Properties of the schedule](image)
3. In the Properties window that pops up, we may find the schedule has an id property, which is S8f45fc9bs5414s075sb346sa631f1eeb6a1, as is shown in Figure 13-44.

4. Log on the server which Report Broker resides on using the user profile that you made the schedule, issue **QWEBQRY/RUNBRSCHE**D and press F4. Paste the id of the schedule into the green screen as the value of the **Schedule ID** parameter. Accept the default value of the Run Report with User ID parameter, which is *CURRENT, since we are logging on using the user profile that we made the schedule. We can also specify a different user profile if it is authorized to the schedule.
5. Press Enter, then the schedule will run and we will get the output in the place where we set it, in the **Distribution** of the schedule. See Figure 13-45.

<table>
<thead>
<tr>
<th>Run a Report Broker Schedule (RUNBRSCHEL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type choices, press Enter.</td>
</tr>
<tr>
<td>Schedule ID . . . . . . . . . . . S8f45fc9bs5414s4075sb346sa631f1eb6a1</td>
</tr>
<tr>
<td>Run Report with User ID . . . . *CURRENT Character value</td>
</tr>
<tr>
<td>F3=Exit  F4=Prompt  F5=Refresh  F12=Cancel  F13=How to use this display  F24=More keys</td>
</tr>
</tbody>
</table>

*Figure 13-45  RUNBRSCHEL on green screen*

13.10 *Report Broker Console*

To view Distribution Server log entries, establish schedule blackout dates, watch server status, and other Report Broker services are all presented to a Web Query Administrator.

The Web Query Administrator can log on Web Query and select **Tool → Report Broker Console** as shown in Figure 13-46 to manage Report Broker.

*Figure 13-46  Report Broker Console*
The Web Query Administrator can view the Server Status by clicking the **Server Status** button as shown in Figure 13-47.

![Server Status](Image)

We can also click **Job Logs** button as shown in Figure 13-48 and check the logs after the schedule runs. By double-clicking the Job Id, corresponding Job Logs will be opened.

![Job Logs](Image)

It is very easy to set up Report Broker Blackout Dates. Click the **Blackout Dates** button as shown in Figure 13-49 and click the blackout dates that you want to set in the calendar. Click **Save** button. Then the Blackout Dates will be saved.

![Blackout Dates](Image)
Assignment #11: Going mobile

In this chapter, we discuss how to make available reports, documents, and dashboards to mobile devices. We describe three approaches to mobile deployment:

- Mobile Favorites from optimized web pages
- Native application
- Email distribution

Prerequisites: To complete this assignment, you need the following report:

1a – Revenue Summary by Product Category

It was created in Assignment 01, Simple Reports.
14.1 Mobile access assignment

Like many companies, the sales workforce at Century has become more increasingly mobile over the last decade. Both working from home and traveling to the various store locations have become the norm for both sales regional managers and the sales force within each of the regions. Consequently, the concept of Bring Your Own Device (BYOD) has become more commonplace; managers and their sales force are using their own personal smart phones and other mobile devices to access the company’s critical business data stored on DB2 for i.

These devices could range from Apple iPads and iPhones to Android devices such as the Motorola Xoom and Samsung Galaxy tablets. A final and rather large obstacle in Dan’s mind is that the IBM i and DB2 Web Query cannot fully deliver upon the requirements demanded by these mobile users and their devices. Namely, he would like the entire Century BI solution to be available from the various mobile devices used by the entire workforce. He wants instant access to the live data, regardless of where the sales person might be or when it is requested. In this assignment, you will use various techniques to deploy some of the charts, reports, and dashboards you created in the previous assignments so that this content is instantly available to the mobile workers and their devices.

14.2 Preparing reports for mobile access

In this section, we show how to make your reports, dashboards, and documents available on your mobile device. Follow these steps:

1. Log on to Web Query using your Username and Password.
2. Expand the Century Electronics top folder and browse to Assignment 01 - Simple Reports. From this folder, right-click 1a – Revenue Summary by Product Category and select Add to Mobile Favorites as shown in Figure 14-1.
Chapter 14. Assignment #11: Going mobile

3. A pop-up message will be displayed indicating that the report was added to the Mobile Favorites folder (Figure 14-2). Click OK to finish adding the report.

![Figure 14-2 Mobile Favorite added](image)

You can check all the reports that are available for mobile access by expanding the Mobile Favorites folder as shown in Figure 14-3.

![Figure 14-3 Displaying reports for mobile access; accessing mobile content using web browser](image)
14.3 Accessing mobile content using the web browser

Now that we have added the report that we want to make available for mobile access, we will show how to access it from mobile devices. For this assignment, we are assuming that you either have a direct network connection to the reporting server or you can connect via VPN to the local network in your company from your mobile device.

The first approach to access mobile content that we want to show is the new DB2 Web Query optimize web page designed for Mobile devices. Active Technologies for Mobile web apps require Internet Explorer 8 or higher. Active technologies comply with Web standards and are compatible with the Apple Safari browser. For Blackberry devices, OS 6 or higher may be required in order to render an Active Report or dashboard in HTML correctly.

Active Technologies check for the screen size of the device at runtime. If the height of the screen is less than 500 pixels, Active Technologies assume that the report or dashboard is running on a mobile device and the mobile user interface is used. The Optimize web page access for mobile device keeps the same secure logon as the DB2 Web Query main portal.

To access the optimized web page for Mobile access, follow these steps:
- On your Mobile device, type the following URL: http://system:12331/webquery/mobile where system is your DB2 Web Query server name or IP address. On this screen, type your userid and password and click or tap the Sign in button.

![Figure 14-4 Optimized Mobile Access web page](image_url)

- After login, you will see the report that we added to Mobile Favorites in the previous section as shown in Figure 14-5. On this panel, you can identify the following controls:
  - **Sign off**: Circle in red, allows you to log off the web page.
  - **Run**: Circle in green, allows you to run reports.
  - **e-mail**: Circle in blue, allows you to send the link for this report to an e-mail account.
To run the report, tap or click the **run** control. The report will be displayed in the web page as shown in Figure 14-6.

You can run any report, document, or dashboard using the procedure described.

**Tip:** Bookmark the web page URL for quick access.

Click or tap **Back** to return to the main web page.
14.4 Using Mobile Faves app

In this section, we show another approach to deploy mobile content on Apple devices. This approach requires the installation of the Mobile Faves app from the Apple store. Mobile Faves is a free universal app for iPad and iPhone, which provides an easy way to natively display, store, and manage any Web Query mobile content in all supported formats. It also allows the user to view and interact with dashboards.

By using this app, you can perform these tasks:
- Configure one or more DB2 Web Query servers and set up user security to access Mobile Faves.
- List available Mobile content and view it by tapping it in the list.
- Store and view previously-run history for viewing offline, and for your future reference.
- Share a Mobile Fave with any email users you designate.

This approach provides more features and faster access than using the mobile web page shown in the previous section.

14.4.1 Installing Mobile Faves

To install the Mobile Faves application on your Apple device, proceed as follows:

1. Open Apple Store on your Apple device
2. Search for: Mobile Faves.

3. Tap the **Install** icon. You will be asked to provided your Apple ID password. Once you provide your password, the installation will proceed. After the installation is complete, you will see the Mobile Faves application on your desktop as shown in Figure 14-8.
14.4.2 Connecting to reporting server and running reports

Follow these steps:

1. Tap the Mobile faves icon located in your apple device desktop. If this is the first time that you are running the application, you will only see the Mobile Faves Home Server as shown in Figure 14-9.

2. Tap Add Server located under the Mobile Faves Home. This opens the add Server configuration Panel.

3. In the configuration Panel, tap Host Title and type a descriptive name for your reporting server. In our example we use ITSOP1.

4. Tap Host Alias and type webquery. This is the application Name.

5. For Host Name, if you are using a DNS server, type the Name of the DB2 webquery server, otherwise type the IP address. In our example we are using an IP address.

6. For Host Port, you need to use 12331.

7. Finally, you need to provide a valid user name and password.

8. When you have finished completing all the required information, tap the Save button located at the top right hand side of the panel.

Figure 14-9 Add new Server Mobile Favorites

Figure 14-10 Filling in the Add Server Configuration panel
After you click the **Save** button, you will be able to see your newly configured server as shown in Figure 14-11. The newly created server contains the reports that we already added to the Mobile Favorites Folder in the previous section.

9. Tap the server that we just added in our example we choose ITSOP1

![Figure 14-11 ITSOP1 server added](image)

10. Tap report 1a - Revenue Summary by Product Category to run it.

![Figure 14-12 Running a report from Mobile Faves app](image)

### 14.4.3 Adding additional reports to mobile favorites

1. First we will add a new folder for our assignment. Right-click **Century Electronics Folder** and click **New Folder**. For Title, type **Assignment 12 - Going mobile** as shown in Figure 14-13.

![Figure 14-13 Creating a new folder](image)
1. Next we want to add an Active Report to the Mobile Favorites folder:
   To do this, we use report 1a - Revenue Summary by Product Category. But first we need to
   change the output format to Active Report.

2. Expand Assignment 01 - Simple Reports and right click report 1a - Revenue Summary by
   Product Category select edit with... and click InfoAssist.

3. Select the Format tab. If the Output types group is not expanded, Click the Output Types
   icon on the ribbon to expand it.

4. Click the Active Report icon on the ribbon to change the output format of this report.
5. Click the **Application Main Menu** and select **Save as** from the drop-down list as shown in Figure 14-17.

![Figure 14-17  Application Main Menu Save as button](image)

6. On the left pane of the **save as** dialog box, make sure to select Assignment 12 - Going mobile. For report Title, type 1a – Revenue Summary by Product Category Active. Click the **Save** button. See Figure 14-18.

![Figure 14-18  Saving Active Report](image)

We also need to publish this folder and make it available for mobile access so that Dan can have access to it on his mobile devices.
7. Right-click Assignment 12 - Going mobile and click **Publish** (Figure 14-19).

![Figure 14-19 Publishing a folder](image)

Notice that after you click the **Publish** button, the font type of the folder and all of its content changed from plain text to bold. This is an easy way to make sure that your content has been published (Figure 14-20).

![Figure 14-20 Font type changed to Bold after Publish](image)

8. Expand Assignment 12 - Going mobile and right click report 1a – Revenue Summary by Product Category Active and click **add to Mobile Favorites**.

Once we have added the report to the mobile favorite folder, we need to go back to the Apple mobile device and open the Mobile Faves app.

9. Tap the Mobile Faves application on your Mobile device.
10. Tap the Mobile Server you added in the previous section. In our case, we tap the ITSOP1 server (Figure 14-21).

![Image of Mobile Faves](image1)

Figure 14-21   Displaying ITSOP1 server content

Notice that this time when you open the reporting server, you see two folders. In the previous section, when you opened the reporting server, no folder structured was displayed (Figure 14-22).

![Image of Mobile Faves with reports](image2)

Figure 14-22   Adding additional reports

11. Tap Assignment 12 - Going mobile to display the reports that are available.

12. Tap the Report to run it.
14.4.4 Saving reports for offline view

In this section, we show how to save reports for offline view. By saving the reports, you make them accessible from the app even when you do not have access to the network.

Follow these steps:

1. In the report that you just ran, tap the **Tools** icon and then tap **Save** (Figure 14-23).

   ![Figure 14-23 Saving Report for offline view](image)

   **Figure 14-23**  Saving Report for offline view

   Wait until the Save icon appears on the top left-hand side (Figure 14-24).

   ![Figure 14-24 Save report - wait for the Save icon](image)

   **Figure 14-24**  Save report - wait for the Save icon

2. Change the Name of the report to **1a Revenue Summary by Product Category offline** and click the **Save** icon (Figure 14-25).

   ![Figure 14-25 Saving a report offline view](image)

   **Figure 14-25**  Saving a report offline view
3. Tap the **Back** icon → default → **Mobile Faves** (Figure 14-26).

![Mobile Faves](image)

*Figure 14-26  Report save for offline view*

Notice that a 1 is now presented next to the report, representing that now you have one report for offline view.

4. To test that the report was saved for offline view, disable the wifi connection on your mobile device and run the report again. As shown in Figure 14-27, notice that this time both Mobile Faves Home and itsop1 servers have a n/a red sign indicating no connection to the servers.

![Mobile Faves](image)

*Figure 14-27  Ipad no wireless connection*
5. Tap the server you configured in the previous section, then tap the report saved for offline view. As you can see from Figure 14-28 at the top, you have the name of the report being executed which is actually pointing to the offline version.

![Table]

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Type</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplifiers/PreAmps/Tuners</td>
<td>Audio</td>
<td>$12,374,428.00</td>
<td>$16,634,858</td>
</tr>
<tr>
<td>Audio Systems</td>
<td>Audio</td>
<td>$122,345,680.00</td>
<td>$40,622,800</td>
</tr>
<tr>
<td>CD Players and Recorders</td>
<td>Audio</td>
<td>$553,847,459.00</td>
<td>$16,908,999</td>
</tr>
<tr>
<td>Digital Cameras</td>
<td>Cameras</td>
<td>$184,103,667.00</td>
<td>$50,774,837</td>
</tr>
<tr>
<td>Digital8 Camcorders</td>
<td>Camcorders</td>
<td>$13,614,953.00</td>
<td>$7,102,353</td>
</tr>
<tr>
<td>DVD</td>
<td>Video</td>
<td>$329,872,045.00</td>
<td>$81,103,145</td>
</tr>
<tr>
<td>DVD Camcorders</td>
<td>Camcorders</td>
<td>$79,376,037.00</td>
<td>$79,003,287</td>
</tr>
<tr>
<td>Handheld and PDA</td>
<td>Office</td>
<td>$18,553,190.00</td>
<td>$4,405,770</td>
</tr>
<tr>
<td>MiniDV Camcorders</td>
<td>Camcorders</td>
<td>$51,539,451.00</td>
<td>$17,411,091</td>
</tr>
<tr>
<td>MP3</td>
<td>Audio</td>
<td>$43,491,588.00</td>
<td>$17,652,928</td>
</tr>
<tr>
<td>Organizers</td>
<td>Office</td>
<td>$11,712,495.00</td>
<td>$6,755,190</td>
</tr>
<tr>
<td>Receivers</td>
<td>Audio</td>
<td>$35,907,113.00</td>
<td>$12,590,113</td>
</tr>
<tr>
<td>Speakers</td>
<td>Audio</td>
<td>$84,717,053.00</td>
<td>$30,036,063</td>
</tr>
<tr>
<td>TV</td>
<td>Video</td>
<td>$168,799,539.00</td>
<td>$18,027,839</td>
</tr>
<tr>
<td>VCR</td>
<td>Video</td>
<td>$21,688,621.00</td>
<td>$5,417,673</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td></td>
<td>$1,561,923,919.00</td>
<td>$32,766,004</td>
</tr>
</tbody>
</table>

Figure 14-28  Displaying Offline Report
14.5 Opening reports received by email

In this section, we show how to open reports that have being emailed to you. For our example, we have sent via email, the report 1a- Revenue Summary by Product Category Active from the Assignment 12 - Going Mobile folder.

1. To open an attached report on your mobile device, tap and hold the attachment icon on the email. You have to wait until a drop-down list is presented as shown in Figure 14-29.

2. Tap **Open** in “MobileFaves”. This will automatically launch the Mobile Faves application and it will open the report.

3. Tap the **Back** icon (Figure 14-30).
4. Tap the **Default** icon (Figure 14-31).

![Figure 14-31  Tap default](image)

5. Tap the **Mobile Faves** icon. This will take you to the initial Mobile Faves panel (Figure 14-32).

![Figure 14-32  Initial Mobile Faves pane](image)

6. Notice that this time there is one category for **Email channel** in the Mobile Faves main page and it has 1 in the right-hand side. This means that you have one report to view in this folder (Figure 14-33).

![Figure 14-33  Mobile Faves main page](image)
14.6 How to use Active Technologies on mobile devices

Dan is excited that he can access reports on his mobile devices, but now he has prepared a list of things he would like to be able to do, including these:

- Sorting data
- Filtering data
- Calculating data on an existing report
- Building graphs

Your challenge in this section is to teach Dan how interact with Active Reports on mobile devices. For this assignment, we will be using the report we opened in the previous section, 14.5, "Opening reports received by email" on page 444.

First we explain how to sort data:

- Tap **Email channel** and then tap your report to run it.
- In our example, we are using the report we created at the beginning of the chapter.

At the top right hand corner of the report, you will see the full-screen icon. You can use this icon to change views from the original Active Report view to full-screen Web app view mode (Figure 14-34).

![Full-screen icon](image)

**Figure 14-34  Running a report Mobile Faves**

**Note:** you can rotate between landscape and portrait to get a tall or wide view of the report or chart.
Tap the **Gross Profit** column heading. This will open a drop-down list. From the list presented, tap **Sort Descending** (Figure 14-35).

![Figure 14-35 Displaying drop-down list](image)

**Note:** Tapping on any column heading will display the drop-down list.

From the drop-down menu, you can select all the actions that can be performed on the Active Report.
Now we explain how to filter data on an Active Report:

1. Tap the **Product Type** Column heading to display the drop-down menu.
2. From the drop-down menu, select **Filter**. Make sure that **Condition** is set to **Equals** and **Values** is set to **Audio**. Tap the **Done** icon (Figure 14-36).

![Figure 14-36 Applying Filter Mobile Faves](image)

As you can see from Figure 14-37, the report is now filtered by audio and it is sorted in descending order by Gross Profit. Also notice that a new tab called Filter has opened (Figure 14-37).

![Figure 14-37 Filtered Report Mobile Faves](image)

3. Close the Filter tab by tapping the x icon.
4. Tap the **Gross Profit** Column heading.
5. From the drop-down menu, select Calculate and then tap % of Total (Figure 14-38).

6. To clear the column, tap Gross Profit, tap Calculate, and tap % of Total.
Next, you want to show Dan how to build a graph:

1. Tap **Gross Profit** Column Heading and tap **Chart**.
2. From the drop-down menu, tap **Chart Type** (Figure 14-39).

![Figure 14-39 Selecting Chart Type](image)

3. Tap **Column** and select the **Column** type chart (Figure 14-40).

![Figure 14-40 Selecting Column Type](image)
4. After you tap the Chart Type, you will be returned to the Chart panel. Make sure that for Chart Type, you have **Column**; and on aggregation, you see **Sum**. On this panel, tap the Product Type. Your graphic should be similar to Figure 14-41.

Figure 14-41  Gross profit by Product Type Graph Mobile Faves

Notice that at the bottom of the graphic, you have an additional toolbar. Each of the icons on the toolbar allows you to modify the current graph. For example, you can change your Graph Type to a pie chart or a line. Try each one of the icons to see how your graph is modified.
Assignment #12: Stored procedures in action

This chapter describes the use of stored procedures to access DB2 data from Web Query. Stored Procedures are a powerful programming tool used to perform batch updates, encapsulate complex business logic (in SQL or other languages), or process business transactions.

In this chapter, we review some examples of how stored procedures can be used in conjunction with DB2 Web Query to extend the reporting capabilities.
15.1 Getting the most from your data with stored procedures

A stored procedure is a program or procedure in a service program that can be called by an application using the SQL CALL statement. Stored procedures can be written in the SQL procedural language, or you can use existing programs or service program procedures (written in RPG, COBOL, JAVA, and so on) and register them to the database as stored procedures.

When it comes to DB2 Web Query data sources to base their reports on, many developers only use database objects such as tables and views. But a very powerful, yet under-utilized feature of DB2 Web Query is its ability to use a stored procedure as a data source, provided that the stored procedure returns a result set. DB2 Web Query has the ability to capture that result set and use it as the source data for a report.

15.1.1 Prerequisites

Before going further with this chapter, you should create a folder under the Century Electronics folder and name it: “Assignment 14 - Stored Procedures in Action”. Place your work from this chapter into this folder.

15.2 Creating a stored procedure synonym

When a DB2 Web Query synonym is created over a stored procedure, the result set is used as the format for synonym. This means that all fields in the result set can be used as columns in the report. In addition, the input parameters of the stored procedures can be used as input parameters for the report. Consequently, you can pass parameter values from a report to the stored procedure, let the procedure use those values to perform the business logic, and return the results to the report.

15.2.1 Reasons you might use a stored procedure

The stored procedure is a powerful technique because it gives the report developer almost complete programmatic control over what is returned to DB2 Web Query. Consider the following ways that a stored procedure could be used with the tool:

- Reuse and repurpose the business logic in your existing programs. You can take an existing RPG program (or one written in any language supported by the IBM i), make small modifications to return a result set, and register it to the database as a stored procedure. This means that many existing reports generated by RPG programs could be converted to work with DB2 Web Query. Comment out the header lines and change the details line to write to a result set, temporary file, or array, rather than a print file record. By combining DB2 Web Query with existing report programs, you can salvage proven business logic and provide a modernized output format for those old reports.

- Use native record level access (RLA), instead of SQL, if you prefer that method of data access.

- Provide the ability to call to other programs, commands, and system APIs as well as pull data from other system objects such as messages queues, data queues, or data areas.

- Provide a way to dynamically change the library list by passing an input parameter to the stored procedure (and changing the library list based on that parameter value), then execute the appropriate process to return the result set.
Adopt authority of the user profile that owns the underlying program or service program. This gives you the ability to restrict access to the database objects and only allow users to access the objects through the programs (stored procedures) with adopted authority.

Provide auditing capability. The stored procedure can include logic to insert a row in an audit log table to record any report request. With so much attention given to security and auditing these days (that is, Sarbanes-Oxley), this can be a very important consideration, especially for users who have access to sensitive information.

Provide the ability to programmatically change attributes of the querying job. These are examples of what can be specified in a stored procedure to change the environment:

- SET CURRENT DEGREE to enable Symmetric Multi Processing (SMP) and boost query performance of a long-running report if the requestor is an executive or other high-profile user.
- SET OPTION SRTSEQ to change the collating sequence of the report.

### 15.3 Example of an HR-related stored procedure

To illustrate how a stored procedure could be used, let us assume that you need to create a report that returns rows from a sensitive table (the HR table) and you must add an auditing feature to this report. That is, each time the report is run, information such as the time stamp, name of the report, and requesting user profile must be logged to an audit table.

To create a stored procedure that returns data from specific columns in the payroll table and satisfies the auditing requirement, take the following steps:

1. From an SQL interface such as System i Navigator Run SQL Scripts, create the audit table:
   ```sql
   CREATE TABLE rptaudlog (rpttimst TIMESTAMP, rptname CHAR(25), rptusrprf CHAR(10))
   ```

2. From the same SQL interface, create the stored procedure:
   ```sql
   CREATE PROCEDURE hr_table_audit (inplantcode CHAR(3))
   DYNAMIC RESULT SETS 1
   LANGUAGE SQL
   NOT DETERMINISTIC
   MODIFIES SQL DATA
   P1 : BEGIN
   DECLARE c1 CURSOR WITH RETURN TO CLIENT FOR
   SELECT lastname, firstname, status, payscale, salary
   FROM hr
   WHERE plantcode = inplantcode;
   INSERT INTO rptaudlog VALUES(CURRENT TIMESTAMP, 'HR Salary Report', SESSION_USER);
   OPEN c1 ;
   END P1  ;
   ```

Several items must be pointed out for this stored procedure:

- The cursor is declared with the "WITH RETURN TO CLIENT" clause specified. It is a good idea to specify this clause to ensure that the result set is returned to the client application. "WITH RETURN TO CALLER" is the default, which would cause problems in the event that you had a nested stored procedure (a stored procedure called by another stored procedure) that was actually returning the result set.

- The INSERT statement is specified to log the request. This satisfies the auditing requirement.
The cursor is opened (and left open). This returns a result set to the client application (which is DB2 Web Query).

15.3.1 Creating the synonym for the stored procedure example

The process for creating a stored procedure synonym is similar to that of creating a synonym over a table. Take the following steps:

1. Log in to Web Query (Figure 15-1).

![Figure 15-1 DB2 Web Query login](image)
2. From the web menu, right-click and select **Metadata** then **New** from the drop-down menu for the folder area in which you want to create metadata. This action will start a new window for metadata selection (Figure 15-2).

![Figure 15-2 Accessing create synonym](image)

3. Expand **Adapters → Configured → DB2 cli**. Right-click *LOCAL* and **Create Synonym** as shown in Figure 15-3.

![Figure 15-3 Creating stored procedure synonym](image)
The Select Synonym Candidates for DB2 cli (*LOCAL) screen is displayed. You will change the object type to Stored Procedure, specify the library and optionally a full or partial object name (example: HR%) and click Next (Figure 15-4).

**Figure 15-4  Creating stored procedure synonym: Step 1**

4. From the list of stored procedures displayed, select **HR_TABLE_AUDIT**, as shown in Figure 15-5. Click **Next**.

**Figure 15-5  Creating stored procedure synonym: Step 2**

If the stored procedure has input parameters, you will be prompted to enter a valid value for the input parameter.

5. As demonstrated in Figure 15-6, specify a valid input parameter value by taking these steps:
   a. Check the INPLANTCODE parameter.
   b. Specify ORL as the value for the input parameter. (This is a valid Plant Code value.)
   c. Specify a Prefix value of _cen and click **Create Synonym**.
d. As shown in Figure 15-7, a confirmation window is displayed to confirm that the stored procedure synonym was successfully created. Click **Next** and **Finish** to close the window. You are now ready to utilize this synonym in reporting.

**Note:** When the synonym is created, the stored procedure is called by DB2 Web Query so that it can receive the result set. This is because it must store the format of the result set in the synonym. Consequently, you must pass it a valid value for the input parameter at this step.

15.4 Creating a report using the stored procedure synonym

Once the stored procedure synonym for the procedure **HR_TABLE_AUDIT** is available, you will use it to create a report. The function of the stored procedure is to add a row to an audit table and return a result set from the HR table. This will allow an administrator to see who has been reviewing the HR data.

Using the **INPLANTCODE** parameter from the stored procedure enables the result to show the required plant information but will also require the user to know the plant identifiers. It will be more user-friendly to prompt for possible plant values, presenting a drop-down list of plants to choose from.
To enable this, we base the report on the PLANT table synonym, which contains the list of manufacturing plants. We then join this to the stored procedure synonym using the plant code as the join field. If you did not want to provide a prompt control interface to the end user, you could simply build the stored procedure directly over the stored procedure synonym and skip the join steps.

15.4.1 Starting Info Assist to create the report

In this section, you create a report over these two synonyms by taking the following steps:

1. Use Info Assist to create a new report in your Century folder. Right-click the folder, then select New and Report from the menu.

2. From the list displayed, select the CEN_PLANT synonym as shown in Figure 15-9, then click OK. We start with the plant table because it has a list of all possible plants within it.

![Figure 15-8 Starting a new report](image)

![Figure 15-9 Selecting synonym for the report](image)
The Info Assistant tool is displayed as shown in Figure 15-10. The tool employs a ribbon menu. As you click each of the various the top level menu items (Home, Format, Data, Slicers, Layout, View), you will see different ribbon menus below the top menu line.
The default view of fields in your table will show the field names. By clicking the menu item View and selecting List rather than Logical, you will change the data area to contain more detailed field information, including size, as depicted in Figure 15-11.

![Expanded field information](Figure 15-11)

### 15.4.2 Establishing the join between Plant table and stored procedure

To join two tables or data sources within your report, do the following steps.

1. Click menu item Data then click Join (Figure 15-12).

![Specifying joins](Figure 15-12)

2. Clicking Join causes the Join dialog to appear as shown in Figure 15-13. Click Add New to view the list of available join objects.
3. From the resulting list of possible data sources, select the CENHR_TABLE_AUDIT synonym and click **OK**. The updated Join dialog now shows your two objects CEN_PLANT and CENHR_TABLE_AUDIT but they are not yet joined.

4. To complete the join, drag the PLANTCODE from the left box to the right box as seen in Figure 15-14 and drop it on the INPLANTCODE field, resulting in a connection arrow.

5. Click **OK**.
**Note:** You may remove the join or optionally select the join type by right-clicking the connection arrow. The join details dialog is shown in Figure 15-15.

![Optional join type dialog](image)

**Figure 15-15** Optional join type dialog

### 15.4.3 Formatting the report

Now that you have joined the tables, you can format the report. From the main screen of Info Assist, you will see all the fields of the joined tables. Create the report by doing the following steps:

1. Drag the desired fields to the canvas as shown in Figure 15-16. You will see actual data. If the underlying table is large, you may be limited to only 500 records, which is the default. You may change this value to smaller or larger on the Slicers ribbon.
2. Click the Run button to see your report. Looking at the resulting work area, notice that a new tabbed window opens with the report output. When you scroll down this output, you will see that you have not yet limited the output to a specific plant. Also, you may be missing a couple of needed fields. Next you will add these fields and the filter function to achieve the plant selection and complete your report. After clicking Run, your resulting output window may still be open. Close the report result tab by right-clicking either of the report tabs, located at the top or bottom, as shown in Figure 15-17 and select Close. This returns your view to the interactive work area.

Figure 15-16  Selecting fields for the report

Figure 15-17  Report output

Chapter 15. Assignment #12: Stored procedures in action  465
3. Because the requested report is supposed to show the complete HR information, you also need to add the Payscale and Salary fields, which are under Measures in the data area. Drag them to the Query area. You can hold shift to select both fields, then drag and drop them on top of the Status field. This will add these fields after Status. Your result should look as in Figure 15-18.

![Figure 15-18  Placing additional fields on the report](image-url)
4. Locate the Plant Code in the list of fields under the Data area and drag this field to the Filter area. Notice that a pop-up filter dialog results as seen in Figure 15-19.

![Figure 15-19  Filter dialog](image)

5. Create a new input parameter to the report by selecting **Prompt**, as shown in Figure 15-20 and pick **Prompt using Data Values (Dynamic)** from the drop-down menu.

![Figure 15-20  Selecting prompt type](image)

6. After picking the prompt type, you will want to change the prompt seen by the user at runtime. Type over the prompt field, changing the value from PLANTCODE to “**Plant Code:**” as shown in Figure 15-21. This will create a heading and drop-down list in your report, enabling the user to select the desired plant code. Click **OK** to exit the filter dialog.
7. The filter area now contains the appropriate code to cause record selection by the plant parameter as shown in Figure 15-22. The user will see a drop-down list of Plants and the selection of one will cause the resulting report to be limited to that single plant.

![Completed filter](image)

**Tip:** Should circumstances require it, you can easily change from a single selection prompt to multiple selection. In this example, it would enable the user to report on one or more plants. The change filter dialog to do this is shown in Figure 15-23.

![Multiple selection option](image)
8. Run the completed report, with selection by a single Plant and verify your results. When you select Plant Code ORL and click Run icon, the result should look like the image in Figure 15-25. The run icon looks like Figure 15-24.

Figure 15-24  The RUN icon in Info Assist

Figure 15-25  Completed report from stored procedure with Plant code selection

15.4.4 Saving your report based on a stored procedure

Now that you have a completed report, save it as follows:

Save your report in your folder, using the name 14a - Stored Procedure Report.

Stored procedures offer a powerful technique and the ability to return data via a result set but appearing to Web Query as any other data source.
15.5 Example of an input parameter stored procedure in RPG

Another example of how a stored procedure could be used entails the use of an ILE RPG program to parse input parameters to simplify entry. Rather than have the user pick an entry from a drop-down list containing many entries, this option allows the knowledgeable user to instead give a list of codes, numbers, or words, separated by a delimiter. This “quick entry” technique would not be possible unless some intelligent program was in between the input string and the SQL statement execution. In this case, RPG enables this easily.

In the following example, we will create an RPG program to parse an input string, encapsulate the program’s “business logic” with a stored procedure, and then use the stored procedure to feed a report in DB2 Web Query. The program will parse a string of country names, entered in the format: Country1, Country2, Country3, Country4. After extracting the parameters, the procedure will return a result set from the database for the selected countries.

The RPG program actually builds the SQL statement WHERE logic using COUNTRY IN (list of countries) to retrieve the results. While this is a simplified example, it provides a scenario which is typical of something that many RPG shops could use whenever critical business logic already exists in RPG and a result needs to be returned via SQL to the consuming application.

To create this example, do the following steps:

1. Enter the following ILE RPG code into source member MULTINPARM of QRPGSRC in QWQCENT library using RDP or another favorite source editor:

   ```rpg
   H option(*srcstmt : *nodebugio)   // This works like
   *ENTRY PLIST
   ExtPgm('MULTINPARM')            D multInParm pr
   D multInParm pi                D inputParm                  200a
   D tick S 1a   inz('')         D sqlStm S 2048a
   D whereClause S 1600a          D country S 15a
   D countryList S 1500a          D sepChar S 1a
   D begPos S 5i 0                D endPos S 5i 0
   /free
   select;                        when inputParm = *blanks;
   return;
   when inputParm = 'ALL';        whereClause = *blanks;
   other;                         // Build CountryList variable
   sepChar = ';';                countryList = *blanks;
   begPos = 1;
   dow 0 = 0;                    endPos = %Scan(sepChar:
   inputParm : begPos);         if endPos = 0;
   if %len(%trim(inputParm)) > 0; // Get last entry in comma separated list
   begPos: %Subst(inputParm :%len(%trim(inputParm)) - begPos + 1);
   countryList = %trim(CountryList) + ' ' +
   begPos;
   tick +
   %trim(country) + tick;
   country = %Subst(inputParm :
   begPos: endPos - begPos);
   countryList = %trim(CountryList) + ' ' +
   tick + %trim(country) + tick
   + ';
   if %len(%trim(inputParm)) < endPos + 1;
   leave;
   end;
   country = %Subst(inputParm : begPos: endPos - begPos);
   countryList = %trim(CountryList) + ' ' +
   tick + %trim(country) + tick
   + ';
   if %len(%trim(inputParm)) < endPos + 1;
   leave;
   end;
   begPos = endPos + 1;
   enddo;
   whereClause = 'WHERE country IN (' + %trim(countryList) + ');
   ```
The process for creating this stored procedure synonym is identical to what you have used for other synonyms and the procedure in the preceding section. Take the following steps:

1. Log in to Web Query.

2. From the web menu, right-click and select Metadata then New from the drop-down menu for the folder area in which you want to create metadata. This action will start a new window for metadata selection.


4. The Select Synonym Candidates for DB2 cli (*LOCAL) screen is displayed. You will change the object type to Stored Procedure, specify the library and optionally a full or partial object name (example: MULTI%) and click Next.

5. From the list of stored procedures displayed, select MULTINPARM, then click Next.

Because this stored procedure has input parameters, you will be prompted to enter a valid value for the input parameter. Specify a valid input parameter value by taking these steps:

a. Check the check box on the INPUTPARM line.
b. Type Germany to satisfy the requirement for a character parameter.
c. Add a the prefix value cen_ then click Create Synonym.
472 IBM DB2 Web Query for i Version 2.1: Implementation Guide

15.5.2 Creating the report from the MULTINPARM stored procedure synonym

Once the stored procedure synonym for the procedure MULTINPARM is available, you will use it to create a report. The function of the stored procedure is to parse the input parameter, locate the several country names, extract them, and build an SQL statement to select from the Stores table using a WHERE clause with IN containing the list of the country names. The procedure will then execute the statement and return the result set to DB2 Web Query.

DB2 Web Query prompting will automatically provide an input field where the user can enter several country names, separated by commas. When the Run button is clicked, the relevant country data will be returned and displayed.

15.5.3 Using Info Assist to create the report

In this section, you create a report using the synonym for the stored procedure by completing the following steps:

1. Use Info Assist to create a new report in your Century folder. Right-click the folder, then select New and Report from the menu.
2. From the list displayed, select the CEN_MULTINPARM synonym as shown in Figure 15-26 and then click OK.

![Figure 15-26 Selecting synonym for the report](image)

**Note:** When the synonym is created, the stored procedure is called by DB2 Web Query so that it can receive the result set. This is because it must store the format of the result set in the synonym. Consequently, you must pass it a valid value for the input parameter at this step.

d. The confirmation window is displayed to confirm that the stored procedure synonym was successfully created. You are now ready to utilize this synonym in reporting.
The Info Assistant tool is displayed as shown in Figure 15-27. Using the menu to change the View option from Logical (the default) to List, will enable you to see the input and output parameters for the stored procedure.

Figure 15-27   The Info Assistant work area in List mode

15.5.4 Formatting the report

1. Drag the INPUTPARM field to the Filter area, generating the filter shown in Figure 15-28. Set this field to receive input from a simple text area (as opposed to dynamic data, which we have used in many examples). This is because the user will simply type free-form text into the input when prompted.
2. Drag Storename, Country, Region, and State to the By area of the Query or to the canvas (Figure 15-29).
3. After dragging the fields, notice that unlike previous design examples, rather than seeing data formatted on the design canvas, you see an error message (Figure 15-30). At this time, this is an expected message, given the way the tool handles a stored procedure during design. When you run the procedure, however, even with null input, the system handles the procedure call as expected. So this message can be ignored at design time. If you look at the By area, the fields are visible there. Check your field sequence in the By area.

4. Click Run in the designer to execute the report, see input parameter prompting. Enter the name of two countries with the comma delimiter and click Run. Notice that in this example, the user spelled the country name German, not Germany. Therefore the result set output included only France (Figure 15-31).
5. After resolving the spelling issue for Germany, the result is as expected. This was a user parameter entry error and not a programming error in this instance that the RPG-based stored procedure is working to find (Figure 15-32).

6. Save the report in the folder as 14b - Multiple Input Parms Separated by Comma.
7. Publish your report so that other authorized users can run it.
Assignment #13: Query/400 modernization

In this chapter, we discuss the similarities and differences between Query/400 and DB2 Web Query, common uses for Query/400, and how DB2 Web Query can maintain that same functionality. In addition, we show how to create metadata from your QRYDFN objects so that DB2 Web Query can run your existing queries.

We also introduce the idea of replacing multiple Query/400 definitions with new Web Query reporting capabilities and introduce complex reporting using the HTML Composer feature of Web Query Developer Workbench.

**Prerequisites:** Before doing the examples related to Developer Workbench, it is advised to complete the earlier chapters on Documents and Dashboards.
16.1 Query/400: a reliable reporting tool

By now, you understand that DB2 Web Query is the intended replacement for Query/400. This does not imply that familiar commands such as WRKQRY and RUNQRY are going away, but rather that the product Query/400 is going away. You can still use older, yet robust, technologies that have stood the test of time and are useful to your business. It is likely that Query/400 falls into this category and has been a reliable reporting tool that your users have become easily adept with. Query/400 appeals to users because it is easy to learn and does not require programming skills or knowledge in SQL. Also, since IBM development has not made recent changes to the Query/400 code, the user interface has remained familiar and code defects are practically non-existent.

DB2 Web Query has the ability to run your existing Query/400 reports without you changing or running a conversion process on the QRYDFN object. You only have to create metadata on the QRYDFN object as you do for a DB2 table. Then DB2 Web Query submits the actual RUNQRY command to the server and displays the results to your browser. Just as RUNQRY has the three output options of display, spool file, or database file, DB2 Web Query also performs the output option that is defined in the QRYDFN.

DB2 Web Query requires special metadata to read from table objects. This is also true of QRYDFN objects. The process of creating metadata on QRYDFN objects is quite similar to the process for tables. After the metadata is created, DB2 Web Query treats table and QRYDFN metadata in the same way.

16.2 DB2 Web Query versus Query/400: Function similarities

Here we summarize how DB2 Web Query and Query/400 have the same functionality:

- Report appearance: Based solely on report appearance, a basic user is unable to tell if the report that is running is based on a DB2 object or a QRYDFN object. The information and appearance of both final reports based on QRY/400 metadata versus DB2 file metadata are identical.

- Batch capabilities: It is common to submit a CL program to batch that performs several RUNQRY commands. DB2 Web Query can also perform this functionality. The eventual goal in some shops might be to completely replace their QRYDFN objects with DB2 Web Query reports. With this in mind, DB2 Web Query has a thread-safe command that allows all your reports developed in DB2 Web Query to be used in your batch jobs.

- Right Outer Join: RUNQRY does not support Right Outer Joins and neither does DB2 Web Query.

16.3 DB2 Web Query versus Query/400: Function differences

In this section, we discuss the functionality that Query/400 has that DB2 Web Query does not have. In all cases, the limitations are explainable and workarounds are provided.
16.3.1 Parameter passing

It is possible to create a QRYDFN object that can accept parameters at runtime. This is done by using a variable in the selection clause. Figure 16-1 shows how this is used. Then the QRYDFN object is called by using the STRQMQRy ALWQRYDFN (*YES) command, which prompts the user for parameters.

<table>
<thead>
<tr>
<th>AND/OR</th>
<th>Field</th>
<th>Test</th>
<th>Value (Field, Number, 'Characters', or ...)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CITY</td>
<td>EQ</td>
<td>:MYCITY</td>
</tr>
</tbody>
</table>

Figure 16-1 QRYDFN with parameters

As noted earlier in this chapter, DB2 Web Query sends the RUNQRY command to the server. It does not send any version of STRQMQRy. This limitation means that QRY/400 queries that were coded for use as STRQMQRy ALWQRYDFN(*YES) to allow parameter input must instead use the DB2 Web Query parameter passing. First, you must change your QRYDFN object to not accept parameters. After you create the metadata, you can use Info Assist to code the parameters into the selection criteria.

16.3.2 Using output files for the next query

It is common to use RUNQRY outfile results for use in the next RUNQRY. One of the main reasons for doing this chaining was to do multiple levels of grouping, aggregation, and sub totaling. With DB2 Web Query you can do all these operations without having to do chaining.

Even though DB2 Web Query does not need to do chaining to perform grouping, aggregation and Sub totaling, it is possible to send the output of a report to a database file. To do this, you must first create metadata on the intermediate output files. The metadata is hardcoded only with a library and file name. It does not check the format-level identifier of the file as some programs do.

For example, library QGPL is used to hold the work files. You must run all the reports and generate the outfiles to QGPL. Do not delete the QGPL files. Then you create the metadata only once on the QGPL work files and create reports from the work files. When the job is done, the work files are deleted. The next time that the job runs, the work files are created again. As long as the files are created with the same fields and format as before, the previously created metadata successfully runs the report. DB2 Web Query does not know that the underlying files have since been deleted and recreated.

Commonly, the library QTEMP is used to store these intermediate work files. The limitation of DB2 Web Query is that you cannot create metadata on any object in QTEMP. Therefore, the intermediate file must be in a different library. Then the metadata can be created. If you cannot change your work files to be in the QTEMP library, you will be unable to do query chaining. If you change your work files from QTEMP to another library, be mindful to change your program to delete the work files.

In summary, metadata remains valid even if the underlying object is deleted and recreated. However, if the underlying object is changed, then the metadata is stale and must be recreated.
16.4 The assignment

Century Electronics has approximately 7,000 *QRYDFN objects on their production server. Not all of them are used; in fact, the majority of them have not been updated or even run in years. You could certainly use the Query/400 adapter to bring all of these queries into DB2 Web Query. However, you would of course end up with over 7,000 DB2 Web Query reports, which is probably not what you want. Dan realizes that many users still use some of these query objects, so he does not want you to simply discard them. Rather he would like for you to bring some of the more popular ones into DB2 Web Query, but he would also like for you to take a long term approach to query modernization and look at ways to simplify this reporting environment, particularly from a report maintenance perspective.

In this assignment, you will do both. You will use the Query/400 adapter to “link” to existing query objects. You will also look at ways to reduce the number of queries by using technologies such as highly parameterized reporting, InfoMini, and Active Reports. These features provide end users with the flexibility to define the data that they want to retrieve and the ability to customize the output format so that it is presented the way they want. By adopting this approach, a single DB2 WebQuery report can replace dozens (in some cases even hundreds) of Query/400 reports.

16.5 Creating metadata over Query/400 objects

Just as DB2 Web Query requires metadata to read from DB2 files, it also requires metadata to read from Query/400. When creating metadata on QRYDFN objects, you must remember to complete a few extra windows, otherwise the metadata creation will not be complete.

As noted earlier, if you change the format of your underlying files, you must recreate the metadata on those files. If you change the QRYDFN on the server side, you must recreate the metadata on that QRYDFN.

The process of creating metadata on a Query/400 runs the query at that time. This is because it is gathering information about the files and columns that were used in the query output. For this reason, the processing of creating metadata on a Query/400 object can be somewhat longer than on a DB2 table.
DB2 Web Query asks for the library name where your Query/400 objects are stored. You can choose to create metadata for all queries in a library in a single execution. In the following steps, we explain the process for creating Metadata for Query/400. There are two additional windows for creating metadata on a Query/400 object versus on a DB2 object. Remember to click **Next** until you no longer see one.

To create Metadata for Query/400, proceed as follows:

1. Right-click the **Century Electronics** folder and click **New Folder**. See Figure 16-2.

![Figure 16-2 Creating a folder](image)

2. In the New Folder dialog box, for title, type: Assignment 15 - Query/400 Modernization and click **OK**. See Figure 16-3.

![Figure 16-3 Create New Folder dialog box](image)
3. Right-click the folder, Assignment 15 - Query/400 Modernization. From the list presented, select **Metadata** and then **edit**. See Figure 16-4.

![Figure 16-4 Creating Metadata](image)

4. In the next Window, click **Adapters**. Right-click the **Query/400** adapter and then click **Create Synonym**. See Figure 16-5.

![Figure 16-5 Selecting the adapter](image)
5. In the **Create Query Synonym for Query/400 step 1 of 2** pane (Figure 16-6), enter the library where the QRYDFN object resides. In this case, we enter the QWQCENT library name. Click **Submit**.

![Figure 16-6 Creating a synonym](image)

6. In the **Select Synonym candidates for Query/400 Step 2 of 2** pane (Figure 16-7), complete these steps:
   a. Select the Query/400 object on which you want to create metadata. For this assignment, we select REVGPFTQRY.
   b. For Prefix type: qrydfn_
   c. Click **Create Synonym**.

![Figure 16-7 List of QRYDFN objects](image)
7. In the Create Synonym for Query/400 Status pane (Figure 16-8), if synonym creation was successful, you see a status of Created successfully. Click **Next**.

![Figure 16-8 Created successfully status message](image)

8. In the Create Synonym for Query/400 File: Save Reports pane (Figure 16-9), notice the Report Name column. Click **Next**.

   This is the last pane on which you must click **Next**. DB2 Web Query creates a report from your QRYDFN.

![Figure 16-9 Final confirmation window: Creation Synonym for Query/400](image)
9. In the Create Synonym for Query/400 File: Save Reports Status pane (Figure 16-10), notice that the status indicates **Created successfully** for the Query/400 metadata creation. Close this window by clicking the **Finish** button.

![Figure 16-10 Created successfully message: conversion from Query/400 to DB2 Web Query](image)

Close the create synonym window and go back into your Assignment 15 - Query/400 Modernization folder. Notice that the metadata is already created as a report `qrydfn_REVGPFTQRY`. You can click this report to run it. You can also right-click it for the editing options.

**Options when creating metadata: prefix and suffix**

The guidelines for adding a prefix and suffix to metadata are the same as outlined in Chapter 3, “Defining metadata” on page 21. Keep in mind that after metadata creation, you will be unable to tell whether the underlying object is a DB2 table or a QRYDFN. You might want to add a prefix or suffix that can help you to identify that the object being queried on the server side is a QRYDFN.

### 16.6 Using DB2 Web Query to edit a QRYDFN

After you create metadata, DB2 Web Query understands the metadata as a result set. You can use DB2 Web Query to edit, sort, and filter the report, but you can only work within that result set. You cannot add new columns to the report, even if the column is from a table that is used in the report. DB2 Web Query, in effect, sees the Query/400 result set as any other table. In previous chapters we learned the difference between Compute and Define fields.

Since compute is data manipulation done on the client side, you can still use compute on your Query/400 reports. However, the define operation is data manipulation performed on the server side. Therefore, you are unable to do this when editing a Query/400 object. Currently bad data is returned and might change into an error message instead.

If you edit the report from DB2 Web Query, those changes are not reflected in the QRYDFN object. When editing a Query/400 report that contains a join, you can add a new join with DB2 Web Query. However, you will be unable to edit the joins already defined in Query/400.
16.7 Modernizing Query/400 definitions

In this assignment, we are required to replace four related QRYDFN objects using one DB2 Web Query report. We are also required to enhanced the report using InfoMini and Active Reports:

- The first QRYDFN object REVGPFTQRY produces a basic summary report that shows revenue by product Category. See Figure 16-11.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Type</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplifiers/Parts</td>
<td>Audio TOTAL</td>
<td>42,374,426.00</td>
<td>16,634,858.00</td>
</tr>
<tr>
<td>Audio Systems</td>
<td>Audio TOTAL</td>
<td>122,345,689.00</td>
<td>49,862,060.00</td>
</tr>
</tbody>
</table>

Figure 16-11 Revenue by Product Category

- The next two QRYDFN objects (CHAINQRY1 and CHAINQRY2) are used to create a summary report that shows Gross Profit Margin by Product Category. CHAINQRY1 creates an output file in QTEMP that it is used as an input file for the second QRYDFN object (CHAINQRY2). This chaining was used to be able to calculate Gross Profit Margin. See Figure 16-12.

<table>
<thead>
<tr>
<th>Gross Profit Margin</th>
<th>Product Type</th>
<th>Product Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>76.87</td>
<td>Audio</td>
<td>Speakers</td>
</tr>
<tr>
<td>57.68</td>
<td>Office</td>
<td>Organizers</td>
</tr>
</tbody>
</table>

Figure 16-12 Gross Profit Margin Report

- The last QRYDFN objects (PARMQRY1) accepts an input parameter at runtime. In our example, it is using PRODTYPE as input parameter. See Figure 16-13.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Type</th>
<th>SUM (LINEPRICE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital8 Camcorders</td>
<td>Camcorders</td>
<td>13,614,953.00</td>
</tr>
<tr>
<td>DVD Camcorders</td>
<td>Camcorders</td>
<td>379,376,637.00</td>
</tr>
<tr>
<td>MiniDV Camcorders</td>
<td>Camcorders</td>
<td>51,539,451.00</td>
</tr>
</tbody>
</table>

Figure 16-13 Product Category Report providing Camcorders as input parameter

For Dan, this is a complex process, as he does not have much experience with the IBM i platform. Our challenge is this assignment is to consolidate these Query/400 definitions in one Web Query report and make it available to Dan via web browser and on his mobile devices.
16.7.1 Building the initial report

We begin by building the first query/400 report that it is displaying Product Category, Product Type, Revenue, and Gross Profit. For this assignment we are using the Logical view of the Data pane:

1. Sign onto DB2 Web Query.
2. Expand Century Electronics Top Folder. Right-click Assignment 15 - Query/400 Modernization Folder, From the list presented select New and then Select Report.
3. From the Select a data Source dialog box select cen_orders and click OK. See Figure 16-14.

Figure 16-14   Selecting a data source
4. From the Data pane, drag the **Product Category** and **Product Type** to the **By** Field category in the Query Design Pane.

5. From the Data Pane, drag **Revenue**, and **Profit** to the **Sum** field container in the Query Design Panel. Your report should look similar to Figure 16-15.

We have finished modernizing the first Query/400 definition. Now we need to add to our report the gross profit margin field. Remember that we are using CHAINQRY1 and CHAINQRY2 to accomplish this task in Query/400, but this is not necessary in DB2 Web Query.
6. From the Data pane, drag the **Margin** field to the **Sum** field container. This field was defined in the Metadata in previous chapters.

7. Run your report. It should look similar to Figure 16-16.

---

**Figure 16-16**   Final Report Definition

Up until this point, we have consolidated the first three QRYDFN objects in one Web Query report. Now we need to make sure that we are able to run this report and select specific Product categories or product types. There are different ways to accomplish this, but for this assignment, we are going to use InfoMini.

You have the option to activate InfoMini when you create a report in Info Assist. InfoMini contains a subset of Info Assist functionality available at runtime. In other words, by using InfoMini, we can provide the user the option to interact with the report at runtime.

To activate InfoMini, use the followings steps:

1. Click the **Format** tab and then click **InfoMini** (Figure 16-17).
You can limit or expand the functionality that is available to the user at runtime when you are using InfoMini as explained in Chapter 8, “Assignment #5: Adding filters to reports and charts” on page 187.

2. Click the drop-down list menu next to the InfoMini button to see available options. Leave the defaults and continue to the next step. See Figure 16-18.

3. From the report that we just created, click the Slicers tab.

4. Select Product Category from the Data Pane and drag it to the Group 1 ribbon. See Figure 16-19.

5. In the options ribbon, click New Group. See Figure 16-20.
6. Select **Product Type** from the Data Pane and drag it to the new created **Group 2** ribbon. See Figure 16-21.

![Figure 16-21  Adding Slicer Category](image)

7. Click the **Format** tab and change the report output format from HTML to **Active Report** on the Output Types ribbon. See Figure 16-22.

![Figure 16-22  Changing Output Format to Active Report](image)

8. Save your report as A15_RPT01.
9. Run your report. Notice that this time a new window is open.
10. Click the **Slicers** Tab. Click the **Product Type** drop-down menu, select **Camcorders**, and then click **OK**.
11. Run your report and compare the values with the ones in Figure 16-23. The values in both reports should be the same.

![Figure 16-23  Running a report with input parameter](image)

12. On the Options ribbon, click the **Clear Slicers** button and run your report again.
13. Our final step is to send the report by e-mail. Click the drop-down menu next to Product Category. From the list presented, click **Send as E-mail**.

**Note:** This option will only be available if you are using Internet Explorer. ActiveX Settings need to be set correctly for this to work.
14. A dialog box pops up requesting some information. Leave the defaults and click **Save Report**.

15. Assuming that you have an e-mail account configured in your computer, a new e-mail window will show up with the Active Report attached to it. Write down the e-mail address and send the e-mail.

   As a final step, we need to publish the report.

16. Right-click folder **Assignment 15 - Query/400 Modernization** and click **Publish**.

17. Right-click report **A15_RPT01** and click **Add to Mobile Favorites**.
16.8 The migration dilemma for Query/400 reporting

This section discusses the approaches to implement highly parameterized reporting. This is one way to provide high-function DB2 Web Query reports to replace legacy reporting environments.

As previously mentioned, DB2 Web Query is positioned as a replacement for Query/400 and offers not only similar basic reporting functions, but the ability to slice-and-dice data in a way that Query/400 cannot match. The web presentation, graphics, and mobile capabilities, which DB2 Web Query makes easy, allow users to visualize data and make business decisions like never before. The web and mobile presentation layers address reporting capabilities that most modern enterprises desire for their knowledge workers with mobile devices.

If you were a user of the Query/400 product, you may have experienced heavy usage of the product. At some clients, hundreds of queries exist, written by many users and utilizing many different files. In almost all cases, there is some overlap of query function and file usage.

16.9 Modernizing your reporting

As with many such changes that impact IT, the goal is not simply to convert your Query/400 objects to Web Query. It is much better to determine the current reporting needs and figure out a more modern way to approach the task. In prior chapters, we discussed dashboards and other compound documents. Web Query provides the capabilities to develop reports that are more responsive than Query/400 reports.

Consider the case of a shop where users have been creating Query/400 reports for 10 or even 20 years. One of the challenges will be to convert the necessary queries, maintain business reporting requirements without re-creating redundancies that may exist. Query/400 was exceptional in its day, but with the addition of web-based reporting, graphics and OLAP processing, a single DB2 Web Query report might replace the function of numerous Query/400 objects.

One way to approach the migration is to use the DSPPGMREF command to generate an output file of query references to files. This would enable you to determine all the queries that used the same files. To further analyze the fields used in each query, you could convert each query from Query/400 object to SQL source code, using the RTVQMQR command. This generates a source member with the equivalent SQL for the subject query. No doubt, with some work, you could write additional queries or SQL to review these files and have some ideas which queries to tackle first or which queries are similar or redundant.

16.9.1 IBM offering for Query modernization

If you feel the task of migrating your query objects is a daunting challenge, IBM Services has an offering to assist you with the process. Consisting of a set of tools to discover, analyze and migrate Query/400 objects, this offering brings these additional tools and IBM’s expertise to the process.
16.10 Replacing Query/400 objects with Active Reports

This section discusses an example of a single, highly parameterized, Active Report. This type of report is typically developed by IT but, in this case, is often deployed to business analysts or disconnected users who want to highly segment the data that they are analyzing. This tutorial assumes that you have completed the Active Reports tutorial and understand those concepts. Here we take an existing Active Report and initiate it from an HTML page that contains a large number of input parameters in a user friendly manner.

Such a report might be used to incorporate data to eliminate one or more Query/400 reports in the web-based environment.

16.10.1 Highly parameterized report development

In this exercise, using an Active Report that we created previously as 3g – Active Report Revenue and Profit Report, we will now add multiple parameters to it. This allows a user to segment the data that he wants to analyze in different ways. Although we base this tutorial on an Active Report, we can invoke any report or graph. This highly parameterized technique is effective for subsetting the data that a user wants to download to Excel.

This exercise uses a report named 15a - Active Report Revenue and Profit Report, which is simply a clone of the previous 3g report with a few changes. The changes to 3g to get 15a are as follows:

1. Open 3g – Active Report Revenue and Profit Report.
2. Remove the Product Name field.
3. Add the CostOfGoodsSold column.
4. Add subtotals by Product Type for the numeric columns.
5. Add traffic lighting on the Gross Profit column for color change to green when the value is above $40M.
6. Save this report in your Century Electronics folder under subfolder Assignment 15 - Query400 migration.
With these changes, your report should resemble that shown in Figure 16-26. You might want to quickly run this report and make sure that it looks like this example.

**15a - Active Report Revenue and Profit Report**

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Product Category</th>
<th>Revenue</th>
<th>Cost of Goods Sold</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Amplifiers/PreAmps/Tuners</td>
<td>$42,374,428.00</td>
<td>25739570.00</td>
<td>$16,634,858</td>
</tr>
<tr>
<td></td>
<td>Audio Systems</td>
<td>$122,345,680.00</td>
<td>82282820.00</td>
<td>$40,062,860</td>
</tr>
<tr>
<td>CD Players and Recorders</td>
<td>$53,847,459.00</td>
<td>37838460.00</td>
<td>$16,008,999</td>
<td></td>
</tr>
<tr>
<td>MP3</td>
<td>$43,491,508.00</td>
<td>26438660.00</td>
<td>$17,052,928</td>
<td></td>
</tr>
<tr>
<td>Receivers</td>
<td>$35,907,113.00</td>
<td>22998000.00</td>
<td>$12,909,113</td>
<td></td>
</tr>
<tr>
<td>Speakers</td>
<td>$84,717,053.00</td>
<td>24680990.00</td>
<td>$60,036,060</td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal: Audio</strong></td>
<td></td>
<td>$382,683,321.00</td>
<td>219978500.00</td>
<td>$162,704,821</td>
</tr>
<tr>
<td>Camcorders</td>
<td>Digital8 Camcorders</td>
<td>$13,614,953.00</td>
<td>6512600.00</td>
<td>$7,102,353</td>
</tr>
<tr>
<td>DVD Camcorders</td>
<td>$379,376,637.00</td>
<td>30373350.00</td>
<td>$79,003,287</td>
<td></td>
</tr>
<tr>
<td>MiniDV Camcorders</td>
<td>$51,539,451.00</td>
<td>34128360.00</td>
<td>$17,411,091</td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal: Camcorders</strong></td>
<td></td>
<td>$444,531,041.00</td>
<td>341014310.00</td>
<td>$103,516,731</td>
</tr>
<tr>
<td>Cameras</td>
<td>Digital Cameras</td>
<td>$104,103,667.00</td>
<td>13332830.00</td>
<td>$50,774,817</td>
</tr>
<tr>
<td><strong>Subtotal: Cameras</strong></td>
<td></td>
<td>$104,103,667.00</td>
<td>13332830.00</td>
<td>$50,774,817</td>
</tr>
<tr>
<td>Office</td>
<td>Handheld and PDA</td>
<td>$18,533,190.00</td>
<td>14067420.00</td>
<td>$4,465,770</td>
</tr>
<tr>
<td>Organizers</td>
<td>$11,712,495.00</td>
<td>4957305.00</td>
<td>$6,755,190</td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal: Office</strong></td>
<td></td>
<td>$30,245,685.00</td>
<td>19024725.00</td>
<td>$11,220,960</td>
</tr>
<tr>
<td>Video</td>
<td>DVD</td>
<td>$329,872,045.00</td>
<td>24876090.00</td>
<td>$80,103,143</td>
</tr>
<tr>
<td></td>
<td>TV</td>
<td>$168,799,539.00</td>
<td>150771700.00</td>
<td>$18,027,839</td>
</tr>
<tr>
<td></td>
<td>VCR</td>
<td>$21,688,621.00</td>
<td>16270950.00</td>
<td>$5,417,671</td>
</tr>
<tr>
<td><strong>Subtotal: Video</strong></td>
<td></td>
<td>$520,360,205.00</td>
<td>415811550.00</td>
<td>$104,548,655</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td></td>
<td>$1,561,922,919.00</td>
<td>1129157915.00</td>
<td>$432,766,004</td>
</tr>
</tbody>
</table>

*Figure 16-26  Gross Profit Active Report*
To add the parameters to this report, do the following steps:

2. From the Data area, one by one, select each of the field names shown in Table 16-1 and either drag it to the filter area or right-click each and select Filter from the menu.

Based on this table, all the conditions are WHERE conditions. The table shows the field name to drag to the Filter pane and the condition to use. For all parameters, click Select values. In all fields but ORDERDATE, select prompting for Dynamic values. In the Dynamic pane, choose Select multiple values. Then click OK.

Table 16-1  Parameters for WHERE conditions

<table>
<thead>
<tr>
<th>Field name</th>
<th>Condition</th>
<th>Select values</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHERE PRODUCTTYPE</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE PRODUCTCATEGORY</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE SALESREP</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE COUNTRY</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE REGION</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE STATE</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE PLANTNAME</td>
<td>EQUAL to</td>
<td>Select parameter. Dynamic data values prompting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select multiple values.</td>
</tr>
<tr>
<td>WHERE ORDERDATE</td>
<td>GREATER THAN or EQUAL to</td>
<td>Select parameter. Enter field name From_Date under Parameter (do not autoprompt). See Figure 16-28 on page 499.</td>
</tr>
<tr>
<td>WHERE ORDERDATE</td>
<td>LESS THAN or EQUAL to</td>
<td>Select parameter. Enter field name To_Date under Parameter (do not autoprompt).</td>
</tr>
</tbody>
</table>
Figure 16-27 shows a sample of the filter for multi-select DB values.

3. For the date fields, instead of using the dynamic data prompt, you need to set up a range based on a value at run-time. This requires the Advanced Filter prompt shown in Figure 16-28. We use From_Date for the first date parameter and To_Date for the second date parameter.

Figure 16-28 Advanced Filter editing for date range and others
The finished Selection criteria pane should look like the example in Figure 16-28 on page 499, with each parameter allowing multiple selections and the order date fitting in a range.

If you run this report, you should see a prompt screen for all these variables, as shown here in Figure 16-29.

4. Save and close the report.
16.10.2 Creating the report in HTML Composer

To create the report in HTML Composer, follow these steps:

5. Navigate to the Century Electronics folder in Developer Workbench. Drill down to the Assign 15 level and right-click the folder, selecting New → HTML File (Figure 16-30).

![Figure 16-30 Creating a new HTML file](image)

6. In the window that opens (Figure 16-31), enter a report name of 15c_HighlyParmedDocument and click Create.

![Figure 16-31 New report name](image)
7. In this example, we create an HTML page that contains the various parameters and a Run button. When the Run button is clicked, a new window opens that contains the Active Report. We must import the report onto the HTML page so that DB2 Web Query automatically brings in all the parameters that are defined in the report, saving us from adding them manually. We remove the report frame itself after we import all the parameters.

Click the report icon (circled in Figure 16-32) and draw a small box in the upper left corner of the pane.

8. Right-click the report (the box that you just drew), select **Reference existing procedure**, and select the Active Report (Figure 16-33).

9. Select the report that you just created.
10. You are presented with a list of parameters that are referenced by this report (Figure 16-34):

a. For SALESREP, change the control type to **Double list control**.
b. For COUNTRY, change the control type to **Radio button**.
c. For PLANTNAME, change the control type to **Check box**.
d. For both dates, change the control type to **Calendar**.
e. Under Parameter grouping options, select **Do not create a form**.

![Figure 16-34 Selecting the parameter control types - Before (left), After (right)](image)

11. Click **OK** to proceed.
The system lays out all the chosen parameters on the canvas, but probably not arranged the way we would want them. Figure 16-35 shows the form controls partially arranged. Move the **Run** button that was generated up to the top of the page.

![Figure 16-35](image-url)  Imported parameters partially arranged
12. When moving the controls, make sure that you keep the headings and controls together. Drag the parameters into a layout similar to Figure 16-36. You may need to scroll to see the entire page of parameters. See the following steps to size the Country control box:

- Make sure that you leave enough room at the top of the report for a report heading.
- Some of the boxes, such as SALESREP, require resizing. Keep any frames that are within a panel in the panel when they are moved or resized.

![Figure 16-36 Rough layout for parameters](image)

**Note:** This exercise is designed to introduce you to many of the controls and capabilities of HTML Composer. It is not intended to teach window design. Do not design a window that has this many different controls and looks like this in production applications.
13. We want to change Country from one column width to two columns widths (Figure 16-37):
   a. Highlight the **Country** control box.
   b. From the Properties pane, select **columns** and type 2.
   c. Size the control box appropriately.

![Properties pane](image)

*Figure 16-37 Two-column radio control box*
16.10.3 Parameter controls

In this section, we illustrate how to define the sequence in which the cursor moves from cursor to cursor, also known as parameter controls. Follow these steps:

1. Highlight the Producttype control box.

2. In the Properties pane on the right, select Tab index and enter 1. The Tab index controls the sequence in which the cursor moves from field to field.

3. Also as part of the properties pane in the Properties and Settings, where you can override options such as your type of control box or the text to go with the ALL option, click the Parameters tab and right-click one of the control boxes. Select “Properties and Settings” as shown in Figure 16-38. Select the add ALL option for every parameter except the dates (Figure 16-39).

![Properties and settings](image)

Figure 16-38 Properties and settings
4. Highlight the **Productcategory** control box.

5. Click the **Properties** tab (Figure 16-40) and under Tab index, enter the value 2.
16.10.4 Chaining the controls together

We want to set up our parameters so that the value selected for product type modifies (filters) the values that are displayed in the product category drop-down list:

6. Click the **producttype** control box. Holding down the Shift key, also select **Productcategory**.

7. Click the **Add chain** icon (highlighted in Figure 16-41). This function chains the parameters together in the sequence in which you selected them.

8. Highlight the **Salesrep** control. In the Properties pane, for Tab index, type 3.

9. Highlight the **Country** control. In the Properties pane, for Tab index, type 4.

10. Highlight the **Region** control. In the Properties pane, for Tab index, type 5.

11. Highlight the **State** control. In the Properties pane, for Tab index, type 6.

12. We want the Country parameter to control or filter the Region parameter, and we want the Region parameter to filter the State list box. To chain Country to Region to State:
   a. Select the **Country** control box.
   b. Hold down the Shift key and select the **Region** control box. Still holding down the Shift key, select the **State** control box.
   c. Click the **Add chain** button shown in Figure 16-41.

13. Highlight the **Plantname** control. In the Properties pane, for Tab index, type 7.

**Tip:** If you right-click a control box that is chained to another control, you can override the chaining logic. The default in our example shows all product categories that have a product type equal to what the user selected. You can choose any relationship to the controlling parameter, which is less than, greater than, and so on. In our example, **EQUAL** is really the only choice that makes sense and it is always the default.
Visual representation of chaining

Before leaving the topic of chaining controls, notice that at the bottom of the workbench designer, there are several tabs; Design, Parameters, and Embedded Javascript. Viewing the parameter tab shows how the controls on the page have been linked. Switch from the Design tab to the Parameters tab, to see this view as shown in Figure 16-42. Finally, using the Javascript tab would enable coding to further control data entry on the page.

Figure 16-42 Visual Parameter Chain view
16.10.5 Using calendar controls

In this section, we illustrate how to define the controls when dealing with Date fields:

14. Right-click the calendar icon under From_Date and select **Calendar Properties**.

15. For Date range, select **Static**. Specify a range from **January 1 2012** to **July 26 2012**. For Date format in data source, select **YYMD**. Click **OK**. See Figure 16-43.

16. Highlight the **From_Date** control.

17. In the Properties pane, for Tab index, type 8.

18. Repeat these calendar control steps for To_Date using a Tab index of 9.

**Tip:** The more common calendar option is probably relative dates, for example, within the last two years. Since our data only contains dates in 2011 and 2012, we chose the static dates for this example. Calendars can also default the date field to today’s date if required.

19. Right-click the **Run report1** button control and select **Hyperlink Properties**.
20. In the Hyperlink Properties window (Figure 16-44), complete these steps:
   b. Change Target Type to Window and Target to New Window. This runs the report in a new window instead of in the frame drawn on the current HTML page.

![Hyperlink properties Run Report](image)

21. Delete the original frame that you drew when importing the report. It is located below all the parameters.

22. Select the RUN control box. In the Properties pane, for Tab index, type 10.

23. Resize the Run button by dragging the frame.

24. Add a heading to the report:
   a. Click the text icon on the tool bar and draw a box to contain your heading (Figure 16-45).

   ![Gross Profit Active Report](image)

   **Note:** In addition to text and reports, you can import images to your page using the icon to the left of the text icon. You can use define cascading style sheets to tailor the look of your page.

25. Enter a title of Gross Profit Active Report.

26. Click your text box so that it is surrounded by a straight line frame and slashes or handles.

27. In the Properties pane on the right, select the ... button next to Styling: Font.
28. In the Font window (Figure 16-46), select the styling for your heading:
   a. For Font, select Arial.
   b. For Font Style, select Bold.
   c. For Size, select 18pt.
   d. For Effects, select Underline. Click OK.

![Font window](image)

Figure 16-46  Styling text

29. Click the background area of the HTML layout.
30. In the Properties pane, click the ... button next to Background color and select a pale color (Figure 16-47).
When we modified all the parameter control boxes, we changed the tab index in the Properties pane. This controls the sequence that the users tab through the fields in the window. We still have a problem in that some of the other elements on the page have a tab index that might conflict with our sequence numbers.

Starting with the title, highlight the frame and find the tab index number. If it is less than or equal to 10, change it to an arbitrary number above 20. The Run button had a tab index of 10 and we want it to be last in our normal sequence. Do not forget to check the arrow elements in Salesrep. See Figure 16-48.

**Tip:** If you hover over the icon second from the left that looks like a hand and multiple small boxes, you should see the text Tab Order. Selecting this shows the sequence of your tabs for the user. Make sure that you do not have duplicates and that the order is left to right, top to bottom for INPUT-capable fields.

Save and run the report.
32. For our first test, select **ALL** for Salesrep and **2012/01/01** to **2012/06/26** for the dates (Figure 16-49).

**Tip:** Having chosen the double list control for Salesrep means that you always must select at least one item for SALESREP. This can be ALL, but there must be a value in the output list.

*Figure 16-49  Prompting for parameters for test run*
33. Click **RUN**. Figure 16-50 shows the output of running this report.

![15b - Active Report Revenue and Profit Report](image)

**Figure 16-50** Test result output

At this point, you can try to run the report, taking advantage of the parameter chaining. Selecting a product type changes the product categories list box. Similarly, choosing a region changes the state displayed.

Then go back to your parameter design page and start tailoring the page to look like a more practical report that you might show to a user.

### 16.10.6 Providing multiple report output format options for users

In some cases, your users may want to choose the output format dynamically at runtime. For example, user OZZIE may want the Gross Profit report to be generated as an Active Report, while user ARCH prefers that same report to be presented as a PDF file, and SHANEG is a power Excel user and likes his reports as spreadsheets. This dynamic specification of the output format can be accomplished at report runtime by using the InfoMini capability of Info Assist.

Go back to Info Assist and edit your report named `15b - Active Report Revenue and Profit Report`. Take the following steps to clone this report with InfoMini enabled:

1. **Click Format.**
2. Select both Active Report and InfoMini (Figure 16-51).

![InfoMini selection enabled](image1)

3. Using Save As, save the report as 15c - Active InfoMini Revenue and Profit Report and then run it.

4. When you run a report that has InfoMini enabled, you will see a miniature version of Info Assist at runtime with the controls to enable various report output options, as shown in Figure 16-52.

![InfoMini report output options](image2)

5. Return to the HTML parameter report that you have open in DB2 Web Query Developer Workbench.

6. As shown in Figure 16-53, right-click the Run Report button icon and select Copy and then Paste to create a duplicate button. Change the text to indicate "Run with output options". Now the form has the option to run and see output or run and select output type.

![Create another button](image3)
7. To define the action that occurs when the user clicks it, right-click the new button and select **Hyperlink properties**, as shown in Figure 16-54.

![Figure 16-54 Establish hyperlink on button](image)

8. From the Hyperlink Properties dialog window, change the Display Text field to Run with Output Options and set the Action, Source, and Target information, as demonstrated in Figure 16-55.

![Figure 16-55 Hyperlink properties](image)

9. Select **External procedure** as the Action, click the ellipsis icon under Source, and (from the list of presented procedures) select your **InfoMini report** as the report to run. An example is displayed in Figure 16-55.

10. Click the **Open** button to accept this report as the source and return to the Hyperlink Properties dialog.

11. To display the PDF report in an overlapping browser pop-up window, select **InfoWindow** for the Target Type setting and specify a size of 700/500 in the size window.

12. **OK** to accept the changes.

13. Click the **Save** icon to save your changes.

14. Run the report and click the new **Run with Output Options** button to test it. You should see a new window with an InfoMini screen as described previously and shown in Figure 16-52.

15. Close the window.

With the InfoMini choice, the user has more control over the output formats such as HTML, PDF, Flash, Excel spreadsheet, and PowerPoint.
16.11 Additional parameter tips

This section describes additional techniques that can be used to provide more control over how report parameters are displayed and handled.

16.11.1 Displaying the values of one column while passing another

When developing DB2 Web Query reports that require prompt control (input parameters), you may run into a requirement to present a drop-down list that is based on a column in your database (for example, product name) but actually pass the value of a different column (such as product number) as the input parameter value. This can be accomplished by utilizing the display field feature of HTML Composer in DB2 Developer Workbench.

To set up a report and html page that utilize this feature:

1. Using Info Assist, create a new report against CEN_ORDERS. The sort fields are PRODUCT NAME and PRODUCTNUMBER, and the measure is Revenue (include commas and floating currency for formatting). An example is shown in Figure 16-56.

![Figure 16-56 New report specification and Revenue format](image-url)
2. In the Data pane, right-click **PRODUCTNUMBER** and select **Filter** to add **PRODUCTNUMBER** as a screening condition. Define it as a multi-value prompt control parameter that is based on **PRODUCTNUMBER** in CEN_ORDERS. An example is provided in Figure 16-57.

![Figure 16-57 Set up prompt control parameter for PRODUCTNUMBER](image)

3. Save the report as **15d-parameterPromptReport**.
4. Run the report with **No Selection**. It should look like the example shown in Figure 16-58.

![Figure 16-58 Example of 15d-parameterPromptReport](image-url)
5. Return to the Developer Workbench tool and create a new HTML file in your Tutorials folder, as shown in Figure 16-59. Name the new html file 15eParameterPrompting.

![Create new HTML file for 15eParameterPrompting](image1)

Figure 16-59   Create new HTML file for 15eParameterPrompting

6. In the HTML Composer tool, select the report icon to add a new report to the layout (Figure 16-60).

![Add report to layout](image2)

Figure 16-60   Add report to layout
7. Using the crosshairs, draw/outline the location of the report on the canvas.
8. Right-click the report outline and select **Reference Existing Procedure**.
9. From the list of reports displayed, select 15d-parameterPromptReport. The New Parameters dialog window is presented.
10. From this window, select **Do not create a form** under Parameter grouping options, then click **OK**. See Figure 16-61.

![Figure 16-61 Parameters for ra6_parm report](image)
11. Move the elements around on the canvas as shown in the example in Figure 16-62.

Figure 16-62  Move elements on canvas
12. Select the PRODUCTMNUMBER listbox element and on the Properties dialog for the field, you will see Value Field and Display Field parameters (Figure 16-63). Notice that by default, they are both identical. By clicking the ellipsis on the right of Display field, you may change the value seen during execution to a more user-friendly descriptive value while still passing the parameter as the original PRODUCTNUMBER. Our user-friendly description is in the field PRODUCTNAME, so we need to select that name in Display field.

![Figure 16-63 Select parameters for Display value](image)

The properties for the PRODUCTNUMBER parameter are displayed as shown in Figure 16-64.

![Figure 16-64 Parameter properties](image)

13. Click the Run icon to test the report.

Notice that the drop-down list is populated with product names rather than the product numbers.
14. Select multiple product names in the list (by selecting them and holding down the Ctrl key on your keyboard) and click **Run Report**. Your results should look similar to the example in Figure 16-65.

![Figure 16-65   Example of report that displays one column as parameter but passes another](image)

The drop-down list on the HTML page is populated with product names, yet the value of the correlating ProductNumber column is passed to the underlying report. Because ProductNumber is the parameter that the report is expecting, the report is able to find and display the appropriate rows.

15. Close the browser window.

16. Back in the HTML Composer session, save the report.

17. Close the HTML Composer session.

### 16.11.2 Using another report to control parameter sorting and filtering

Another useful feature that can be implemented in HTML Composer is the ability to use another procedure (another term for a report) to control the parameter list sorting and filtering. This is useful, for example, if you have a report with a prompt control parameter of the OrderDate column, but you would like the drop-down list to be sorted in descending order (rather than the default, which is ascending). You would also like to filter this list to only show dates for the year 2012.

To illustrate how this can be set up, the following three components are created in this exercise:

- Base report with prompt control of OrderDate. This report shows revenue for the selected OrderDate by country and region.
- Report (procedure) that sorts by OrderDate in descending order and only includes rows for the year 2012. This report is generated to XML output format.
- HTML Layout that calls the base report and uses the procedure to populate and sort the drop-down list.
Follow these steps:

1. Launch Info Assist to create a new report based on the CEN_ORDERS synonym.
2. Sort the report by ORDERDATE_MDYY, COUNTRY, and REGION.
3. Drag Revenue into the Sum pane and specify column formatting of commas and floating currency. An example is shown in Figure 16-66.

![Figure 16-66 Using a procedure to sort the parameter list: base report](image)

4. Set up a prompt control parameter over the ORDERDATE column by doing these steps:
   a. Drag the ORDERDATE field from the list of available fields into the Filter conditions pane.
   
   **Note:** In the QWQCENT test data, the metadata for OrderDate specified the field in the YYMD format and we wanted it in MDYY format for this example, so a Define field was created to reformat the date. This field OrderDate_MDYY was used for the report column but NOT for the filter.

   b. Click the Prompt button and select prompt using data values (Dynamic) option. link.
   c. Verify that the field name ORDERSDATE is selected and click the Allow Multiples button.
These steps are shown in Figure 16-67.

5. Click **OK**.

6. Save your report as **15f - Revenue for Selected Order Date**.

7. Run your report. Use the prompt control.

   Notice that **OrderDates** are listed in the drop-down list and are sorted in ascending order, as shown in Figure 16-68.

The behavior that you really want for this drop-down list is to present the **OrderDates** in descending order. You would also like to filter this list so that only order dates for the year 2012 are presented and can be selected by the user.

One way to obtain this behavior is to create another report (procedure) and use it to handle the parameter sorting and filtering. This procedure would be used to populate the listbox, via XML, with the dates. We will use SQL to expose the desired date range as metadata that can be utilized by the listbox. An SQL view over the **Orders** table is created, with the limitation of accessing 2012 dates only. This can be referenced in the HTML page to populate the listbox with descending dates for only 2012. The SQL for this view is as follows:

```sql
create view qwqcen.distinctOrdDt
as
Select distinct orderdate
from qwqcen.orders
where year(orderdate) in 2012 ;
```
Once you create the metadata DISTINCTORDDT.mas to make this view available, the HTML Composer is used to connect the view to the listbox in our example. The step is handled by editing the properties for the listbox and specifying this datasource as the embedded procedure to drive the listbox. We select sorting in descending sequence for the listbox. See Figure 16-69.

Figure 16-69   Connecting Listbox to embedded procedure
8. Run your HTML page to see the result. It should resemble the output shown in Figure 16-70. Now the date selection includes only 2012 dates and they appear in the list in descending sequence.

![Figure 16-70 Resulting prompt for 2012 dates in descending sequence](image)

The result is as desired. Note that one potential issue is the use of the special value ALL in this circumstance. All enables selection of all data in the underlying table, which has data for several years. Thus if ALL is used, the 2011 dates would show up also. Our listbox is connected to the view, so it shows only the limited year we wanted. Therefore, if using this technique, do NOT check the box for Add ALL option.

This example is now complete.

9. Save the HTML file in your chapter folder.

10. Close the HTML Composer session.

11. Return to the Web browser and run the report.
Assignment #14: Creating JD Edwards reports

The DB2 Web Query Adapter for Oracle JD Edwards is optimized to work seamlessly with the JD Edwards World or JD Edwards EnterpriseOne application. This adapter provides real-time access to your JD Edwards data and will leverage the security and business rules that your organization has invested in JD Edwards.

In addition, JD Edwards User-Defined Codes (UDC) lookups, date conversions, and friendly column titles are automatically handled. With these adapters, Web Query users will be able to generate and distribute reports, charts, and documents against JD Edwards data while adhering to the security rules defined in the JD Edwards application.

Century Electronics uses JD Edwards as their Enterprise Resource Planning (ERP) solution. As such, Dan would like you to create reports based on data in the JD Edwards database.

This chapter takes you through the configuration, administration, and basic reporting steps associated with the JD Edwards adapters using the reporting tool Info Assist to create a report.
17.1 Connecting to a remote JD Edwards database using adapters for JD Edwards

This chapter highlights the differences between the adapter for JD Edwards World and the adapter for JD Edwards EnterpriseOne when connecting to a remote JD Edwards database. The document also describes what files need to be copied in order to connect to a remote JD Edwards database. As an administrator, we recommend that you review 17.1.1, “Areas to consider when connecting to a remote JD Edwards database” before you attempt to connect to a remote JD Edwards database.

17.1.1 Areas to consider when connecting to a remote JD Edwards database

When connecting to a remote JD Edwards database, ensure that you account for the following points of consideration:

1. In the case of the JD Edwards World adapter, the dictionary tables that are replicated will get out of sync if the originals are changed.
2. Report data retrieval may be slower than if the tables were local, depending on the amount of data to process.

17.1.2 Using JD Edwards adapter to connect to a remote JD Edwards database

**Note:** The JD Edwards dictionary files are needed on the local system to access remote JD Edwards databases. See the following sections for names of these files.

The JD Edwards World adapter and the JD EnterpriseOne adapter function differently in how they access the dictionary information:

- The JD Edwards World adapter does not use an extract of the dictionary files for the Master File conversion step, but does have a UDC descriptions extract locally to speed up the UDC lookup when running a report.
- The JD Edwards EnterpriseOne adapter uses an extract for all of the dictionary information.

The metadata repository for the adapter will need to be re-created if there are changes to the information in UDC or security tables. This applies to both adapters, but principally the JD Edwards EnterpriseOne adapter. If the repository is not refreshed, then information in the report may be incorrect, or access to the data may be restricted or allowed depending on the security change.
17.1.3 JD Edwards dictionary files needed on local system to access remote JD Edwards databases

The following synonym files need to be copied for JD Edwards to use the remote database.

These files are needed for JD Edwards World 7:
- F0092
- F0001
- F0005
- F9401
- F0004
- F9202
- F9201

These files are needed for JD Edwards World 8 and 9:
- F0092
- F0001
- F0005
- F9401
- F0004
- F9202
- F9210

For JD Edwards EnterpriseOne:
- F0092
- F00950
- F980WSEC
- F0004
- F0005
- F9202
- F9210

These files need to be copied to the local system in a library that is in the Web Query startup library list and the user profile library list. That library name will also be used in the entries needed when configuring the JD Edwards adapters.

17.2 Using the Adapter for JD Edwards World

The Adapter for JD Edwards World allows DB2 Web Query to access JD Edwards World data sources. With this adapter, data in the JD Edwards World DBMS is displayed using rules contained in dictionary files, thereby ensuring that valid information is returned to the requesting program.

17.2.1 Preparing the JD Edwards World environment

Although no environment preparation steps are required, ensure that your system complies with all software specifications.

Do not add this JD Edwards adapter to a Reporting Server which already contains a configured adapter for JD Edwards EnterpriseOne. If you would like to add this adapter to that server configuration, you must remove the existing adapter for JD Edwards EnterpriseOne first.
The only software requirement is to use a JD Edwards World Application installation configured with DB2.

### 17.2.2 Overview of the setup process

The setup process is composed of the following basic steps:

2. Refresh the metadata repository. You will need to perform this step initially, and repeat it only if there are changes in the JD Edwards metadata tables. This occurs infrequently at most sites.
3. Create the JD Edwards World synonyms. Synonyms are required for Web Query reporting against a data source.

### 17.2.3 Configuring the Adapter for JD Edwards World

In this section, we explain how to configure the Adapter for JD Edwards World. Follow these steps:

1. Log on to DB2 Web Query as the DB2 Web Query (user profile with QWQADMIN group) administrator ID.
   
   The administrator is the user that configures and manages the adapter configuration; other users are not permitted to manage and configure adapters.

2. In the Reporting area, create folder "Assignment 15 - Creating JD Edwards reports". In this tutorial, the folder is created under the Century Electronics folder as in Figure 17-1.

![Figure 17-1 Menu to create folder](image)
3. Expand **DB2 Web Query → Century Electronics → Assignment 15 - Creating JD Edwards reports**. Right-click the **Assignment 15 - Creating JD Edwards reports** folder, and select **Metadata → Edit** as in Figure 17-2.

![Figure 17-2 Menu to edit metadata](image)

4. In the new opened window, click the **Adapter** to open the Adapter tab, as in Figure 17-3.

![Figure 17-3 Open the Adapter tab](image)

5. In the left-hand Adapter navigation pane, expand the Available folder.
6. Expand the ERP folder.
7. Expand the JD Edwards World folder.
8. Double-click **A7.x - A9.x**, and the configuration window displays as in Figure 17-4.

![Figure 17-4 JD Edward World A7.x - A9.x Configuration](image)

9. Select the connection parameters:
   a. **Business Unit Security:**
      Check this box to enable automatic execution of JD Edwards World Business Unit Security. The Server for IBM i automatically restricts user access to data, based on information retrieved from the F0001 and F0006 tables, and then adds appropriate WHERE conditions to the user's submitted data access request. Unchecked (OFF) is the default setting. If you check this parameter, you cannot turn it OFF until the server is shut down and then restarted (with no parameter settings).

   b. **Search Type Security:**
      Check this box to enable automatic execution of JD Edwards World Search Type Security. The adapter automatically restricts user access to data, based on information retrieved from the F0005 table, and then adds appropriate WHERE conditions to the user's submitted data access request. Unchecked (OFF) is the default setting. If you check this parameter, you cannot turn it OFF until the server is shut down and then restarted (with no parameter settings).

   c. **Business Unit (PA):**
      Check this box to revert (if necessary) to an older security model used by this adapter. Unchecked (OFF) is the default setting. If checked, this option overrides standard Business Unit Security (as described above).

   d. **Column Security:**
      Check this box to enable column security based on information in the F9401 file. Unchecked (OFF) is the default setting. If you check this parameter, you cannot turn it OFF until the server is shut down and then restarted (with no parameter settings).

   e. **UDC Direct File Access:**
      Check this box to enable User Defined Code Direct File Access. Unchecked (OFF) is the default setting.

      Important: It will create files, udcdicdb.*, in the JDWSEC application folder directory. Do NOT delete these files.
f. Select Profile:
   This must be EDASPROF.
10. Click **Configure**.
    You will receive a confirmation message.
11. Click **OK**.

Restarting the Reporting Server disconnects any users currently working in DB2 Web Query, so confirm that no Web Query user jobs are running before clicking OK. After the server restarts, the adapter for JD Edwards World is successfully added to the configuration.

### 17.2.4 Refreshing the Metadata repository

The Metadata repository contains the dictionary information for the JD Edwards World tables. You must refresh the repository the first time you set up the adapter and repeat the process each time the JD Edwards World tables change.

**How to refresh the Metadata repository**

Important: In order to refresh metadata, you must have first configured the adapter.

1. Right-click **JD Edwards World** → Click **Refresh Metadata Repository** as in Figure 17-5.

   This is only done when you first configure the adapter for JD Edwards World, or when JD Edwards data dictionary information changes.

   ![Figure 17-5 Menu to Refresh Metadata Repository](image)

2. Select the version of JD Edwards World you will be using. Enter the name of the library for each of the specified objects.
   The UDC library parameter is the library name that will contain information on the User Defined Codes in the JDE dictionary. A new library with the name specified will be created on the system. Additionally, a new table will be created in that library which will contain UDC information to be used by DB2 Web Query.

3. Click **Refresh Now**.
   Once the refresh has completed, the metadata repository has been successfully refreshed.
17.2.5 Creating the JD Edwards World synonyms

To report against JD Edwards World data, you must first create synonyms.

**How to create the JD Edwards World synonyms**

Follow these steps:

1. Right-click **JD Edwards World**, and select **Create Synonym**.
2. Click the DB2 CLI connection that points to your JD Edwards World data tables.
3. Select the restrictions you would like to apply when searching for synonym candidates.
   - Restriction options included are restrict object type, further restricting Tables, Views, Aliases, and MQTs.
4. Click **Next**.
5. Select the check box next to the table(s) you want to create synonyms for. Click **Create Synonyms**.
6. Add JD Edwards dictionary information to your synonym.
   - Options to specify include date format, presumptive join, field names, language code, UDC, and Combine UDC.
     a. Select date format:
        - The options are: YMD, YYMD, DMY, MDY, MDYY, DMYY, MYY, YYM. (YYMD is the default setting.) The selected format will be used only if the field is described as a DATE in the Data Dictionary.
     b. Presumptive Join:
        - Check the Presumptive Joins box to include additional DEFINEs (virtual fields) for presumptive join fields in the synonym. Checked (ON) is the default setting.
     c. Field Names:
        - Select Long Fieldname (the default) to display the field descriptions as names on reports. Select Short Fieldname to use the JDE aliases as field names on reports.
     d. Language Code:
        - Enter the appropriate Language Code, which exists in the JDE F9292 file. (Leave the field blank for English.)
     e. UDC:
        - Check the UDC box to ensure that UDC description fields are generated as DEFINEs (virtual fields) in the synonym. Checked (ON) is the default setting.
     f. Combine UDC:
        - Check this box to Combine User Defined Code. Unchecked (OFF) is the default setting.
7. Click **Continue**.

Once you have created the synonyms, you can now develop DB2 Web Query reports to access JD Edwards World data.
17.3 Using the adapter for JD Edwards EnterpriseOne

The adapter for JD Edwards EnterpriseOne allows DB2 Web Query to access JD Edwards EnterpriseOne data sources. With this adapter, data in the JD Edwards EnterpriseOne DBMS is displayed using rules contained in dictionary files, thereby ensuring that valid information is returned to the requesting program.

17.3.1 Preparing the JD Edwards EnterpriseOne environment

Although no environment preparation steps are required, ensure that your system complies with all software specifications.

Do not add this JD Edwards adapter to a Reporting Server which already contains a configured JD Edwards World adapter. If you would like to add this adapter to that server configuration, you must remove the existing JD Edwards World adapter first.

The only software requirement is to use a JD Edwards EnterpriseOne Application installation configured with DB2.

17.3.2 Overview of the setup process

The setup process for the adapter for JD Edwards EnterpriseOne is composed of the following basic steps:

1. Configure the adapter for JD Edwards EnterpriseOne. Define what type of security to implement.

2. Refresh the metadata repository. You will need to perform this step initially, and repeat it only if there are changes in the JD Edwards metadata tables. This occurs infrequently at most sites.

3. Refresh the security extract. This step is required only if Group or Role based security is configured in step 1. This captures the current JD Edwards EnterpriseOne rules for the adapter to enforce.

4. Create the JD Edwards EnterpriseOne synonyms. Synonyms are required for Web Query reporting against a data source.
17.3.3 Configuring the adapter for JD Edwards EnterpriseOne

In this chapter, we explain how to configure the Adapter for JD Edwards EnterpriseOne. Follow these steps:

1. Log on to DB2 Web Query as the DB2 Web Query (user profile with QWQADMIN group) administrator ID.
   The administrator is the user that configures and manages the adapter configuration; other users are not permitted to manage and configure adapters.

2. In the Reporting area, create folder “Assignment 15 - Creating JD Edwards reports”.
   In this tutorial, the folder is created under the Century Electronics folder as in Figure 17-6.
   If you already have this folder created, you can skip this step.

![Menu to create folder](image)
3. Expand DB2 Web Query → Century Electronics → Assignment 15 - Creating JD Edwards reports. Right-click the Assignment 15 - Creating JD Edwards reports folder, and select Metadata → Edit as in Figure 17-7.

![Figure 17-7 Menu to edit metadata](image)

4. In the new opened window, click the Adapter to open the Adapter tab, as in Figure 17-8

![Figure 17-8 Open the Adapter tab](image)

5. In the left-hand Adapter navigation pane, expand the Available folder.
6. Expand the ERP folder.
7. Expand the JD Edwards EnterpriseOne folder.
8. Double-click **JD Edwards EnterpriseOne**; the configuration window displays as shown in Figure 17-9.

![Figure 17-9  JD Edward EnterpriseOne configuration](image)

9. Select the connection parameters:
   a. **Server Authentication:**
      Check this box if the reporting server is secured. This option applies when every JD Edwards EnterpriseOne user has a user ID on the reporting server system as is the case in Web Query.
   b. **Security Type:**
      When you configure the adapter for JD Edwards EnterpriseOne, you must choose if your JDE environment is configured to use role-, group-based security, or no security (NONE).
   c. **UDC Direct File Access:**
      When you select this check box, you give users access to the User Defined Code Direct File.
   d. **Select Profile:**
      You must choose edasprof.

10. Click **Configure**.

    You will receive a confirmation message.

    **Important:** The reporting server agents will be stopped. You need to confirm that no Web Query jobs are running before clicking OK. Restarting the Reporting Server disconnects any users currently working in DB2 Web Query.

11. Click **OK**.
17.3.4 Refreshing the metadata repository

The Metadata repository contains the dictionary information for the JD Edwards EnterpriseOne tables.

You must refresh the repository the first time you set up the adapter and repeat the process each time the JD Edwards EnterpriseOne dictionary tables change.

How to refresh the metadata repository

You can refresh the metadata repository from the Adapters list in the navigation pane on the web page:

1. Right-click the configured JD Edwards EnterpriseOne adapter and select Refresh Metadata Repository as in Figure 17-10.

You will need to perform this step initially, and repeat it only if there are changes in the metadata for tables. This occurs infrequently at most sites.

The Refresh Metadata Repository pane opens. The JDE tables required for this procedure are listed in the first column.

2. Enter the Library name of the library containing the specified objects. The UDC library can be any arbitrary name, for example, UDCDIC.

3. Click Refresh Now to refresh the metadata repository.

Once the refresh has completed, the metadata repository has been successfully refreshed.

17.3.5 Refreshing the security extract

The security extract is a snapshot of the security rules defined in JD Edwards EnterpriseOne.

The adapter uses this extract to enforce the restrictions when reporting against JD Edwards EnterpriseOne data. You must refresh the security extract as often as the security rules change in the JD Edwards EnterpriseOne application.
How to refresh the security extract
In order to refresh the security extract, navigate to the Adapters list in the navigation pane on the web page:

1. Right-click the configured JD Edwards Enterprise One adapter and select Refresh Security Extract as in Figure 17-11.

   **Note:** You will need to perform this step upon initial configuration of the adapter, and repeat it only if there are changes in the JD Edwards EnterpriseOne security rules.

   ![Menu to refresh security extract](image)

   **Figure 17-11** Menu to refresh security extract

2. Enter the Library name of the library containing the specified objects.

3. Click **Submit** to refresh the security extract.

17.3.6 Creating the JD Edwards EnterpriseOne synonyms

To report against JD Edwards EnterpriseOne data, you must first create synonyms.

How to create the JD Edwards EnterpriseOne synonyms

Follow these steps to create the synonyms:

1. Right-click **JD Edwards EnterpriseOne**, and select **Create Synonym**.

2. Click the DB2 CLI connection that points to your JD Edwards EnterpriseOne data tables.

3. Select the restrictions you would like to apply when searching for synonym candidates.
   Restriction options included are restrict object type, further restricting Tables, Views, Aliases, and MQTs.

4. Click **Next**.

5. Select the parameters you would like the synonym to include.
   Parameters options include With foreign keys, One-part name, Application, Prefix, Suffix, and Overwrite existing synonyms.
a. With foreign keys:

Select the **With foreign keys** check box to include within this synonym every table related to the current table by a foreign key. The resulting multi-table synonym describes all of these tables’ foreign key relationships.

b. One-part name:

On the IBM i platform, the One-part name check box is unchecked by default. The unchecked behavior generates a table name that includes the explicit name of the library containing the table. For example, if you specified a library on the first Create Synonym pane, a qualified name like the following is automatically created in the Access File:

```
TABLENAME=MYLIB/MYTABLE
```

With this explicit type of entry in the Access File, at runtime, the library is directly located and searched for the table name. If you select the check box, the explicit library name is not stored in the metadata (Access File). When the synonym is generated, the library portion of the table name is omitted from the Access File, and appears like this:

```
TABLENAME=MYTABLE
```

With this type of entry in the Access File, at runtime, the library path of the user is searched until the table name is located.

c. Application:

This defaults to the first application folder in the application path.

d. Prefix/Suffix:

If you have tables with identical table names, assign a prefix or a suffix to distinguish them. For example, if you have identically named human resources and payroll tables, assign the prefix HR to distinguish the synonyms for the human resources tables. Note that the resulting synonym name cannot exceed 64 characters. If all tables and views have unique names, leave prefix and suffix fields blank.

e. Overwrite existing synonym:

To specify that this synonym should overwrite any earlier synonym with the same fully qualified name, select the Overwrite existing synonyms check box.

Note: The connected user must have operating system write privileges in order to recreate a synonym.

6. Select the check box next to table(s) that you want to create synonyms for.

7. Click **Create synonym**.

8. Add JD Edwards dictionary information to the synonym:

   a. Select date format:

      The options are: YMD, YYMD, DMY, MDY, MDYY, DMYY, MYY, YYM. (YYMD is the default setting.) The selected format will be used only if the field is described as a DATE in the Data Dictionary.

   b. UDC:

      Check the UDC box to ensure that UDC description fields are generated as DEFINEs (virtual fields) in the synonym. Checked (ON) is the default setting.

   c. Combine UDC:

      Check this box to Combine User Defined Code. Unchecked (OFF) is the default setting.

9. Click **Continue**.

   The synonym has been successfully created.
17.4 Developing a JD Edwards report

This section will highlight the JD Edwards synonym using Info Assist. We will use the F0911 table (Account Ledger) for this section of the tutorial and assumes you have completed all the prior sections of this tutorial.

Benefits of JD Edwards adapter
These are the benefits of the JD Edwards adapter:

- Proper decimal notation
- Automatic UDC lookups
- Julian to Gregorian date conversion
- User friendly column titles
- Leveraging Presumptive Joins (World only) and Security definitions

This tutorial will highlight the first four benefits.

Developing a JD Edwards Report
Here is how to develop a JD Edwards Report:

1. Log on to DB2 Web Query.
2. Expand DB2 Web Query → Century Electronics → Assignment 150 - Creating JD Edwards reports. Right-click the Assignment 15 - Creating JD Edwards reports folder, and select New → Report as in Figure 17-12.

![Menu to Create Report](image)

Figure 17-12   Menu to Create Report
3. Select the JD Edwards F0911 synonym in the **Select data source** dialog window. See Figure 17-13.

![Select Synonym](image)

*Figure 17-13  Select Synonym*
By default, you are presented with the Logical view of the field list from F0911. The Logical view arranges your fields by Dimension and Measures. Your fields are sorted such that all your numeric fields are grouped under a heading called Measures and all the character fields are grouped under Dimensions, as in Figure 17-14.

![Logical view of the field list](image)

*Figure 17-14  Logical view of the field list*
4. If you want display field names, you can set this by clicking the **Logical** icon on the View ribbon and selecting **Field**. See Figure 17-15.

![Figure 17-15 Display field names](image)

5. Scroll down the field list and notice the UDC (User Defined Codes) fields. These represent the descriptive text for key fields in the file.
6. Scroll down further and notice the Measures associated with this file, as in Figure 17-16.

![Figure 17-16 Measures fields](image-url)
7. Select some of each of the aforementioned fields and build a report. You can double-click fields, or drag and drop them on to your Interactive Design View panel to build the report. Info Assist will put dimensions as Sort fields and measures as Measure fields where you can aggregate as required. The other option is to drag fields into a specific area of the Query Panel.

Figure 17-17 shows the Interactive Design view using Data from Source. It represents what your report will look like at runtime using data from the JD Edwards data source.

Figure 17-17  Build a report

a. Notice that the Query Panel to be 2x2 has been changed by selecting the icon from the Query Panel group on the View ribbon. The icon on the View ribbon and the Query Panel group are both highlighted with boxes labeled A in Figure 17-17.

b. Notice the UDC field, DOCUMENT_TYPE_CODE_DESC_1, is provided. In this case, it is giving the descriptive name for Document Type. This is highlighted in the box labeled B in Figure 17-17.

c. Notice that the Date is converted to a Gregorian date YYMD. This is highlighted in the box labeled C in Figure 17-17.

d. Notice the decimal precision on the numeric columns as well as the friendly column titles. This is highlighted in the box labeled D in Figure 17-17.
8. There are a couple of tasks you can perform to enhance your report before running it:

a. UDC field titles can be changed by right-clicking the UDC field in the Interactive Design View and selecting the **Change Title**... option as in Figure 17-18.

![Interactive Design View](image)

*Figure 17-18   Menu to change title*

A dialog box will appear to allow you to enter in a new column title.

b. Currency fields can be easily formatted with floating currency symbols. Select a numeric field on the Interactive Design View. Let's select Amount. Notice the Field ribbon appears for Amount, as in Figure 17-19.

![Interactive Design View](image)

*Figure 17-19   Select Amount field*

Use the Format group on the Field ribbon to add floating currency and commas by clicking the respective icons. An item that is highlighted in yellow means the option is turned on. See Figure 17-20.

![Format group](image)

*Figure 17-20   Add floating currency*
To do more advance formatting, click the drop-down and select **More options**… See Figure 17-21.

![Menu to more options](image1.png)

*Figure 17-21  Menu to more options*

Change decimal precision to 2. See Figure 17-22.

![Window to change field format](image2.png)

*Figure 17-22  Window to change field format*
The Interactive Design View dynamically reflects this change, as in Figure 17-23.

![Interactive Design View of the report](image)

**Figure 17-23  Interactive Design View of the report**

c. Add a subtotal on each DOCUMENT_TYPE_CODE_DESC_1. On the Interactive Design View, click the DOCUMENT_TYPE_CODE_DESC_1 field and click the Subtotal icon in the Break group on the DOCUMENT_TYPE_CODE_DESC_1 Field ribbon as in Figure 17-24.

![Button to add Subtotal](image)

**Figure 17-24  Button to add Subtotal**
Notice that a subtotal is added dynamically to the Interactive Design View, as in Figure 17-25.

9. Save your report as **15a - JD Edwards report**.
10. Click the **Run** button on the Quick Access Toolbar to run your report, as in Figure 17-26.
Depending on your Info Assist settings, your report output will appear in a tab or window. In this example, Info Assist directs the output to a single tab. See Figure 17-27.

This tutorial guides you through your first JD Edwards report. As you can see, configuring the JD Edwards adapter, managing JD Edward synonyms, and developing a report with Web Query Info Assist is very similar to any other data source in Web Query.
The Century Challenge BI solution: Postmortem

In this chapter, we look back on the Century Challenge BI solution and provide the results of the challenge.
18.1 Summary

In the previous chapters in Part 2, you completed a variety of assignments related to the Century Challenge BI solution. In each chapter you were given assignments by a skeptical executive who did not believe in the IBM i platform, the DB2 for i database, or the DB2 Web Query product. In the end, you delivered on all of the assignments and in many cases, you exceeded Dan's expectations. All the reports, charts, dashboards, and scheduling requirements were delivered, and all within the 2-month period.

As a result of your efforts, Dan decided that you and Mel were correct: that the IBM i platform is powerful, modern, secure, stable, reliable, and leading edge. And that it would be foolish for a business to ever move off of such a platform. He humbly accepted defeat in the challenge, but in the process, he became an ardent and enthusiastic supporter of the IBM i. In fact, a few short months later, he placed the order for a new Power 7 model, and initiated projects to look at migrating other business applications and databases to the IBM i platform. He fired Fitzgerald (his caddy at the country club), citing an abundance of bad IT advice and lack of moral support. He even aspires to speak at midrange user conferences in the future to present a case studies on Century Challenge BI solution and the migration projects. What a difference two months makes!

Figure 18-1   The "new" Executive Dan (beard now gone)
IBM DB2 Web Query for i
Version 2.1

Follow the best practice guides to simplify report development

Take your reporting to the next level of Business Intelligence

Learn DB2 Web Query by using the easy-to-follow tutorials

Business Intelligence (B1) is a broad term relating to applications designed to analyze data for purposes of understanding and acting on the key metrics that drive profitability in an enterprise. Key to analyzing that data is providing fast, easy access to it while delivering it in formats or tools that best fit the needs of the end user.

At the core of any business intelligence solution are end user query and reporting tools that provide intuitive access to data supporting a spectrum of end users from executives to “power users,” from spreadsheet aficionados to the external Internet consumer.

IBM DB2 Web Query for i offers a set of modernized tools for a more robust, extensible, and productive reporting solution than the popular Query for System i tool (also known as Query/400). IBM DB2 Web Query for i preserves investments in the reports developed with Query/400 by offering a choice of importing definitions into the new technology or continuing to run existing Query/400 reports as-is. But it also offers significant productivity and performance enhancements by leveraging the latest in DB2 for i query optimization technology.

This IBM Redbooks publication provides a broad understanding of the new DB2 Web Query product. It entails a group of self-explanatory tutorials to help you get up to speed quickly. Overall, this book is designed for IT users. You can use Part 1, “Tutorials for DB2 Web Query” on page 1, as stand-alone tutorials for anyone who is developing their own queries.